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The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards
and Technology (NIST) addresses businesses’ most pressing cybersecurity problems with
practical, standards-based solutions using commercially available technologies. The NCCoE
collaborates with industry, academic, and government experts to build modular, open, end-to-
end reference designs that are broadly applicable and repeatable. The center’s work results in
publically available NIST Cybersecurity Practice Guides, Special Publication Series 1800, that
provide users with the materials lists, configuration files, and other information they need to
adopt a similar approach.

To learn more about the NCCoE, visit http://nccoe.nist.gov. To learn more about NIST, visit
http://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that
facilitate the adoption of standards-based approaches to cybersecurity. They show members of
the information security community how to implement example solutions that help them align
more easily with relevant standards and best practices.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. The documents in this series do not
describe regulations or mandatory practices, nor do they carry statutory authority.

To protect power generation, transmission, and distribution, energy companies need to control
physical and logical access to their resources, including buildings, equipment, information
technology, and industrial control systems. They must authenticate authorized individuals to the
devices and facilities to which they are giving access rights with a high degree of certainty. In
addition, they need to enforce access control policies (e.g., allow, deny, inquire further)
consistently, uniformly, and quickly across all of their resources. This project resulted from direct
dialogue among NCCoE staff and members of the electricity subsector, mainly from electric
power companies and those who provide equipment and/or services to them. The goal of this
project is to demonstrate a centralized, standards-based technical approach that unifies identity
and access management (IdAM) functions across operational technology (OT) networks,
physical access control systems (PACS), and information technology systems (IT). These
networks often operate independently, which can result in identity and access information
disparity, increased costs, inefficiencies, and loss of capacity and service delivery capability. This
guide describes our collaborative efforts with technology providers and electric company
stakeholders to address the security challenges energy providers face in the core function of
IdAM. It offers a technical approach to meeting the challenge, and also incorporates a business
value mind-set by identifying the strategic considerations involved in implementing new


http://172.16.33.88:9080/AlertEnterprise/
https://nistgov.sharepoint.com/sites/nccoe/Energy/Shared%20Documents/IdAM%20Practice%20Guide/Drafts/NIST_SP1800-2c_ES_IDAM-HowToLRK.docx
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technologies. This NIST Cybersecurity Practice Guide provides a modular, open, end-to-end
example solution that can be tailored and implemented by energy providers of varying sizes and
sophistication. It shows energy providers how we met the challenge using open source and
commercially available tools and technologies that are consistent with cybersecurity standards.
The use case scenario is based on a normal day-to-day business operational scenario that
provides the underlying impetus for the functionality presented in the guide. While the
reference solution was demonstrated with a certain suite of products, the guide does not
endorse these products in particular. Instead, it presents the characteristics and capabilities that
an organization’s security experts can use to identify similar standards-based products that can
be integrated quickly and cost-effectively with an energy provider’s existing tools and
infrastructure.

Cyber, physical, and operational security; cyber security; electricity subsector; energy sector;
identity and access management; information technology
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1.1 PRACTICE GUIDE STRUCTURE

This NIST Cybersecurity Practice Guide demonstrates a standards-based example solution and
provides users with the information they need to replicate this approach to identity and access
management (IdAM). The example solution is modular and can be deployed in whole or in
parts.

This guide contains three volumes:

o NIST SP 1800-2a: Executive Summary

e NIST SP 1800-2b: Approach, Architecture, and Security Characteristics — what we built
and why

e NIST SP 1800-2c: How To Guides — instructions - YOU ARE HERE

for building the example solution

The following instructions show IT professionals and security engineers how the National
Cybersecurity Center of Excellence (NCCoE) implemented example solutions to the challenge of
a centralized IdAM system. We developed two builds that conform to federal standards and best
practices, and address the challenge of providing a secure, centralized, uniform, and efficient
solution for managing authentication and authorization services, access control, and
provisioning across what are currently three independent and disparate corporate silos: IT,
operational technology (OT), and physical access control systems (PACS) networks.

This example solution is packaged as a “How To” guide. The guide demonstrates how to
implement standards-based, commercially available cybersecurity technologies in the real
world, based on risk analysis.

We cover all the products that we employed in this example solution. We do not recreate the
product manufacturer’s documentation, which is presumed to be widely available. Rather, these
guides show how we incorporated the products together in our environment.

These guides assume that the people using this document have experience implementing
information technology security products (including systems integration and administration of
networked Windows and Linux systems, firewalls, routers, etc.) in an electricity subsector
organization. While we have used the commercially available products described here, we
assume that you have the knowledge and expertise to choose other products that might better
fit your IT systems and business processes.” If you use substitute products, we hope you'll seek

! Certain commercial entities, equipment, or materials may be identified in this document in order to describe an
experimental procedure or concept adequately. Such identification is not intended to imply recommendation or
endorsement by NIST or NCCoE, nor is it intended to imply that the entities, materials, or equipment are

necessarily the best available for the purpose.
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products that are congruent with standards and best practices, as we have. Refer to NIST SP
1800-2b: Approach, Architecture, and Security Characteristics, Section 4.5, Table 2, for a list of
the products that we used, mapped to the cybersecurity controls provided by this example
solution, to understand the characteristics you should seek in alternate products. Section 4.4
Security Characteristics and Controls Mapping, of that document describes how we arrived at
this list of controls.

The security characteristics in our access management platform are informed by guidance and
best practices from standards organizations, including the North American Electric Reliability
Corporation’s (NERC) Critical Infrastructure Protection (CIP) standards. In addition, this
document was reviewed by the NERC ES-ISAC to ensure that the approach was informed by
standards and NERC regulations.

While we have used a suite of commercial products to address this challenge, this guide does
not endorse these particular products, nor does it guarantee regulatory compliance. Your
utility’s information security experts should identify the standards-based products that will best
integrate with your existing tools and IT system infrastructure. Your company can adopt this
solution or one that adheres to these guidelines in whole, or you can use this guide as a starting
point for tailoring and implementing parts of a solution. This NIST Cybersecurity Practice Guide
does not describe “the” solution, but a possible solution. This is a draft version. We are seeking
feedback on its contents and welcome your input. Comments and suggestions will improve
subsequent versions of this guide. Please contribute your thoughts to energy_nccoe@nist.gov,
and join the discussion at http://nccoe.nist.gov/forums/energy.

1.2 CONVENTIONS

Filenames, pathnames, partitions, URLs, and program names are in italic text:
filename.conf
.../folder/filename.conf
http.//nccoe.nist.gov

Commands and status codes are in Courier:
mkdir

Code that a user inputs is in Garamond bold:

service sshd start

NIST Cybersecurity Practice Guide SP 1800-2c
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The NCCoE constructed the IdAM build infrastructure using off-the-shelf hardware and
software. The infrastructure was built on Dell model PowerEdge R620 server hardware. The
server operating system was VMware vSphere virtualization operating environment. In addition,
a 6-terabyte Dell EquallLogic network attached storage (NAS) product was used for storage, Dell
model PowerConnect 7024 and Cisco Catalyst 3650 and 3550 physical switches were used to
interconnect the server hardware, external network components, and the NAS.

The lab network was accessible from the public Internet via a virtual private network (VPN)
appliance and firewall to enable secure Internet and remote access. The lab network was not
connected to the NIST enterprise network. Table 1 lists which software and hardware
components were used in the builds, the specific function each component contributes, and
whether the product was installed within the virtual environment or as physical device.

Product Vendor

Dell

Dell

Dell

VMware

Microsoft

Microsoft

Windows

Windows

Table 1. Build Implementation Component List (including security controls)

Component
PowerEdge R620
PowerConnect 7024
Equallogic

vSphere vCenter Server
version 5.5

Windows Server 2012
r2
Active Directory Server

Windows 7

Windows Server 2012
r2
DNS Server

SQL Server

NIST Cybersecurity Practice Guide SP 1800-2c

Function
Server hardware
Network switch

Network attached
storage

Virtual server and
workstation
environment

Authentication and
authority

Information
management

Domain name system

Database

Implementation
(physical device or
virtual environment)

Physical device
Physical device

Physical device

Virtual environment

Virtual environment

Virtual environment

Virtual environment

Virtual environment
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Product Vendor

AlertEnterprise

CA Technologies

Cisco

Cisco

Cisco

GlobalSign

Mount Airey
Group

Mount Airey
Group

Mount Airey
Group

Mount Airey
Group

RADiFlow

4 | NIST Cybersecurity Practice Guide SP 1800-2c

Component

Enterprise Guardian

Identity Manager
Rel 12.6.05 Build
06109.28

ISE Network Server
3415

Catalyst 3550

Catalyst 3650

SSL Certificate

Ozone Authority

Ozone Console

Ozone Envoy

Ozone Server

Industrial Service
Management Tool
(iSIm)

Function

Interface and translation
between IdAM central
store and the PACS
management server

Identity and access
automation
management
application, IdAM
provisioning

Network access
controller

Network switch

TrustSec-enabled
physical network switch

Cloud certificate and
registration authority

Central attribute
management system

Ozone administrative
management console

Enterprise identity store
interface

Ozone centralized
attribute based
authorization server

Supervisory control and
data acquisition (SCADA)
router management
application

Implementation
(physical device or
virtual environment)

Virtual environment

Virtual environment

Virtual environment

Physical device

Physical device

Virtual environment

Virtual environment

Virtual environment

Virtual environment

Virtual environment

Physical device
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Product Vendor

RADiFlow

RSA

RSA

TDi Technologies

RS2 Technologies

Schweitzer
Electronics
Laboratory

Schneider
Electric

XTEC

Component

SCADA Router
RF-3180S

Adaptive Directory
Version 7.1.5

IMG
Version 6.9
Build 74968

ConsoleWorks

AccessIT! Universal
Release 4.1.15

Physical access control
components

SEL-2411

Tofino Firewall model
number
TCSEFEA23F3F20

Xnode

2.1 BUILD IMPLEMENTATION OVERVIEW

Function

Router/firewall for
SCADA network

Central identity store,
IdAM provisioning

Central IdAM system
(workflow management)

User access controller,
monitor, and logging
system

Configures and monitors
the PACS devices (e.g.,
card readers, keypads)

Remote Terminal Unit
(RTU)

Ethernet/IP firewall

Remote access control
and management

Implementation
(physical device or
virtual environment)

Physical device

Virtual environment

Virtual environment

Virtual environment

Virtual environment
server and physical
device card reader

Physical device

Physical device

Physical device

The build implementation consists of multiple networks implemented to mirror the
infrastructure of a typical energy industry corporation. The networks include a management
network and a production network, Figure 1. The management network was implemented to
facilitate the implementation, configuration, and management of the underlying infrastructure,
including the physical servers, vSphere infrastructure, and monitoring. The production network,

Figure 1, consists of

e the demilitarized zone (DMZ)

NIST Cybersecurity Practice Guide SP 1800-2c
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e Identity and Access Management - IdAM

e [T - business management system

e OT - ICS/SCADA industrial control system and energy management system (EMS)
e PACS — physical access control system networks

These networks were implemented separately to match a typical electric utility enterprise
infrastructure. Firewalls are configured to route traffic and limit access among the production
networks to block all traffic except required inter-network communications. The primary inter-
network communications are the user access and authorization updates from the central IdAM
systems to and from the directories and PACS, IT, and OT networks. The DMZ provides a
protected neutral network space that the other networks of the production network can use to
route traffic to and from the Internet or each other.
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Figure 2. IdAM build implementation production network

The IdAM network represents the proposed centralized/converged IdAM network/system. This

network was separated to highlight the unique IdAM components proposed to address the use
case requirements.

The IT network represents the business management network that typically supports corporate

email, file sharing, printing, and Internet access for general business-purpose computing and
communications.

The OT network represents the network used to support the energy management systems
(EMS)s and industrial control systems (ICS)/supervisory control and data acquisition (SCADA)
systems. Typically, this network is either not connected to the enterprise IT network or is
connected with a data diode (a one-way communication device from the OT network to the IT
network). Two-way traffic is allowed per NERC-CIP and is enabled via the OT firewall only for
specific ports and protocols between specific systems identified by IP address.

The PACS network represents the network used to support the physical access control systems
across the enterprise. Typically, this network uses the enterprise IT network and is segmented
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from the user networks via virtual local area networks (VLANSs). In our architecture, a firewall is
configured to allow limited access to and from the PACS network to facilitate the
communication of access and authorization information. Technically, this communication
consists of user role and responsibility directory updates originating in the IdJAM system.

The public Internet is accessible by the lab environment to facilitate both cloud services and
access for vendors and NCCoE administrators.

The VPN firewall was the access control point for vendors to support the installation and
configuration of their components of the architecture. The NCCoE also used this access to
facilitate product training. This firewall also blocked unauthorized traffic from the public
Internet to the production networks. Additional firewalls are used to secure the multiple
domain networks (IT, OT, IdAM, and PACS) explained below.

Switching in the implementation is executed using a series of physical and hypervisor soft
switches. VLAN switching functions are handled by physical Dell switches and the virtual
environment. Routing was accomplished using the firewalls.

2.2  BUILD IMPLEMENTATION DESCRIPTIONS

Figure 3 depicts the build network comprising the management, VendorNet, IdAM, DMZ, IT, OT,
and PACS subnetworks. VendorNet provides remote access for vendors to access, configure,
demonstrate, and provide training for each of the implemented products. The IdAM network
contains the central IJAM components of the build (described below). The IT, OT, and PACS
networks contain the representative components of a typical electric utility enterprise, as
described below.
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140 Figure 3. Build Network

141  The IdAM network (Figure 4 and Figure 5) contains the central IdJAM components for Build #1
142 and Build #2. The IdAM components are placed into a separate network to highlight the
143  importance of protecting these assets and to simplify the demonstration of their capabilities.
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Build #1 uses the CA Identity Manager product for the IdAM system and identity store.
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149  Build #2 uses the RSA IMG and Adaptive Directory products for the IdAM system and identity
150  store.

151  The IT network (Figure 6) contains the components common in the business operations IT
152  networks/systems in all organizations.

Information Technology

NCCoE Management Network

FW 1032.2.0/24 Business Operations Area
DMZ
172.16.7.128/25
133
R
IT_Fw &
IT - VLAN101 1 rustsec
172.16.5.0/24 Switch
%\ .250
MS AD @
' : 8 -
77 &$
[}
Cisco ISE
(Identity
Services
Engine)
153 VMware Virtual Datacenter
154 Figure 6. IT Network

155  The OT network (Figure 7) contains the OT components, which include representative

156  components found in electric utility OT networks/systems. These components were chosen to
157  demonstrate the integration capabilities of the central IJAM capability. The lab did not attempt
158  to replicate a fully operational OT network or set of systems. Because we had a limited number
159  of remote terminal units (RTUs) available, we used Raspberry Pi on the network to emulate an
160 RTU.
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The PACS network (Figure 8) contains the PACS components, which include representative
components found in electric utility physical access control systems. These components were
chosen to demonstrate the integration capabilities of the central IdAM capability.

Physical Access Control Area

Management Network
10.32.2.0/24

DMZ
172.16.7.128/25

135

PACS FW ﬁ

PACS - VLAN104 n
172.16.7.0/24
0 i 1
Physical Network 7 \w
PACS Active|y ;
amn Directory | o ' .
S
o g
Reader
Card Read
\A;:’i:h K:_:p:crl \/\—3
000 RS2Tech |5
000 X
keypad Electronic \/
Lock TBD
Win Serv
2012
Network of PAC Systems
VMware Virtual Datacenter

Figure 8 PACS Network
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168 2.3

169 Table 2 includes the IP address assignments used for the builds.

IP NETWORK ADDRESS ASSIGNMENTS

170 Table 2 Build IP Address Assignments
DMz System Vendor Access System IdAM Mgmt System
Network IP Network IP Network IP
10.32.2.0/25 | Subnet 10.32.2.128/25 | Subnet 172.16.4.0/24 | Subnet
10.32.2.1 NCCoE 10.32.2.129 NCCoE 172.16.4.1 IdAM FW
FW/Gateway FW/Gateway LAN
10.32.2.10 Vcenter 10.32.2.130 Vendor AD 172.16.4.2 RSA IMG
10.32.2.11 ESXi #1 10.32.2.131 Vendor RDS §172.16.4.3 RSA
Adaptive
Directory
10.32.2.12 ESXi #2 10.32.2.132 RSA/SCE 172.16.4.5 AlertEnter
prise
10.32.2.22 Border FW 10.32.2.133 AlertEnt 172.16.4.9 Ozone
WAN Console
10.32.2.50 RS1 FTP 10.32.2.134 CA 172.16.4.10 Ozone
Synology Server
10.32.2.X Veam Backup J 10.32.2.135 RADiFlow 172.16.4.11 Ozone
Server Authority
10.32.2.136 MAG 172.16.4.12 Ozone
Envoy
10.32.2.137 TDi 172.16.4.13 Ozone PPA
10.32.2.232 Border FW 172.16.4.15 CA IM
OPT1
172.16.4.22 Microsoft
sQL
172.16.4.253 CentOS
DNS
171
172
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173 Table 2. (cont.) Build IP Address Assignments
IT Network System PAC Network System OT Network System
IP IP IP
172.16.5.0/ subnet 172.16.7.0/25 Subnet 172.16.6.0/25 Subnet
24
172.16.5.1 IT FW LAN 172.16.7.1 PACS FW 172.16.6.1 OT FW LAN
LAN
172.16.5.2 IT AD, DNS, 172.16.7.2 PACS AD, 172.16.6.2 OT AD, DNS,
CA DNS, CA CA
172.16.5.6 | Workstation 172.16.7.5 n/a 172.16.6.4 RADiFlow
FW/SW
172.16.5.7 | Workstation 172.16.7.6 | XTEC XNode 172.16.6.5 Schneider
Firewall
172.16.7.11 PACS 172.16.6.6 Workstation
Console
172.16.7.15 PACS 172.16.6.8 TDi
Workstation ConsoleWorks
172.16.7.101 LAB Door 172.16.6.100 RADiFlow
Controller Terminal
Server for SEL
172.16.6.202 RADiFlow
Vendor Host
174
175
176 3.1 OPERATING SYSTEMS
177  All machines used in the build had one of the following operating systems (OS) installed:
178 e Windows 7 enterprise
179 e Windows server 2008 R2
180 e Windows server 2012 R2
181 e MicroFocus SUSE Linux Enterprise Server 11
182 e (CentOS7.
183 3.1.1 Windows Installation and Hardening Details
184  The NCCoE Windows OS images are derived from the Department of Defense (DoD) Security
185  Technical Implementation Guide (STIG) images. The Windows systems were installed using
186 installation files provided by the Defense Information Systems Agency (DISA). These images
187  were chosen because they are standardized, hardened, and fully documented. The STIG
188  guidelines are available on-line at http://iase.disa.mil/stigs/os/Pages/index.aspx.
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Modifications to the STIG compliant OS configurations were required for each product to enable
its operation. The compliance results in Section 17 identify the specific OS configuration
modifications (noncompliant configuration items) needed in each case.

3.1.2  SUSE Linux Enterprise Server 11 Installation and Hardening Details

The SUSE OS was included as part of the virtual appliance image provided by RSA for the IMG
product. The center did not make any OS configuration changes. The OS was not configured to
meet the DoD CentOS 6 STIG. The STIG guidelines are available on-line at
http://iase.disa.mil/stigs/os/Pages/index.aspx. The OS configurations for SUSE Linux
implementation are listed in Section 17. The compliance results report for SUSE Linux is
included for illustration purposes, Section 20.2.

3.1.3 Base Linux Installation and Hardening Details

The NCCoE base Linux OS used in the build is CentOS 7. This OS is available as an open source
image. The OS was configured to meet the DoD CentOS 6 STIG, because no CentOS 7 STIG was
available at the time the build was implemented. The STIG guidelines are available on-line at
http://iase.disa.mil/stigs/os/Pages/index.aspx. The OS configurations for each Linux
implementation are listed in section 17. The compliance results reports identify the
configuration items that do not conform to the STIG configuration guide.

3.2 FIREWALL CONFIGURATIONS

The firewalls were deployed to minimize the allowed traffic among the silo networks as well as
to minimize traffic received from the DMZ and the public Internet. The goal was to limit the
cross-network traffic/connections to only those required to support the use case.

The following firewall configurations include the rules that were implemented in each of the
firewalls for the build implementation. These configurations are provided to enable the reader
to reproduce the traffic filtering/blocking that was achieved in the build implementation.
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Table 3. Border Firewall Rules

Aliases

Name Values Description

Virtuallnfra 10.32.2.10-12 Virtualization Systems for Build

VPNserver 172.16.7.253 VPN Server

WAN Interface

Allow/Deny Protocol Source Port Destination Port | Description

Allow IPv4 — All 10.32.2.0/25 Any Any Any Allow all management
network traffic

Allow IPv4 — All 10.255.2.0/25 Any Any Any Center VPN to all
systems

Allow IPv4 — TCP Any Any WAN Address 80 Allow access to
WebGUI pfSense

Allow IPv4 —TCP 10.255.2.0/25 Any 172.16.4.8 5176 | Center VPN to
Consoleworks

Allow IPv4 — TCP 10.255.2.0/25 Any 172.16.4.8 443 Center VPN to
Consoleworks HTTPS

Deny IPv4 — TCP Any Any WAN Address Any Block All access to
pfSense

Allow IPv4 — TCP Any Any 172.16.7.110 3389 | RDP to Lab-PCon
PACS (Backups)
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Table 4. Border Firewall Rules (continued)

LAN Interface

Allow/Deny Protocol Source Port Destination | Port | Description

Allow IPv4 — All 172.16.7.135 Any Virtuallnfra | Any | Lab laptop to
Virtualization

Deny IPv4 — All Any Any Virtuallnfra | Any | Block all to
Virtualization

Deny IPv4 — TCP 172.16.8.0/24 Any 10.32.2.0/25 | Any | Block Vendor VPN from
Management

Deny IPv4 —TCP 10.32.2.128/25 | Any 10.32.2.0/25 | Any | Block Vendor VPN from
Management

Allow IPv4 — All LAN Net Any Any Any | Default Allow Any LAN

Allow IPv6 — All LAN Net Any Any Any | Default Allow Any LAN

Allow IPv4 —TCP 172.16.7.128/25 | Any 10.32.2.117 | 3389 | RDP to 117

Allow IPv4 — UDP 172.16.7.128/25 | Any 10.32.2.117 | 3389 | RDP to 117

Deny IPv4 — All Any Any Any Any | Block IPv4

Deny IPv6 — All Any Any Any Any | Block IPv6
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Table 5. IdAM Firewall Rules

Aliases

Name Values Description

AD_DCs_All | 172.16.{5,6,7},2 All DCs in

Infrastructure
LinuxSystems | 172.16.4.{2,3,8,1 Used for SSH
0,11,12,253}
MAG_Linux | 172.16.4.{10,11, Systems for MAG
12}
WAN Interface

Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All 10.32.2.0/25 | Any Any Any Allow all management network traffic
Allow IPv4 — All 10.255.2.0/25 | Any Any Any Center VPN to all systems
Allow IPv4 — TCP 172.16.7.133 | Any Any Any IT to IdAm
Allow IPv4 — TCP Any Any LinuxSystems IMG Allow SSH to Linux
Allow IPv4 — All Any Any 172.16.4.8 161,162,514 Allow SNMP, Syslog, default to TDi

,5176
Allow IPv4 — All AD_DCs_All Any 172.16.4.15 Any AD DCs to IdAM-CA
Allow IPv4 — All 172.16.8.50 Any | 172.16.4.15,22 Any CA to CA_srvl2, CA_SQL srv12
Allow IPv4 — TCP Any Any 172.16.4.2 5900-5910 VNC to IMG
Allow IPv4 — TCP 172.16.7.2 Any 172.16.4.2 Any PACS AD to IMG
Allow IPv4 — TCP 172.16.7.2 Any 172.16.4.3 Any PACS AD to Adaptive Directory
Allow IPv4 — TCP 10.32.2.0/25 Any 172.16.4.8 517, 6443 MGMT to TDi Consoleworks
LAN Interface

Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All LAN Net Any Any Any Default Allow Any LAN
Allow IPv6 — All LAN Net Any Any Any Default Allow Any LAN

Table 6. IT Firewall Rules
Aliases
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Name Values Description
Alert_Enterprise 172.16.4.5 AlertEnterprise
CA 172.16.4.15 CA
CA_RSA _Alert | 172.16.4.{2,3,5,15}, | CA, RSA, Alert
172.16.7.132
ConsoleWorks 172.15.4.8 Console Works
IT_Network 172.16.7.132 IT network
LinuxSystems 172.16.5.4 All Linux on IT
Ozone 172.16.4.10-12 Ozone products
RSA 172.16.4.2-3 IMG, Adaptive
Dir
WAN Interface
Allow/Deny Protocol Source Port | Destination Port Description
Allow IPv4 — All 10.32.2.0/25 Any Any Any Allow all management network traffic
Allow IPv4 — TCP 172.16.7.132 Any Any Any I[dAM to IT
Allow IPv4 — TCP Any Any | LinuxSystems 22 Allow SSH to Linux
Allow IPv4 — All Any Any 172.16.5.2 53 Allow DNS
Allow IPv4 — TCP IT_Network Any 172.16.5.4 25443 Alert to ITEMAIL
Allow IPv4 — TCP ConsoleWorks Any LAN net 22,161-162 TDI to IT-Net
Allow IPv4 — TCP CA_RSA_Alert Any 172.16.5.2 389, 636 LDAP/LDAPS to AD
LAN Interface
Allow/Deny Protocol Source Port | Destination Port Description
Allow IPv4 — All LAN Net Any Any Any Default Allow Any LAN
Allow IPv6 — All LAN Net Any Any Any Default Allow Any LAN
Table 7. OT Firewall Rules
Aliases
Name Values Description
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LinuxSystems 172.16.6.7 All Linux on OT
RADiFlow 172.16.6.{4,6,202} | All RADiFlow IPs
WAN Interface

Allow/Deny Protocol Source Port Destination Port Description

Allow IPv4 — All 10.32.2.0/25 Any Any Any Allow all management network
traffic
Allow IPv4 — TCP Any Any 172.16.6.10 22 SSH to RPi RTU
Allow IPv4 — TCP Any Any LinuxSystems 22 Allow SSH to Linux
Allow IPv4 — All Any Any 172.16.6.2 53 Allow DNS
Allow IPv4 — All 172.16.4.8 Any LAN net 22,161- TDI to OT-Net
162
Allow IPv4 —TCP Any Any 172.16.6.2 389, 636 Any LDAP to AD
Allow IPv4 — TCP 172.16.4.{2,3,15} | Any 172.16.6.2 Any AdaptiveDir, IMG, CA IM to AD
Allow IPv4 — TCP Any Any 172.16.6.100 2001- Telnet Access through RADiFlow
2101
LAN Interface

Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All LAN Net Any Any Any Default Allow Any LAN
Allow IPv6 — All LAN Net Any Any Any Default Allow Any LAN

221
222
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Table 8. PACS Firewall Rules

Aliases
Name Values Description
Virtuallnfra 10.32.2.10-12 Virtualization Systems
for Build
WAN Interface
Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All 10.32.2.0/25 Any Any Any Allow all management network
traffic
Allow IPv4 — All 172.16.7.132 Any | 172.16.7.{2,11} Any IdAM to PACS-Console, PACSDC
Allow IPv4 — TCP Any Any 172.16.7.2 389, 636 Any LDAP to AD
Allow IPv4 — All Any Any 172.16.7.2 53 Allow DNS
Allow IPv4 — All 172.16.4.8 Any LAN net 22,161- TDI to PACS-Net
162
Allow IPv4 — TCP 172.16.4.{2,3,15} | Any 172.16.7.2 Any AdaptiveDir, IMG, CA IM to AD
Allow IPv4 — TCP Any Any | 172.16.7.110 3389 MRDP Nat to LAB Machine PACS
LAN Interface
Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All LAN Net Any Any Any Default Allow Any LAN
Allow IPv6 — All LAN Net Any Any Any Default Allow Any LAN
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225 3.3 NETWORK SERVICES

226  Microsoft Active Directory was used to provide directory services in each silo networks (OT,
227  PACS, IT). Linux CentOS 7 was used to provide DNS services in the IdAM network. Microsoft
228  Windows Server was used to provide certificate authority services in each network.

229 3.3.1 IT Network — Network Services (AD and Certificate Authority) Installation and Configuration Settings
230 3.3.1.1 Active Directory

231  Use these basic domain controller configuration settings:

232 e Hostname: ITDC
233 e Domain: ES-IDAM-B1.TEST
234 e |P:172.16.5.2

235  Step-by-step instructions:

236 1. Launch Server Manager.

237 2. From the dashboard, select Option 2, Add Roles and Features.

238 3. Select Role-based or Feature-based installation.

239 4. From the server pool, select the local server named ITDC.

240 5. Select Active Directory Domain Service and DNS Server.

241 6. When prompted to add features, select Add Features for each role.

242 7. Wait for Server Manager to finishes installing,

243 8. Select Post-Deployment Configuration for Active Directory from the Task menu.

244 9. After Active Directory Domain Services Configuration Wizard automatically launches.
245 e Select Add a New Forest deployment operation.

246 e Specify ES-IDAM-B1.TEST root domain, then select Next >.

247 e Select Windows Server 2012 R2 for both the Forest Functional Level and the
248 Domain Functional Level,

249 e Under Domain Controller Capabilities:

250 o Check both DNS server and Global Catalog.

251 o Uncheck read-only domain controller.

252 o Specify a password for DSRM and select Next >.

253 e Continue through the Wizard without modifying any options.

254 e Select Install on the next window. After installation, the server automatically
255 reboots.

256  3.3.1.2 Certificate Authority Role
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e Use these basic certificate authority configuration settings: CA Setup Type:
Enterprise CA

e CAType: Root CA

e Cryptographic options: RSA 2048 and SHA1
e CN:IT-ES-IDAM-B1-IDAM-ITDC

e DN suffix: DC=IT-ES-IDAM-B1, DC=TEST

Step-by-step instructions:

From the Server Manager dashboard, select Option 2, Add Roles and Features.

Select Role-based or Feature-based installation (this is a single option to choose).

From the server pool, select the local server named OTDC.

When prompted to add features, select Add Features.

1.

2.

3

4. Select Active Directory Certificate Services.

5

6. When prompted to select roles services, check Certificate Authority.
7

After the Server Manager finishes installing, select Post-deployment Configuration for

Certificate Services from the Task menu.
8. When prompted to specify setup type, select Enterprise CA.
9. When prompted to specify CA type, select Root CA.

10. When prompted to specify private key, select Create a new private key.

11. When prompted to specify cryptographic options, select RSA with a key length of 2048

and select SHA1 for the hash algorithm.

12. Leave the CN and DN suffix, which should be based on the computers hostname and

domain.
13. Select 5 years for certificate validity period.
14. Leave the default options for the certificate database and log location.

15. After configuration is complete, restart the server.

3.3.2  OT Network — Network Services (AD, DNS Server, and Certificate Authority) Installation and
Configuration Settings

3.3.2.1 Active Directory Domain Services and DNS Server

e Use these basic certificate authority configuration settings:Hostname: OTDC
e Domain: OT-ES-IDAM-B1.TEST
e [P:172.16.6.2

Step-by-step instructions:

1. Launch Server Manager.
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N o u kW N

From the dashboard, select Option 2, Add Roles and Features.
Select Role-based or Feature-based installation.

From the server pool, select the local server named OTDC.
Select Active Directory Domain Service and DNS Server.

When prompted to add features, select Add Features for each role.

After the Server Manager finishes installing, select Post-deployment Configuration for

Active Directory from the Task menu.
The Active Directory Domain Services Configuration Wizard launches:
e Forthe deployment operation, select Add a New Forest.

e For the root domain, specify OT-ES-IDAM-B1.TEST, then select Next >.

e For both the Forest Functional Level and the Domain Functional Level, select

Windows Server 2012 R2.
e Under Domain Controller Capabilities:
o Check both DNS server and Global Catalog.
o Uncheck read-only domain controller.
o Specify a password for DSRM and select Next >.

e Continue through the wizard without modifying any options.

On the last page, select Install. After installation, the server automatically
reboots.

3.3.2.2 Certificate Authority Role

Use these basic certificate authority configuration settings:CA Setup Type:
Enterprise CA

CA Type: Root CA

Cryptographic options: RSA 2048 and SHA1
CN: OT-ES-IDAM-B1-IDAM-QOTDC

DN suffix: DC=0T-ES-IDAM-B1, DC=TEST

Step-by-step instructions:

1.
2
3
4.
5
6

Ensure the domain controller installation has been completed before proceeding.
From the Server Manager dashboard, select Option 2, Add Roles and Features.
Select Role-based or Feature-based installation (this is a single option to choose)
From the server pool, select the local server named OTDC.

Select Active Directory Certificate Services.

When prompted to add features, select Add Features.
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9.

10.

11

13.

14.
15.
16.

333

When prompted to select roles services, check Certificate Authority.

After the Server Manager finishes installing, select Post-deployment Configuration for
Certificate Services from the Task menu.

When prompted to specify setup type, select Enterprise CA.
When prompted to specify CA type, select Root CA.

. When prompted to specify a private key, select Create a new private key.

12.

When prompted to specify cryptographic options, select RSA with a key length of 2048
and select SHA1 for the hash algorithm.

Leave the CN and DN suffix, which should be based on the computer’s hostname and
domain.

Select 5 years for certificate validity period.
Leave the default options for the certificate database and log location.

After configuration is complete, restart the server.

PACS Network — Network Services: AD, DNS Server, and Certificate Authority Installation and
Configuration Setting

3.3.3.1 Active Directory Domain Services and DNS Server

Use these basic domain controller configuration settings:

e Hostname: PACSDC
e Domain: PACS-ES-IDAM-B1.TEST
e |P:172.16.7.2

Step-by-step instructions:

1.
2.
3.

4
5.
6
7

Launch Server Manager.

From the dashboard, select Option 2, Add Roles and Features.

Select Role-based or Feature-based installation (this is a single option to choose).
From the server pools, select the local server named PACSDC.

Select Active Directory Domain Service and DNS Server.

When prompted to add features, select Add Features for each role.

After the Server Manager finishes installing, select Post-deployment Configuration for
Active Directory from the Task menu.

The Active Directory Domain Services Configuration Wizard launches:

e Select Add a new forest for the deployment operation. Specify PACS-ES-IDAM-
B1.TEST for the root domain, then select Next.
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3.3.3.2

e Select Windows Server 2012 R2 for both the forest functional level and the
domain functional level.

e Under domain controller capabilities:
o Check both DNS server and Global Catalog.
o Uncheck read-only domain controller.
o Specify a password for DSRM and select Next >.

e Continue through the Wizard without modifying any options.

On the last page, select Install. After installation, the server automatically
reboots.

Installation of Certificate Authority Role on the PACS network

Use these basic domain controller configuration settings:

CA Setup Type: Enterprise CA

CA Type: Root CA

Cryptographic options: RSA 2048 and SHA1
CN: PACS-ES-IDAM-B1-IDAM-PACSDC

DN suffix: DC=PACS-ES-IDAM-B1, DC=TEST

Step-by-step instructions:

N o u kr w N oe

0o

10.
11.

12.

13.

From the Server Manager dashboard, select the Option 2, Add Roles and Features.
Select Role-based or Feature-based installation.

From the server pools, select the local server named OTDC.

Select Active Directory Certificate Services.

When prompted to add features, select Add Features.

When prompted to select roles services, check Certificate Authority.

After the Server Manager finishes installing, select Post-deployment Configuration for
Certificate Services from the Task menu.

When prompted to specify setup type, select Enterprise CA.
When prompted to specify CA type, select Root CA.
When prompted to specify private key, select Create a new private key.

When prompted to specify cryptographic options, select RSA with a key length of 2048
and select SHA1 for the hash algorithm.

Leave the CN and DN suffix, which should be based on the computer’s hostname and
domain.

Select 5 years for certificate validity period.
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14. Leave the default options for the certificate database and log location.
15. After configuration is complete, restart the server.

3.3.3.3 Modify the AD Lightweight Directory Access Protocol (LDAP) schema with custom PACS
attributes.

Custom attribute details:

e Common Name: pacsAllDoors

e X.5000ID:1.3.6.1.4.1.4203.666.1
e Syntax: Boolean

e Common Name: pacsHomeAccess

e X.5000ID:1.3.6.1.4.1.4203.666.2
e Syntax: Boolean

e Common Name: pacsWorkAccess

e X.5000ID:1.3.6.1.4.1.4203.666.3
e Syntax: Boolean

Step-by-step instructions:

1. Launch Command Prompt as an administrator.
2. Runthe command: regsvr32 schmgmt.dll

3. Launch the Microsoft Management Console.

4. Select File > Add/Remove Snap-in.

5. From the Snap-in menu, select Active Directory Schema, then select OK.

6. Expand the Active Directory Schema, then select Attributes.

7. To create an attribute for the all doors access level, right-click on Attributes, then select
Create Attribute.

8. Select OK when prompted with the Schema Object Creation Warning.

9. Enter the following fields:
e Common Name: pacsAllDoors
e LDAP Display Name: pacsAllDoors
e Unique X500 ObjectID:1.3.6.1.4.1.4203.666.1
e Syntax: Boolean
10. Select OK when finished.
11. Create an attribute for the home access level by entering the following fields:
e Common Name: pacsHomeAccess

e LDAP Display Name: pacsHomeAccess
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e Unigue X500 ObjectID:1.3.6.1.4.1.4203.666.2
e Syntax: Boolean
12. Create an attribute for the work access level by entering the following fields:
e Common Name: pacsWorkAccess
e LDAP Display Name: pacsWorkAccess
e Unigue X500 ObjectID:1.3.6.1.4.1.4203.666.3
e Syntax: Boolean

13. After creating custom attributes, add the attributes to the user class so that every user
contains the attribute:

e Select the Classes drop-down under Active Directory Schema.
e Right-click on User, then select Properties.
e Select the Attributes tab, then select Add.

e Select the attribute you want to add to the user class. Then select OK. Do this for
the pacsAllDoors, pacsHomeAccess and pacsWorkAccess attributes.

e Then select Apply and OK.

e Restart the server.

3.3.4 |dAM Network — Network Services (DNS Server) Installation and Configuration Settings
A Linux CentOS 7 DNS server was established on the IdAM network to provide DNS services to
the IdAM components. No other network service was installed in the IdAM network.

System Environment Settings

e (CentOS7

e VM with 4 CPU Quad Core 2.199GHz.

e VM with 16384MB of memory.

e Virtual Hard Disk containing 98GB of storage.

Linux CentOS DNS Configuration

Basic DNS configuration settings are specified using three different system files that are located
in the /etc and /var subdirectories of the root directory as follows.

3.3.4.1 System file 1 — named.conf in the /etc subdirectory

//

// named.conf

//
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// Provided by Red Hat bind package to configure the ISC BIND named(8) DNS
// server as a caching only nameserver (as a localhost DNS resolver only).

//

// See /ust/share/doc/bind*/sample/ for example named configuration files.

//

options {
listen-on port 53 { 127.0.0.1; 172.16.4.253; };
#listen-on-v6 port 53 { ::1; };
#listen-on-v6 { none; };
directory " /var/named";
forwarders  { 8.8.8.8; 8.8.4.4; };
dump-file " /var/named/data/cache_dump.db';
statistics-file "' /var/named/data/named_stats.txt";
memstatistics-file " /var/named/data/named_mem_stats.txt";
allow-query { localhost; 172.16.4.0/22; };
allow-transfer { localhost; 172.16.4.0/22; };

/*
- If you are building an AUTHORITATIVE DNS server, do NOT enable
recursion.

- If you are building a RECURSIVE (caching) DNS server, you need to
enable

recursion.

- If your recursive DNS server has a public IP address, you MUST enable
access

control to limit queries to your legitimate users. Failing to do so will
cause your server to become part of large scale DNS amplification
attacks. Implementing BCP38 within your network would greatly
reduce such attack surface

*/

recursion yes;

dnssec-enable yes;
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};

dnssec-validation yes;

dnssec-lookaside auto;

/* Path to ISC DLV key */
bindkeys-file " /etc/named.iscdlv.key';

managed-keys-directory " /var/named/dynamic";

pid-file "' /run/named/named.pid";

session-keyfile "' /run/named/session.key";

logging {
channel default_debug {

file "data/named.run";

severity dynamic;

b
b
zone "." IN {
type hint;
file "named.ca'";
}5

zone "idam-es-idam-b1.test" IN {
type mastet;

file "idam-es-idam-b1.test";
allow-update { none; } ;

};

zone "4.16.172.in-addr.arpa" IN {
type master;
file "'4.16.172.db"";

allow-update { none; };
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};

zone "ot-es-idam-bl.test" IN {

type slave;

masters {

172.16.6.2;
¥

forwarders {};

};

zone "'pacs-es-idam-bl.test" IN {

type slave;

masters {
172.16.7.2;
};

forwarders {};

};

zone "es-idam-bl.test" IN {

type slave;

masters {

172.16.5.2;
¥

forwarders {};

};

include " /etc/named.rfc1912.zones";

include " /etc/named.root.key";

$TTL 86400

@ IN SOA idam-dns.idam-es-idam-bl.test.

2011071001 ;Serial

NIST Cybersecurity Practice Guide SP 1800-2c
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552 3600 ;Refresh

553 1800  ;Retry

554 604800 ;Expire

555 86400 ;Minimum TTL

556 )

557 @ IN NS idam-dns.idam-es-idam-b1.test.

558 @ IN PTR idam-es-idam-b1.test.

559 idam-dns INA 172.16.4.253

560

561

562 101 IN PTR idam-dns.idam-es-idam-bl.test.
563 System file — idam-es-idam-bl.test in the /etc subdirectory
564

565 $TTL 86400

566 @ IN SOA  idam-dns.idam-es-idam-bl.test. root.idam-es-idam-b1.test. (
567 2011071001 ;Serial

568 3600 ;Refresh

569 1800  ;Retry

570 604800 ;Expire

571 86400 ;Minimum TTL

572 )

573

574 @ IN NS idam-dns.idam-es-idam-b1.test.
575 @ IN A 172.16.4.253

576 idam-dns IN A 172.16.4.253

577 idam-ca IN A 172.16.4.15

578 idam-sql IN A 172.16.4.22

579 adaptivedir IN A 172.16.4.3

580 img IN A 172.16.4.2

581 consoleworks IN A 172.16.4.8

582 ozoneserver IN A 172.16.4.10

583 ozoneenvoy  IN A 172.16.4.12

584 ozoneauthority IN A 172.16.4.11

585 alertentIN A 172.16.4.5

586 WIN-IPERGL2ELUD IN A 172.16.4.5
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Remote terminal units (RTU) provide the cyberspace to physical interface. Remote terminal
units are used to collect data such as voltage, current and phase from substation equipment.
They are also used to deliver commands via contact closures or output voltage to change device
operations such as switches, circuit breakers or capacitors.

4.1 TCP/IPRTU

The TCP/IP RTU in this build is emulated with a RaspberryPi 2 system. The system was
developed to simulate a Modbus protocol programmable logic controller (PLC).

4.2 SERIALRTU

The serial RTU in this build is a Schweitzer Engineering Laboratory SEL-2411 programmable
automation controller configured to support the Modbus protocol. It is connected to the
RADiFlow ICS Firewall via serial interface.

Cisco Identity Services Engine (ISE) controls the ability of devices to connect over the network.
ISE expands on basic network address-based control to include the identity of the person using
a device. ISE is used in the builds to provide a gateway function between IT and OT, limiting
which users and devices are allowed to connect from IT to resources in OT.

The Cisco ISE component should be installed in a virtual machine (VM) on the IT network. This
ISE component will be used in conjunction with the TrustSec switch that is located on the IT
network to control access from the IT network to the OT network.

5.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Category: PR.PT-3: Access to systems and assets is controlled,
incorporating the principle of least functionality

NIST 800-53 rev 4 Security Controls: AC-3, CM-7

5.2  PRE-INSTALLATION TASK

1. Obtain OVA file from Cisco for Cisco ISE 1.4.

2. Place OVA file in Datastore for vSphere installation.

3. Ensure that the user domain has a security group (the build used OTAccess) for
determining access to the OT network.
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INSTALL AND CONFIGURE

Follow the guide located at: http://www.cisco.com/c/en/us/td/docs/security/ise/1-
4/installation quide/b ise InstallationGuidel4/b ise InstallationGuidel4 chapter 010
0.html
e This is the Cisco ldentity Services Engine Hardware Installation Guide, Release
1.4, section on Installing ISE on a VMware Virtual Machine.
o To deploy the OVA file, follow the instructions at the heading “Installing Cisco ISE
on Virtual Machines.”
e After OVA is deployed, follow instructions at heading “Installing Cisco ISE
Software on a VMware System.”
After the system is installed, type setup at the prompt.
The following are prompts and build responses:
Enter hostname: ise
Enter IP address[]: 172.16.4.77
Enter IP netmask[]: 255.255.255.0
Enter IP default gateway[]: 172.16.4.1
Enter default DNS domain[]: idam-es-idam-bl.test
Enter primary nameserver[]: 172.16.4.253
Add secondary nameserver? Y/N[N]: <blank>
Enter NTP server[time.nist.gov]: 172.16.4.1
Add another NTP server? Y/N[N]: <blank>
Enter system time zone[UTC]: EST
Enable SSH service? Y/N [N]: Y
Enter username [admin]: admin
Enter password: <password>

Enter password again: <password>

After ISE finishes the installation, connect to ISE through the web browser using the IP
address specified during the setup phase.

Begin the Setup Assistant.

Select Wired for setup access services, and select the Enforce radio button. For subnets
to protect, type the target network (in build, the OT network: 172.16.6.0/24). Press
Next.

Uncheck Cisco Unified IP Phone box

Select AD group : es-idam-bl.test/Builtin/Users

Leave the default checked boxes as is.

Select Yes for authenticate users using Cisco ISE, select Join the Active Directory domain,
and add domain credentials (in build, we used es-idam-b1l. test for domain and the
domain admin credentials to connect). Fill in the Employee Switched VLAN Interface box
with: 172.16.5.0 /24. Press Next.
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9. Select switch (build used Cisco Catalyst 3560 Series Switches), fill in pertinent

information for switch. For Employee VLAN ID, build used 104. Select a RADIUS Shared
Secret (build used password). Press Next.

10. Confirm all settings are correct, then select Confirm Configuration Settings.

TrustSec switch configuration information: Taken from the Network Device Configuration tab in
the Setup Assistant Review section, the recommended configurations to be set globally on the
TrustSec-enabled switch are as follows:

aaa
|
aaa
aaa
aaa
aaa
aaa
aaa
aaa
aaa

new-model

authentication dotlx default group radius
authorization network default group radius
authorization auth-proxy default group radius
accounting delay-start all

accounting auth-proxy default start-stop group radius
accounting dotlx default start-stop group radius
accounting network default start-stop group radius

server radius dynamic-author

client 172.16.4.77 server-key 7 15020A1F173D24362C

aaa

session-id common

switch 1 provision ws-c3650-48ps

authentication mac-move permit

ip routing

ip device tracking

ip dhcp snooping vlan 102

no ip dhcp snooping information option

ip dhcp snooping

dotlx system-auth-control

!

diagnostic bootup level minimal

spanning-tree mode pvst

spanning-tree extend system-id

!

redundancy

mode Sso

!

ip ssh version 2
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class-map match-any non-client-nrt-class
match non-client-nrt

!
policy-map port child policy

class non-client-nrt-class

bandwidth remaining ratio 10

snmp trap mac-notification change added
spanning-tree portfast

!

ip access-list extended ACL-DEFAULT
remark Allow DHCP

permit udp any eq bootpc any eq bootps
remark Allow DNS

permit udp any any eq domain

permit icmp any any

permit tcp any host 172.16.4.77 eq 8443
permit tcp any host 172.16.4.77 eq 443
permit tcp any host 172.16.4.77 eq www
permit tcp any host 172.16.4.77 eq 8905
permit tcp any host 172.16.4.77 eqg 8909
permit udp any host 172.16.4.77 eq 8905
permit udp any host 172.16.4.77 eqg 8909

deny ip any any

ip access-1list extended ACL-WEBAUTH-REDIRECT
permit tcp any any eq www

permit tcp any any eq 443

deny ip any any

!

logging origin-id ip

logging source-interface GigabitEthernetl/0/48
!

radius-server attribute 6 on-for-login-auth
radius-server attribute 6 support-multiple
radius-server attribute 8 include-in-access-req

radius-server dead-criteria time 5 tries 3

radius-server host 172.16.4.77 auth-port 1812 acct-port 1813 key 7

140713181F13253920
!

radius server host
|

wsma agent exec
profile httplistener
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profile httpslistener
wsma agent config

profile httplistener

profile httpslistener
wsma agent filesys

profile httplistener

profile httpslistener
wsma agent notify

profile httplistener

profile httpslistener

!
wsma profile listener httplistener
transport http

!
wsma profile listener httpslistener
transport https

ap group default-group

end

For each interface that is to be controlled, the recommended configurations are as follows:

interface GigabitEthernetl1/0/10

switchport access vlan 101

switchport mode access

switchport block unicast

switchport voice vlan 105

ip arp inspection limit rate 2000

ip access-group ACL-DEFAULT in

authentication event fail action next-method
authentication event server dead action authorize vlan 101
authentication event server alive action reinitialize
authentication host-mode multi-auth

authentication open

authentication order dotlx mab

authentication priority dotlx mab

authentication port-control auto

authentication periodic

authentication timer reauthenticate server
authentication timer inactivity 180

authentication violation restrict

mab
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dotlx pae authenticator

dotlx timeout tx-period 10

spanning-tree portfast

spanning-tree bpduguard enable

ip dhcp snooping limit rate 2048

11.

12.

13.

14.

15.

16.

Go to the top tabs and click Administration > System > Deployment. (If a warning that
says “This node is standby mode. To register other...Role to Primary” click OK.) Under
the Deployment Nodes — Hostnames click on the ise link. Then click Profiling
Configuration, and ensure that Netflow, Radius, DNS, SNMPQUERY, and SNMPTRAP are
selected. If they are not selected, select them. Then click Save.
Select Administration > Identity Management > External Identity Sources. In the frame
on the left choose Active Directory, then choose ise.idam-es-idam-b1.test. Click
Connections tab, select the checkbox next to the domain es-idam-bl.test. Check
to see if there is a green check in the Status column. If yes click Save.
If not, Click Join, and type in the AD Credentials and click Save. A green check
should appear in the Status column.
Select Administration > Identity Management > External Identity Sources > Groups tab.
Click Add > Select Group From Directory. Click retrieve groups. Check the es-idam-
bl.test/Users/Domain Users box and the es-idam-b1.test/Builtin/Users box and the es-
idam-b1.test/Users/OTAccess box. These items are specified for protected access (the
build used OTAccess). Then Click OK. Then click Save. Relogin as directed.
Select Administration > System > Settings. Click on Policy Sets in the frame at the left of
the screen, and click enabled (if it is not already clicked). Click Save if needed.
Select Policy > Policy Elements > Results. In the frame at the left of the screen, left
column, click Authorization, then Downloadable ACL List. Create the following (all IP
addresses are pertinent to the current build.; these addresses will need to be replaced
with IP addressing that is appropriate to the target environment):
o All_But_OT-Access-DACL
= Name:All But OT-Access-DACL
=  DACL Content:
deny ip any 172.16.6.0 0.0.0.255
permit ip any any

Click Save
In the left column, select Authorization Profiles and click Add to create the
following:
o All_and_OT
* Name:All and OT
= Access Type: ACCESS ACCEPT
=  Check DACL Name: PERMIT ALL TRAFFIC
Click Submit
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o All_But_OT_Access
= Name:All But OT Access
= Access Type: ACCESS ACCEPT
* Check DACL Name: A11 But OT-Access-DACL
Click Submit
o DenyAccess
= Name: DenyAccess
= Access Type: ACCESS REJECT
Click Submit
17. Select Policy > Policy Elements > Conditions. In the left column, select Authorization,
then Simple Conditions. Click Add to create the following:

o NotOTAccess

= Name:NotOTAccess

= Attribute: Select the domain (build uses es-idam-bl.test)>
ExternalGroups

= QOperator: Not Equals

= Value: Select the Security Group (build uses es-idam-
bl.test/Users/OTAccess)

Click Submit

o IT_DomainUsers

* Name:IT DomainUsers
= Attribute: Select the domain (build uses es-idam-bl.test)>
ExternalGroups
= QOperator: Equals
= Value: Select domain users group (build uses es-idam-
bl.test/Users/Domain Users)
Click Submit
18. Select Policy > Policy Sets. Select Default and configure policies. Choose the arrow next
to Authorization to expand the section. Choose the top rule and click the option arrow
to the right of the Edit link within the policy. Click New rule above.

o Rule 1: Click the plus sign in the Conditions box. Select Create New Condition
(Advanced Option). Select Attribute > es.idam-b1.test > External Groups. Leave
equals Select Attributes > es-idam-b1.test/Users/OTAccess. Click the plus sign in
the Permissions box. Select item drop down choose Standard > All_and_OT. Click
Done button on right.

Click the arrow to the right of the Edit link within the top policy (new policy
created above) Click Insert Below.

o Rule 2: Click the plus sign in the Conditions box. Select Existing Condition from
Library. Select arrow to choose simple conditions > NotOTAccess. Select arrow
next to the gear icon (on right). Select Add Condition from Library. Select Arrow
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to choose Simple conditions > IT_DomainUsers. Click on the Permissions input
box. Click the plus sign in the Permissions box. Click the arrow and choose
standard > All_But_OT_Access. Click Done. Click Save.

CA Identity Manager implements the central IdJAM workflow in Build #1. It receives input from
an HR system in the form of .csv files. The access and authorization for each user is based on the
business and security rules implemented in workflows within Identity Manager. The workflows
include management approval chains as well as approval/denial data logging. Once Identity
Manager has processed the access and authority request, the updated user access and
authorization data is pushed to the central ID store. The central ID store contains the
distribution mechanism for updating the various downstream (synchronized) directories with
user access and authorization data. This process applies to new users, terminated users
(disabled or deleted users), and any changes to a user profile. Changes include promotions, job
responsibility changes, and any other change that would affect the systems a user needs to
access.

6.1  SECURITY CHARACTERISTICS
Cybersecurity Framework Categories:

e PR.AC-1: Identities and credentials are managed for authorized devices and users
e PR.AC-4: Access permissions are managed, incorporating the principles of least privilege
and separation of duties

NIST 800-53 rev 4 Security Controls: AC-2, AC-3, AC-5, AC-6, AC-16, |IA Family

CA Identity Manager is installed on the IdAM network on a VM running the Windows Server
2012 R2 OS.

Important: The following instructions are for a single server demo environment and are not
intended to be used for a production deployment.

This guide walks you through a basic installation of CA Identity Manager on JBoss, on a single
Windows server. For comprehensive instructions for installing CA Identity Manager, refer to the
CA Identity Manager Installation Guide for JBoss at https://support.ca.com.

6.2  INSTALLATION PREREQUISITES

The following steps are required prior to the CA Identity Manager installation. (For supported
versions of all software, review the CA Identity Manager Support Matrix at
https://support.ca.com.)

1. Use a server with a supported OS (e.g., Windows 2012 R2).
2. Install a supported version of the JDK. (e.g., 1.7.0_71).
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6.3

6.4

N

L ® N o U kW

Install a supported version of JBoss. (e.g., jboss-eap-6.3).

To install JBoss as a Windows service, follow the instructions at the following link:
https.//access.redhat.com/documentation/en-

US/JBoss Enterprise Application Platform/6.3/html/Installation Guide/Install JBoss En
terprise Application Platform 6 Microsoft Windows Service.html

Create a Database and associated user with DBA permissions on a supported database
(e.g., MSSQL 2012).

Download and unzip CA Identity Manager software from https://support.ca.com.

INSTALL CA DIRECTORY
From the unzipped location, go to CADirectory x64\dxserver\windows and execute
dxsetup.exe.
Select Typical installation.
Uncheck “DXmanager will manage...”

Accept all other defaults.

INSTALL CA IDENTITY MANAGER

From the unzipped location, execute ca-im-12.6.XX-win32.exe

Select Components: deselect “Connect to Existing SiteMinder Policy Server” and
“Extensions for Siteminder...”. Leave the rest of the checkboxes checked.

Deployment Size: compact

Provisioning Server Hostnames: Just click Next

Provisioning Directory Information: enter a shared secret and confirmation.
Destination Location: accept default

FIPS Information: accept default

Application Server Information: JBoss

JBoss Application Server Information: Choose and locate the folder where JBoss is
installed. Enter the fully qualified URL and Port for JBoss. Leave the Cluster fields blank.

10. Select Java Virtual Machine: Click “Search for Others”. Select jdk1.7.0_71\bin\java.exe.

11. Key Encryption Information: accept default

12. Select Database Type: Select SQL 2005, 2008, or 2012

13. Database Connection Information: Enter hostname, database and credentials as created

in the prerequisites above.

14. Login Information: Enter a username and password to be used for the Management

Console. Leave the Enable Secure Login for Management Console checked
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6.5

15. HTTP Proxy Settings: Leave blank
16. Review Settings: Click Install

17. After the installation completes, start JBoss by executing jboss-eap-

6.3\bin\standalone.bat.

18. Review the log file to verify that JBoss started without error: jboss-eap-

6.3\standalone\log\server.log

19. If you receive a timeout error such as “Timeout after [300] seconds waiting for service

container stability...”, increase the timeout by modifying standalone.bat, adding the
following attribute to the startup script:
-Djboss.as.management.blocking.timeout=900

CREATE THE SAMPLE NETEAUTO DIRECTORY

Open a command prompt as the administrator user
cd to “C:\Program Files (x86)\CA\ldentity Manager\IAM Suite\ldentity
Manager\tools\samples\NeteAuto\Organization”

o You will see several sample files. For this example, we will use neteauto.ldif
Execute the following commands:

dxnewdsa -s500 neteauto 3895 "dc=security,dc=com"
dxserver install neteauto

dxserver stop neteauto

dxloaddb -v -s neteauto neteauto.ldif

dxserver start neteauto

To log in to the IM Management Console, navigate to
http://<ServerName>:8080/iam/immanage and log in using the credentials you supplied
in Login Information above.
From Directories, select “Create or Update from XML”.
Browse to C:\Program Files (x86)\CA\ldentity Manager\IAM Suite\ldentity
Manager\tools\samples\NeteAuto\Organization.
Select directory.xml. Click Next.
Supply values for the fields in this window as follows:
e Name - NeteAuto
e Description - (Optional)
e Connection Object Name - neteauto
e Host - the machine name where you ran the dxserver commands above
e Port-3895
e Username/User DN - uid=NeteAuto
Administrator,ou=People,ou=Employee,ou=NeteAuto,dc=security,dc=com
e Password/Confirm Password - test
e Secure Connection - Unchecked
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963 9. Click Next, then Finish.

964 6.6  CREATE THE PROVISIONING DIRECTORY

965 1. From Directories, select “Create or Update from XML”".

966 2. Browse to C:\Program Files (x86)\CA\ldentity Manager\IAM Suite\ldentity
967 Manager\tools\directoryTemplates\ProvisioningServer.

968 3. Select directory.xml. Click Next.

969 4. Supply values for the fields in this window as follows:

970 e Name - Provisioning

971 e Description - (Optional)

972 e Connection Object Name - provisioning

973 e Host - the machine name where IM is installed

974 e Provisioning Domain - im

975 e Username - the username you supplied in Login Information above
976 e Password/Confirm Password - the password you supplied in Login Information
977 above

978 5. Click Next, then Finish.

979 6.7 CREATE THE NETEAUTO ENVIRONMENT

980 1. From Environments, select “New”.
981 2. Supply the following information:
982 e Environment name - NeteAuto
983 e Description - (Optional)
984 e URL alias - neteauto
985 e Base URL — accept the default (make sure it is a fully qualified host name in the
986 URL)
987 3. Click Next.
988 4. Select the “NeteAuto” directory. Click Next.
989 5. Select the “Provisioning” directory. Click Next.
990 e URL alias used to reference public tasks — neteauto_pub
991 e User for anonomous authentication — SelfRegUser
992 6. Click Validate. Then click Next.
993 7. Select “Create Default Roles”. Click Next.
994 8. Select the Checkbox for Active Directory.
995 9. Scroll down and click the Browse button.
996 10. Select the NIST_PXPolicies.xml file provided with this guide. (Download the file from
997 https://nccoe.nist.qov/sites/default/files/nccoe/NIST PXPolicies.zipx and unzip it.)
998 11. Click Next.
999 e System Manager — SuperAdmin
1000 12. Click Add. Then click Next.
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e Inbound Administrator — SuperAdmin
13. Click Next.
e Password/Confirm Password - the password you supplied in Login Information
above
14. Click Next.
15. Review the settings, then click Finish.
16. Allow a few minutes for the Environment to deploy.
17. When finished with “0 error(s)”, click Continue.
18. Click “NeteAuto”.
19. Click “Advanced Settings”, then “Workflow”. Enable both check boxes and click Save.
20. Click the “Restart Environment” button.
21. Verify that you can login to the environment by going to the environment URL and
logging in:
e http://<FullyQualifiedServerName>:8080/iam/im/<ProtectedAlias>
e Username: SuperAdmin
e Password: test

6.8 CONFIGURE CONNECTION TO ALERTENTERPRISES DATABASE

Generate the encrypted password for the Alert Database as follows:

1. From a command prompt, cd to C:\Program Files (x86)\CA\Identity
Manager\IAM Suitel\Identity Manager\tools\PasswordTool

e Execute the following command: pwdtools -JSAFE -p
<AlertDBPassword>

e The result displays the Encrypted value with a prefix of {PBES}.
e Copy this encrypted password to be used below for EncryptedALERTDBPassword.

2. From the JBoss installation directory, create the following folder structure:
jboss-eap-6.3\modules\com\mysgl\main
e Download Connector/ J from http://dev.mysql.com/downloads/connector/

e Select Platform Independent, Compressed Zip Archive. Download.

e Unzip and copy the mysqgl-connector-java-5.1.35-bin.jar to the mysgl\main folder
you created above.

e Under the same folder, create a text file named module.xml. Paste the
following text into the file:

<?xml version="1.0" encoding="UTF-8"?>
<module xmlns="urn:jboss:module:1.1" name="com.mysqgl">
<resources>

<resource-root path="mysgl-connector-java-5.1.35-
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1038 bin.jar"/>

1039 </resources>

1040 <dependencies>

1041 <module name="javax.api"/>

1042 </dependencies>

1043 </module>

1044 3. From jboss-eap-6.3\standalone\configuration edit standalone-full.xml

1045 4. In the “<drivers>” section, add:

1046 <driver name="mysqgl" module="com.mysqgl">

1047 <driver-class>com.mysqgl.jdbc.Driver</driver-class>
1048 </driver>

1049 5. Just above the “<drivers>”" section, add a new data source:

1050 <datasource Jjndi-name="java:/iam/im/jdbc/jdbc/AlertDB"
1051 pool-name="MySQLPool" use-java-context="true">

1052 <connection-url>

1053 Jdbc:mysqgl://ALERTDBServerName:3306/ALERTDBName

1054 </connection-url>

1055 <driver>

1056 mysql

1057 </driver>

1058 <pool>

1059 <max-pool-size>30</max-pool-size>

1060 </pool>

1061 <security>

1062 <security-domain>mysqgldb</security-domain>

1063 </security>

1064 </datasource>

1065 6. In the “<security-domains>”" section, add the following security domain:

1066 <security-domain name="mysqgldb">

1067 <authentication>

1068 <login-module

1069 code="com.netegrity.jboss.datasource.PicketBoxPasswordEncry
1070 ptedLogin" flag="required" module="com.ca.iam.idmutils">
1071 <module-option name="userName"

1072 value="ALERTDBUserName" />

1073 <module-option name="password" value="

1074 EncryptedALERTDBPassword " />

1075 <module-option name="managedConnectionFactoryName"
1076 value="jboss.jca:name=iam/im/jdbc/jdbc/WPDS, service=LocalTx
1077 CM" />

1078 </login-module>

1079 </authentication>

1080 </security-domain>
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7. Restart the JBoss service

8. Review the log file to verify that JBoss started without error: jboss-eap-
6.3\standalone\log\server.log

6.9 PoLicy XPRESS PoLicYy REVIEW

1. Login to the NeteAuto Environment that you created above by navigating to
http://<FullyQualifiedServerName>:8080/iam/im/<ProtectedAlias>

2. For NeteAuto the username/password is superadmin/test.

3. Navigate to Policies > Policy Xpress > Modify Policy Xpress Policy, and click Search.

4. Select the desired Policy to review and modify as desired.

Check for Duplicates on Create: Stops the task with a message to the user if
duplicates are detected for the CardNumber or the UserID on the Alert Database

Check for Duplicates on Modify: Stops the task with a message to the user if the
CardNumber is already used by another user on the Alert Database.

Check for Numeric on Create and Modify: Stops the task with a message to the
user if the PIN, FacilityCode, or CardNumber is not an integer.

Check PACs fields on Create and Modify: Stops the task with a message to the
user if none of the PACs checkboxes are selected. At least one must be selected.

Create AE User: Creates User on the Alert Database if all above checks pass.
Provisions user to Active Directory.

Disable AE User: Disables User on the Alert Database, by setting the UserStatus
to “Inactive”

Enable AE User: Enables User on the Alert Database, by setting the UserStatus to
“Active”

Modify AE User: Modifies User on the Alert Database if all above checks pass.

6.10 UPDATE CREATE USER AND MODIFY USER SCREENS

L L

From Roles and Tasks > Admin Tasks > Modify Admin Task, search and select Create User.
Go to the Tabs tab and click the edit pencil next to Profile.

Click Browse Next to the Create User Profile.

Select the Default User Profile, and click the Edit button.

Click the edit pencil next to each of the following fields:

Office: Change Name to PIN

Postal Code: Change Name to Facility Code. Change Permission to
Read/Write Required.

Cell Phone: Change Name to Home Phone.
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10.
11.
12.

13.
14.

e Business Phone: Change Name to Work Phone.

e State: Change Name to Pacs All Door. Change Style to Checkbox. Set Check
value to 1. Set Unchecked Value to O.

e City: Change Name to Pacs Work Access. Change Style to Checkbox. Set
Check value to 1. Set Unchecked Value to 0.

e Address: Change Name to Pacs Home Access. Change Style to Checkbox. Set
Check value to 1. Set Unchecked Value to 0.

e Employee Number: Change Name to Card Number. Change Permission to
Read/Write Required.

e For any non-required fields that you don’t want to display: Change Style to
Hidden.

Click OK.
Select the Create User Profile, and click the Edit button.
Repeat Step 5 for this profile. When finished, click OK.

Navigate to Users >Manage Users >Create User, and click “Yes” for the warning message
about losing changes.

Select Create New User, and click OK.
Verify that the fields you updated are changed as desired.

Navigate to Users >Manage Users >Modify User, and click “Yes” for the warning message
about losing changes.

Select Create Modify User, and click OK.
Verify that the fields you updated are changed as desired.

6.11 INSTALL ACTIVITY DIRECtORY CERTIFICATE

2.
3.
4.

Obtain the Active Directory certificate(s) from the domain controller(s) you want to
connect to and copy them to the Identity Manager server.

Double-click on the certificate, and click Install Certificate.

Select Local Machine, then Place all Certificates in the following store. Click Browse.
Select Trusted Root Certification Authorities. Click OK twice.

6.12 ACQUIRE ACTIVITY DIRECTORY ENDPOINT

1.

From Endpoints >Manage Endpoints >Create Endpoint, select Create a new endpoint of
Endpoint type ActiveDirectory. Click OK.

e Endpoint: Give your endpoint a name

¢ Hostname: Fully qualified host name for the Active
Directory Domain Controller
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2.
3.

e UserID:Fully qualified User 1ID,for example: domain\userid.
e Password/Confirm Password: Password for the AD User

Click the Security tab. Check the “Use LDAP — SSL Encryption” checkbox.

Click Submit.

6.13 EXPLORE AND CORRELATE ACTIVE DIRECTORY

L ® N o U A~ W

13.
14.

From Endpoints >Explore and Correlate Definitions >Create Explore and Correlate
Definition, select Create a New Object of Type Explore and Correlate and click OK.

Explore and Correlate Name: Give it a name such as “Explore AD <domain
controller name>"

Select the Explore endpoint... checkbox. Uncheck the rest of the checkboxes.
Click the Select Container/Endpoint/Explore Method button.

Select Active Directory and click Search.

Select the endpoint you created above. Click Select.

Click Search.

Select the containers that you want to be connected to Identity Manager.

Click Select, then Submit.

. From Endpoints > Execute Explore and Correlate, select Execute Now and click Next.
11.
12.

Browse for the Explore and Correlate Definition you just created, then click Finish.

Repeat the steps above to create and execute a Correlate Definition, with only one
difference: On the step Explore endpoint step, uncheck Explore endpoint, and check
Update User Fields, Correlate Accounts to Users, and Create Users as needed.

From System > View Submitted tasks, click Search.

Verify that both the Explore and Correlate definitions completed successfully.

6.14 CREATE THE ACTIVE DIRECTORY ACCOUNT TEMPLATE AND PROVISIONING ROLE

From Endpoints > Account Templates > Create Account Template, select Create a new
Account Template of Endpoint Type “Active Directory”. Click OK.

Give the Account Template a name, such as “<domain controller name> Account
Template”.

From the Endpoints tab, add the Active Directory Endpoint you created above.
From the Groups tab, add the Active Directory groups you want to provision to the user.

When finished, click Submit.
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1180 6. From Roles >Provisioning Roles >Create Provisioning Role, select Create a new

1181 provisioning role, click OK.

1182 7. Give the Provisioning Role a name such as “<domain controller name> Provisioning
1183 Role”

1184 8. From the Account Templates tab, add the Account Template you just created above.
1185 9. From the Administrators tab, select a user, or group of users that you want to be the
1186 Administrators of this role. For example, to make the members of a certain Admin role
1187 the administrators of this provisioning role:

1188 e C(Click Add.

1189 e From the Users drop-down select a group of users, such as Users who are
1190 members of <role-rule>, then admin role.

1191 e Browse, search, and select the Admin Role you want to add.

1192 e From the Owners tab, select a user, or group of users that you want to be the
1193 Owners of this role, using the same process as used for the Administrators tab.
1194 e Click Submit.

1195 6.15 MODIFY CREATE AE USER POLICY to INCLUDE THE NEW PROVISIONING ROLE

1196 1. From Policies >Policy Xpress >Modify Policy Xpress Policy, search and select the Create
1197 AE User policy.

1198 2. From the Action Rules tab, click the edit pencil next to Create User

1199 3. Click the edit pencil next to Add otdc. Click the Browse “...” button next to the

1200 Provisioning Role Name. Select the Provisioning Role you just created.

1201 4. Click Select, OK, OK, Submit.

1202 6.16 ADD WORKFLOW CONTROL OVER CREATE USER AND ANY OTHER TASK AS DESIRED

1203 1. From Roles and Tasks >Admin Tasks >Modify Admin Task, search and select Create User.

1204 2. From the Events tab, click the edit pencil next to the CreateUserEvent workflow process.
1205 3. Select the Non-Policy Based workflow process “SingleStepApproval.”

1206 4. For the approval, select “Approve Create User” *

1207 5. For the Participant resolver select the type of members you want to assign. For example,
1208 Admin Role Members. *

1209 6. Click Add Admin Roles. Search and select the Admin Roles you want to have approve this
1210 workflow. *

1211 7. Repeat the above 3 steps with * for the Primary Approver.

1212 8. When finished with both approvers, click OK, then Submit.
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The above steps can be used for the Modify User and Enable/Disable User tasks (or any
other task).

6.17 TEST CREATION OF A USER MANUALLY

From Users >Manage Users > Create User, select Create a New User, click OK.

Fill out the fields as desired for the new user, keeping in mind the policy rules explained
above. For example, PIN, Facility Code, and Card Number must be integers, and at least
one Pacs access checkbox must be checked.

Click Submit, then OK.

From Home > View My Worklist, select and approve the workflow for the Create User
task *

From System >View Submitted tasks, click Search. Verify that the Create User task
completed successfully. *

Connect to the AE Database. Verify that the user was created successfully. *

Connect to the Active Directory Domain Controller. Verify that the user was created
successfully. *

Repeat all the steps above for Modify User, Enable User, and Disable User.

6.18 TEST CREATION OF A USER WITH A CSV FILE

3
4
5
6.
7
8
9

Download the file HRBulkUsers4.csv from
https://nccoe.nist.gov/sites/default/files/nccoe/HRBulkUsers4.csv.

Modify the CSV file to enter the desired values for the new users to be created. Keep in
mind the policy rules that must be followed as described above.

From System > Bulk Loader, Browse for the CSV file.

What field represents the action to perform on the object: action.
What field will be used to uniquely identify the object: uid.

Click Next.

What is the Primary Object: USER.

Select a task to execute for action 'create': Create User

Click Finish.

Repeat the steps from Section 9.17 (above) with an asterisk (*) to approve the users and
verify that they were successfully created.
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RSA IMG implements the central IdAM workflow in Build #2. It receives input from an HR system
in the form of .csv files. The access and authorization for each user is based on the business and
security rules implemented in workflows within RSA IMG. The workflows include management
approval chains as well as approval/denial data logging. Once IMG has processed the access and
authority request, the updated user access and authorization data is pushed to the central ID
store. The central ID store contains the distribution mechanism for updating the various
downstream (synchronized) directories with user access and authorization data. This process
applies to new users, terminated users (disabled or deleted users), and any changes to a user
profile. Changes may include promotions, job responsibility changes, and any other change that
would affect the systems a user needs to access.

7.1  SECURITY CHARACTERISTICS
Cybersecurity Framework Categories:

e PR.AC-1: Identities and credentials are managed for authorized devices and users
e PR.AC-4: Access permissions are managed, incorporating the principles of least privilege
and separation of duties

NIST 800-53 rev 4 Security Controls: AC-2, AC-3, AC-5, AC-6, AC-16, |IA Family
7.2 IMG INSTALLATION

Install IMG using the included installation guide on a server running SUSE Linux OS or from an
IMG virtual appliance image. The RSA Installation guide is available for licensed customers at
http://www.emc.com/domains/rsa/index.htm.

7.3 IMG CONFIGURATION AND INTEGRATION WITH DIRECTORIES

After install, open a web browser and point it to the IP Address or DNS name of the RSA IMG
server. The following instructions are provided along with screenshots depicting each step.
Unless stated otherwise the settings are included in each screenshot.

Log in with the default credentials:

Username: AveksaAdmin (case sensitive)
Password: aveksal23

Change the password when prompted to change.

7.3.1  Set Up Custom Attributes
1. Navigate to ‘Admin’ then ‘Attributes’:

NIST Cybersecurity Practice Guide SP 1800-2c


http://www.emc.com/domains/rsa/index.htm

1274
1275

1276

1277
1278

DRAFT

Edit || Test || Collect Identity |

Figure 9. IMG Attributes Window

1. Click on ‘User’ then ‘Edit’ as shown in Figure 10.
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2. Modify your attributes to match Figures 11-13.

Attribute Configuration - User

Once an attribute is configured, it can not be deleted. The option selected for Data Source is a one-time change and cannot be edited later. The Editable option for Collected attributes will be
available only for attributes that were mapped in an identity collector.

Attribute Name DataType  Length Data Source Editable In Detail In Popup PT::;:?{

Empty
£ Backup Supervisor [user 7] [collected ] v o) v
£ Creation Date (pate  +] [collected 7] v v v
2 Deletion Date (Date v] [collected 7] v v v
2 Department [sting v| [256 | [colected v © v v v
2 Email Address [stng v] [256 | [ collected ] e v @
2 Exception Count |m| | Managed v:\ o v v 2
2 | expiration Date [pate  +| [ collected v v ¢ ¢
% | Expiration value | sting  v| \E| | Collected ':\ v v v
2 First Name [sting v| [256 | [colected  v] © v v v
2 [full Name [suing v| [256 | [collected v © v o) )
2 [is App Owmer | swing 7| \E| | Managed v:\ @ v v v
2 s Deleted [ integer ] [collected 7] v v v
= [\s Manager | sting  v| \E| | Collected '_\ o v v v
% [is Menter [sting v| [256 | [Manages v O v v v
2 [Is Senior Manager [suing v| [256 | [wanagec v e e ¢ v
£ Is Terminated |:W| [ collected B @ “ @
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£ |Job Code | | sting ¥ | |E| | Collected '| o 7] @ 7]
2 | Jab Femily | [sting v| [256 | [ collected B @ @ @
2 [JobLevel | [integer v] [coleted  *| @ 7] @ ]
2 Job Status | sting v | |E| | Collected '| @ @ “ w
2 LastName [suing v| [256 | [colected  v] © @ @ £
2 | Location | [sting v| [256 | [ coliected v o @ @ @
2 other | [user 7] [colected  +| O ] @ @
2 |pacs All Doors | [suing v]| [256 | [collected B @ @ @
£ | PACS Home ACcess | [sting ] |256 | [ collected | @ 7] @ 7]
2 [pAcs Work Access | [sting v| [256 ] [ collected | B “ “ @
2 previous Supervisor | [user | [ Managed @ @ @ @
£ | self Reviewer | | user v | Collected '| o 7] @ 7]
S supervisor [swing v| [256 | [colected  v] O ] @ @
2 Termination Date [pate v | collected \ @ ] @
2 Title | sting ¥ | |256 | |Cc>llened '| o 7] @ 7]
2 [Transfer Date | [pate 7] [Mansged  v| @ F] @ @
£ UniqueId [sting v [2000] [ collected e @ 77 @
2 Userld | sting v | |E| | Collected '| @ @ @
1281 S [ User Risk Level | [suing v| [256 | [managed  v] © © @w @
1282 Figure 12. IMG Attributes Examples
2 Violation Count |m_‘ |_m_| (] 7] 7]
2 LoginID || string ':\ |E| |m| o @ @
% |on || string ':\ |E| |W| @] 72 @
2 ou | [stng v (256 | [colected  *] © ] @
1283 | Add attribute | | Add separator |
1284 Figure 13. IMG Attributes Examples
1285 3. Click on OK.
1286 4. Click on ‘Account’ then ‘Edit” as shown in Figure 14.

Return to: </ Home

Attributes

‘ Account H Account Mapping “f Business Source “f Application Rale ” Business Unit “, Change Request ” Entitlement ”f

1 )

1287 [

1288 Figure 14. IMG Edit Attributes

1289 5. Modify your attributes to match those shown in Figure 15. IMG Attribute Example.
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 Attribute Configuration - Account

Once an attribute is configured, it can not be deleted. The option selected for Data Source is a one-time change and cannot be edited later. The Editable option for Collected
attributes will be available only for attributes that were mapped in an identity collector.
Hide in
Attribute Name Data Type Database ID Data Source Editable Custom Value In Detail In Popup Popup if
Empty
= .Account Email String ¥ CAS10 v Collected v td T td
2 | Account Expiration Date Date v CAD1 v Collected v td T td
% | Account Full Name Stnng ¥ CAS2 A Collected v t ¥ td
2 | Account Risk Level String ¥ CAS3 v Managed r L4 L4 L L
2 | Account Risk Score Integer ¥ CAIN v Managed r L4 L4 L L
2 | Account Status Sting ¥ CAS8 v Collected r L4 L4 L4
= | Account Technical Name String ¥ CAS4 T Collected v i | Ld
< |DN String ¥ CAS7 v Collected v i i Ld
2 Last Reviewed Date Date v LAST REVIEWED D, ¥ Managed v i i Ld
= | PACS All Doors String ¥ CAS1 v Collected v td T td
2= | PACS Home Access String ¥ CASS v Collected v td T td
% | PACS Work Access Stnng ¥ CAS6 A Collected v t ¥ td
2= |Login ID String ¥ CAS9 v Collected r L4 L L
1290 | Add Attribute | | Add Separator
1291 Figure 15. IMG Attribute Example
1292 6. Click on ‘OK.

1293  7.3.2 Set up Organization Users

1294  The next step is to set up the organization’s existing users. In the example solution, we used a
1295  CSV file that contains all the users in the organization. This CSV file needs to be copied to a
1296  convenient location on the IMG server. You can get a sample CSV file, HR_Data_Move.csv at
1297  https://nccoe.nist.gov/sites/default/files/nccoe/HR_Data_Move.csv.

1298 1. Once the CSV file is copied to the server, perform the following actions:
1299 2. Navigate to ‘Resources’ and under resources, select ‘Directories’ as shown in Figure 16.

Home Users Resources = Roles Requests Data Access Reviews

Directories

Applications

System Dashboard

1300 ‘ ‘
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1301 Figure 16. IMG Resources Directories

1302 3. Click ‘Create Directory’ as shown in Figure 17.

@‘Eﬂ http://172.16.4.2/aveksa/main?ReqType= GetPage&PagelD=DirectorySummaryPage 2 = & || 1 RSA IMG - Directories

Home  Users Resources >  Roles Requests Data Access Reviews

Return to: < Home

Directories
Create Directory | | Collect Data (all) |

Grouping: |- select - [v]

Search: >~

O ‘ Directory 4 | Description ‘ Business Owner
1303 —
1304 Figure 17. IMG Create Directory
1305 4. Select ‘Other Directory’ and click ‘Next” as shown in Figure 18.

Create Directory

Select Directory

Search: oy
Name 4 ‘ Description

O ’, Active Directo Creates Directory, Identity Collector, Account Collector and p
‘ J i (based on configuration) for Active Directory

. i Creates a directory
@ Other Directory

ms | 1selected

156

1308 Figure 18. IMG Create Directory

1309

1310 5. Enter ‘HR’ in the ‘Directory Raw Name’ field. Click ‘Finish’ as shown in Figure 19 .
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Create Directory

Directory Raw HR "

MName®*:

Directory: | yp

Description: ‘ | ‘

Long Description:

Short Description
(Tooltip):

Help Link:

Allow Account (O Yes @ No
Disabling:

#

Allow Account ) Yes  (® No
Locking;

Directory Attributes

Business Use:
Category:
Classification:

Functional
Cwnership:

Figure 19. IMG Directory Information

You have now created your first directory which will serve as a repository for all the HR Data for
the organization.

6. Repeat the above steps, creating a second directory. This one will be named ‘RSA
Adaptive Directory’. This container will be used to pull AD accounts from the Adaptive
Directory server. In this case be sure to select the two options as shown in Figure 20.
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Create Directory

Directory Raw | RSA Adaptive Directory Accounts

Mame™:

Directory: | RSA Adaptive Directory Accounts

Description:

Long Description:

Short Description |

(Tooltip):

Allow Account ® Yes () Mo
Disabling:

Allow Account ® Yes () Mo
Locking:

Directory Attributes

Business Use: |

Category: |

Classification: |

Functional |

Ownership:

Locality: |

Sensitivity: |

Figure 20. IMG Create Directory
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7.3.3  Populate the HR Directory

The next step is to populate the HR directory with users.

1. Click on ‘Resources’ and ‘Directories’ again as shown in Figure 21.

Home Users

System Dashboard

Resources =

Directories

Applications

Roles Requests

Data Access

@|m http://172.16.4.2/aveksa/main?ReqType= GetPage®PagelD=HomeTab_DashboardT: 2O ~ ¢ || EA RSA IMG -

Reviews

Figure 21. IMG Directories

2. Click on your new HR directory you just created as shown in Figure 22.

Home Users Resources -

Return to: < Home

Directories

Grouping: |- select —

Search; >

[] | pirectory

Roles

#

Requests Data Access

Reviews

Rules

Create Directory | | Collect Data (all) |

Dascription

‘ Business Owner

[]  Active Directory
[]  contractors

DHR“

[] RsA Adaptive Directory Accounts

4 jtems

Figure 22. IMG Directories
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1331 3. Click on ‘Collectors’ then click ‘Create Identity Collector’ as shown in Figure 23Figure 23.
1332 IMG Create Identity Collector.

Home  Users Resources *  Roles Requests Data Access

Return to: </ Home - Directories

Directory: HR /

General AFX Connector Binding Collectors Accounts Who Has Access What Access

| Create Identity Collector | | Create Account Collect

Grouping: |- select -
Search; 4
Mame 4 ‘ Description | Collector Type
1333
1334 Figure 23. IMG Create Identity Collector
1335 4. Enter details as below as shown in Figure 24.
Edit Collector: HR Identities
Collector Description
Collector Name*® : | HR Identities X |
Description :
Data Source Type : | Database
Agent : | Ayeksasgent
Directory : | 4R
Status Active
Schedule
Scheduled : () Yes (® Mo
1336
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Figure 24. IMG HR Identities

5. Click ‘Next’, and enter details as below as shown in Figure 25.

Edit Collector: HR Identities

Database Connection
08 Type : | TR ~ |
Driver Class* : | com.hxtt.sql.text. TextDriver
URL* : | jdbcicsvi//f/fhome/oracle/database/SampleData

User Name © | aveksasdmin

Password : | gpeeseee

Figure 25. IMG HR Identities (cont.)

6. Use the same username and password you use to log into the IMG management web
page.

The URL will point to the folder that the CSV file is located in. In this example, the full field is:

jdbc:csv://///home/oracle/database/SampleData/Demo/HR/?_CSV_Header=true;tmpdir=/hom
e/oracle

The CSV file is located in home/oracle/database/SampleData/Demo/HR

7. Click ‘Next’.
8. Leave ‘Users’ selected and click ‘Next’ as shown in Figure 26.

Edit Collector: HR Identities

Select types of identity data to collect

o Users
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Figure 26. IMG HR Identities - Users

1. Enter details as shown in Figure 27 and Figure 28 , below. The full text of the ‘User Data
Query’ is as follows:

select fname, lname, case when substr(lname,1,2) = 'IT' then
'it' when substr (lname,1,2) = 'OT' then 'ot' else 'pacs' end as
OU, login, email as sAMAccountName, email, location, bu,
department, title, supervisor, Jjob level, job status, login as
SR, 1s terminated, previous manager, Jjobcode, previous manager
as backjp supervisor, job family,concat (lname,', ', fname)as
fullname, is manager, email as UniquelID from HR Data Move

The highlighted section is specific to this example, based off of our sample data, the OU that the
user needs to be provisioned in is based off of the last name. Basically, when the 1° two letters
of the last name = IT, the user will have ‘it’ set to the OU attribute, if it’s OT, then ‘ot’ is set as
the OU attribute, any other scenario the OU attribute is set to ‘pacs’.

NIST Cybersecurity Practice Guide SP 1800-2c



DRAFT

Edit Collector: HR Identities

Mapping for user attributes

User Data
Users Data Query™ : Iseler:t fname, Iname, case when substr(lname, 1,2) = 'IT' then 'it" when -
substr{lname,1,2) = "OT" then "ot’ else 'pacs’ end as OU, login, email as |:|
sahMaccountMame, email, location, bu, department, title, supervisor, job_level,
job_status, login as SR, is_terminated, previous_manager, jobcode, e
previous_manager as backjp_supervisor, job_family,concat(lname’, ',fname)as y

User attribute DB column with value

User ID* : | sAMACcountMame |

Business Unit Id : | bu | value is Business Unit | Mame v
Backup Supervisor | | value is User | User ID &
DN : | |

Department . | department |

Email Address : | email |

Expiration Date : | |

Expiration Value : | |

First Mame : |.fr.arr|e |

Full Name : [fullname |

Is Manager : | is_manager |

Is Terminated : | is_terminated |

Job Code: | |
1365 ob Code |_Jobcode |

1366 Figure 27. IMG HR Identities

1367
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Jab Family :

Job Lewvel :

lob Status @

Last Mame :
Location !

Legin 1D :

ou:

Other

PACS All Doors &
PACS Home ACcess
PACS Work Access
Self Reviewer !
Supervisor |
Terminaticon Date
Title :

Unigue Id :

9. Click ‘Finish’

Job_family
Job_level
Job_status
Iname
location
login

ou

previous_manager value is User | User ID v

SR

supervisor

title

UniquelD

value is User | User ID ¥

Figure 28. IMG HR Identities (cont.)

7.3.4  Configure Adaptive Directory Container
The next step is to configure the Adaptive Directory Container with ldentity and Account

collectors.

1. Navigate to the Adaptive Directory Container as shown in Figure 29.
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EA R3A IMG - Directories ¥ ' B R5A | Adaptive Directory © X

€ - C | [1172164.2/aveksa/main?0id=2&ReqType=GetPage&PagelD=C

Requests Data
Return to: </ Home

Directories Applications

Grouping: | -- select -- v
Search: | jol
|| | Directory 4| Description

HR --

(]
[ RsA Adaptive Directory Accounts --
2

items

1376

1377 Figure 29. IMG Adaptive Directory Container

1378

1379  This identity collector will tie together user identities in Adaptive Directory to user identities in
1380  the HR CSV file.

1381 2. Click on ‘Collectors’ and ‘Create Identity Collector’ as shown in Figure 30.

RSA

Requests Data Access Reviews Reports Collectors

Return to: <« Home - Directories

Directory: RSA Adaptive Diréffory Accounts

f General ]f AFX Connector Binding ][ Collectors ]( Accounts ]f Who Has Access ]f What Access ” Resource Profile ]f Requests ][ Violation

Create Identity Collector | | Create Account Collector | | Create Entitlement Collector |

v

1382 Grouping: []W_\
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1383 Figure 30. IMG Identity Collector
1384 3. Create the ID collector as follows, clicking ‘Next’ between each screen shown in Figure
1385 31, Figure 32, Figure 33, Figure 34 and Figure 35.

Edit Collector: RSA Adaptive Directory Identity Collecotr

Collector Description

Collector Name" [RSA Adaptive Directory Identity Collecotr ]
Description !
)
Data Source Type ! | Ldap ¥ |
Agent | Aveksahgent v |

Directory | RSA Adaptive Directory Acco ¥ |

Status @ | Active v |

Schedule

Scheduled : () Yes @ No

1386

1387 Figure 31. IMG AD Identity Collector

1388
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Edit Collector: RSA Adaptive Directory Identity Collecotr

Connection

Host" : [h?2.16.4.3 ]

Port” : | 2389 |

Bind DN* | cn=Directory Manager |

Bind Password”® :

UsessL: [J

Disable Paging : |

Figure 32. IMG AD Identity Collector

Edit Collector: RSA Adaptive Directory Identity Collecotr
select types of identity data to collect

+ Lsers

Figure 33. IMG AD Identity Collector
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Edit Collector: RSA Adaptive Directory Identity Collecotr

Mapping for user attributes

User Data

User attribute Mapping

User Base DN* : [dc:master,dc:test

User Search Scope® : | Subtree v -

User Search Filter” | | (&(objectCategory=person){objectClass=user){sAMAccountName=*))

User ID*: | userPrincipalMame |

Business Unit Id : | | value is Business Unit | Name ‘ri
Backup Supervisor : | | value is User | User ID v
DN: |dn |
Department . | |
1395 Email Address | |
1396 Figure 34. IMG AD Identity Collector

1397
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Is Terminated !

Job Code !

Job Family :

lob Level

lob Status :

Last Mame !
Location !

Login 1D

ou

Other @

PACS All Doors
PACS Home ACcess |
PACS Work Access |
Self Reviewer !
Supervisor !
Termination Date !
Title :

Unique Id :

4. Click Finish

value is User | User ID
pacsallDoors
pacsHomeAccess
pacs\WorkAccess

value is User | User D

Figure 35. IMG AD Identity Collector

7.3.5 Create an Account Collector
The next step is to create an account collector which pulls all relevant attributes from Adaptive

Directory.

1. Click on ‘Collectors’ and ‘Create Account Collector’ as shown in Figure 36.
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Home Users Resources Roles Requests Data Access Reviews Rules Reports Collectors

Return to: < Home +« Directories

Directory: RSA Adaptive Dirgfitory Accounts

( General ][ AFX Connector Binding ][ Collectors ][ Accounts \I[ Who Has Access ][ What Access ][ Resource Profile ][ Requests N Viol:

| Create Identity Collector | | Create Account Collector | | Create Entitlement Collector |

Grouping: - select -- v ,
1406 Search: | ;;3\

1407 Figure 36. IMG AD Create Account Collector
1408 2. Create the Account collector as follows, clicking ‘Next’ between each screenshot, Figure
1409 37 through Figure 46 below.

Edit Collector: RSA AD Directory Accounts

Collector Description

Collector Name™ : | RSA AD Directory Accounts |

Description ©
-
Data Source Type ! | Ldap L |
Agent | AveksaAgent v |
Status | Active v |
Schedule
Scheduled : () Yes ® Mo

1410
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1411 Figure 37. IMG Edit Collector

Edit Collector: RSA AD Directory Accounts

Connection

Host™: [1?2.16.4.3 l

Port” ; [2389 :

Bind DN* | cn=Directory Manager |

Bind Passwaord® ;

(EET T ] |

UsessL: [
1412 Disable Paging : L
1413 Figure 38. IMG Edit Collector
1414
Edit Collector: RSA AD Directory Accounts
Select types of account data to collect
[« Accounts
[ User Account Mappings
[#] Groups
Case Sensitivity
1415 Data 1= case sensitive (This option has been disabled as first successful collection has already occcurred)
1416 Figure 39. IMG Edit Collector
1417
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Edit Collector: RSA AD Directory Accounts

Account Base DN* ¢

Account Search ;
Scope®

Account Search Filter” ;

Account 1D* :

Account Attribute

Last Legin Date :
Account Disabled
Account Locked !
Account email !

Account expiration !
date

Account full name :
Account status ;

Account technical
name

User Account
Mapping Attribute

DM

Login D ¢

PACS All Doors ©
PACS Home ACcess @

PACS Work Access |

User ID™ ;

Mapping for account and user account attributes

Search Configuration for Accounts

[ Hc =master,dc=test

| Subtree r

Accounts will be created by the User Account Mapping, unless the Accounts option is selected in this collector,

. (&(objectCategory=person)(objectClass=user)(sAMAccountMame="))

| distinguishedMame

Attribute in Ldap schema

| lastLogon

| userPrincipalMame

| accountExpires

| displayMame

| useraccountControl

| sAMAccountMame

Figure 40. IMG Edit Collector

|:dn

| pacsAllDoors

| pacsHomeAccess

| pacsWorkAccess

Attribute in Ldap schema

userPrincipalMame

1420

Figure 41. IMG Edit Collector
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Edit Collector: RSA AD Directory Accounts

Mapping for group attributes

Group Data

Group attribute

Edit Collector: RSA AD Directory Accounts

Group Base DN &
Group Search Scope™ @

Group Search Filter” @

Group ID/Name* :
Member of Group® :
DN :

Description :
Domain :

Cwner &

Cwner &

Resource type :

Mapping

[bc=master,DC=test

| Subtree v

. {objectclass=group)

|. distinguishedName

|member

| cn

| description

| value is User | User ID

| managedBy

Edit User Resclution Rules

Target Collector

Figure 42. IMG Edit Collector

User Attribute

| Lsars

¥ | | User Id
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Figure 43. IMG Edit Collector

Edit Collector: RSA AD Directory Accounts

Edit Member Account Resolution Rules

Target Collector Account Attribute

| RSA AD Directory Accounts v/ [ o~ R

Figure 44. IMG Edit Collector

Edit Collector: RSA AD Directory Accounts

Edit Sub-group Resolution Rules

Target Collector Group Attribute

| RSA AD Directory Accounts ¥ | | Mame ¥ | E]

Figure 45. IMG Edit Collector

Edit Collector: RSA AD Directory Accounts

Edit Group Owner Resolution Rules

Target Collector User Aftribute

| Users "’| | User Id r | E]

Figure 46. IMG Edit Collector
3. Click ‘Finish’
A Test button is provided with each account collector and identity collector.

4. Test each account collector you created using the test button. This action verifies that
IMG can retrieve the account information for each directory added as shown in Figure
47 below.
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ectory Accounts

Accounts

Collection History

Edit | | Test | | Collect Accounts

Figure 47. IMG Account Test

A successful test will look something like Figure 48.

’ Test Collector: RSA AD Directory Accounts

<tns:account-data is-data-encoded="true" xsi:schemalLocation="http://wuw.aveksa

<account id="CMN=DoD_Admin,cu=it,dc=master,dc=test">

<attributes userAccountControl="512" lastlLogon="138791218124985148" sAMAcc
<faccount>
<account id="CM=xGuest,ou=it,dc=master,dc=test">

<attributes userAccountControl="514" lastlLogeon="8" sAMAccounthame="xGuest"
</account>
<account id="CMN=krbtgt,cu=it,dc=master,dc=test">

<attributes userfAccountControl="514" lastLogon="&" sAMAccountName="krbtgt"
</account>
caccount id="CN=IdAM,ou=it,dc=master,dc=test":>

<attributes userfAccountControl="66048" displayMName="Ida&M" lastLogon="1387%
<faccount>
<account id="CN=Tony2ITInfrUser,cu=it,dc=master,dc=test">

<attributes userfccountControl="512" lastlogon="8" sAMAccountMame="Tony2IT
</account>
<account id="CMN=DoD_Admin,cu=ot,dc=master,dc=test"»

<attributes userAccountControl="512" lastlLogon="13879@259983919639" sAMAcc
</account>
<account id="CM=xGuest,ou=ot,dc=master,dc=test">

<attributes userAccountControl="514" lastlLogeon="8" sAMAccountName="xGuest"
<faccount>
<account id="CM=krbtgt,cu=ot,dc=master,dc=test">

<attributes userfAccountControl="514" lastLogon="@" sAMAccountName="krbtgt"
</account>
caccount id="CN=IdAM,ou=ot,dc=master,dc=test">

<attributes userdccountControl="66@48" displayMame="IdaM"™ lastLogon="@" sA

4

[X)

FY

-

Cancel

Figure 48. IMG Successful Test Example
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7.3.6  Edit the Unification Configuration Participating Collectors
The next step is to configure Unification — this is the process of joining Identities from the HR
CSV and the Adaptive Directory collectors.

1. Click on ‘Collectors’ and ‘Unification Config’ as shown in Figure 49.

BT T

aptive Directory Accounts Identity Collectors

ctory Accounts -4

Mapping Collection History

Unification Config

Account Collectors

Role Collectors

Edit | | Test | | Collect Accounts | Entitlement Collectors

Multi-App Collectors
Data Access Collectors
App Metadata Collectors
Agents

Scheduling

Attribute Synchronization
Figure 49. IMG Unification Configuration

2. Choose the Participating Collectors tab. Click on Edit as shown in Figure 50.

R e T S TR

Return to: < Home

Unification Configuration

Participating Collectors || Attribute Sources Joins Referance Resolutions

) Edit | | Run Unification ‘
Participating Collectors
Collector Name Is Collection Mandatory Attribute Processing Order
No 1 Yes

HR Identities

RSA Adaptive Directory Identity Collecotr Mo 2 No

Unification Schedule

Schedule: Mot Scheduled
Figure 50. IMG Participating Collectors

3. Configure as shown in Figure 51 and Figure 52. Click Next on each screen.
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Edit Participating Collectors

Edit Collector Participation and Unification Schedule

Collector Mame Collection Mandatory Create Users
HR Identities O %]
RSA Adaptive Directory Identity Collecotr (8] (8]

Scheduled : () Yes @ MNo

Figure 51. IMG Edit Participating Collectors

Edit Participating Collectors

Select Processing Order for Participating Collectors

Attribute Processing Order

HR Identities

RSA Adaptive Directory Identity Collecotr

Figure 52. IMG Edit Participating Collectors

In the above example, we have HR Identities at the top. This indicates that HR Identities is
authoritative source — if there are any discrepancies between the data between the two, then
the one at the top will win by default, but this can be overridden, which we will see later.

4. Click Finish.

7.3.7  Edit Unification Configuration Attribute Source
The next step is to change the default behavior of the authoritative source for the necessary
attributes.

1. Choose the Attribute Sources tab. Click on Edit as shown in Figure 53.

e T Y S T

Return to: <« Home

Unification Configurati
Participating Collectors [ Attribute Sources ]f Joins 1( Reference Resolutions 1

Backup Supervisor Mot Set

Business Unit Id * Not Set *

DM RSA Adaptive Directory Identity Collecotr
Department Mot Set ~

Email Address Mot Set *

Exception Count Mot Set *

Expiration Date Mot Set

Expiration Value Mot Set
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1469 Figure 53. IMG Unification Configuration Attribute Sources
1470 2. Edit the Attributes shown in Figure 54 and Figure 55. Leave alone any attribute shown as
1471 ‘Not Set’. These attributes will use the default behavior:

Edit User Attribute Mapping

User Attribute  Authoritative Source

Backup Supervisor :  (nof collected)

Business Urut Id :

|« Not Set * v|

DN | RSA Adaptive Directory Identity Colle: ¥ |

Department :

|+ Not Set * v|

Email Address ;

|« Not Set * r|

Exception Count : (not collected)
Expiration Date :  (not collected)

Expiration Value :  (not collected)

First Name ;

|+ Not set * v|

Full Mame :

|« Not Set * r|

Is App Owner :  (not collected)

Is Manager !

|+ Not Set * v|

ls Monitor ©  (not collected)

Is Senior Manager :  (not collected)

Is Terminated : | « Mot Set * v |
Job Code : | Mot Set * v |
Job Family : [« Mot Set * v |
Job Level : | Mot Set * v |
Job Status ;| = Mot Set * v |

1472 -
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1473

Last Mame :

Location ;

Login 1D ¢

ol

Other ;

PACS All Doors

PACS Home ACcess ;

PACS Work Access

Previous Supervisor !

Self Reviewer ;

Termination Date ;
Title
Transfer Date ;

Unigue Id :

ser Rizk Level ;

Vialation Count ;

1474
1475

1476 3. Click on OK.

Figure 54. IMG Edit User Attribute Mapping

* Mot Set ™ ¥
* Mot Set * ¥
* Mot Set ™ ¥
* Mot Set ™ =
* Mot Set * ¥
RS4 Adaptive Directory Identity Coller ¥
RSA Adaptive Directory Identity Coller ¥
RSA Adaptive Directory Identity Coller ¥
* Mot Set * ¥
* Mot Set * ¥
* Mot Set ™ =

Figure 55. IMG Edit User Attribute Mapping

1477  7.3.8 Edit Unification Configuration Attribute Source
1478  The next step is to configure which attribute to use from each directory so IMG knows how to

1479 tie users together.

1480 1. Choose the Joins tab. Click on Edit as shown in Figure 56.

1481
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1488

1489
1490

1491
1492

1493

DRAFT

Home Users Resources Roles Requests Data Access Reviews Rules Reports

Return to: « Home

[ Participating Collectors W Attribute Sources N loins M Reference Resolutions 1

Joined Collectors Join Criteria

HR Identities : RSA Adaptive Directory Identity HR Identities.User Id = RSA Adaptive Directory
Collecotr Identity Collecotr.User Id

Unification Configuration ‘ ‘

Figure 56. IMG Unification Configuration Joins

2. Choose the HR Identities from the Primary Identity Collector dropdown box as shown in
Figure 57.

Join Criteria

Only Identity Collectors that are set to Create Users are available in the Primary Collector selection below. All active Identity
Collectors are available in the Secondary Collector selection.

Primary Identity Collector Attribute Operator  Secondary ldentity Collector  Attribute

| HR Identities = | | UserId "| | = "| | RSA Adaptive Directory "| | User Id W | (x]

Figure 57. IMG Edit Joins
3. Click ‘Finish’.

7.3.9  Start Data Collection
The next step is to start collecting identity data.

1. From the home page choose the Resources > Directories tab. Click Collect Data (all)
button as shown in Figure 58.
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Home Resources Requests | Data Access

Return to: < Home Directories

Directories GRS

Create Directory | | Collect Data (all) |

Grouping: | -- select -- v
Search: ,,;._z:
| | Directory 4| Description | Business Owner
tl HR -- Aveksasdmin,
) RSA Adaptive Directory Accounts - Aveksaldmin,
1494 2 items
1495 Figure 58. IMG Start Data Collection
1496 2. Click OK on the next window as shown in Figure 59.
' Collect Data %)

This will collect data from
all directories

Collection will run as & background process. Total execution time will depend on the volume of
data.

[#] Collect Identity And Run Unification

|#*| Collect Accounts

| OK | | Cancel | | Help
1497 - y
1498 Figure 59. IMG Collect Data
1499 3. The process will take 30 seconds or so to complete. You can check the progress under
1500 ‘Admin’ and ‘Monitoring’ as shown in Figure 60.
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1508

DRAFT

RSA Aveksasdmin, | Options |N Logout

Return to: < Home System

Monitoring d Monitoring

User Interface

Admin

Data Runs Performance Summary Statistics Memory Usage Thread Information Schedule Information :
Attributes
Descriptions
Time Span: | Today M Hide Completed Syst eCEUECIEH
Workflow
Status: Completed: 16
. Email
Grouping: | -- select-- ¥
Search: D Tab Change Events
. Web Services
Run ¥ | Run Type | Sourcel(s) £ SIcucH Q-ueue - £ o £| Run Time s Staty
Start Time Start End Import/Export
1391 Rules Pre- -- 3/23/15  0m00:00 3/23/15  3/23/15 00:00:00  00:00:00 CompjlatelyTTa N+
processing 604 PM 6:04 PM 6:04 PM
1590 Business RSA AD Directory 3/23/15  0m00:01  3/23/15  3/23/15  00:00:00 00:00:00 Completed
Description Accounts 6:04 PM 6:04 PM  5:04 PM
Processing
1589 Change Verification RSA AD Directory 3/23/15  000:01 3723715 3723715 00:00:00 DW Completed
Accounts 6:04 PM 6:04 PM 5:04 PM
1588 Rule Processing Termination 3/23/15 000003 3723715 3723715 00:00:01 DD‘:W Completed
604 PM 6:04 PM 6:04 PM
1547 Rule Proressing Movars 32315 oe0eN? 3230150 323150 00N 000N Combleted

Figure 60. IMG Data Collection Monitoring

You will see all the processes change to ‘Complete’ when done.

7.3.10 Review Data Collected
Now you can look at this data by going to ‘Users’ then ‘Users’ and ‘Groups’.

1. From the home page choose the Users > Groups tab as shown in Figure 61 to review the
data collected.
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1511
1512

1513

1514
1515

1516

DRAFT

Retumn to: -

Aveksasdmin,

| Options | Help | L¢

Business Units

Create Request v | | My Access | | Team Access | | MoveOU
Grouping: | -- select -- v
Search: ) Table Optic
Name | Department +| Title + Is Deleted Is Terminated £ ':')ertml et RV 3
ate

AveksaAdmin, - - Mo MNo - -
ITinfrUser, Tony2 ~ Energy Marketing EM Department No No - it

Head
ITInfrUser, Jon Energy Marketing EM Department Yes Yes 3/18/15 3:04 FM it

Head
ITApplUser, Ron  Energy Marketing Energy Marketing Yes Yes 3/17/15 10:58 it

Tracler PM
ITApplUser, Ron2  Energy Marketing Energy Marketing - Yes Yes 3/17/15 10:58 it

Representative P
OTOpsiInfrUser, Energy Ops Department Yes Yes 3/17/15 1058 ot
Jim Operations A Manager PM
OTOpsinfruser, Energy Ops Department  -- Yes Yes 3/17/15 10058 ot

Ve P TR [N PR —— m

Figure 61. IMG Data Collection Review

7.3.11 Configure Business Rules
The next step is to configure Business Roles.

1. Click on Roles > Roles as shown in Figure.

RN

Return to: < Home ) Roles
Role Sets

Configuration

Requests

o e | e

Roles

Br v | | Actions ¥ | | Analysis v

Show: Latest Versions | Pending Changes

Grouping: | - select -- v
Figure 62. IMG Roles

2. Click on ‘Create / Discover’ and ‘Discover Roles’ as shown in Figure 63.
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Home Users Resources Roles Requests Data Access Reviews

Return to: < Home

Roles

| Create/Discover v | | Actions ¥ | | Analysis T

Create Role
. ‘ersions Pending Change:
Discover Roles
v |

—

Grouping: | -- select --

Search: | & |
|| | Role Name # ‘ Members | Entitlements ¢ | Role Quality | Owner +| Stats
J oo701 - 1 0 AveksaAdmin, New
Managing '
1517 Director
1518 Figure 63. IMG Discover Roles
1519 3. Configure as follows as shown in Figure 64 through Figure 66.

Role Creation

How do you want to create the roles?

® from users
) from user-entitlement clusters
) from entitlements

Where do you want to put these new roles?

'® Existing role set| Job Roles W |

L Mew role set named | | with roles of type | Business

1520
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1521 Figure 64. IMG Discover Roles

Role Creation

Roles will be created for each unique combination of user attributes.

Users matching  All® (matches 299 out of 299).

Create Roles Spliton | User.Job Code \ [x] 58 unique values
these Attributes

| User.Title r | [x7] 58 unique values

66 Roles would be created

Suggest Entitlements  (#] Add suggested entitlements to roles

Suggest Entitlements 12 (o atches 397 out of 397)
1522 Matching

1523 Figure 65. IMG Discover Roles

Discover Roles

Role Information Expressions

What expressions should be used to generate role information?

Mame | ${User.Job Code} - ${User.Title} | v

Last Reviewed Date | | v
Risk | | v

1524

1525 Figure 66. IMG Discover Roles

1526 4. Notice how there are some duplicates — the job codes are the same, but the descriptions
1527 are slightly different. You can combine these rolls into one as shown in Figure 67:
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1534

1535

DRAFT

Discover Roles

Figure 67. IMG Discover Roles

5. When you are done combining duplicates, click Finish.

7.3.12 Create Automated Rules

Role Creation
For each row in the table below a new role will be created. The selection checkboxes are used to identify roles for use with the button bar below the table o
[ | Role Mame 4 | Members
00701 - Managing Director 1
U 00702 - Executive Assistant - Ur-
U 00703 - Business Startegist 1
,D‘ 10100 - Chief Executive Office 1
10101 - AM Department Mar 1
} 10101 - IT Department Mana 1
L' 10102 - Lead Infr Admin 1
L' (10102 - sr Infr Admin 3
ltems 1 - 50 of 66 | 2 selected EJ Page 12 1 i]
| Remove | | ComﬁRemove Users | | Remave Entitlements |
[ Hide Entitlernents That Are Already Used In Committed Roles
[ Hide Entitlernents That Are Already Used In New Uncommitted Roles
Suggest entitlements that 0 12 % of members have | Refresh | | Show More |

The next step is to create rules for automatically detecting and invoking work flows for new

users and terminations.

1. Click on ‘Rules’ and ‘Definitions’ as shown in Figure 68.

Requests Diata Access Reviews Rules

Definition

|nue rs Rule Sets

Violations

i

Exceptional Access

Workflows

Configuration
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1536 Figure 68. IMG Roles Definitions

1537 2. Click on ‘Create Rule’ and configure as shown in Figure 69 and Figure 70 for New Users.

Edit Rule: New User

Rule Mame* : | Mew User |

Description :

Owner® ;. AveksaAdmin, @

Control URL ;

Control Description :

Type” ‘ Provisioning - Joiner/Mover [l
Status” : ‘ Active EI
RuleSet”: ® Exjsting rule set| Default Rule Set v

) Mew rule set named | |

Condition
[« Trigger when new users are detected (joiners)

[]Trigger when users change categories (movers)

Actions

Assign provisioning request form Default Provisioning Form?

Provisioned entitlements®:

Entitlernent Suggestion Modeling®

For these users: All

Categorize them based on: Job Code

Consider the following entitlements when making suggestions: All
1538 Suggested entitlements that 0% of members have

1539 Figure 69. IMG New User

1540

90 | NIST Cybersecurity Practice Guide SP 1800-2¢



1541
1542

1543
1544

DRAFT

Optional entitlements that 0% of members have
Allow arbitrary entitlements
Allow selection from AllR

Allow user comparisons
Assignee™:

® Supervisor

O Specified by target user attribute
O Selected user

[ For movers also generate a review using review definition:

Processing Schedule/Trigger

® Use global configuration O Define for this rule

Scheduled : Mo

Triggered : Run after identity unification

Figure 70. IMG New User

3. Click on ‘Create Rule’ and configure as shown in Figure 71 and Figure 72 for User
Terminations.
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Edit Rule: Termination

Rule Mame® |Termination |

Description ;

Owner* ;  AveksaAadmin, @

Control URL ;

Control Description

Type" ! | Provisioning - Termination |
Status” ; | Active hd
Rule Set”: @ Existing rule Set| Default Rule Set VI

© Mew rule set named | |

Condition

Condition* : For terminated users matching the following condition

IT Users™®
Actions
Each action will submit a separate change request
[] Disable accounts (excludes shared and service accounts)
[v] Delete accounts (excludes shared and service accounts)
For particular accounts All®
Perform this action
® Immediately O After | | days
1545
1546 Figure 71. IMG User Termination
[0 Revoke user entitiements (excludes shared and service accounts)
[ Shared Accounts
[ Service Accounts
Processing Schedule/Trigger
® Use global configuration O Define for this rule
Scheduled: ) ves (2 No
1547 Triggered ; [/|Run after identity unification
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1548 Figure 72. IMG User Termination
1549
1550 4. Click ‘OK’.

1551  7.3.13 Create Provisioning Template
1552  The next step is to create a template that IMG uses when provisioning accounts in Adaptive
1553  Directory:

1554 1. Click on ‘Requests’, ‘Configuration’, ‘Account Template’ tab, then ‘Create Account
1555 Template’ as shown in Figure 73 .

Return to: < Home 5
Requests Configuration
A

3 Account Templates Submission Monitoring Policies MNaming Policies

Settings Request Buttons Request Forms Lsg] Workflows

Password Management
Templates are used for creating accounts and ma - Configuration
Search:
1556 D Name r | Description & | Is Service Acce
1557 Figure 73. IMG Request Configuration
1558 2. Enter a name, and click OK as shown in Figure 74.
Account Template t:’

Mame*: | Account Template

Description @
Is Service Account: () Yes  (® Mo
Account Creation: pyoq-m
Form
| oK | | Cancel | | Help |

1559 y
1560 Figure 74. IMG Account Template
1561 3. Click on the name of the account template you just created and add parameters as
1562 shown in Figure 75.
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Account Template: IT Account Template

MName: [T Account Template

Is Service Account:  No

Template Parameters

Add Parameter

Table Options
D| Action | Name | Default Value Submission Field
CN ${User.Login_ID} ~
sn S{User.Last_Mame}
sAMAccountMame ${User.Login_ID}
mail ${User.Email_Address}
Account ${User.Login_ID}
userPrincipalMame §{User.Email_Address}
Password §{GeneratedPassword}
givenhame §{User.First_Name}
v
Bitems
Delete
Pending Account Parameters
| Add Pending Account Parameter
Table Options
|:| | Action | Name | Default Value Submission Field
Mame CN=5{User.Login_ID} ou=5{User.OU}, dc=master dc=test -
v
1item
Delete
1564 Figure 75. IMG IT Account Template

1565  Next configure the IMG AFX module which will allow IMG to provision to Adaptive Directory:

1566 4. Click on ‘AFX’ and ‘Connectors’ as shown in Figure 76.

Reviews Collectors ARX Admin

Connector Templates

Servers

Import

Export

1567
1568 Figure 76. IMG AFX Connectors
1569 5. Click on ‘Create Connector’ as shown in Figure 77.
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| Data Access | Reviews

Rules | Reports Collectors

“

| Create Connector

1570
1571 Figure 77. IMG Create Connector
1572 6. Configure the ‘General’ tab as shown in Figure 78.
Edit Connector: RSA Adaptive Directory Connector
J General ” Settings N Capabilities 1
Mame" : | RSA Adaptive Directory Connector |
Description : ‘
Server” : | AFX Server VI
State ! | Active EI
Export As Template : | |
1573 ' :
1574 Figure 78. IMG AD Connector AFX Server
1575

7. Configure the ‘Settings’ tab as shown in Figure 79 through Figure 81.
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Edit Connector: RSA Adaptive Directory Connector IT

e | Seings | copis |

Connection Details

Host': [h72.164.3

Port” : [1636

Uze Secure !
Connection v

Login Distinguished

Nare® : |cn=D|'rect0r_'.r Manager |

*
Password™ |------------------------------------------- |

Timeout (seconds)” | 10

Distinguished Name

Account DN Prefix : | CN |

Account DM Suffix | dc=master,dc=test |

Group DN Prefix : |y |

Group DM Suffix . | dc=master,dc=test |

DM Suffix Mappings . |
1576
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1577 Figure 79. IMG AD Connector AFX Server

Edit Connector: RSA Adaptive Directory Connector IT

e | Setings | Capais |

Connection Details

Host": |172,16.4.3

Port* : | 1636

Use Secure :
Connection v

Legin Distinguished

Narme® : |cn=D|'rectory Manager |

L
Password™ : |------------------------------------------- |

Timeout (seconds)® | 10

Distinguished Name

Account DN Prefix : |' CN .|

Account DN Suffix | dc=master,dc=test |

Group DN Prefix : |y |

Group DN Suffix ; | dc=master,dc=test |

DM Suffix Mappings -
1578 |
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1579 Figure 80. IMG AD Connector AFX Server

Object Creation

LDAP object classes to

create account* ' | ‘top','person’,'organizationalPerson’,'user’

LDAP ohject classes to

create group® | | top’, group’
Group
ot member
AccountLockUnlock

Account Lockout :
Threshold attribute | 10

value®
Miscellaneous
Dependent Exchange
1580 Connector
1581 Figure 81. IMG AD Connector AFX Server
1582 8. Configure the ‘Capabilities’ tab as shown in Figure 82.

Edit Connector: RSA Adaptive Directory Connector IT

[ General N Settings ” Capabilities h

Account
[w] Create an Account on an AD server

[v] Delete an Account from an AD server
[+]Reset an Account's password
[w] Add Account to AD Group
[v] FRemove Account from AD Group
[w]Enable an Account
[v] Disable an Account
[+]Update an Account
[w]Move an Account
[+]Lock an Account
[w]Unlock an Account

Group
[v] Create a Group on an AD server
[w] Delete a Group from an AD server
[w] Update a Group

1583
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Figure 82. IMG AD Connector IT

9. Check all capabilities needed for to the connector. Once all are selected, click on the
capability name one by one and configure as shown in Figure 83 through Figure 96.
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Edit Con:mector: RSA Adaptive Directory Connector IT

General Settings Capabilities
Account Create an Account on an AD server
[#] Create an Account on an AD server b‘
[+] Delete an Account from an AD server Command Input Parameters
[w] Reset an Account's password
[w] Add Account to AD Group Parameter Name Type Default Value Required Encrypted Display Name Mapping Description
Remove Account from AD Grou 1 B S —— T Y r N
%Enableanﬁ\ccount P |A(count | | STRING I |N0t,Avai|ab\e | O |Accoum: Mame | |${AccountTempIate‘NamE}‘ |Fu\| DN | =
[w/] Disable an Account | sAMAccountiName | | STRING : I | Not_fwvailable | v O | sAMAccountMame | | $iAccountTemplate.sAMA | Logon name used to support clients and servers running earlier v | x
[w] Update an Account . S o : .
¥ Move an Account |_CN | | STRING I | Not_Available | OJ | Common Name | | ${AccountTemplate.CN} |_Nama that represents an object. It is used to perform searches | ®
[¥|Lock an Account |sn | | STRING |E| | Not_svailable | ] O | Last Name | |${AccountTempIate‘;ﬂ} ‘ |Sumame of a persen | (E3]
[w] Unleck an Account i i . o . i i
Group |_giveﬂName | | STRING |E| | Mot_Available | ] O | First Name | | ${AccountTemplate.givenh |_A given name of a person | =
Createa G AD E o F E 2 o F E 2
% D;T:t:: Gr::.]::::an A:}e::\:-a (i | [ stRING [v] [Not_Avsilable ] = O [Emeil address | | StAccountTemplate mail} | Simple SMTP address of = person | @
[w] Update a Group Password STRING Initial password to set ${AccountTemplate.Passwt Password which is required for login =
L J L P 1 P L 9 9 J
|‘userPr|nc|palName | | STRING : I | | v ] | UserPrincipalMarne | | S{AccountTemplate.userPri |‘U;ErPrmc\palName (Email Address) | [E3]
Add More...
Command Output Parameters
Parameter Name Type Attribute Display Name Mapping Description
1588 Add More...
1589 Figure 83. IMG AD Connector IT Capability Configuration

1590
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Edit Cor_mector: RSA Adaptive Directory Connector IT

General Settings Capabilities

Account
[w] Create an Account on an AD server
[] Delete an Account from an AD server ‘..
[w] Reset an Account's password
[w] Add Account to AD Group
[w] Remove Account from AD Group
[w] Enable an Account
[w] Disable an Account
[v] Update an Account
[w] Move an Account
[+l Lock an Account
[v] Unlock an Account

Ferin

1591

Delete an Account from an AD server

Command Input Parameters

Parameter Name Type Default Value

| [stemG [+ |

Required Encrypted Display Name

] @ O

Mapping Description

‘:Account

Add More...

|Accoum: Name | | §{Account.Name}

|Full DN

Figure 84. IMG AD Connector IT Capability Configuration

Edit Connector: RSA Adaptive Directory Connector IT

General Settings Capabilities

Account
[w] Create an Account on an AD server
[#] Delete an Account from an AD servey
[#] Reset an Account's password
[w] Add Account to AD Group
[#] Remove Account from AD Group
[] Enable an Account
[w] Disable an Account
[#] Update an Account
[w] Move an Account
[#] Lock an Account

1592
1593

Reset an Account's password

Command Input Parameters

Parameter Name Default Value

Type Required Encrypted Display Name Mapping Description
|‘Account | | STRING I ‘ ‘ O |Ac:ount Name | | S{Account.Name} ‘ II' | Full DN | (E3)]
|‘Passwwd | | STRIMG I ‘ ‘ | Initial password to reset to | | password ‘ lzl |A new password to reset | =

Add More...

Figure 85. IMG AD Connector IT Capability Configuration

101 | NIST Cybersecurity Practice Guide SP 1800-2c



DRAFT

Edit Connector: RSA Adaptive Directory Connector IT

General Settings Capabilities
Account

[w] Create an Account on an AD server

[w] Delete an Account from an AD server

[#] Reset an Account's password

[#] Enable an Account
[w] Disable an Account
[+] Update an Account
[w] Move an Account
[v] Lock an Account
[w] Unlock an Account
Group
[w] Create a Group on an AD server
[] Delete a Group from an AD server
[v] Update a Group

1594

Add Account to AD Group

[¥] Add Account to AD Group ?
[+] Remove Account from AD Group

Command Input Parameters

Parameter Name Type Default Value
[Account | [stame [+] |
[Group ] [sTRinG [v] |

Add More...

Required Encrypted Display Name Mapping Description
| ¥ O |Account DN or Account Name] ‘:I{Account.Name} ‘ |‘Fu|| DN | E]
| "1 |Group DN or Group Name | | §{Group.Mame} |- Full DN of group or group name | 32

Figure 86. IMG AD Connector IT Capability Configuration
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Edit Connector: RSA Adaptive Directory Connector IT

General Settings ‘Capabilities

Account
[w] Create an Account on an AD server
[w] Delete an Account from an AD server
@ Reset an Account's password
[w] Add Account to AD Group
[w] Remove Account from AD Group b
[w] Enable an Account
[w] Disable an Account
[#] Update an Account
[w] Move an Account
[#] Lock an Account
[#] Unlock an Account
Group
[w] Create a Group on an AD server
[] Delete a Group from an AD server

Remove Account from AD Group

Command Input Parameters

Parameter Name Type Default Value Required Encrypted Display Name

| [string [+] | ] = O

[Group REEIEN | O

Mapping

|Accuunt ‘Account DM or Account Mame | | S{Account.Name}

| | siGroup.DN}

[Group DM or Group Mame

Figure 87. IMG AD Connector IT Capability Configuration

Edit Connector: RSA Adaptive Directory Connector IT

General Settings Capabilities

Account
[w] Create an Account on an AD server
[w] Delete an Account from an AD server
[w] Reset an Account's password
[w] Add Account to AD Group
[w] Remove Account from AD Group
[#] Enable an Account &
[w] Disable an Account
[#] Update an Account
[w] Move an Account
[+] Lock an Account

Enable an Account

Command Input Parameters

Parameter Name Type Default Value

| [stRING [+] |

Required Enaypted Display Name

] @ O

Mapping Description

|7 |[Funon | @

|A::uunt

Add More...

‘_Account MName | ‘ ${Account.Name}

Figure 88. IMG AD Connector IT Capability Configuration

Edit Connector: RSA Adaptive Directory Connector IT

General Settings Capabilities

Account
[] Create an Account on an AD server
[] Delete an Account from an AD server
E Reset an Account's password
[] Add Account to AD Group
E Remove Account from AD Group
[] Enable an Account
[/] Disable an Account h
[+] Update an Account
[w] Move an Account
[w] Lock an Account
[« Unlock an Account

Disable an Account

Command Input Parameters

Parameter Name Type

| [swinG[] |

Default Value Required Encrypted Display Name

| & O

Mapping Description

|7 [Futlon | @

|A::ount

Add More...

[Account Name ‘ | $iAccount.Mame}

Figure 89. IMG AD Connector IT Capability Configuration
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Edit Connector: RSA Adaptive Directory Connector IT

General Settings Capabilities
Account
[] Create an Account on an AD server
[] Delete an Account from an AD server
E Reset an Account's password
[w] Add Account to AD Group
E Remove Account from AD Group
[] Enable an Account
[] Disable an Account
[¥] Update an Account *
[w] Move an Account
[w]Lock an Account
[ Unlock an Account
Group

[] Create a Group on an AD server

3 Nalate 2 Grom fram 2n AN coner

Update an Account

Command Input Parameters

Parameter Mame Type Default Value Required Enaypted Display Name Mapping Description
[Account | [strinG [+] | ] @ 1 Account Name | [ saccount.Name} |7 [Funon | @

Add Mare...

Figure 90. IMG AD Connector IT Capability Configuration

Edit Connector: RSA Adaptive Directory Connector IT

General Settings || Capabilities
Account

[w] Create an Account on an AD server

[] Delete an Account from an AD server

[ Reset an Account's password

[ Add Account to AD Group

[ Remove Account from AD Group

[w] Enable an Account

[] Disable an Account

[+l Update an Account

[¥] Move an Account b

[l Lock an Account

[ Unlock an Account

Move an Account

Command Input Parameters

Parameter Name Type Default Value Required Encrypted Display Name Mapping Description
‘Account | | STRING El | ‘ ] O |Account MName | |5{A:count.Nama} | |Fu|l DM of account or legin name | [I]
|NewParentDN | [ sTRING |+ | ] "] |New Parent's DN | | stAccount.DN} | | DN of new account base or organizational unit | =

Add More...

Figure 91. IMG AD Connector IT Capability Configuration
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Edit Connector: RSA Adaptive Directory Connector IT

General Settings Capabilities
Account

[w] Create an Account on an AD server

[w] Delete an Account from an AD server

[ Reset an Account's password

[w] Add Account to AD Group

[#] Remove Account frem AD Group

[w]Enable an Account

[w] Disable an Account

[¥] Update an Account

[w] Move an Account

[¥] Lock an Aceount h

[ Unlock an Account

Frran

General Settings Capabilities
Account

[] Create an Account on an AD server

[] Delete an Account from an AD server

[] Reset an Account's password

[w] Add Account to AD Group

[w] Remove Account from AD Group

[]Enable an Account

[] Disable an Account

[ Update an Account

[ Move an Account

[¥] Lock an Account

[ unlock an Account h

Lock an Account

Edit C0|:mector: RSA Adaptive Directory Connector IT

Command Input Parameters

Parameter Name Type Default Value Required Encrypted Display Name Mapping Description
‘:Account | ‘ STRING | | ‘ ] O |A::ount Name ‘ | SfAccount.Mame} | ‘:Full DM of account or login name | @

Add Mare...

Figure 92. IMG AD Connector IT Capability Configuration

Unlock an Account

Command Input Parameters

Parameter Name Type Default Value Required Encrypted Display Name Mapping Description

|_Accuunt | ‘ STRING El | | ] O ‘_Account Name

Add More...

J | ${Account,Name} “Il ‘_FUH DN of account or login name | [E3]

Figure 93. IMG AD Connector IT Capability Configuration
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Edit Connector: RSA Adaptive Directory Connector IT

General Settings Capabilities

Account
[] Create an Account on an AD server

[+ Delete an Account from an AD server
[+] Reset an Account's password

[+] Add Account to AD Group

[+l Remove Account from AD Group

[] Enable an Account

[] Disable an Account

[l Update an Account

[] Move an Account

[+] Lock an Account

[+ Unlock an Account

Group

[] Create a Group on an AD server b

[] Delete a Group from an AD server
[] Update a Group

Create a Group on an AD server

Command Input Parameters

Parameter Name Type Default Value

[Group | [strinG [+] |

len | | sTRING |+ | |

| groupType | | sTRING : |-2147423646

Add More...

Required Encrypted Display Name Mapping Description
O |Group Name ‘ |HGroup.Name} | |FuH DN of group or group name ‘ [£3]
O |_Common Name ‘ | ${Group.Mame} | lzl |Namethat represents an object. It is used to perform searches ‘ [£3]

vl O |GroupType ‘ | ${Group.Resource Type} Hzl |Set of flags that define the type and scope of a group object ‘ x

Figure 94. IMG AD Connector IT Capability Configuration
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Edit Connector: RSA Adaptive Directory Connector IT

General Settings Capabilities
Account
[] Create an Account on an AD server
[] Delete an Account from an AD server
[ Reset an Account's password
[] Add Account to AD Group
[] Remove Account from AD Group
[] Enable an Account
[] Disable an Account
[] Update an Account
[] Move an Account
[#] Lock an Account
[+] Unlock an Account
Group
E Create a Group on an AD server
[¥] Delete a Group from an AD server
[#] Update a Group

Delete a Group from an AD server

Command Input Parameters

Parameter Name Type Default Value Required Encrypted Display Name Mapping Description

‘Gmup | | STRING ‘ | | Ld} |Group Name | | ${Group.Name} ‘ ‘Full DN of group or group name ‘ €3]

Add More...

Figure 95. IMG AD Connector IT Capability Configuration

Edit Connector: RSA Adaptive Directory Connector IT

General | Settings || Capabilities
Account

[w] Create an Account on an AD server

[#] Delete an Account from an AD server

[w] Reset an Account's password

[w] Add Account to AD Group

[w] Remove Account from AD Group

[w] Enable an Account

[w] Disable an Account

[w] Update an Account

[w] Mowve an Account

[w] Lock an Account

[#] Unlock an Account

Group
[w] Create a Group en an AD server

E Delete a Group from aAD server
[ Update a Group

10. Click OK.

Update a Group

Command Input Parameters

Parameter Name Type Default Value Required Encypted Display Name Mapping Description

|_Gmup | ‘ STRING ‘ | | jid) ‘Group MName | | ${Group.Mame} | |FuH DN of group or group name ‘ =

Add More...

Figure 96. IMG AD Connector IT Capability Configuration
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7.3.14 Configure Adaptive Directory to Use AFX Connector
The next step is to configure the RSA Adaptive Directory ‘Directory’ to use the new AFX
Connector.

1. Click on Resources > Directories tab as shown in Figure 97 and select HR and click OK.

e

Return to: < Home Directories

Directories Sipplislions

Create Directory | | Collect Data (all)

Grouping: | —- select [w]

Search: } &

[1| Directory A ‘ Description | Business Owner
] HRr -- AveksaAdmin,
[] RsA Adaptive Directory Accounts -- AveksaAdmin,
2 itemns

Figure 97. IMG Resources Directories

2. Thenin the next window choose the AFX Connector Binding tab as shown in Figure 98.
3. Click the Edit Connector Binding as shown in Figure 98.

T N e e T T

Return to: <« Home - Directories

Directory: RSA Adaptive Directory Accounts

General AFX Connector Binding Collectors Accounts Who Has Access | What Access | Resource Profile Requests

'*l Edit Connector Binding | | Clear Connecter Binding

Connector:  mapped to AFX Connector RSA Adaptive Directory Connector IT
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Figure 98. IMG AD Accounts

 Select AFX Connector Binding %)

Connector: | poa Adaptive Directory Coni | ¥

OK || Cancel | | Help

Figure 99. IMG AD AFX Connector Binding
4. Click OK as shown in Figure 99.
Now the system is ready.

7.4 UsING RSA IMG

7.4.1 Adding a New User
1. Open the HR CSV file and add a user.
2. Goto ‘Resources’, ‘Directories’ and click ‘Collect Data (all)’ as shown in Figure 100.

RSA

Feturn to: < Home

Directories Applications

Create Directory | | Collect Data (all) |

Grouping: | -- select -- [v]

Search: =

|:| Directory A | Description | Business Owner
[] HR -- Awvekzaldmin,
[] RSA Adaptive Directory Accounts -- Aveksafdmin,
2 items
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Figure 100. IMG Resources Directories

1. Click ‘OK’ as shown in Figure 101.

This will collect data from

all directories

Collection will run as a background process. Total execution time will depend on the velume of
data.

[+ Collect Identity And Run Unification

[#] Collect Accounts

OK

|| Cancel | | Help

Figure 101. IMG Collect Data

2. After about 30 seconds go to ‘Requests’, ‘Activities’ and click ‘Perform’ next to the
request to add a new user as shown in Figure 102.

4

Returnto: <« Home

Aveksafdmin,

| Options | Help | Logout

Data Access

Collectors

Activities

e

| ByWork ltem By Ascignee By Entitlement

Workflows

UG LUt [ Pending:1 | Completed: 244

Configuration

Grouping: | - select -- ;E

Search:

P2

Table Options

Action £| 04| Activityld 7| Task ‘A(ﬁﬂlystate ¢ ;:;u“g:t (] Requested On & | C On ¢ | Priority Due By | Notes
272 Complete Available Aveksahdmin,  3/24/151:31PM -~ 3/27/151:31 - -

Default PM

Provisicning

Form for Test30

[Tinfruser -
Titem
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1648 Figure 102. IMG Requests Activities

1649 3. Select a group you would like to add the user to, Click ‘Next’, then ‘Accepted’ as shown in
1650 Figure 103.

Access Request: ITInfrUser, Test50
Default Provisioning Form Page 1of 7

Please select the entitlements Test30 [TinfrUser should have. The suggested entitlements represent the access the system thinks this user should have based on the provisioning rule 'New User'. The optional
entitlements represent additional access the system also thinks the user might need.

Suggested Entitlements (At least 0% of the users have these entitlements) «
Grouping: Business Source Name »

Search: Table Options
Entitiement Name « | Entitlement Type e t[ DN | Description =/ Domain ¢
=] RSA Adaptive Directory Accounts (2} ~
[] CN=Denied RODC Password rou| 50 Denied RODC Password Members in this group cannot  --
group group
Replication Replication Group have their passwords replicated
Group,ou=it,de=master,dc=test to any read-only domain
contrellers in the domain

CN=Domain group 50 Domain Admins Designated administrators of

Admins, ou=it,dc=master, dc=te the domain

st v
1 Group (2 total items | 1 selected)

Arbitrary Entitlements »
Compare with a typical user?

Accepted
Rejected

Reassign

1651 B < Back Finish
1652

Figure 103. IMG Accepted Access Request

1653 4. Enter a description if you wish, and click ‘Finish’.

1654 5. Go to ‘Requests’, and click ‘Requests’. Click the name of the request as shown in Figure
1655 104.
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Return to: < Home

Requests

0
&
-Th
m
-
i
1

Grouping: | - select --

M

Data Access

Requests

Requests
Approvals
Activities

Worlflows

[eam Access | | MoveQ

Pending: 29 Comg

Password Management

Configuration

Search: P
QE*HEL/ ¢ | state ©| Requested By ¢| Reay
] 00066 Fulfillment Phase Aveksatdmin, 3724,

1656
1657

1658

1659

1660 you selected as shown in Figure 105.

Edit

Figure 104. IMG Requests

6. After about 30 seconds, your new user will be provisioned to AD and added to the group

Cancel

[ Overall Status: | 50%

1/2 (Fulfillment Phase)

00068
Aveksaldmin,

Name:
Requested By: on 3/24/15 1:33 PM
Notes:
Workflow Jobs:  Processing Workflow
Email Log:

AFX Log:

Email Log
AFX Log™

Additional Information

Ij Default Provisioning Form ™ (For [TInfrlser, Test31 )
Test51ITInfrUser

Test31TInfrUser

Test51
Test31TInfrUser@ES-1dAM-B1.TEST

AccountTemplate.Account:
AccountTemplate.CN:
AccountTemplate.givenName:

AccountTemplate.mail:

Attachments
Ne file selected. Upload Attachment
Status
Details: Fuffillment: © 50 | 1/2 Changes Fulfilled (0/0 Activities)

[e4
W[«

[® & Approval Phase

= & Fulfillment Phase
[ & IT AFX Fulfillment
) Changes processed by AFX handler

Test51ITInfrUser
[TInfrlser
Test31TInfrUser@ES-1dAM-B1.TEST

AccountTemplate. sAMAccountName:
AccountTemplate.sn:

AccountTemplate.userPrincipalName:

) Verified
Account Changes i~
Search: -~ Table Options
Status Action Account Entitlement Type Business Source Entitlement State A ‘
= Create CN=Test31TInfrUser,ou=it,dc  Owner RSA Adaptive Directory ITInfrUser, Test31 Completed “
=master,dc=test Accounts

1661
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Figure 105. IMG New User Provisioned

Note: The state of the group add will remain pending, and the overall status will remain at 50%
until you recollect data from the Directories page so that IMG can detect that the user has been
added to the group successfully as shown in Figure 106.

| Ovwerall Starturs: (0 T 2/2 (Fulfillment Phase)

Name: 00068
Requested By: AveksaAdmin, ' on 3/24/15 1:53 PM
Motes: -
Workflow Jobs:  Processing Workflow
Email Log: Email Log
AFX Log: AFXLlog®

Additional Information

D Default Provisioning Form ™ (For ITInfrlser, Test31 )

AccountTemplate.Account:  Test31TInfrUser AccountTemplate sAMAccountName:  Test31(TInfrUser
AccountTemplate.CN:  Test31TInfrUser AccountTemplate.sn:  [TInfrUser
AccountTemplate.givenMame:  Test51 AccountTemplate.userPrincipalName:  Test31(TInfrUser@ES-1dAM-B1.TEST

AccountTemplate.mail:  Test31TInfrUser@ES-1dAM-B1.TEST

Attachments
Mo file selected. Upload Attachment
Status

Details:  Fulfillment: 2/2 Changes Fulfilled (0/0 Activities)

[ & Approval Phase

[=] & Fulfillment Phase
(&2 IT AFX Fulfillment

Account Changes »

Search: b Table Options
Status | Action Account Entitlement Type Business Source Entitlement State
£ gﬂ Create CM=Test31[TInfrUser,ou=it,dc Owner R5A Adaptive Directory ITInfrlser, Test31 Completed -
=master,dc=test Accounts
@ H Add CM=Test31[TInfrUser,ou=it,dc Group RSA Adaptive Directory CN=Domain Completed
=master,dc=test Accounts Admins,ou=it,de=master,de=

test

Figure 106. IMG Successful User Add

7.4.2  Moving a User
1. Open your CSV file and change the attribute that defines the OU that the userisinto a
different OU.
2. Collect data again.
3. The OU change is detected, and IMG deletes the user from the original OU and adds the
user to the new OU.
4. Go to ‘Requests’ and ‘Activities’” and click ‘Perform’ as shown in Figure 107.
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Return to: <« Home

Activities

By Work Item By Assignee By Entitlement

Show: All: 253 Pending: 1 Completed: 252

Grouping: | __ select -- [w]
Search:
Action £ 04| Activityld 7 | Task ‘A.d?u?tystaie (3 Eg:ﬁ £ | Assignee(s) Requested On & | Completed O
2846 Complete Available -- Aveksafdmin,  3/24/15 207 PM  --
Default
Provisicning
Form for Test52
OTInfrUser

1 itermn
Figure 107. IMG Requests Activities

5. Select the group you would like the moved user to have access to, click ‘Next’ and
‘Accepted’, then ‘Finish’ on the final screen. As you did before for adding a new user.

6. Collect data again so IMG can confirm that the user is added to the appropriate group in
the new OU.

7. Terminating a user

8. Delete the user from the HR CSV file.

9. Collect data again.

10. The user is automatically removed.

11. Collect data again, so IMG can confirm the user is no longer in Adaptive Directory.

12. Check the Status in ‘Requests’, and ‘Requests’ as shown in Figure 108.
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Returnto: <« Home - Requests
Request: 00077

Overall Status:

1/1 (Fulfillment Phase)

Name: 00077
Requested By: AveksaAdmin,  (through the rule Termination ) on 3/24/15 2:12 PM
Fulfillment Date: 03/23/15

Motes: Request submitted by the systern for the rule Termination on behalf of the
rule owner AveksaAdmin,.

Workflow Jobs: Processing Workflow
Email Log: Email Log
AFX Log: AFXLog®

Attachments
No file selected. Upload Attachment
Status

Details: Fulfillment: 1/1 Changes Fulfilled (0/0 Activities)

& Approval Phase

[E @ Fulfillment Phase
[ & IT AFX Fulfillment
2 Changes processed by AFX handler

© Verified
Account Changes »
Search: P Table Options
Status | Action Account Entitlement Type Business Source Entitlement State A |
£ =5 Delete CN=Test320TInfrUser,ou=ot, Account OTlInfrUser, Test32 Completed .
de=master,dc=test -

1item

Figure 108. IMG Request Status
8 INSTALLATION OF ADAPTIVE DIRECTORY: RSA (BuiLD #2)

RSA Adaptive Directory implements the central IdAM ID store in Build #2. It receives input from
central IdAM system (RSA IMG). The central ID store contains the distribution mechanism for
updating the various downstream (synchronized) directories with user access and authorization
data. This process applies to new users, terminated users (disabled or deleted users), and any
changes to a user profile. Changes include promotions, job responsibility changes, and any
other change that would affect the systems a user needs to access.

8.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for
authorized devices and users

NIST 800-53 rev 4 Security Controls: AC-2, IA Family

8.2 RSA ADAPTIVE DIRECTORY IS INSTALLED ON THE IDAM NETWORK, ON A VM THAT IS RUNNING

CENTOS 7

The following lines detail the command line installation procedure for RSA Adaptive Directory,
including displayed responses:
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[root@localhost ~]# 1s
anaconda-ks.cfg reports xml
[root@localhost ~]# cd
[root@localhost /]# 1s
bin dev home lib64 mnt proc run srv tmp var
boot etc lib media opt root sbin sys usr
[root@localhost /]# cd media
[root@localhost medial# 1s
cdrom
[root@localhost media]# cd cdrom
[root@localhost cdrom]# 1s
Documentation rsa_7.1.5_linux_64.bin rsa_7.1.5_windows_64.exe
[root@localhost cdrom]# su root ./rsa 7.1.5 linux 64.bin
Preparing to install...
WARNING: /tmp does not have enough disk space!
Attempting to use /root for install base and tmp dir.
Extracting the JRE from the installer archive...
Unpacking the JRE...
Extracting the installation resources from the installer archive...
Configuring the installer for this system's environment...

Launching installer...

Graphical installers are not supported by the VM. The console mode will be used instead...

RSA Adaptive Directory 7.1.5  (created with InstallAnywhere)

Preparing CONSOLE Mode Installation...

Please read the following License Agreement carefully.
LICENSE AGREEMENT
**% IMPORTANT INFORMATION - PLEASE READ CAREFULLY ***
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(...Lic agreement text omitted...)
DO YOU ACCEPT THE TERMS OF THIS LICENSE AGREEMENT? (Y/N): Y

Choose Install Folder

Please choose a destination folder for this installation

Where would you like to install?

Default Install Folder: /root/rsa/adaptivedirectory

ENTER AN ABSOLUTE PATH, OR PRESS <ENTER> TO ACCEPT THE DEFAULT: Enter

Please choose the Install Set to be installed by this installer.
>1- RSA Adaptive Directory New Cluster / Standalone

2- RSA Adaptive Directory Cluster Node

3- Customize...

ENTER THE NUMBER FOR THE INSTALL SET, OR PRESS <ENTER> TO ACCEPT THE DEFAULT:
Enter

New Cluster settings

Enter information below about the new cluster to create:
- The cluster name

- The ZooKeeper ports that will be used

Cluster name: (DEFAULT: clusterl): clusterl
ZooKeeper Ensemble Port: (DEFAULT: 2888): 2888
ZooKeeper Leader Election Port: (DEFAULT: 3888): 3888
ZooKeeper Client Port: (DEFAULT: 2181): 2181

Please provide the administrator name:

Admin User Name (DEFAULT: cn=Directory Manager): Directory Manager
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Server administrator password

Please provide a password for the administrator user :
Password (DEFAULT: ): secretsecret

Confirm Password (DEFAULT: ): secretsecret

Adaptive Directory port numbers

Please enter port numbers for Adaptive Directory:
Adaptive Directory Port (DEFAULT: 2389): 2389
Scheduler Port (DEFAULT: 1099): 1099

Adaptive Directory SSL Port: (DEFAULT: 1636): 1636

Adaptive Directory HTTP port numbers

Please enter port numbers for Adaptive Directory HTTP services:

Adaptive Directory HTTP Port (DEFAULT: 8089): 8089
Adaptive Directory HTTPS Port (DEFAULT: 8090): 8090

Certificate configuration

Use an existing certificate (Y/N)? (DEFAULT: N): N
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Application Server Configuration

Enter information below to configure the Application Server

- Administrator user name for initial server instance.

- Administrator password for initial server instance (must be at least 8
characters in length).

- Administration server port number for initial server instance.
- HTTP/HTTPS port number for initial server instance.

- JMX port number for initial server instance.

Admin User (DEFAULT: admin): admin

Password (DEFAULT: ): secretsecret

Confirm Password (DEFAULT: ): secretsecret

Admin Port (DEFAULT: 4848): 4848

HTTP Port (DEFAULT: 9090): 9090

HTTPS Port (DEFAULT: 9191): 9191

JMX Port (DEFAULT: 8686): 8686

Control Panel Configuration

These are the settings for the Web Server hosting the Control Panel.

Enter the HTTP/HTTPS ports to configure the Web Server on the main instance:
These are the settings for the Web Server hosting the Control Panel.

HTTP Port (DEFAULT: 7070): 7070

Enter the HTTP/HTTPS ports to configure the Web Server on the main instance:
HTTPS Port (DEFAULT: 7171): 7171

Port validation failed

Control Panel HTTP port These are the settings for the Web Server hosting the
Control Panel. is invalid.

Please select a new one.

PRESS <ENTER> TO ACCEPT THE FOLLOWING (OK): Enter
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Control Panel Configuration

These are the settings for the Web Server hosting the Control Panel.

Enter the HTTP/HTTPS ports to configure the Web Server on the main instance:
HTTP Port (DEFAULT: 7070): 7070

HTTPS Port (DEFAULT: 7171): 7171

Pre-Installation Summary

Please Review the Following Before Continuing:

Product Name: RSA Adaptive Directory 7.1.5

Install Folder: /root/rsa/adaptivedirectory

Install Set: RSA Adaptive Directory New Cluster / Standalone
Product Features: Application, Sample Data

Java VM Installation Folder: /root/rsa/adaptivedirectory/jdk
Administrator User: cn=Directory Manager

Adaptive Directory Ports: 2389 8089 8090

Scheduler Port: 1099

SSL Configuration: 1636

Start TLS Configuration: TLS is disabled.

Certificate Configuration: Self signed certificate.

App Server Configration: 4848 9090 9191 8686

Web Server Configuration: 7070 7171

Disk Space Information (for Installation Target):

Required: 1,164.03 MegaBytes

Available: 49,030.86 MegaBytes

PRESS <ENTER> TO CONTINUE: Enter
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1879

1880  ============ ==== ====
1881 Installation Complete

1882
1883  Congratulations. RSA Adaptive Directory 7.1.5 has been successfully installed to:

1884  /root/rsa/adaptivedirectory In order to start working with RSA Adaptive Directory 7.1.5, please
1885  follow these steps:

1886 - LOG OFF
1887 Then
1888 - LOG IN

1889 - Copy and paste your license key when prompted after running RSA Adaptive
1890 Directory 7.1.5

1891 -Run /root/rsa/adaptivedirectory/bin/openControlPanel.sh
1892  PRESS <ENTER> TO EXIT THE INSTALLER: Enter

1893 8.3 ADDITIONAL STEPS REQUIRED AFTER INSTALLATION IS COMPLETE

1894 Then you need to install netstat: yum install net-tools
1895 Copy the license.lic file to: /root/rsa/adaptivedirectory/vds_server

1896  Open all relevant firewall ports on the CentOS server

1897 Run /root/rsa/adaptivedirectory/bin/openControlPanel.sh
1898 Run /root/rsa/adaptivedirectory/bin/runContextBuilder.sh
1899  From a web browser go to: http:IPADDRESS:7070

1900  Start the server by clicking the Start button.

1901  Click on Tools menu item, and start the Application Server.

1902

1903  Configuration Procedure:

1904  From a web browser, connect to the Adaptive Directory server and log in (Note the URL with
1905 port number) using the following credentials: (Default credentials) See Figure 109.

1906 Username: cn=Directory Manager
1907 Password: secretsecret

1908
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E= RSA | Adaptive Directory ¢ %

€ - C [1172.16.4.3:7070/main/login 7

Login You are accessing the server instance: vds_server

[EEZ Adaptive Directory Control Panel

* Login: | cn=Directory Manage \
* Password: | ............ ‘
* Required field
1909 B
1910 Figure 109. Adaptive Directory Login Page

1911  On the main page, Figure 110, start the Adaptive Directory server:

m RSA | Adagtive Directory - %

4 -+ €[4 172164.3:7070/main/app/index =

EEVAY Adaptive Directory Control Panel R it s A

Semings  Direciory  Wirards  Tasks  Server Monitoring  Data Source Moaitoring  Tooks

Server Status

B Server is stopped

= Server Usage

Memory Usage ‘Connection Usage
Phak mandey ; Pk tomasim
:I..m% .- Max connections allowed I
Hsig
1912
1913 Figure 110. Adaptive Directory Main Page

1914  Onthe Tools tab, Figure 111, click Start it to start the Persistent Cache service:
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En RSA | Adaptive Directory ¢ %

€ = C |[417216.4.3:7070/main/app/index

Adaptive Directory Control Panel

Dashboard Wizards Tasks Server Monitoring

Settings

Directory

- Real-Time Persistent Cache Refresh

Logged in as cn=Directory Manager (Logout)
) Server (vds_server)is running
ZK

Data Source Monitoring Cluster

To use the Real-Time Persistent Cache Refresh, the application server must be running. [ startit |

star.

A WARNING
The

ion server may take a minute or two the first time to

i~

Cache
Refresh
Monitoring

~ Reporting

To launch reports, the database used by log2db must be running.
B e

{ . WARNING

ik e nrevidad b dof

At ae camnle datahace

1915
1916

1917

1918 Data Sources.

&

Figure 111. Adaptive Directory Tools Page

Now go to the Settings tab, Figure 112 and click Server Backend Settings and then click LDAP

8 HEA| Adaptive Diectery %

€ & C [ 172.164.3:7070/main/app/index

E&TAY Adaptive Digs Control Panel

[i— Directory  Wieards  Tasks Manitoring

. Eerems Fronl End Settngs - Admnskubon
3> Server Front End, S
L Server Settings
. Server Nome
& Connection Pooljng
LODAP Data S
& port
§ D8 Data Solroes T30 | Canant be changed mhie the séner & running

4 Custorn Deta Sources
# Inwmal Connections. Directory Manager Settings
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[ = Rsa | Adaptive Directory - x N}

L C' | [1 172.16.4.3:7070/main/app/index

Adaptive Directory Control Panel

Settings Directory Wizards Tasks Server Monitoring

Logged in as cn=Directory Manager (Logout)

7

) Server (vds_server) is running

Data Source Monitoring Tools Logs

Server Backend Settings > LDAP Data Sources = Add LDAP Data Source

Cluster

SAVE
> Server Front End Settings
v Server Backend Settings Add LDAP Data Source
i . Data Source Name Data Source Type Status [?]
+ Connection Pooling 1TAD LDep v o
® 4 LDAP Data Sources
Host Name Port
ginHDatalsoices ITDG es-idam-b1 test 636 ¥ ssL
] Custom Data Sources
Bind DN Bind Password
& Internal Connections |dAM@es-idam-bitest | e
Kerberos Profiles
% Base DN Use Kerberos profile: v
cn=Users,do=es-idam-b1,de=test CHOOSE
> Security £__tm | Disable Referral Chasing
TEST COMNECTION
> Limits Enforcement Paged Results Control, page size:
> Interception
s v Failover LDAP Servers
> Application Server
> Memory Cache » Advanced
> Logs
Help

Figure 113. Adaptive Directory LDAP Data Source

Enter details for your “backend AD” as shown in Figure 113. Click the Test Connection button to
be sure your settings are correct. Repeat this process for all the AD clusters, i.e., for the backend

ADs on the IT, OT, and PACS networks. You can Clone your first connection to make repeat

additions easier.

Now click on Directory, click on Configuration, right-click on Root Naming Contexts, and select

Naming context as shown in Figure 114.
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54 RSA | Adaptive Directory © X Y|

C' | [0 172.16.4.3:7070/main/app/index
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Adaptive Directory

Logged in as cn=Directory Manager (Logout)
© Sewverivds_server)is running

Cluster

Dashboard Settings

Configuration Directory Tree |

Wizards Tasks Server Monitoring

Data Source Monitoring

'Fl localhost localdomain:1636
v §. RootNamina Confexts.
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fEon-ey  Settings.
Ean=m Global Settings...
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» 8 dv=commonobjectcatalog
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» 19 0mexamples
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@ Cache

v %Schema

@ LDAP
L5 ORX
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n=ca  Directory Tree Wizard..

=tk Naming Context..

~**-—jing Contexts
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refreshlog

clog

BENE pout Adobe Flash Player 17.0.0.188...
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cn=localjournal
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cn=replicationjournal
cn=tombstone
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dv=commonabjectcatalog
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& 1o store
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& 1o store
& 1D store
& HorPstore
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‘1: Virtual Tree
'1: Virtual Tree

'1: Virtual Tree
*a

Figure 114. Adaptive Directory Configuration of Naming Context

New Naming Context

New Naming Context

Please enter a naming context, and selectthe type of backend to be associated with this naming context.

You are presented with this screen, Figure 115:

Y]

Maming Context: | de=mastr,de=test]

Type:
& () LDAP Backend

@ (_) Database Backend

1?: (=) Virtual Tree

‘ (_) HDAF store

“A () DSMUSPUL Senice

() LDIF File

Assist

Next } Cancel

Figure 115. Adaptive Directory New Naming Context

Enter the “name” you would like your new Virtual LDAP directory to be configured with. Select
Virtual Tree and click Next.
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bd

" New Naming Context
Configure Virtual Tree

The naming context will point to a virtual directory view (.dvx file) that has been created in the Context Builder.

Virtual Tree

(+) Create anewview (.dvx) () Use an existing view (.dve)

L

*MNaming Context : dc=mastr,dc=test

* Directory view :

Select:

Active

&

| 4 Back | OK || Cancel

Figure 116. Adaptive Directory Configure Virtual Tree

Leave the defaults selected as shown in Figure 116, and click OK. You will see the following
screen, Figure 117.

=

15 virtual Tree

The naming context has been created successfully

Lo

Figure 117. Adaptive Directory Virtual Tree

You now have a virtual directory naming context created, and the next step is to configure this
virtual directory to include all the backend AD clusters.

Right-click on your newly created Virtual Directory and select New Level as shown in Figure 118:

126 | NIST Cybersecurity Practice Guide SP 1800-2c



1946
1947

1948
1949

1950
1951

1952
1953

DRAFT
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€« C | [ 172.16.4.3:7070/main/app/index

Adaptive Directory Control Panel

Tasks Server Monitoring Data Source Monitoring Too|

8 cn=cacherefreshiog
# cn=changelog

Fen=config
8§ cn=extendedxjoin

»ggidv=  XDelete
P dv= New Level
» v
oo Settings.
‘0:( Global Settings...
P978  About Adobe Flash Player 17.0.0.182...
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g Cache
'%Schema
@ LDAP
E)0RX

Naming Context

Dashboard Settings Directory Wizards
‘Configuration Dlrectury Tree
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Twe: % Virtual Tree

de=master,de=test

3 cn-masterdatacatalog Directory View | dv=dc_master_dc_test
8§ cn=replicationjournal
» P, demaster destase Active . ]

K Delete

Figure 118. Adaptive Directory Create New Level

Enter a “name” for this LDAP backend mapping. This name will be an OU in the Virtual

Directory as shown in Figure 119.

" |5] New Level : master,dc

Level type: [ ou (organizationalUnit) 'J

Z .

ou |1

objectClass . top

organizationallnit

lij Cancel

P

Figure 119. Adaptive Directory New Level Name

Right-click this new OU in your Virtual Directory and select Backend Mapping as shown in Figure

120.
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B RSA | Adaptive Directory ¢ X

€ - C [1172.164.3:7070/main/app/index

Adaptive Directory Control Panel

Dashboard Settings Directory Wizards Tasks Server

Configuration Directory Tree

(1 Fl localhost.localdomain: 1636
v ‘ Root Maming Contexts Properties

48t cn=cacherefreshlog
{8 cn=changelog

% cn=config RDM Valug: | ITAD
* cn=extendedxjoin

{8% cn=masterdatacatalog Type:  Label

RDM Mame : ou

8t cn=replicationjournal Object Class - m
v "-E dec=master,dc=test

ou=lT
:ou=DT lﬂj
‘ ou=PACS
g ou .
> g8 v Backend Mapping \
> -z_E dv=c Mew Level
> # dv=s Delete Level
‘ o=cc
‘ a=cd Settings..
[ '?-E o=e% Global Settings...
> 1& O=VC About Adobe Flash Player 17.0.0,188..,

> 1& ou=AllFratiles
@ Cache
1954 = (TL Srhama
1955 Figure 120. Adaptive Directory Backend Mapping

1956 Leave LDAP Backend selected and click Next as shown in Figure 121.
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Backend Mapping

Backend Mapping

FMaming Context :

Type:

& () LDAP Backend

@ (_) Database Backend
'T: () Virtual Tree

‘ (_) HDAP store

“a () DSMLISPHL Senice

() LDIFFile

X
Please enter a naming context, and select the type of backend to be associated with this naming context
Next ’ Cancel

Figure 121. Adaptive Directory Backend Mapping

Now select one of your backend AD clusters we configured earlier and click OK as shown in

Figure 122.

Backend Mapping

Configure LDAP Backend

LDAP Backend

Data Source : l itad

X

A proxy to a remote LDAP server will be created. Any requests sent to the VDS for this naming context will be routed to the remote LDAP ser

*Host:

*Port:

Bind DN :

Bind Password :

Options : || Test Connection

*Remote Base DN . | cn=Users dc=es-idam-b1,de=test

Mapped Base DN:

Import Configuration

l ‘ Back le Cancel J

k]

Figure 122. Adaptive Directory Configure LDAP Backend

Repeat this procedure for all your backend AD clusters (i.e., for the backend ADs on the IT, OT,

and PACS networks).

By default, the Adaptive Directory server will return default AD attributes.
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8.4 CusTOM ATTRIBUTE CONFIGURATION
Custom attributes are required and are configured as follows:

Click on Directory, then Configuration, and then expand the virtual directory you are working
with and select the backend mapping to AD to which you want to make changes. Then click the
Attributes tab and Add as shown in Figure 123.

S Bl L1
} B RSA | Adaptive Dicectory | \ =
%= € 1721643 mainfapp/index ¥ =
[ Logged in as cn=Diractory Manager (Logoul
Adaptive Directo ntrol Panel © Server (vds_server) is running

Tasks Sarver Moniloring

Data Source Monitoring Tools Logs Cluster K

[ Atributes Handling
Actual Name | Vinual Name

DH Remapping Anways Requested | Higden
manager manages v

scretany

LRAANSAS RS

Figure 123. Adaptive Directory Addition Attributes

Find the attribute you would like to add in the top drop-down list, and enter a “name” (it could
be the same or different) for the attribute you want Adaptive Directory to return. Then select
DN Remapping and click OK as shown in Figure 124.

" Add/Edit Main Attribute

Mame :

Virtual Mame :

X

DM Remapping :

pacsillDoors
pacsAllDoors

]

=)

Always Requested: | |
Hidden: ||

[ oK Jl Cancel J

. v

Figure 124. Adaptive Directory Add/Edit Main Attribute

Complete this procedure for any additional custom attributes that are required and for any
additional AD backends to which you may need to add attributes.
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Your Adaptive Directory virtual directory is now complete and can be accessed from RSA IMG /
Aveksa or any other application that can access LDAP directories.

You can address this virtual directory by configuring the connecting application with the IP
address or DNS name of the Adaptive Directory server and using port 2389. For the base DN,
you would use the name of your virtual directory—in the above example, ‘dc=master,dc=test’
and the relevant OU (backend AD cluster) you want to access. You would use the same
username (cn=Directory Manager) and password you use to log in to the application.

For example, Figure 125 and Figure 126 show the connection information from RSA IMG to

Adaptive Directory.
Edit Collector: RSA AD Directory Accou

Connection
Host*: |[172.16.4.3 x
Port® : | 2389
Bind DN* | cn=Directory Manager
Bind Password® ! | ewsesses

UsessL: [

Disable Paging : [

Figure 125. Adaptive Directory Edit Collector

Search Configuration for Accounts
Accounts will be created by the User Account Mapping, unless the Accounts opticn is selected in this collector.

Account Base DN* ;| He=master,dc=test X

Account Search :
Subtree |V
Scope™ J

Account Search @ | (&(objectCategory=person){objectClass=user)(sAMAccountName=*})
Filter*

Figure 126. Adaptive Directory Search Configuration for Accounts

8.5 RSA AD OPTIMIZATION AND TUNING

8.5.1 Disable Referral Chasing
Referral chasing should be disabled for performance reasons. Check the Disable Referral Chasing
option when you define the LDAP data source.
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8.5.2  Limit Attributes Requested from the LDAP Backend

Whenever RSA Adaptive Directory queries a backend LDAP, the default behavior is to ask for all
attributes (although only the attributes requested in the query will be returned to the client).
This default behavior of RSA Adaptive Directory is for the following reasons:

¢ Joins have been configured and the filter in the search request involves attributes from
both the primary and secondary sources (i.e., the query filter contains conditions on
both primary and secondary objects).

* Interception scripts may involve logic based on attributes from the backend and so
require these attributes. These attributes may not be specifically requested or searched
for by the client. However, RSA Adaptive Directory must retrieve them from the backend
in order for the script logic to be valid.

e Access Control List (ACL) checking. You can set up ACLs based on attribute/values of an
entry (e.g., mystatus=hidden), so RSA Adaptive Directory may need the whole entry to
check the authorization.

e For entry caching. The entire entry needs to be in the entry cache.

If your virtual view does not require all attributes to be requested for any of the conditions
mentioned above, you can enable the option to limit the attributes that are requested for
better performance. If this option is enabled, RSA Adaptive Directory will query the backend
server only for attributes requested from the client in addition to attributes set as Always
Requested on the Attributes tab.

8.5.3  Process Joins and Computed Attributes Only When Necessary

The default behavior of RSA Adaptive Directory is to process associated joins and build
computed attributes whenever a virtual object is reached from a query regardless of whether
the attributes requested come from a secondary source or computation. If you enable the
option to process joins and computed attributes only when necessary, RSA Adaptive Directory
will not perform joins or computations when a client requests or searches for attributes from a
primary object only. If a client requests or searches for attributes from secondary objects or
computed attributes, RSA Adaptive Directory will process the join(s) and computations
accordingly. Use caution when enabling this option if you have interception scripts defined on
these objects or if access controls based on filters are being used (both of which may require
other attributes returned from secondary sources or computations regardless of whether or not
the client requested or searched for them).

8.5.4  Use the Client Sizelimit Value to Query the Backend

Whenever Adaptive Directory queries a backend LDAP, the default behavior is to ask for all
entries (sizelimit=0) even if the client to Adaptive Directory indicates a sizelimit. This is the
default behavior because the entries returned by the backend are possible candidates but may
not be retained for the final result that is sent to the client. For example, if an ACL has been
defined in Adaptive Directory, not all entries from the backend may be authorized for the user
(who is connected to Adaptive Directory) to access. As another example, when joins or
interception scripts are involved with the virtual view, they may also alter the entries that match
the client's search. To limit the number of entries from the backend, using paging is the
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recommended approach. If the backend supports paging, Adaptive Directory will not get all the
results at once; rather, it will get only one page at a time (pagesize is indicated in the
configuration). In this case, if Adaptive Directory has returned to the client the sizelimit
required, Adaptive Directory will not go to the next page.

If your virtual view does not involve any of the conditions mentioned above (joins,
interceptions, ACL), and using paging between Adaptive Directory and the backend is not
possible, you can enable the Client Sizelimit value option to limit the number of entries
requested from the backend. If this option is enabled, Adaptive Directory will use the sizelimit
specified by the client instead of using sizelimit=0 when querying the backend.

AlertEnterprise Guardian is installed on the IdAM network, in a VM running the Windows Server
2012 R2 OS. Guardian is used to control privileged user access to the components located on
the network OT systems. Guardian collects user authorization information from the AD located
within the OT network. There are three parts to the AlertEnterprise Guardian How-To guide,
each of which is provided in the subsections below: Subsection 12.2 provides general product
installation and set-up information. Subsection 12.3 provides the AlertEnterprise configuration
information as configured in the RSA build. Subsection 12.4 provides the AlertEnterprise
configuration information as configured in the CA build.

9.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for
authorized devices and users

NIST 800-53 rev 4 Security Controls: AC-2, IA Family

9.2  INSTALLATION ON TOMCAT AND WINDOWS

This section describes the detailed procedure of installing AlertEnterprise products on Tomcat
on a Windows platform. It lists the hardware and software pre-requisites as well as the steps to
install and use the AlertEnterprise suite of applications.

When copying text from this guide, it is recommended that you first paste text to a Notepad file
and then copy it from there to use it for running scripts. You should use the “Notepad++”
application for this purpose.

Installation Prerequisites

The AlertEnterprise Suite is delivered as a WAR (Web application Archive) file that needs to be
deployed on the client’s application server. Before you actually start deploying on your
application server, you must check for the pre-requisites. Refer to AlertEnterprise Systems
Requirements document included in the installation package.

Pre-Installation Verification
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2073  Before you start installing AlertEnterprise product, verify the proper functioning of the
2074  underlying software systems. Verify that:

2075 e Your system meets all the software and hardware prerequisites as described in Systems
2076 Requirement Specification document.

2077 e Compatible version of Java Runtime Environment (JRE) is installed and working on the
2078 system.

2079 e Compatible version of the web server is installed and running.

2080 e Compatible version of the database server is installed and running.

2081 e Supported Internet Browser (for example, Microsoft Internet Explorer) is working

2082 properly.

2083  Zip extracting software is required. You can download WinZip from
2084  www.winzip.com/downwz.com.

2085 Installing Mandatory Software Applications

2086 Before deploying the AlertEnterprise application, install JRE and a Web Application Server (for
2087 example, Tomcat). You must also install the latest version of Adobe Flash Player to enable the
2088 Internet browser you will be using to access the AlertEnterprise application.

2089 Installing JRE
2090 Toinstall JRE:

2091 1. Download the application server-compatible JRE.
2092 2. Double-click the setup launcher to start the installation process.

2093  Setting Java Home

2094 1. Make sure that JAVA_HOME variable is set to the folder where Java is installed and
2095 $JAVA HOME$/bin isinthe system’s path.

2096 2. Open the Command Prompt in Administrator Mode (Right Click > Run As Administrator)
2097 and issue:

2098

2099 Set JAVA_HOME=<PATH OF JDK/JRE>

2100

2101 Where <PATH OF JDK/JRE> is the path where Java is installed, for example,

2102 C:\Program Files\Java\JDK1.6

2103

2104 3. Setting Path:

2105

2106 PATH= C:\Program Files\Java\JDK1l.6.0-21\bin; $PATHS

2107

2108 4. Checking JAVA_HOME and PATH:

2109

2110 Echo %JAVA_HOME%
2111 Echo %PATH%
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Checking JAVA Version: Java -version

Running ActiveMQ as Windows Service
After extracting the folder, the folder name appears as “apache-activemq” at the specified
location.

1. Gotothe folder apache-activemg and move to bin/win32 in Windows
Explorer and right-click on TnstallService.bat file and select Run as
Administrator. Refer to .

2. Once the above batch file gets executed, verify that the ActiveMQ is added as Windows
Services.

3. Goto Run command and enter services.msc. The Services window appears. Refer
to the following screen shot.

" Services

File Action View Help

& |[EEa= Hs »nn

£ Services (Local) . Services (Local)

ActiveMQ Name Description Status Startup Type Log On As

Stop the sence o Activex Installer (.. Provides Us.. Manual Local Syste...

Restart the service

- " Adaptive Brightness Monitors a... Manual Local Service
i Adobe Flash Playe... This service ... Manual Local Syste...

DES_“iF'tiU”: i Apache Tomcat Apache To... Manual Local Syste...

ActiveMQ Broker i Apache Tomcaté  Apache To.. Automatic Local Syste...
. Application Experi... Processesa.. Started Manual Local Syste...

- Annlication Identity  Determines . IManual Local Service

Figure 127. Adaptive Directory Search Configuration for Accounts

4. The Apache ActiveMQ service has an administrative console. To check if the service is

running correctly, you simply need to connect to the admin console.
URL: <IP address of the server where Active MQ is
installed>:8161/admin

5. Perform the following if Active MQ is on a server other than AlertEnterprise server:
e Search for the URL that starts with TCP ://<IP Address>:61616 in
activemqg.log located in Apache ActiveMQ home directory/data folder.
Refer to the following screen shot:
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Qrganize v

i Narme Date modified Type Size
{ Fau ¥

kahadb 8/1/2012 3:54 PM File folder
= Lib kahadb-- 7/24/2012 4:55 AM  File folder
/T ] activemg.log 8/1/20123:54 PM  Text Document 23KB
J 3  wrapper.log 8/1/2012 3:54 PM Text Document 31 KB
= P

By

Figure 128. Guardian ActiveMQ Home/Data Directory

e Copy the URL and update the context.xml fileinthe <Tomcat
Home>/conf and appContextDB.properties filelocatedin

<Tomcat Home/webapps/AlertEnterprise/WEB-INF/classes>.

Steps for Failure Case:

If the system throws an error message while executing the bat file or the ActiveMQ Services

screen does not appear, follow these steps:
1. Navigate to the folder <ActiveMQ home directory>\bin\win32.

2. Openthe InstallService.bat filein alocal text editor.

3. Modify the bottom part of the script to look like the following. Note that your

JAVA_HOME environment variable needs to already be set and also need to pass it as a

variable to the wrapper.

:conf

set WRAPPER CONF="$ACTIVEMQ HOME$\bin\win32\wrapper.conf"
set ACTIVEMQ HOME="set.ACTIVEMQ HOME=%ACTIVEMQ HOMES$"

set ACTIVEMQ_BASE="Set.ACTIVEMQ_BASE=%ACTIVEMQ_BASE%"

set JAVA HOME="set.JAVA HOME=%JAVA HOMES%"

rem

rem Install the Wrapper as an NT service.

Rem

:startup

"$ACTIVEMQ HOME$\bin\win32\wrapper.exe" -i $ WRAPPER CONF%
$ ACTIVEMQO HOME$ $ ACTIVEMQ BASE$ % JAVA HOMES$

if not errorlevel 1 goto :eof
pause

4. Openthe <ActiveMQ home directory>\bin\win32\wrapper.conf
local text editor and change this:

# Java Application
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wrapper.java.command=java

to this:
# Java Application

wrapper.java.command=%JAVA HOMES$\bin\java.exe

After you have performed these steps, you should be able to run the TnstallService.bat
successfully.

5. Toalsousethe UninstallService.bat file, open itand hard-code the path to
the wrapper:

rem
rem Uninstall the Wrapper as an NT service.

rem

:startup

"$ACTIVEMQ HOME$\bin\win32\wrapper.exe" -r % WRAPPER CONF$%
if not error level 1 goto : eof

pause

After executingthe InstallService.bat file, you can see the ActiveMQ in Services.
6. If the ActiveMQ server is not up and the system throws the following error:

| WARN | tmpdir | org.eclipse.jetty.util.log | WrapperSimpleAppMainjava.io.|lOException: The
system cannot find the path specified

at java.io.WinNTFileSystem.create File Exclusively (Native Method)
at java.io.File.check And Create (File.java:1343)

at java.io.File.create Temp File (File.java:1431)

Solution:
You must manually create two folders: <ActiveMQ home directory>/work and
<ActiveMQ home directory>/temp.

To check whether ActiveMQ is started, access the following link as shown in Figure 129.
http://<Server IP Address>:8161/admin/
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« c 172.16.32.194:8161/admin

ActiveMQ

Home | Queses | Topics | Subscribers | Conneclions | Scheduled | Send

Welcome!
Welcome to the ActiveM Console of localhost (ID:AEDEVR4LXDE-56537-1366007959265-0:0)

You can find more information about ActiveMQ on the Apache ActiveM( Site

Broker
Narms lacalhost
Warsion 5.4.0

i ITD:AEDEVRALXOG6-565I7- 1366007050 F 6500

Figure 129. Guardian ActiveMQ

Installing Apache Tomcat
You must install hardware and operating system versions specific to Apache Tomcat:

Double-click the setup launcher to start the setup. It will start the installation process.
Click Next to start the installation process.

1.
2
3. Click | Agree to accept the license terms. It displays the Choose Components screen.
4. Select Custom as install type and uncheck the Examples option.

5

Click Next to specify the Destination Folder for installation. We strictly recommend using
D:\AlertEnterprise\Tomcat location.

Click Next to specify configuration parameters.
Enter the desired port in the Connector Port text area. 8080 is the default port.

Specify the User Name and Password in the respective fields.

L ® N O

Click Next to select the path of JRE installed on the system.

10. Select the path of JDK/JRE you just installed. For example, C: \ Program
Files\Java\jrel.6.

11. Click Install to start the file copying process. Uncheck Run Apache Tomcat and Show
Readme options in the final dialog box.

12. Click Finish to finish the installation.

Apache Tomcat Configuration
You need to specify Tomcat configuration as specified in the following steps:
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1. Click Start > Programs > Apache Tomcat > Configure Tomcat option.
2. Click Java tab in the Apache Tomcat Properties dialog box.
3. Enter the following settings:

e Initial memory pool: 1024

e Maximum memory pool: 1024

e Thread stack size: 300

Note: These settings may vary with the volume of random access memory (RAM) in
the server.

4. Click Apply and OK to close the dialog box.

Configuring Database Server

You need to perform some configurations in the database server to install AlertEnterprise
applications. You must perform these configurations through the database administrator login.
The current version of AlertEnterprise products supports Oracle and MS SQL Server databases.
The NCCoE build also supports MySQL server database.

To configure the database server:

1. Create a schema/SID as per your naming convention in the database server. The steps to
create schema can be different with different database management systems. Refer to
the administrators guide for the database management system installed at your
landscape.

2. Create a new user with full access to the created schema.

3. Runtheincluded SQL files AlertReport471.ddl or AlertReport471.sql
and AlertQuartz.sqgl onthe new schema created. This step should be performed
while installing the AlertEnterprise application for the first time.

Avoiding Case-sensitivity Issues in Alert DB

To avoid case-sensitivity issues while using the search and sort functionalities in the
AlertEnterprise applications, enable “Case Insensitiveness” search in the database. By default, it
is set as case-sensitive.

Follow these steps to avoid case-sensitivity issues:
1. Create a trigger to support case insensitiveness.

/***********/

create or replace
trigger set nls onlogon
AFTER LOGON ON SCHEMA
DECLARE
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BEGIN
EXECUTE IMMEDIATE 'ALTER SESSION SET NLS SORT="BINARY CI"';
EXECUTE IMMEDIATE 'ALTER SESSION SET NLS COMP="LINGUISTIC"';

END set nls onlogon;
/************/

2. Restart the AlertEnterprise Application server.

The effect may not be visible in some client tools like SQL Developer. To see the effect in the
SQL Developer tool: :
1. Open SQL Developer and click Tools > Preferences.

2. Click Database > NLS and do the following:
e Setthe Sort option to BINARY CI.

e Set the Comparison option to LINGUISTIC.

Enabling Support for International Characters
Storage of character data is controlled by character-set setting at database level. It is
recommended to have the following database settings to support international characters:

For Oracle:
NLS CHARACTERSET = AL32UTFS8

NLS NCHAR CHARACTERSET = AL16UTF16

For SQL Server:
e Server Collation = SQL Latinl General CP1 CI AS

Deploying the Application

After you have successfully configured the database, proceed to deploy the AlertEnterprise
product on your web application server. The following deployment steps are required for the
Tomcat 6.0 version:

1. Stop the Tomcat server from the Windows services if it is already running. Click Start >
Run and type services.msc then click OK. Select the Apache Tomcat and click the
Stop Service icon to stop the service.

2. Copythe AlertEnterprise.war, AccessMap.war (if you possess Alertinsight
license), and AlertEnterpriseHelp.war, and jasperserver—-pro.war files
to <Tomcat installation folder>\webapps\ path.

3. You need to copy password management war file ATPM. war to <Tomcat
installation folder>/webapps if you possess license for the Password
Management application.

4. Create anew folder AlertCommonLib and AlertExternalLib under
<Tomcat Installation Folder>.
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5. Extract AlertCommonLib.zip under AlertCommonLib folder.You will see
many new files in this folder.

6. Editthe <Tomcat Installation Folder>\conf\catalina.properties
using any editor and add append the following to the common . loader as described
below:
common.loader=${catalina.base}/lib,5{catalina.base}/lib/*.jar,${catalina.home}/lib,${cat
alina.home}/lib/*.jar,${catalina.home}/AlertCommonLib/*.jar,${catalina.home}/AlertExt
ernalLib/*.jar (bold path added). Save the file and close the editor.

7. Add Database Connection. Add a new <resource> entry as below with name
"idbc/alntdb" in < Tomcat installation folder>\conf\context.xml.
Replace the code in <> with relevant information.

For MY-SQL Server:

<Resource

description="DB Connection"

name="jdbc/alntdb" auth="Container"
type="com.mchange.v2.c3p0.ComboPooledDataSource"
factory="org.apache.naming.factory.BeanFactory"

user="username"

password="password"

jdbcUrl="jdbc:mysqgl://<IP of DB Server>:3306/<DB Instance Name>"
driverClass="com.mysqgl.jdbc.Driver"

maxPoolSize="100" minPoolSize="5" acquirelIncrement="5"

numHelperThreads="20" maxIdleTime="600"
maxIdleTimeExcessConnections="300"

debugUnreturnedConnectionStackTraces="true"
unreturnedConnectionTimeout="900"

/>

For repository setting in same context . xml, add the following entry:

<Resourcelink name="AlertEnterpriseRepo" global="AlertEnterpriseRepo"
type="javax.jcr.Repository" />

For ActiveMQ settings in same context.xml, add the following entry:

<Resource name="jms/connectionFactory"
auth="Container"
type="org.apache.activemg.ActiveMQConnectionFactory"
description="JMS Connection Factory"
factory="org.apache.activemqg. jndi.JNDIReferenceFactory"
brokerURL="tcp://localhost:61616"
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brokerName="LocalActiveMQBroker"
useEmbeddedBroker="false"/>

<Resource name="jms/requestSubmissionQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue requestSubmissionQueue"
factory="org.apache.activemqg.jndi.JNDIReferenceFactory"
physicalName="requestSubmissionQueue"/>

<Resource name="jms/requestApprovalQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue requestApprovalQueue"
factory="org.apache.activemqg. jndi.JNDIReferenceFactory"
physicalName="requestApprovalQueue"/>

<Resource name="jms/autoApprovalQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue autoApprovalQueue"
factory="org.apache.activemqg.jndi.JNDIReferenceFactory"
physicalName="autoApprovalQueue"/>

<Resource name="jms/queue/taskSubmissionQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue taskSubmissionQueue"
factory="org.apache.activemqg. jndi.JNDIReferenceFactory"
physicalName="taskSubmissionQueue"/>

<Resource name="jms/queue/taskRejectionQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue taskRejectionQueue"
factory="org.apache.activemqg.jndi.JIJNDIReferenceFactory"
physicalName="taskRejectionQueue"/>

<Resource name="jms/queue/projectCancelQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue projectCancelQueue"
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factory="org.apache.activemqg. jndi.JNDIReferenceFactory"

physicalName="projectCancelQueue"/>

<Resource name="jms/queue/projectCompleteQueue"
auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue projectCompleteQueue"

factory="org.apache.activemqg. jndi.JNDIReferenceFactory"

physicalName="projectCompleteQueue"/>

<Resource name="jms/eventRequestQueue"
auth="Container"

type="org.apache.activemqg.command.ActiveMQQueue"

description="JMS Queue eventRequestQueue"

factory="org.apache.activemqg. jndi.JNDIReferenceFactory"

physicalName="eventRequestQueue" />

<Resource auth="Container" description="my Queue"
factory="org.apache.activemqg. jndi.JNDIReferenceFactory"
name="jms/regQueue" physicalName="requestQueue"
type="org.apache.activemqg.command.ActiveMQQueue" />

<Resource auth="Container" description="my Queue"
factory="org.apache.activemqg.jndi.JNDIReferenceFactory"
name="jms/resQueue" physicalName="responseQueue"
type="org.apache.activemqg.command.ActiveMQQueue"/>

8. Edit <Tomcat installation folder>\conf\server.xml.Replacethe

code in <> with relevant information:

<GlobalNamingResources>
<! -- Editable user database that can also be used by
UserDatabaseRealm to authenticate users
->
<Resource auth="Container"
configFile="/AlertEnterpriseRepo/repository.xml"
description="AlertEnterprise Repository"

factory="com.alnt.repository.jndi.JackrabbitRepositoryFactory"

homeDir="/AlertEnterpriseRepo" name="AlertEnterpriseRepo"
type="javax.jcr.Repository"/>

<Resource auth="Container" description="Rule Engine Service"

factory="com.sae.ruleengine.jndi.RuleEngineFactory"
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name="Sedna" password="MANAGER" type="com.sae.rulekEngine.RuleEngine"
username="SYSTEM" />

<Resource name="UserDatabase" auth="Container"
type="org.apache.catalina.UserDatabase"

description="User database that can be updated and saved"
factory="org.apache.catalina.users.MemoryUserDatabaseFactory"
pathname="conf/tomcat-users.xml"/>

</GlobalNamingResources>

9. Open <Webserver installation folder>\bin location and double-click tomcat5w.exe. Click
Java tab and under Java options add the following lines at the end:

-XX:PermSize=512m
-XX:MaxPermSize=512m
-Xms1024m

-Xmx1024m

-Djs.license.directory=C:\AlertApplication\Tomcat
6.0\webapps\jasperserver-pro

-Dcom.alnt.fabric.loadInitData=force
-Dalert.db.update=update

Note: These settings may vary with the volume of RAM in the server.

10. Start the Tomcat server.

11. Start the AlertEnterprise application by using the address, which is of the form
http://<Server IP Address>:8080/AlertEnterprise.
Note: The name and contents of the init script will vary depending on the database
management system of the organization. 8080 is the default port on local host. If you
want to change it, then change it in the sever.xml.

12. Log on to the application by using admin credentials. You should be able to view Home
screen of the application.

9.3  ALERTENTERPRISE APPLICATION CONFIGURATIONS FOR THE RSA BUILD
Systems/Connectors

9.3.1 System Type Import of DB Connector:
1. Login to Application.
2. Go to Setup tab > Manual Configuration > Import/Export.

3. Check System Types and click on Import.
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4. Select the .csv files, which are there in the software build package under connector

\ALNTDbconnector\InitDataFiles folder.

5. After selecting all the files, click on the Upload button.

6. Refresh page until it shows as success or failed.

7. Restart the server if required.

9.3.2  System Types Param of DB Connector:

1. Login to Application.

2. Go to Setup tab >Manual Configuration >Systems > System Types.

W

Click on Next button.

b

Search for Connector named “DBConnector” and click on Modify button.

Add the following attributes one by one and click on the ADD button —

The following fields need to be provided under Name field and Label can be any user-

friendly name see Figure 130.

CREATE USERO
UPDATE_USERO
LOCK_USERO
UNLOCK_USERO
DELIMIT USERO
USER_PROVISIONEDO
ADD_ROLESO
DEPROVE ROLESO
CREATE_USER1

LOCK USERI1
Name Label Parameter Level
jndiMame Indi Mame Mandatary
DATE_TIME_FORMAT Date and Time Forma... tMandatary
DATE_TIME Date Format Mandatory
passwordColumnkame Passwrd Column Mame Mandatary
userldColumnMarne Userld Caolurmn Marne Mandatary
EXTERMAL_USER_ID_AT... External Userld Att.., Mandatory
MODIFIED_ENTITLEMEN. .. Fetch User Entitlem... Mandatory
GET_aLL_USERSO GET_ALL_USERSO Mandatory
GET_INCREMEMTAL_USE... GET_INCREMEMTAL_USE. .. Mandatory
CREATE_USERD Create CardHolder 3., Mandatory
UPDATE_USERD Update CardHaolder Q... Mandatory
LOCK_USERD Lock CardHolder Que... Mandatory
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UMLOCK_USERD Unlock Card Holder ... Mandatary
DELIMIT_WSERD Change CardHalder ... Mandatary
USER_PROVISIOMEDO Check Card Holder P... Mandatary
ADD_ROLESO Assign Raoles ta Car... Mandatary
DEPROWE_ROLESO Femove Roles From C... IMandatary
GET_GEMERATED_USERI... Retrieve User Id Qu... IMandatary
driverMame driverMame Mandatary
url LREL IMandatory
LserMame userMarme Mandatary
passwaord password Mandatory

Figure 130. Guardian DB Connector Attributes

CONFIGURATION: Create “PACS AD” System

1. Setup > Manual Configuration > Systems > System.

2. Click on New to create a new system.

3. Definition...Enter the following:

e System Type— LDAP from drop-down

e Connector Name - PACS AD

e Connector Description - PACS AD

e Connector Long Description - PACS AD

e Connector Type — LDAP (default)

4. Click on Next.

5. Parameters...Enter the following:

Table 9. Guardian PACS AD Parameters

System Param Name

System Param Value

bindPass 060yplUQT3I0gHMbuRWeuw==
useSSL FALSE

baseDns DC=pacs-es-idam-b1,DC=test
groupBaseDn DC=pacs-es-idam-b1,DC=test
reconBaseDN

getincrementGrpChanges

FALSE
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System Param Name

System Param Value

wsdlURL

wsUserName

wsPwd

rootLevelDomain

cookielLocation

adUserName

SYS_CON_ATTR_POST_CREATE_SCRIPT

SYS_CON_ATTR_POST_CREATE_SCRIPT_PARAMS

objectClass User
Skipprovisioning Yes
lastModifiedColumnRole whenChanged
lastModifiedColumn whenChanged
host 172.16.7.2
port 389
CN=AlertEnterprise,
bindDn CN=Users,DC=pacs-es-idam-b1,DC=test

6. Click on Next.
7. Attributes...Enter the following:

e Application — Alert Access

e Check the following boxes — Provisioning, Role Management, Offline System.

e Leave Connector Category as Production.

e Time Zone — Greenwich Mean Time from drop-down

8. Click on Next.

9. Click on Save.

CONFIGURATION: Create “Identity DB” System
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1. Setup > Manual Configuration > Systems > System.

2. Click on New to create a new system.

3. Definition...Enter the following:

System Type — Database (JDBC J2EE) from drop-down

Connector Name — IDENTITYDB

Connector Description - IDENTITYDB

Connector Long Description - IDENTITYDB

Connector Type — Database (JDBC J2EE) (default)

4. Click on Next.

5. Parameters...Enter the following:

Table 10. Guardian Identity DB Parameters

System Param Name

System Param Value

driverName

url

userName

password

whereClause

jndiName

java:comp/env/jdbc/alntdb

6. Click on Next.

7. Attributes...Enter the following:

Application — All

Check the following boxes — Provisioning, Certification, Identity Provider, Allow
Modify Role and Allow Time Change.

Leave Connector Category as Production.

Time Zone — Eastern Daylight Time from drop-down

8. Click on Next.

9. Click on Save.

CONFIGURATION: Create “ACCESSIT PACS” System
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2544 1. Setup > Manual Configuration > Systems > System.
2545 2. Click on New to create a new system.

2546 3. Definition...Enter the following:

2547 e System Type — DBConnector from drop-down
2548 ¢ Connector Name — ACCESSIT PACS

2549 e Connector Description - ACCESSIT PACS

2550 e Connector Long Description - ACCESSIT PACS
2551 e Connector Type — DBConnector (default)
2552 4. Click on Next.

2553 5. Parameters...Enter the following:

2554 Table 11. Guardian ACCESSIT PACS Parameters

System Param Name

System Param Value

driverName

URL jdbc:sqlserver://<HOST_NAME>:<PORT>;databaseName=Al
Universal

userName DB User Name

password DB User Password

Date and Time Format

CardholderID

External Userld Attribute

CardholderID

Create CardHolder Query

INSERT INTO
[AlUniversal].[dbo].[Cardholders]([CardholderID],[LastName],[FirstName],[Middlelnitial],[C
ompanylID],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[CreatedByUser],
MemberOfAllSites],[UserText1],[UserText2],[UserText3],[UserText4],[UserText5],[UserText6
1,[UserText7],[UserText8],[UserText9],[UserText10],[UserText11],[UserText12],[UserText13],
[UserText14],[UserText15],[UserText16],[UserText17],[UserText18],[UserText19],[UserText2
0],[Department],[UserDatel],[UserDate2],[UserDate3],[UserDate4],[UserDate5],[UserNum
ericl],[UserNumeric2],[UserNumeric3],[UserNumeric4],[UserNumeric5],[CardholderStatus
],[CardholderActiveDate],[CardholderExpireDate]) VALUES
(NEWID(),SLastName,SFirstName,SMiddlelnitial, SCompanylD,SNotes,GetUTCDate(),'alerte
nt',GetUTCDate(),'alertent’,'1',SUserText1,SUserText2,SUserText3,SUserText4,SUserText5,$
UserText6,SUserText7,SUserText8,SUserText9,SUserText_10,SUserText_11,SUserText_12,$
UserText_13,SUserText_14,SUserText_15,SUserText_16,SUserText_17,SUserText_18,SUser
Text_19,SUserText_20,SDepartment,SUserDatel,SUserDate2,SUserDate3,SUserDate4,SUs
erDate5,SUserNumericl,SUserNumeric2,SUserNumeric3,SUserNumeric4,SUserNumeric5,'
1',SCardholderActiveDate,SCardholderExpireDate)

Update CardHolder Query

update [dbo].[Cardholders] set LastModified=GetUTCDate() where
CardholderID=$CardholderID
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System Param Name

System Param Value

Lock CardHolder Query

update [dbo].[Cardholders] set CardholderStatus='0' where CardholderID=$CardholderlD

Unlock Card Holder Query

update [dbo].[Cardholders] set CardholderStatus='1' where CardholderID=$Cardholder|D

Check Card Holder Provisioned
Query

select CardholderlID from [dbo].[Cardholders] where CardholderID =$CardholderiD

Assign Roles to Card Holder Query

INSERT INTO [dbo].[CardholderAccessLevels] ( [CardholderAccessLevellD],
[CardholderID], [AccessLevellD],[LastModified],[ActivateDate],[ DeactivateDate]) VALUES (
NEWID(), SCardholderID,(select AccessLevellD from [dbo].[AccessLevels] where
AccessLevelName=SROLE_NAME),GetUTCDate(), NULL, NULL)

Remove Roles From Card Holder
Query

delete from [dbo].[CardholderAccessLevels] where CardholderID=$CardholderID and
AccessLevellD=(select AccessLevellD from [dbo].[AccessLevels] where
AccessLevelName=SROLE_NAME)

Retrieve User Id Query

select CardholderlID from [dbo].[Cardholders] where UserText1=SUserText1

CREATE_USER1

INSERT INTO [AlUniversal].[dbo].[Cards]
([CardID],[CardholderID],[CardNumber],[FacilityCode],[PINNumber],[PINExempt],[APBExe
mpt],[UseExtendedAccessTimes],[CardStatus],[ActiveDate],[ExpireDate],[UserLevel],[UseC
ustomReporting],[Eventinfo],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[
CreatedByUser],[IssueLevel],[DeactivateExempt],[VacationDate],[VacationDuration],[UseCo
unt],[TempDeactivateStart],[TempDeactivateEnd], [Classification],[IPLocksetUserType],[IPLo
cksetAccessMode],[IPLocksetCredentialFormat],[IPLocksetAccessAlways],[RawPrimaryCred
ential],[LargeEncodedCardID],[EmbossedNumber]) VALUES (NEWID(),(select CardholderID
from [dbo].[Cardholders] where
UserText1=SUserText1),SCardNumber,SFacilityCode,$PIN,'0','0','0','1',NULL,NULL,'0','0',NUL
L,NULL,SYSDATETIME(), alertent’,SYSDATETIME(), 'alertent",'0','0', NULL,'0",'255',NULL,NULL,'
Active',NULL,NULL,NULL,NULL,NULL,NULL,")

LOCK_USER1 Fgadrzts u[:: ;J:ri]v:esrézlga[gz;]ggfrds1 set Cardstatus='0",Classification='InActive' where
2555 6. Click on Next.

2556 7. Attributes...Enter the following:

2557 e Application —All

2558 * Check the following boxes — Provisioning, Role Management, and Offline System.
2559 e Leave Connector Category as Production.

2560 e Time Zone — Eastern Daylight Time from drop-down

2561 8. Click on Next.

2562 9. Click on Save.

2563 Identity & Access— Enable Identity

2564 1. Setup > Manual Configuration >ldentity & Access>Enable Identity.

2565 2. Enable the following for “Identity DB” system, see Figure 131.
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+ Maintain Tdentities | ves v

= Commeclor | IDENTITIDE | v

Reset Save

Figure 131. Guardian Identity Configuration

9.3.3 Identity & Access— User Field Mapping
1. Setup > Manual Configuration > Identity & Access > User Field Mapping.
2. Select User = Identity (from drop-down) and click on Go.

3. Click the Create New button.
Select values for respective fields and hit on save (Refer to below sheet for values
selection.)

4. Repeat Steps 1-4 for all fields in the sheet.
Follow the steps above to configure the User Field mappings manually. You can match the
values in the file at https.//nccoe.nist.gov/sites/default/files/nccoe/UserFieldMapping_data.csv.

Identity & Access > Recon Authoritative Fields

1. Setup > Manual Configuration > Identity & Access > Recon Authoritative Fields.
2. Click on Create.

3. Enter the following shown in Figure 132.

Recon Authoritative Fields
Systems Authoritatiwe Field
DBCOMMECTOR Firsthame
DBCONMECTOR LastMame
PACS AD PacsallDoors
PaCs AD PacsHomeAccess
PACS AD PacswWorkaccess
PACS AD FirstMame
PACS AD LastMame

Figure 132. Guardian Recon Authoritative Fields

Identity & Access > Request Categories

1. Setup > Manual Configuration > Identity & Access > Request Categories.
2. Click on New.
3. Enter following at define Request Category screen:

e Name — New Hire

e Description — New Hire
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Visible — Yes

Hover Text —

Provisioning Actions — Create User, Change Roles
Request Category Type - Resources

Display the following in USS — Enterprise Roles

4. Click on Save.

5. Repeat similar to above for following Request Categories:

Termination

Name — Change Access

Description — Change of Access

Visible — Yes

Hover Text —

Provisioning Actions — Create User, Change Roles, Change User
Display the following in USS — Resources

Add Existing — Systems and Remove Roles

6. Click on Save.

ChangeAccess

O

(@)

(@)

Name — Terminate

Description — Terminate User

Visible — Yes

Hover Text —

Provisioning Actions — Lock User, Change Roles
Display the following in USS — Resources

Add Existing — Systems

7. Click on Save.

Identity & Access>Provisioning>Provisioning Mapping

1. Setup > Manual Configuration > Identity & Access > Provisioning > Provisioning Mapping.

2. On the next screen select System and click Next.
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3. Follow the mapping shown in Figure 133 to Create/Update provisioning mappings for
the ACCESS IT PACS system.

DB Connector Attribute Mapping

DB Connector Atribute

UserTextl
Firsthame
LastName
CompanylD
CardholderlD

Mandatory
No
Ves
Vs
No

Ves

DB Connector Connector Name
Connector Type

AertEnterprise Attrib...

Userld
Firsthlame
LastName
Prianty
Userld

DBConnector

ACCESSIT PACS

Defalt Value

Editable
Ho
Yes
Yes
Mo

Yes

Visible Validati... Is User-...
Ho Ho Ho
Yes Ho Ho
Yes Mo Mo
Mo Mo Mo
Yes Mo Mo

Figure 133. Guardian DB Connector Attribute Mapping

User Data> User Data Source

1. Setup > Manual Configuration > User Data > User Data Source.

2. Follow the mappings and configurations found in the files at
https://nccoe.nist.gov/sites/default/files/nccoe/UserManagement-UserDataSource.zip.
Create/Update accordingly.

User Data> User Mapping

1. Setup > Manual Configuration > User Data > User Mapping.

2. Select “Identity DB” system from the list and click on Save button.

Policy Engine> Rules

1. Setup > Manual Configuration > Policy Engine > Rules.

2. Click on New and add the following:

Table 12. Guardian Policy Engine Rules

Rule Name

Entity Type

Rule Type

Description

Applicable to

Attributes

Drop down value

Selection Value

All Door Access New

Workflow

AlertAccess

All Door Access New

Suggest/Default

PacsALLDoors AND Request Category

Equals

1. True and New Hire

2. True and Remove User
Access

3. True and ChangeAccess

Home Access Level New

Workflow

AlertAccess

Home Access Level New

Suggest/Default

PacsALLDoors AND Request Category

Equals

1. True and New Hire

2. True and Remove User
Access

3. True and ChangeAccess

WO Access Level New

Waorkflow

AlertAccess

WO Access Level New

Suggest/Default

PacsALLDoors AND Request Category

Equals

1. True and New Hire

2. True and Remove User
Access

3. True and ChangeAccess
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Policy Engine> Suggest/Default Access

1. Setup > Manual Configuration > Policy Engine > Suggest/Default Access.

2. Click on New and enter the following:

Table 13. Guardian Policy Engine Suggest/Default Access

Name Tvbe Rule Name Search Default Selected
yp By System Role
All Door Access Default | All Door Access NEW | Systems | ACCESSIT | ALL DOORS
PACS
Home Access Level Default | Home Access Level Systems | ACCESSIT | Home
PACS Access
Level
WO Access Level Default | Home Access Level Systems | ACCESSIT | WO Access
PACS Level
NewHireDefaultSystems | Default | NewHireDefaultSyst | Systems | ACCESSIT
ems PACS
Policy Engine>Rule Action Handler
1 —Setup > Manual Configuration > Policy Engine > Rule Action Handler.
2 — Click New and create the following Action Handlers:
Table 14. Guardian Policy Engine Rule Action Handler
. Update | Evaluate
Action Handler Workflow Task Type Value Priority | Identity | Enterprise
Name
Info Role
Recon New Hire | AlertAccess | Recon Create | New Hire | 0O Yes No
Request
Recon terminate | AlertAccess | Recon Create | Terminate | O Yes No
Handler Request
Recon Error AlertAccess | Recon 0
Handler Exception
Record Task
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ReconChangeHa | AlertAccess | Recon Create
ndler Request

Change
Access

Yes

No

Policy Engine>Policy Designer

1. Setup > Manual Configuration > Policy Engine > Policy Designer

2. Select New to create new Policy designer as:

User Policy New

1. Name — User Policy New
2. Rule Type — AlertAccess
3. Description — User Policy
4. Priority—29

5. Active —Yes

6.

Default Process — No

Figure 134 depicts the new policy interface to create the User Policy described above.
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User Policy Mew {AlertAccess)

o Change Handler J

:_Slup::

> 9 Create User

a Terminate J

0 Error Handler J

Figure 134. Guardian User Policy

The following table describes User Policy New.

Table 15. Guardian User Policy

... Is Task Update
Step Name Type Condition handler Task Handler Query
User ID SmasterUser[Userld]
1 Check Decision .size='0'
Task Recon New
2 Create User Handler Yes Hire
ScheckStatus[UserSt
Terminate atus,Active,InActive]
3 Check Decision .action='LOCK'
Task
4 Terminate Handler Yes Recon
Terminate
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Is Task Update
N T iti Task H |
Step ame ype Condition handler ask Handler Query
Handler
Remove
Access ScheckAuthFields[].s
5 Check Decision tatus='Yes'
Error Task Recon Error
6 Handler Handler Yes Handler
Change Task Recon Change
7 Handler Handler Yes Handler

Job Scheduler>Triggers Field Map

N o vk~ w N

Click on New.
Enter Group Name — PACSAD Field Map
Description — PACSAD Field Mapping

Select Type — Reconciliation

Click New and create mapping per below table.
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Setup > Manual Configuration > Job Scheduler > Triggers Field Map

After creating Field Map, select the newly created map and select Configure.



2669

2670

2671

2672

2673

2674
2675

2676

DRAFT

Table 16. Guardian Job Scheduler Triggers Field Map

User
userEnt | Trainin
Mapped roleTyp | userRol | userBadg | RoleTyp g

AE Attribute Key userType e e e e Type

sAMAccountName | Userld TRUE FALSE FALSE FALSE FALSE FALSE

accountExpires ValidTo TRUE FALSE FALSE FALSE FALSE FALSE

givenName FirstName TRUE FALSE FALSE FALSE FALSE FALSE

sn LastName TRUE FALSE FALSE FALSE FALSE FALSE
userAccountContr

ol statusLDAP TRUE FALSE FALSE FALSE FALSE FALSE

pacsAllDoors PacsAllDoors TRUE FALSE FALSE FALSE FALSE FALSE

PacsHomeAcces
pacsHomeAccess s TRUE FALSE FALSE FALSE FALSE FALSE
pacsWorkAccess PacsWorkAccess TRUE FALSE FALSE FALSE FALSE FALSE

Job Scheduler>Triggers

1. Setup > Manual Configuration > Job Scheduler > Triggers

2. Click New and create the following Triggers:

AlertDbConnectorTrigger

Table 17. Guardian Job Scheduler Triggers

Name PACSAD Trigger
Description PACSAD Trigger
Type Reconciliation
Batch Size 100

Number of Attempts | 3

Policy Designer for

User policy New
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Users/Roles

System: PACS AD
Reconciliation From

Reconciliation System | PACS AD

Field Mapping Group | PACSAD Field Map

User Type True

User Role True

Job Scheduler>Scheduler

1. Setup > Manual Configuration > Job Scheduler > Scheduler.

2. Click New and enter the following as shown in Figure 135:

Job Type — Reconciliation Job

Job Name - <Job Name>

Reconciliation for — User

Reconciliation Type — Incremental Reconciliation
Reconciliation Triggers — PACSAD Trigger

Select the schedule as Immediate, Once, periodic or Advance.For Periodic Job,
specify the Job Start date, End date, and duration of job frequency.
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* Job Type Reconciliation Job v
* Job Name PACS AD User Reconciliation
Global d
Job Visibility private v
Notification Templates Choose One v
*Reconciliation For Users
Roles

User Training

*Reconciliation Type Incremental Reconciliation v
*Reconciliation Trigogers PACSAD Trigoer v
Init Date Load No v
Create/Update Scheduled Jobs = [x] 7
Immediate
Once
* Periodically
Advance
Time Zone (GMT-05:00) America/New_Yi ¥
Start At [ps/08/2015 | (7] 20 58
[date] [hrs] [minutes]
EndAt |06/08/2016 | (&) 20 58
[date] [hrs] [minutes]
Rerun every 2
[Repeat Duration] [Repeat Unit]
Save Cancel
Figure 135. Guardian Reconciliation Job
3. Click Save.

9.4 SECTION 3. ALERTENTERPRISE APPLICATION CONFIGURATIONS FOR THE CA BUILD

9.4.1 System Type Import of DB Connector:
1. Login to Application.

2. Go to Setup tab > Manual Configuration > Import/Export
3. Check System Types and click on Import.

4. Select the .csv files, which are there in software build package under Connector
\ALNTDbconnector\InitDataFiles folder.

5. After selecting all the files, click on Upload button.
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2699 6. Refresh page until it shows as success or failed.

2700 7. Restart the server if required.

2701 9.4.2 System Types Param of DB Connector:

2702 1. Login to Application.
2703 2. Go to Setup tab> Manual Configuration _> Systems > System Types
2704 3. Search for Connector named “DBConnector” and click on Modify button.
2705 4. Click on Next.
2706 5. Add the following attributes one by one and click on the ADD button.
2707 The following fields in Table 18 need to be provided under Name field and Label can
2708 be any user-friendly name as shown in
MODIFIED_EMTITLEMEN. .. Fetch User Entitler. .. Mandataory
GET_alLL _USERSO GET_aLL_USERSO Mandataory
GET_IMCEEMENTAL_USE... GET_IMCREMENTAL_USE... Mandataory
CREATE_USERD Create CardHolder Q... Mandataory
UPDATE_LISERD Update CardHaolder Q... Mandataory
2709 LOCK_USERD Lock CardHolder Que... Mandataory
2710 and Figure 136: (If the name or label already exists do not add)
2711 Table 18. Guardian Name and Label Fields
Name Label
jndiName Jndi Name
DATE_TIME_FORMAT Date and Time Format
DATE_TIME Date Format
passwordColumnName Passwrd Column Name
userldColumnName Userld Column Name
EXTERNAL_USER_ID_ATTRIBUTE External Userld Attribute
MODIFIED_ENTITLEMENTS Fetch User Entitlement based on last
modified date(not by user)
GET_ALL_USERSO GET_ALL_USERSO
GET_INCREMENTAL_USERSO GET_INCREMENTAL_USERSO
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CREATE_USERO

Create CardHolder Query

UPDATE_USERO

Update CardHolder Query

LOCK_USERO

Lock CardHolder Query

UNLOCK_USERO

Unlock Card Holder Query

DELIMIT_USERO

Change CardHolder Validity Query

USER_PROVISIONEDO

Check Card Holder Provisioned Query

ADD_ROLESO

Assign Roles to Card Holder Query

DEPROVE_ROLESO

Remove Roles From Card Holder Query

GET_GENERATED_USERIDO

Retrieve User Id Query

driverName driverName
url URL

userName userName

password password

CREATE_USER1

CREATE_USER1

LOCK_USER1

LOCK_USER1

Mame Label Parameter Level
jndiMarme Indi Mare Mandatary
DATE_TIME_FORMAT Date and Time Forma... Mandatory
DATE_TIME Date Format Mandatary
passwordColumnMarme Passwrd Column Mame Mandatory
userldColumnMame Userld Column Mame Mandatary
EXTERMAL_USER_ID_AT... External Userld Att... Mandatary
MODIFIED_EMTITLEMEN. .. Fetch User Entitlem. .. Mandatary
GET_aLL_USERSO GET_aLL_USERSO Mandatary
GET_IMCREMEMTAL_USE... GET_IMCREMEMTAL_USE... Mandatary
CREATE_USERD Create CardHolder Q... Mandatary
UPDATE_USERD Update CardHalder Q... Mandatary
LOCK_USERD Lock CardHolder Que... Mandatary
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UMLOCK_IUSERD Unlock Card Holder ... Mandatory
DELIMIT_USERD Change CardHaolder ... Mandataory
IUSER_PROYISIOMNEDO Check Card Halder P... Mandataory
ADD_ROLESO Aszsign Roles to Car.., Mandataory
DEPROYE_ROLESD Remowe Roles From C... Mandataory
GET_GEMNERATED_USERI.., Retrieve User Id Qu... Mandatary

Figure 136. Guardian DB Connector Attributes

9.4.3 Create System Connectors for all Target Systems

1. CONFIGURATION: Create connector for “Alert User Database (External)”

This connector is required to connect the Alert user table exposed to third-party systems (CA in
this case) and get the data.

Steps to create this connector:

1. Setup Tab > Manual Configuration > Systems > System.
2. Click New to create a new system.
3. Definition...Enter the following:
o System Type — DBConnector
® Connector Name — ALERTDBCONNECTOR
® Connector Description — ALERT DB CONNECTOR
® Connector Long Description — ALERT DB CONNECTOR
e Connector Type — DbConnector (Label)
4. Click on Next.
5. Parameters...Enter the following:

Table 19. Guardian Manual Configuration System Parameters

System Param Name System Param Value
Jndi Name java:comp/env/jdbc/alertdb
Date and Time Format MM/dd/yyyy HH:mm:ss

select Userld,

FirstName,LastName,Email, WorkPhone,HomePhone,Department,EmployeeType,PacsAllDoor,Case
WHEN PacsAllDoor='1' then 'TRUE' Else 'FALSE' END as PacsAllDoor,CASE WHEN
PacsHomeAccess='1' then 'TRUE'else 'FALSE' END as PacsHomeAccess , CASE WHEN
GET_ALL_USERSO PacsWorkAccess="'1' then 'TRUE' else 'FALSE' END as

PacsWorkAccess,CardNumber,FacilityCode,LastModifiedDate,ValidFrom ValidTo,Title,UserStatus,PIN
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System Param Name

System Param Value

from alnt_idm_user_dtls

GET_INCREMENTAL_USERSO

select Userld,

FirstName,LastName,Email, WorkPhone,HomePhone,Department,EmployeeType,PacsAllDoor,Case
WHEN PacsAllDoor='1' then 'TRUE' Else 'FALSE' END as PacsAllDoor,CASE WHEN
PacsHomeAccess='1' then 'TRUE'else 'FALSE' END as PacsHomeAccess , CASE WHEN
PacsWorkAccess="'1' then 'TRUE' else 'FALSE' END as
PacsWorkAccess,CardNumber,FacilityCode,LastModifiedDate,ValidFrom,ValidTo,Title,UserStatus,PIN
from alnt_idm_user_dtls where LastModifiedDate> STR_TO_DATE(SLAST_RUN_DATE,'%m/%e/%Y
%H:%i:%s') and UserStatus="'Active'

External Userld Attribute

Userld

Userld Column Name

Userld

6. Click on Next.

7. Attributes...Enter the following:

® Application — Alert Access

® Check the following boxes — Provisioning, Role Management, Offline System.

® Leave Connector Category as Production

e Time Zone — Eastern Daylight Time from drop-down

Note: TimeZone should be same as the TimeZone where application is hosted.

8. Click on Next.

9. Click on Save.

2. CONFIGURATION: Create “Identity DB” System

This is connector is required for internal purposes. Ignore this step if Identity DB Connector

already setup

Steps to create this connector:

1. Setup Tab > Manual Configuration > Systems > System.

2. Click New to create a new system.

3. Definition...Enter the following:

e System Type — Database (JDBC J2EE) from drop-down
® Connector Name — IDENTITYDB
o Connector Description - IDENTITYDB
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® Connector Long Description - IDENTITYDB
e Connector Type — Database (JDBC J2EE) (default)
4. Click on Next.

5. Parameters...Enter the following:
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Table 20. Guardian Identity DB Parameters

System Param Name System Param Value
driverName (use default)
url (use default)
userName (use default)
password (use default)
whereClause (use default)
jndiName java:comp/env/jdbc/alntdb

6. Click on Next.
7. Attributes...Enter the following:
e Application —All

e Check the following boxes — Provisioning, Certification, Identity Provider, Allow
Modify Role and Allow Time Change.

e Leave Connector Category as Production
e Time Zone — Eastern Daylight Time from drop-down
8. Click on Next.

9. Click on Save.
3. CONFIGURATION: Create “ACCESSIT PACS” System

This is connector is required for integrating with RS2 PACS system and performing various
provisioning operations.

Steps to create this connector:

1. Setup Tab > Manual Configuration > Systems > System.
2. Click New to create a new system.
3. Definition...Enter the following:
e System Type — DBConnector from drop-down
® Connector Name — ACCESSIT PACS
® Connector Description - ACCESSIT PACS
® Connector Long Description - ACCESSIT PACS
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e Connector Type — DBConnector (default)

4. Click on Next.

5. Parameters...Enter the following:

Table 21. Guardian PACS DBConnector Parameters

System Param Name

System Param Value

driverName com.microsoft.sqlserver.jdbc.SQLServerDriver

URL jdbc:sqlserver://<HOST_NAME>:<PORT>;databaseName=Al
Universal
<HOST_NAME> should be replaced with the hostname of
the RS2 PACS system

username Login User Name to connect to RS2 PACS database

Password Login password to connect to RS2 PACS database

Date and Time Format

MM/dd/yyyy HH:mm:ss

External Userld Attribute

CardholderID

Create CardHolder Query

INSERT INTO
[AlUniversal].[dbo].[Cardholders]([CardholderID],[LastName],[FirstName],[Middlelnitial],[C
ompanylID],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[CreatedByUser],[
MemberOfAllSites],[UserText1],[UserText2],[UserText3],[UserText4],[UserText5],[UserText6
],[UserText7],[UserText8],[UserText9],[UserText10],[UserText11],[UserText12],[UserText13],
[UserText14],[UserText15],[UserText16],[UserText17],[UserText18],[UserText19],[UserText2
0],[Department],[UserDatel],[UserDate2],[UserDate3],[UserDate4],[UserDate5],[UserNum
ericl],[UserNumeric2],[UserNumeric3],[UserNumeric4],[UserNumeric5],[CardholderStatus
],[CardholderActiveDate],[CardholderExpireDate]) VALUES
(NEWID(),SLastName,SFirstName,SMiddlelnitial, 5CompanylD,SNotes,GetUTCDate(),'alerte
nt',GetUTCDate(),'alertent’,'1',SUserText1,SUserText2,SUserText3,SUserText4,SUserText5,$
UserText6,SUserText7,SUserText8,SUserText9,SUserText_10,SUserText_11,5UserText_12,$
UserText_13,SUserText_14,SUserText_15,5UserText_16,SUserText_17,5UserText_18,SUser
Text_19,SUserText_20,SDepartment,SUserDatel,SUserDate2,SUserDate3,SUserDate4,5Us
erDate5,SUserNumericl,SUserNumeric2,SUserNumeric3,$UserNumeric4,SUserNumeric5,'
1',SCardholderActiveDate,SCardholderExpireDate)

Update CardHolder Query

update [dbo].[Cardholders] set LastModified=GetUTCDate() where
CardholderlD=$CardholderID

Lock CardHolder Query

update [dbo].[Cardholders] set CardholderStatus='0' where CardholderID=$CardholderID

Unlock Card Holder Query

update [dbo].[Cardholders] set CardholderStatus='1"' where CardholderID=SCardholderID

167 | NIST Cybersecurity Practice Guide SP 1800-2c




2785
2786
2787
2788
2789
2790
2791
2792

2793

2794

DRAFT

System Param Name

System Param Value

Check Card Holder Provisioned
Query

select CardholderlD from [dbo].[Cardholders] where CardholderID =$CardholderiD

Assign Roles to Card Holder Query

INSERT INTO [dbo].[CardholderAccessLevels] ( [CardholderAccessLevellD],
[CardholderID], [AccessLevellD],[LastModified],[ActivateDate],[ DeactivateDate]) VALUES (
NEWID(), SCardholderID,(select AccessLevellD from [dbo].[AccessLevels] where
AccessLevelName=$ROLE_NAME),GetUTCDate(), NULL, NULL)

Remove Roles From Card Holder
Query

delete from [dbo].[CardholderAccessLevels] where CardholderID=$CardholderID and
AccessLevellD=(select AccessLevellD from [dbo].[AccessLevels] where
AccessLevelName=SROLE_NAME)

Retrieve User Id Query

select CardholderID from [dbo].[Cardholders] where UserText1=SUserText1

CREATE_USER1

INSERT INTO [AlUniversal].[dbo].[Cards]
([CardID],[CardholderID],[CardNumber],[FacilityCode],[PINNumber],[PINExempt],[APBExe
mpt],[UseExtendedAccessTimes],[CardStatus],[ActiveDate],[ExpireDate],[UserLevel],[UseC
ustomReporting],[Eventinfo],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[
CreatedByUser],[IssueLevel],[DeactivateExempt],[VacationDate],[VacationDuration],[UseCo
unt],[TempDeactivateStart],[TempDeactivateEnd],[Classification],[IPLocksetUserType],[IPLo
cksetAccessMode],[IPLocksetCredentialFormat],[IPLocksetAccessAlways],[RawPrimaryCred
ential],[LargeEncodedCardID],[EmbossedNumber]) VALUES (NEWID(),(select CardholderID
from [dbo].[Cardholders] where
UserText1=SUserText1),SCardNumber,SFacilityCode,SPIN,'0','0','0",'1',NULL,NULL,'0','0',NUL
L,NULL,SYSDATETIME(),'alertent’,SYSDATETIME(),'alertent','0','0',NULL,'0','255',NULL,NULL,"'
Active',NULL,NULL,NULL,NULL,NULL,NULL,")

LOCK_USER1

update [AlUniversal].[dbo].[Cards] set CardStatus='0',Classification="InActive' where
[CardNumber]=$CardNumber

6. Click on Next.

7. Attributes...Enter the following:

e Application — All

® Check the following boxes — Provisioning, Role Management, and Offline System.

® Leave Connector Category as Production

e Time Zone — Eastern Daylight Time from drop-down

8. Click on Next.

9. Click on Save.

Form customization — Attributes

Create New Custom Form Attributes
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1. Setup > Manual Configuration > Form customization > Attributes

2. Click on New Button
3. Create new attribute called PacsAllDoors based on the information provided below in
Table 22.
4. Click Save
Table 22. PacsAllDoors Attributes
Field Name Field Value
Name PacsAllDoors
Label PacsAllDoors
Description PacsAllDoors
Visible Yes
Mandatory No
Read Only No
Field Type TextField (Select this value from drop down)

USS Create Request

Yes(Select CheckBox)

USS User Information

Yes(Select CheckBox)

Approver View

Yes(Select CheckBox)

Provisioning Yes(Select CheckBox)
Create Request 10

Sequence

User Info Sequence 10

Approver Sequence 10

Group Name

Personnel Information (Select this value from drop down)

5. Repeat Steps 1-4 to create the following custom form attributes
1. Create PacsHomeAccess Attributes (See Table 23)
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2804 Table 23. PacsHomeAccess Attributes
Field Name Field Value
Name PacsHomeAccess
Label PacsHomeAccess
Description PacsHomeAccess
Visible Yes
Mandatory No
Read Only No
Field Type TextField (Select this value from drop down)
USS Create Request Yes(Select CheckBox)
USS User Information Yes(Select CheckBox)
Approver View Yes(Select CheckBox)
Provisioning Yes(Select CheckBox)
Create Request 11
Sequence
User Info Sequence 11
Approver Sequence 11
Group Name Personnel Information (Select this value from drop down)
2805
2806 2. Create PacsWorkAccess Attributes (as shown in Table 24)
2807 Table 24. PacsWorkAccess Attributes
Field Name Field Value
Name PacsWorkAccess
Label PacsWorkAccess
Description PacsWorkAccess
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Field Name Field Value

Visible Yes

Mandatory No

Read Only No

Field Type TextField (Select this value from drop down)
USS Create Request Yes(Select CheckBox)
USS User Information Yes(Select CheckBox)
Approver View Yes(Select CheckBox)
Provisioning Yes(Select CheckBox)
Create Request 12

Sequence

User Info Sequence 12

Approver Sequence 12

Group Name

Personnel Information (Select this value from drop down)

3. Create FacilityCode Attributes as shown in Table 25.

Table 25. FacilityCode Attributes

Field Name Field Value

Name FacilityCode

Label Facility Code

Description Facility Code

Visible Yes

Mandatory Yes

Read Only No

Field Type TextField (Select this value from drop down)
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Field Name Field Value

USS Create Request No

USS User Information No

Approver View No

Provisioning Yes(Select CheckBox)

Create Request
Sequence

User Info Sequence

Approver Sequence

Group Name

Personnel Information (Select this value from drop
down)

4. Create PIN Attributes as shown in Table 26.

Table 26. PIN Atributes

Field Name Field Value

Name PIN

Label PIN

Description PIN

Visible Yes

Mandatory No

Read Only No

Field Type TextField (Select this value from drop down)
USS Create Request Yes(Select CheckBox)
USS User Information No(Select CheckBox)
Approver View No(Select CheckBox)
Provisioning Yes(Select CheckBox)
Create Request 12
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Field Name Field Value

Sequence

User Info Sequence

Approver Sequence

Group Name Personnel Information (Select this value from drop down)

Modify Employee Type Attribute

PwwnNpeE

Setup > Manual Configuration > Form customization > Attributes
Select Employee Type Field from list of Attributes and Click Modify
Click on DropDown Values Icon

On the popup window, Click on New and Provide Employee in both Name and Label

fields, Figure 137.

Create DropDownValues

*Mame Emplovees *Label Employee|
Gancel Save

Figure 137. Create DropDownValues

5. Similarly configure values for Contractor field, Figure 138.
DropDown Yalues Y
Hame Label
Contractor Contractor
Employee Employes
Figure 138. Contractor Field

6. Click Save and then Click Save to save the configuration
7. lgnore this step if these values already exists

Modify Status Attribute

PwwnNpE

Setup > Manual Configuration > Form customization > Attributes

Select Status field from list of Attributes and Click Modify

Click on DropDown Values Icon

On the popup window Click on New and provide Active in both Name and Label
fields, Figure 139.
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Create DropDown¥alues
*Name Active *Label Active

Cancel Save
Figure 139. DropDownValues

DropDown Yalues

Name Lahel
Active Active
Inactive InActive

Figure 140. InActive

5. Similarly configure values for InActive field, Figure 140
6. Click Save and then Click Save to save the configuration
7. lgnore this step if these values already exists for Status field

Identity & Access— Enable Identity

1. Setup > Manual Configuration >ldentity & Access>Enable Identity

2. Enable the following for Identity DB system as shown in Figure 141.

ri erilily Cunfiyuration L?
* Maintain Identities | e ¥

= Commeclor | IDENTITIDE | v

Reset Save

Figure 141. Guardian Identity Configuration

9.4.4 |dentity & Access— User Field Mapping
1. Setup > Manual Configuration > Identity & Access > User Field Mapping.
2. Select User = Identity (from drop-down) and click Go.
3. Click the Create New button.
4

Select Custom Field, Primary Key, Visible In List, IsSearchable fields based on the table
listed below. Select checkbox for these fields if it is specified as “Yes” otherwise, keep it
as unselected.

5. Click on Save button to save the record

6. Repeat Steps 1-5 for all fields in the following table, Table 27. Ignore fields if pre-existing
mapping already exists for a particular field.
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Table 27. User Field Mapping Table

Custom Field Primary Key Visible In List IsSsearchable
Userld No Yes No
ValidFrom No Yes No
ValidTo No Yes No
FirstName No Yes Yes
LastName No Yes Yes
Email No No No
Building No No No
Managerld No No No
BadgeStatus No No No
BadgeType No No No
BadgeValidFrom No No No
BadgeValidTo No No No
Location No No No
Badgeld No No No
EmployeeType No No No
Department No No No
Password No No No
Groups No No No
ManagerName No No No
ManagerLN No No No
Manager No No No
Managerld No Yes No
Status No No No
Telephone No No No
ImageUpload No No No
Password_AD No No No
PacsAllDoors No Yes No
PacsHomeAccess No Yes No
PacsWorkAccess No Yes No

Identity & Access > Recon Authoritative Fields

1. Setup > Manual Configuration > Identity & Access > Recon Authoritative Fields.

2. Click on New.
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2858 3. Select ALERTDBCONNECTOR from Systems Drop down and select Authoritative field as
2859 PacsAllDoors as shown in

Create Recon Authoritative Fields

* Systems  ALERTDBCONMECTOR v
* Authoritative Field PacsallDoars v
Cancel Save

2860

2861 Figure 142. Authoritative Fields

2862 4. Click Save button to save the mapping.

2863 5. Repeat Steps 1-4 to configure mapping other fields PacsWorksAccess and

2864 PacsHomeAccess as listed in the screenshot shown in Figure 139.
ALERTDRBCOMMECTOR PacsallDoors
ALERTDBCOMMECTOR PacsworkAccess
ALERTDBCOMMECTOR PacsHome&ccess

2865 New Modify Delete

2866 Figure 143. Guardian Recon Authoritative Fields

2867 Identity & Access > Request Categories

2868 1. Setup > Manual Configuration > Identity & Access > Request Categories

2869 2. Select ChangeAccess Category name and Click Modify

2870 3. On the Modify screen make following changes

2871 a. Inthe Provisioning Actions section Un select Delimit user and Change Validity

2872 Dates check boxes if they are selected

2873 b. Go to Add Existing section and select System and Remove Role option for

2874 Resources/Roles Drop down field

2875 4. Click Save Button to save the configuration

2876  Identity & Access>Provisioning>External Provisioning Attributes

2877 1. Setup > Manual Configuration > Identity & Access > Provisioning > External Provisioning
2878 Attributes
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2879 2. Select ACCESSIT PACS system from the list and Click Configure

2880 3. On the Next screen, Click on New Button and provide “LastName” in both Name and
2881 description fields

2882 4. Click Save to save the configurations as shown in Figure 144,

Create External Provisioning Attribute

Name LastMarme
Description LastMame|
Cancel Save

2883

2884 Figure 144. External Provisioning Attribute

2885

2886 Repeat the Steps 1-4 to configure the following fields listed in the following screenshot,

2887 Figure 145. Note: The Fields Names are case sensitive.

2888 5.
Hame Description
LastMame LastMame
FirstMame Firsthame
Middlelnitial MiddleInitial
CampanyID CompanyID
UserTextl UsarTextl
CardholderID CardholderID
CardMumber CardMurnber
FacilityCode FacilityCode
PIM PIM

2889

2890 Figure 145. Attribute Fields

2891

2892 Identity & Access>Provisioning>Provisioning Mapping

2893 1. Setup > Manual Configuration > Identity & Access > Provisioning > Provisioning Mapping.
2894 2. Select ACCESSIT PACS and click on Configure.
2895 3. On the Next Screen, Figure 146, Click New Button and select UserText1 from
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DB Connector

Attribute Name LSS '
AlertEnterprise
Attribute Name Userld '
Derived Attribute v
MName
Mandatory Mo v
EditﬂhIE YES v
"-'.iSthE YES v

Default Yalue

Show Auto
Generate

Validation Flag

Is User-Id
attribute

Cancel Save

Figure 146. Provisioning Mapping

4. Click on Save button to save the mapping

5. Repeat the steps 1-4 to configure other fields as shown in Figure 140.

DB Connector Attribute Mandatory AlertEnterprise Attrib... Default Value Editable Visihle
UserTextl Mo Userld Mo
Firsthame Yes FirstName Yes
LastMame Yes LastName Yes
CompanylID Mo Priarity Mo
CardholderlD Yes Userld Yes
CardMurmnber Yes Badgeld Yes
FacilityCode Mo FacilityCode 20 Yes
PIM Mo PIN Yes

Cancel New Modify Delete

Figure 147. Guardian DB Connector Attribute Mapping

Policy Engine> Rules

1. Setup > Manual Configuration > Policy Engine > Rules
2. Click New Button

3. On the Next screen provide following information. See Figure 148.
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Define Rules

* Rule Name Al Door Access MNew
Entity Type o rkFlow Entity
Rule Type Alerticcess v
* Description All Door Access MNew
2
* applicable To Initiator

Decision
Suggest/Default
FRole Model
Palicy
Master User Search
Groups

Role Certification
unMitigatedrRiskallowed

* Aattributes:

aAnd fOr: and ar
PacsallDoors b Request Category v
2906 Mext Ccancel
2907 Figure 148. Policy Rules
2908 4. Click Next Button
2909 5. Onthe next screen, Figure 149, click New to define a new Rule Condition for NewHire
2910 request category

Define Condition

If PacsallDoors equals ¥ | True and
Fequest :
Categary equals ¥ || MewHire v
2911 Add Cancel
2912 Figure 149. Rule Conditions
2913
2914 6. Repeat the step 5 to define rule condition for other request categories Remove User
2915 Access and ChangeAccess as shown in Figure 150.
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If PacsallDoors and Request Category
= True = NewHire
= True = Remove User ACCess
= True = ChangeAccess
= true = Changeiccess

Figure 150. Rule Conditions

7. Repeat Step 1-6 to configure Other Rules Home Access Level New and WO Access Level
New as shown in following Table 21.

Table 28. Guardian Manual Configuration Policy Engine Rules

Rule Name Entity Type| Rule Type Description Applicable to Attributes Drop down value Selection Value

1. True and New Hire
2.True and Remove User
Suggest/Default Access

All Door Access New Workflow |AlertAccess |All Door Access New PacsALLDoors AND Request Category |Equals 3. True and ChangeAccess

1. True and New Hire

2. True and Remave User
Suggest/Default Access

Home Access Level New |Workflow |AlertAccess |Home Access Level New PacsALLDoors AND Request Category |Equals 3. True and ChangeAccess

1. True and New Hire

2. True and Remave User
Suggest/Default Access

WO Access Level New  |Workflow |AlertAccess |WO Access Level New PacsALLDoors AND Request Category |Equals 3. True and ChangeAccess

Policy Engine> Suggest/Default Access

1. Setup > Manual Configuration > Policy Engine > Suggest/Default Access.

2. Click New and enter the following information to create All Door Access criteria, shown
in Figure 151 .
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* Mame All Door Access

* Type Default

Use identity old
values

Provisioning Action

Cancel Back Next

3. Click Next Button

Description &ll Door Access

* Condition Al Door Access Mew

Search By Role
Attributes

Search by Systems +

Search by Training
Roles

Search by Training
Attributes

Search by Enterprise
Roles

Figure 151. Default Access

4. On the Next screen, Enter ACCESSIT PACS in System Name Field and hit Search button

5. The System will appear in Search Results pane. Click Add link under Action column to
add the system to Selected Systems section

6. Click Next Button

7. On the next screen, enter ALL DOORS in Role Name Field and hit Search button

8. The Role will appear in Search Results pane. Click Add link under Action column to add
the role to Selected Roles section

9. Click Save button to save the configuration

10. Repeat the steps 1-9 to configure other criteria for Home Access Level,

WO Access Level, NewHireDefaultSystems as listed in Table 29. Manual Configuration
Policy Engine Suggest/Default Access

Table 29. Manual Configuration Policy Engine Suggest/Default Access

... Search By Selected Selected
Name Type Condition
System System Role
All Door Access Default All Door Access Yes ACCESSIT ALL
NEW PACS DOORS
(Select
check box)
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Home Access Level | Default Work Access Level | Yes ACCESSIT Home
New PACS Access
(Select Level
check box)
WO Access Level Default Home Access Yes ACCESSIT wo
Level New PACS Access
(Select Level
check box)
NewHireDefaultSy | Default NewHireDefaultSy | Yes ACCESSIT
stems stems PACS
(Select
check box)

11. Select all existing Suggest Default Access criterias other than the one listed in Table 22
and Click Delete button to delete them.
Policy Engine>Rule Action Handler
1. Setup > Manual Configuration > Policy Engine > Rule Action Handler.
2. In Action Handlers List page select ReconChangeHandler and Click Modify
3. Onthe next screen Select Recon Create Request Task Type and Click Update Task

4. On the popup window Click on Value drop down field and select ChangeAccess from the
list as shown in Figure 152.

b
Task type | Recon Create Request v |
Value | Changefccess v |
Priority 0
Update Identity Info | Yes v |
Evaluate Enterprise Role | Mo v |
Cancel Sawve Task

Figure 152. Modify Task

5. Click on Save Task and then Click Save Button
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Policy Engine>Policy Designer

1. Setup > Manual Configuration > Policy Engine > Policy Designer
2. Select New to create new Policy designer as shown in Figure 153.
Name — User Policy New
Rule Type — AlertAccess

Description — User Policy

* Name User Policy New
* Rule Type Alertaccess v

Description User Palicy Mew

Back Next Cancel

Figure 153. Policy Designer

3. Click Next

4. Drag the elements from the tool bar section, available on top of the page and place
them onto the layout page and connect each node as shown in
Figure 154.

N Q BB & B 0O = H
S start end Merge Decision Task Task Group MNotify transition Save
B Figure 154. Toolbar

. represents Start button

“Stop
represents End Button

Us
represents Decision
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2977 represents transition

» v’ Create User

2978 represents Task

2979

2980 5. Guide lines to configure the policy

2981 a. To place an element/node on the layout page, drag it from the toolbar and place
2982 it.

2983 b. To connect two nodes, select transition icon from tool bar and then mouse over
2984 to the first node and connect to the other node in the same direction specified in
2985 the Figure 23)

2986 c. To provide text for a Decision or Task or Line, double click on the corresponding
2987 node and enter the text. Hit Enter after that to come out of the edit mode.

2988
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2992
2993

2994
2995

2996

2997
2998
2999

3000
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> 9 Create User

a Terminate J

User Policy Mew {AlertAccess)

@ Error Handler J

o Change Handler J

:_Slup::

Figure 155. Guardian User Policy

6. Click on Step 1 decision box and it will open popup window with some fields. See Figure

156
7. Enter SmasterUser[Userld].size='0' in the Condition text box and hit Enter
< Tasks =
Templates
Decision
Condition:

|$masterLlser[Llserld].size='EI' |

Figure 156. Tasks Popup

8. Similarly, click on other Steps (2 to 7) and configure the data based on Table 30.

9. For decision nodes provide Condition value and for Task nodes like Create User,
Terminate User, Change Handler, Error Handler provide IsTaskHandler and Task Handler
fields
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Table 30. Condition Decision Values
... Is Task Task Update
Step Name Type Condition handler Handler Query
User ID
1 Check Decision | SmasterUser[Userld].size='0'
Create Task Recon New
2 User Handler Yes Hire
Terminat ScheckStatus[UserStatus,Acti
3 e Check | Decision ve,InActive].action='LOCK'
Recon
Terminat Task Terminate
4 e Handler Yes Handler
Remove
Access ScheckAuthFields[].status="Ye
5 Check Decision s'
Recon
Error Task Error
6 Handler | Handler Yes Handler
Recon
Change Task Change
7 Handler | Handler Yes Handler
Job Scheduler>Triggers Field Map
1. Setup > Manual Configuration > Job Scheduler > Triggers Field Map.
2. Click New
3. Enter Group Name — Alert DbConnector Field Mapping
4. Description — Alert DbConnector Field Mapping
5. Select Type — Reconciliation
6. After creating Field Map, select the newly created map and select Configure
7. Click New and create mapping per below, Table 31
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Table 31. Guardian Job Scheduler Triggers Field Map

AE Attribute mappedKey userType |[roleType |userRole |userBadge |userEntRoleType |userTrainingType
Userld Userld TRUE FALSE FALSE FALSE FALSE FALSE
FirstName FirstName TRUE FALSE FALSE FALSE FALSE FALSE
LastMame LastMame TRUE FALSE FALSE FALSE FALSE FALSE
Email Email TRUE FALSE FALSE FALSE FALSE FALSE
Telephone WorkPhone TRUE FALSE FALSE FALSE FALSE FALSE
Mobile HomePhone TRUE FALSE FALSE FALSE FALSE FALSE
EmployeeType |EmployeeType TRUE FALSE FALSE FALSE FALSE FALSE
PacsAllDoars PacsAllDoor TRUE FALSE FALSE FALSE FALSE FALSE
PacsHomeAccess [PacsHomeAccess TRUE FALSE FALSE FALSE FALSE FALSE
PacsWorkAccess |PacsWorkAccess TRUE FALSE FALSE FALSE FALSE FALSE
Badgeld CardNumber TRUE FALSE FALSE FALSE FALSE FALSE
Format FacilityCode TRUE FALSE FALSE FALSE FALSE FALSE
ValidFrom ValidFrom TRUE FALSE FALSE FALSE FALSE FALSE
ValidTo ValidTo TRUE FALSE FALSE FALSE FALSE FALSE
Title Title TRUE FALSE FALSE FALSE FALSE FALSE
Status UserStatus TRUE FALSE FALSE FALSE FALSE FALSE
PIN PIN TRUE FALSE FALSE FALSE FALSE FALSE
AlertDepartment |Department TRUE FALSE FALSE FALSE FALSE FALSE

Job Scheduler>Triggers

1. Setup > Manual Configuration > Job Scheduler > Triggers

2. Click New and create the following Triggers in Table 32.

AlertDbConnectorTrigger

Table 32. Guardian AlertEnterprise DB Trigger

Name AlertDbConnectorTrigger
Description AlertDbConnectorTrigger
Type Reconciliation

Batch size 100

Number of Attempts 3

Policy Designer for Users/ Roles

User policy New

System: Reconciliation From

ALERTDBCONNECTOR

Reconciliation System

ALERTDBCONNECTOR

Field Mapping Group

ALERTDBCONNECTOR Field Mapping

User Type

True

User Role

True

Job Scheduler>Scheduler

1. Setup > Manual Configuration > Job Scheduler > Scheduler.
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2. Click New and enter the following, shown in Figure 142.

3. Click Save.
e Job Type — Reconciliation Job
e Job Name - <Job Name>
e Select Global check box
e Reconciliation for — User
e Reconciliation Type — Incremental Reconciliation
e Reconciliation Triggers — AlertDbConnectorTrigger
e Select the schedule as Immediate, Once, periodic or Advance.
e For a periodic job, specify the job start date, end date, and duration of job

frequency.
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* Job Type Reconciliation Job
* Job Name Mlert External DB User Reconciliation
Global v
Job Visibility private v
Notification Templates Choose One ¥
*Reconciliation For Users
Roles

User Training

*Reconciliation Type Incremental Reconciliation v

*Reconciliation Triggers lAIertDbConnectorTrigger v |

Init Date Load Mo v

Create/Update Scheduled Jobs = [x] *
Immediate
Once
*' pPeriodically
Advance
Time Zone (GMT-05:00) America/New_Y1 ¥
Start At [ps/08/2015 | b7l 20 58
[date] [hrs] [minutes]
End At |06/08/2016 | (%] 20 58
[date] [hrs] [minutes]
Rerun every [2 Minutes v
[Repeat Duration] [Repeat Unit]
Save Cancel
Figure 157. Guardian Reconciliation Job
3. Click Save.

The Access It Universal RS2 Technologies PACS Server is installed on the PACS Network to help
control physical access to simulated facilities, rooms, etc. RS2 Technologies cards and card
readers were also included in both builds. The RS2 Technologies PACS Server is installed on a

VM that is running the Windows Server 2012 R2 OS.

10.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-2: Physical access to assets is managed and

protected

NIST 800-53 rev 4 Security Controls: PE-2, PE-3, PE-4, PE-5, PE-6, PE-9
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3047 10.2 SYSTEM ENVIRONMENT

3048 The system for the PACS-Console Server configured by the NCCoE contains the following
3049 configuration settings and environmental constraints:

3050 e Windows Server 2012 R2

3051 e VM with CPU Quad Core 2.199GHz

3052 e VM with 8192MB of memory

3053 e Virtual Hard Disk containing 240 GB of storage.

3054 10.3 AIUNIVERSAL INSTALLATION

3055 1. Insert the AIUNIVERSAL CD into the CD-ROM drive.

3056 2. Launch Setup64.exe as Administrator.

3057 3. Follow install instructions:

3058 e Select|do not have a SQL Server installed.

3059 e When prompted to install SQL Server 2008 R2 Express Edition select Yes.

3060 e Afterinstallation of SQL Server. Select Install Access It! Universal.

3061 e When prompted to install a Stand-Alone Server version of Access It! select OK.
3062 e When prompted by the install wizard select Next >.

3063 e Read the license agreement and select Next > if you agree with the terms of the
3064 agreement.

3065 e Use default installation folder C:\Program Files(x86)\RS2 Technologies\Access It!
3066 Universal\ then select Next >.

3067 e When the installer is ready select Next > to continue.

3068 e Select Close to exit the installer after completion.

3069 10.4 PoOST INSTALLATION

3070 1. Launch Access It! by selecting it from the Start menu.
3071 2. When prompted to select server, enter the host name of server: PACS-CONSOLE.
3072 3. Log in with the default user name and password.

3073 10.4.1 Connect Access It! Universal to Door Controller

3074 1. Under the Main > Hardware tab, select Channels.
3075 2. Create a new Channel.

3076 3. For Channel Type select IP Server.

3077 4. Ensure Protocol Type is SCP.
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10.
11.

12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.

Select Save.

Create a new SCP.

Under the General tab ensure that Model is set to EP-1501Plus.

Under the Comm tab ensure that Channel is set to Channel 000 (the channel just
created).

TCP/IP Settings:

IP Address: 172.16.7.101
Port Number: 3001

Encryption Settings: None.

Under the Card Formats tab:

Format Name: 26 Bit Wiegand Facility code: 20
Format Name: 26 Bit Wiegand Facility code: 219

Save changes to SCP 000.
Under SIOs
Edit SCP 000 - SIO 00

Under General tab ensure Model is set to EP-1501.
Edit SCP 000 —SIO 01

Under General tab ensure Model is set to MR-52.

Under Main > Hardware select Installed Readers
Create SCP 000 — SIO 00-Reader 1

Create SCP 000 — SIO 01-Card Reader

Create SCP 000 -SIO 01-MRDT Keypad

Under Configuration > Access Levels create New Access Level.

Create new access levels.

Access Level Name: All Doors.

Assigned Readers for All Doors: SCP 000 — SIO 01-Card Reader and SCP 000 —SIO
01-MRDT Keypad.

Access Level Name: Home Access Level.
Assigned Reader for Home Access Level: SCP 000 — SIO 01-MRDT Keypad.
Access Level Name: Work Order Access Level.

Assigned Reader for Work Order Access Level: SCP 000 — SIO-Card Reader
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10.4.2 Enable TCP/IP to SQL 2008 R2 Server

Launch Microsoft SQL Server Configuration Manager.

Expand SQL Server Network Configuration (32-bit).

Select Protocols for AIUNIVERSAL.

Right-click on TCP/IP and then select Properties.

Select tab IP Addresses.

Under IP1 ensure IP Address is set to 0.0.0.0 and TCP Port is set to 1433.

Under IPALL ensure TCP Dynamic Ports is set to 52839 and TCP Port is set to 1433.

© N O U kB W N E

Restart the SQL server by selecting SQL Server Services then right click on SQL Server
(AIUNIVERSAL) and select Restart.

The TDi ConsoleWorks server was installed in two different locations in the builds. It was
installed on the OT network to control and monitor access between OT technicians and physical
devices such as the RTUs and the RADiFlow ICS firewall. The following two sections provide
details on the steps needed to install and configure each of these servers.

11.1 SEecCURITY CHARACTERISTICS
Cybersecurity Framework Categories:

e PR.PT-1: Audit/log records are determined, documented, implemented, and reviewed in
accordance with policy

e PR.PT-3: Access to systems and assets is controlled, incorporating the principle of least
functionality

NIST 800-53 rev 4 Security Controls: au Family, AC-3, cM-7

11.2 CONSOLEWORKS SERVER INSTALLATION

ConsoleWorks was installed on the OT network to control and monitor access between OT
technicians and physical devices such as the RTUs and the RADiFlow ICS firewall. ConsoleWorks
uses the OT directory to authenticate users requesting access to these devices. It also
establishes a permanent SSH or telnet connection to each of the RTUs and ICS firewall using
pre-established usernames and passwords. As users request access and are authenticated
ConsoleWorks makes the cross-connection from the user to the specific SSH or telnet session to
allow access. Once the cross-connection is established the user has access to the device to
make any changes needed. When the user completes their task they log-off of the connection
and ConsoleWorks removes the cross-connect between the user and the SSh or telnet session.
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ConsoleWorks logs all user access requests, all of the traffic on the session, and can alert on any
pre-defined aspect of the traffic. Directory based authentication is used to manage the user
access in near real time.

On the OT network, the ConsoleWorks Server is installed on a VM that is running the Windows
Server 2012 R2 (hardened server OS) image, as explained in Section 1.

11.2.1

System Environment

The system for the OT Network ConsoleWorks Server configured by the NCCoE contains the
following configuration settings and environmental constraints:

L ©® N o

Windows Server 2012 R2 OS

VM with CPU Quad Core 2.199GHz

VM with 8192MB of memory

Virtual Hard Disk containing 240 GB of storage.

ConsoleWorks Server Installation on the OT Network

After installing the OS, download the TDi Technologies Installer from
http://support.tditechnologies.com/get consoleworks.

Launch the cw_server v4.9-0u0.exe application. The installer requires administrative
privileges to execute.

When prompted by Windows User Account Control, select Yes to continue.

The ConsoleWorks Server InstallShield Wizard should display a welcome message. Select
Next > to continue.

When prompted by the InstallShield Wizard to accept the license agreement, read
carefully. If you agree with the license terms, select Next > to continue with the
installation.

Enter the User Name and Organization fields, then select Next > to continue.
Select Complete when prompted for setup type, then select Next > to continue.
Click Install to begin installation of ConsoleWorks Server.

After the InstallShield Wizard has completed, ensure that Launch upgrade script (if
upgrading from 32 bit) is unchecked.

. Select Finish.

Post-installation Configuration of ConsoleWorks on the OT Network

Copy TDi Technologies license key files into
C:\ProgramData\ConsoleWorks/Server\LMF\TDI_Licenses

Go to Start > Run > services.msc.

Right-click on the ConsoleWorks Server Service, then select Properties.
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4. Select Start to start the service. Then change the Startup Type from Manual to
Automatic.

5. Select Apply to save changes. Both the ConsoleWorks Server and ConsoleWorks LMF
Server services should be running.

6. Test browser connectivity by going to http://localhost:5176. The default account is
CONSOLE_MANAGER. The default password is: Setup

11.2.4 Configuring External Authentication for the OT Network ConsoleWorks Server

1. From the left menu, select the SECURITY tab.
2. Select External Authentication.
3. Ensure the Enable External Authentication checkbox has been selected.
4. Select Add.
e Parameter 1: OT-ES-IDAM-B1
e Parameter 2: CW _
e Required Profile: CONSOLE WORKS
e Template User: CONSOLE MANAGER
e Leave all other fields blank.
5. Then select Next.
6. Enter a Username and Password to test External Authentication settings.
7. Then select Next.
8. Then select Save.

A RADiIFlow switch is installed on the physical network that represents the industrial control
system component that can be accessed and controlled via the OT network. A RADiFlow
management workstation is installed on the OT network. The RADiFlow Management
Workstation is installed on a VM that is running the Windows 7 Enterprise OS.

12.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.PT-3: Access to systems and assets is controlled,
incorporating the principle of least functionality

NIST 800-53 rev 4 Security Controls: AC-3, CM-7
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12.2 OT Network RADiFlow Management Workstation INSTALLATION

12.2.1 Installing iSIM
1. Launch the iSIM installer as an administrator
2. Set the Destination Directory to C:\Program Files (x86).

3. Leave default settings for all other options

12.2.2 iEMS
1. Launch iEMS from the Start menu.
2. From the menu items, select System > Switch Initialization > Force Switch Model > 3180.

3. In the main windows dialog box, enter the switches IP address 172.16.6.4 and then
select Refresh.

4. From the menu items, select Configuration > Interfaces > Serial Ports...

5. Select the Terminal Server tab and ensure Service 1 and Service 2 dialog boxes are
checked.

6. Under Service 1, enter these settings:
e ServicelD:1
e Local IP Address: 172.16.6.100
e Telnet Port: 2050
¢ Null CR Bit Mode: OFF

7. Under Service 2, enter these settings:
e ServiceID: 2
e Local IP Address: 172.16.6.100
e Telnet Port: 2051

e Null CR Bit Mode: OFF
8. Then Select Create/Update.

9. Select the Serial Ports tab ensure Port-1 and Port-2 dialog boxes are checked.
10. Under Port 1 enter these settings:

e Application: Terminal Server
e Local Position: Slave

e Service-id: 1

e Operation Mode: Transparent
e Buffer Mode: byte

e Protocol: any

e Baudrate: 9600
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Databits: 8
Stopbits: 1

Parity: no
Allowed-latency: 6
Bus-idle-time: 30
Dtr-dsr: enable
Rts-cts: enable
Local-dsr-delay: O
Local-cts-delay: O
Tx-delay: 10
Bits-for-syncl: 28
Bits-for-sync2: 1
Unit-id length: 2
lec101-link-address-len: 2

11. Under Port 2 enter these settings:

Application: Terminal Server
Local Position: Slave
Service-id: 2

Operation Mode: Transparent
Buffer Mode: byte

Protocol: any

Baudrate: 9600

Databits: 8

Stopbits: 2

Parity: no

Allowed-latency: 6
Bus-idle-time: 30
Dtr-dsr: enable
Rts-cts: enable
Local-dsr-delay: O
Local-cts-delay: O
Tx-delay: 10
Bits-for-sync1: 28
Bits-for-sync2: 1
Unit-id length: 2
lec101-link-address-len: 2

12. Then Select Create/Update.

NIST Cybersecurity Practice Guide SP 1800-2c
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13.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-4: Access permissions are managed, incorporating
the principles of least privilege and separation of duties

NIST 800-53 rev 4 Security Controls: AC-2, AC-3, AC-5, AC-6, AC-16

13.2 OzONE CONSOLE INSTALLATION AND AUTHORITY CONFIGURATION

1. Install CA Certificate into trusted root store (MAG_DEV_CA.crt).
2. Install Ozone Authority Certificate into Trusted People store (ozoneauthority.crt).
3. Install Administrator keys into Personal store (adminl.crt and admin2.crt).
4. Run Setup Ozone Console.exe
e Run Ozone Console.
* Go to Configuration>0zone Authority>New...see Figure 158.
* In the Proof Settings tab:
o Select SHA256 for the Entity Digest Algorithm.
o Select SHA256withRSA for the Proof Signature Algorithm.

[ Ozone Authority Configuration EI@-'

Proof Settings | Authority Web Service | Database Tuning |

Entity Digest Algorithm Proof Signature Algorithm:
| SHA256 | |sHA2S6wihRSA |

[7] Enable Logically Massive Proofs

Mumber of ertities required for Logically Massive Proof

-I.-m-r-
U

Change percentage required befare full republish

Ely

U

Logically Massive Proof republication schedule

How long should the LMP sub-procofs remain valid ?

Save ] [ Cancel

Figure 158. Ozone Proof Settings

5. In the Authority Web Service tab, Figure 159.
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6. Select a certificate to be used to digitally sign the configuration (Admin 1).

Set the HTTPS Port to 443.

Select SHA1withRSA for the Message Signature Algorithm.

=2 =R
Proof Settings | Authority Web Service | Database Tuning

Message Transaction Timeout:(Seconds)

120 =

Ozone Authority Configuration

Message Transaction Allowed ClockSkew: (Seconds)

30 =
HTTPS Paor: Backend Port:
443 = 4210 =

[T] Enable HTTF Listener
HTTP Port: Server Backlog:
4201 : 20 =

Message Signature Algorthm
SHATwihRSA |

[ Save ] l Cancel

Figure 159. Ozone Authority Web Service

Click Save.

7. Save the file as AuthorityConfiguration.xml.

8. SCP the file to Ozone Authority machine.

13.3 OzONE AUTHORITY INSTALLATION

Create keys and certificates and store in Java Keystore (JKS)

Install java

[root@ozone ~]# yum install java

Install mariaDB

[root@ozone
[root@ozone
[root@ozone
[root@ozone

H= = 3 e

yum install mariadb-server
reboot

systemctl start mariadb
systemctl enable mariadb

Secure the mysql installation
[root@ozone ~]# mysql secure installation
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Create the Ozone Authority database and user
[root@ozone ~]# mysql -u root -p

MariaDB> create database ozone;
Query OK, 1 row affected (0.02 sec)

MariaDB> create user 'ozone'@'localhost' identified by 'password';
Query OK, 0 rows affected (0.00 sec)

MariaDB> grant all privileges on ozone.* to 'ozone'(@'localhost';
Query OK, 0 rows affected (0.00 sec)

MariaDB> flush privileges;
Query OK, 0 rows affected (0.00 sec)

Install the Ozone Authority
[root@ozone locall# ed /usr/local/
[root@ozone locall# tar -xzf ~/Ozone\ Authority-2014.tar.gz

Copy AuthorityConfiguration.xml to conf directory
[root@ozone locall# mv ~/AuthorityConfiguration.xml authority/conf/

Copy AuthorityLicense.xml to conf directory
[rootQozone locall# mv ~/Authoritylicense.xml authority/conf/

Copy JKS to keystores directory
[root@ozone locall# mv ~/authority.jks authority/keystores/

Copy administrator certificates to bin directory
[rootQ@ozone locall# mv ~/adminl.cer authority/bin/
[rootQozone locall# mv ~/admin2.cer authority/bin/

Run the Ozone Authority script

[root@ozone locall# ed authority/bin/

[root@ozone bin]# ./startAuthority.sh

Configuration file not found, would you like to create a new
installation? [Y] Y

*HAWARNING* * *

This product MUST be installed by an Ozone Certified

Engineer. Pericore, Inc. cannot be held liable for damages resulting
from negligent or fraudulent actions of unauthorized or unqualified
administrators. Please review all documentation thoroughly before
continuing. Continuation of this configuration process represents an
agreement to abide by the Pericore EULA.

Do you wish to continue? [N] : y

Please select the license file for this Ozone Authority.:
1: /usr/local/authority/conf/AuthorityLicense.xml

2: Other...

Choice [1] : 1
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Please select the configuration file for this Ozone Authority.:
1: /usr/local/authority/conf/AuthorityConfiguration.xml

2: Other...
Choice [1] : 1
Do you wish to set any passphrase complexity requirements? [N] : N

Note: If you require passphrase at start, you will not be able to
restart this Ozone Authority without user intervention.
Do you wish to require a passphrase to start this Ozone Authority? [N] N

Using keystore type: RSA

Do you have an existing keystore you wish to use for this Ozone Authority?
[yy ™Y

Please select the keystore file for this Ozone Authority::
1: /usr/local/authority/keystores/authority.jks

2: Other...
Choice [1] : 1
Please enter the passphrase. : 123456

May 15, 2015 1:24:22 PM com.pericore.util.PericoreProvider jsafeJCEinit
POST: [FIPS] FIPS-140 compliance self-test passed.

What type of database do you wish to use?:
1: SQLSERVER

2: ORACLE
3: MYSQL
Choice [1] : 3

Please enter the hostname or IP address of the database server: [ozone]
localhost

Please enter the port number for the database: [3306] 3306

Please enter the username for the database: [] : ozone

Please enter the database password: password

Using only available database: ozone

How many initial administrators would you like to create? [2] : 2
Page 1 | Current Directory:

[00] ../

[01] 1lib/

[02] adminl.cer

[03] admin2.cer

Please select the file containing the administrators certificate: [ # ] : 2
3Page 1 | Current Directory:

(001 ../

[01] 1lib/

[02] adminl.cer

[03] admin2.cer

Please select the file containing the administrators certificate: [ # ] : 1
Please enter distinguished name (DN) of the starting Organizational

Unit (OU) for this proof tree: [0U=0Ozone] : ou=0Ozone, dc=NCCOE, dc=test

Is: ou=0zone, dc=NCCOE, dc=test correct? [Y] : Y

Please enter the minimum number of administrators required to approve
changes to the initial proofs: [1] : 1

200 | NIST Cybersecurity Practice Guide SP 1800-2c



3426
3427
3428
3429
3430
3431
3432
3433
3434
3435
3436
3437
3438
3439
3440
3441
3442
3443
3444
3445
3446
3447
3448
3449
3450
3451
3452
3453
3454
3455
3456
3457
3458
3459
3460
3461
3462
3463
3464
3465
3466
3467
3468
3469
3470
3471
3472
3473
3474
3475
3476
3477
3478
3479
3480
3481
3482

DRAFT

Please enter a name for the initial publication schedule: [Primary Schedule]
Daily

Please enter the publication interval: [12] : 12

Please select the time unit::

1: Minute

2: Hour

3: Day

Choice [1] : 2

Please enter the validity period after publication: [12] : 12

Please select the validity period time unit::

1: Minute

2: Hour

3: Day

Choice [1] : 2

Please enter a name for the initial distribution point for proofs. [File
Distribution Point] : LDAP Distribution Point

Please enter the initial distribution point for proofs. This may be changed
later. [file:///usr/local/authority/proofs/] : ldap://ozoneauthority/
Configuration File: /usr/local/authority/conf/AuthorityConfiguration.xml
May 15, 2015 1:25:16 PM
com.pericore.util.ObjectIdentifierFactory$OIDDataloader debug

INFO: ObjectIdentifierFactory Read 240.165 kb in 2.511 ms; Indexed 2,415 Arcs
in 51.731 ms; 2,310(1,054:5) keys => 2.003 kb

Created proof ou=Master Authorization Group, ou=0Ozone, dc=NCCOE, dc=test in
the database.

Created proof ou=Applications, ou=Master Authorization Group, ou=Ozone,
dc=NCCOE, dc=test in the database.

Created proof ou=Groups, ou=Master Authorization Group, ou=0zone, dc=NCCOE,
dc=test in the database.

Created proof ou=Attribute Types, ou=Master Authorization Group, ou=0zone,
dc=NCCOE, dc=test in the database.

Allowing a user certificate to be associated with a directory GUID

allows for a migration path from username and password to a PKI based
authentication and authorization mechanism. However, this method

lowers the initial security settings by relying on a directory for the
association. Please be sure you understand the risks associated with

this method before allowing this mechanism to be used.

Would you like to allow users certificates to be associated with a directory
GUID? [N] : N

Do you wish to display a logon message? [N] : N

Ozone Authority

Version: 2014 - 4.0.1 (Build: 475)
Copyright Pericore, Inc. 2014

Started at: May 15, 2015 1:24:13 PM EDT
Licensed to: NCCOE

Built: ou=Master Authorization Group, ou=0Ozone, dc=NCCOE, dc=test in
0:00:00.304.

Built: ou=Applications, ou=Master Authorization Group, ou=0zone, dc=NCCOE,
dc=test in 0:00:00.243.

Built: ou=Groups, ou=Master Authorization Group, ou=0zone, dc=NCCOE, dc=test
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in 0:00:00.215.

Built: ou=Attribute Types, ou=Master Authorization Group, ou=0zone, dc=NCCOE,
dc=test in 0:00:00.214.

Push Certificates loaded with: 0 certificates

Started HTTPS Listener on port: 443
Ozone Authority>

Install LDAP (389) directory server

[root@ozone ~]# yum install 389-ds-base

[root@Qozone ~]# vi /etc/hosts

Modify the first line of hosts file so that it is the same as below:
127.0.0.1 ozoneauthority.nccoe.test localhost localhost.localdomain
localhost4 localhost4.localdomain4

Configure the directory server
[root@ozone ~]# setup-ds.pl

This program will set up the 389 Directory Server.

It is recommended that you have "root" privilege to set up the software.
Tips for using this program:

- Press "Enter" to choose the default and go to the next screen

- Type "Control-B" or the word "back" then "Enter" to go back to the
previous screen

- Type "Control-C" to cancel the setup program

Would you like to continue with set up? [yes]: yes

Your system has been scanned for potential problems, missing patches,
etc. The following output is a report of the items found that need to
be addressed before running this software in a production
environment.

389 Directory Server system tuning analysis version 23-FEBRUARY-2012.

NOTICE : System is x86 64-unknown-linux3.8.13-68.2.2.el7uek.x86 64 (1
processor) .

NOTICE : The net.ipv4.tcp keepalive time is set to 7200000 milliseconds
(120 minutes). This may cause temporary server congestion from lost

client connections.

WARNING: There are only 1024 file descriptors (soft limit) available, which
limit the number of simultaneous connections.

WARNING : The warning messages above should be reviewed before proceeding.

Would you like to continue? [no]: yes
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Choose a setup type:

1. Express

Allows you to quickly set up the servers using the most
common options and pre-defined defaults. Useful for quick
evaluation of the products.

2. Typical
Allows you to specify common defaults and options.

3. Custom
Allows you to specify more advanced options. This is
recommended for experienced server administrators only.

To accept the default shown in brackets, press the Enter key.

Choose a setup type [2]: 2

Enter the fully qualified domain name of the computer

on which you're setting up server software. Using the form
<hostname>.<domainname>

Example: eros.example.com.

To accept the default shown in brackets, press the Enter key.
Warning: This step may take a few minutes if your DNS servers
cannot be reached or if DNS is not configured correctly. If

you would rather not wait, hit Ctrl-C and run this program again
with the following command line option to specify the hostname:

General.FullMachineName=your.hostname.domain.name

Computer name [ozone.mountaireygroup.com]: ozoneauthority.nccoe.test

The server must run as a specific user in a specific group.

It is strongly recommended that this user should have no privileges
on the computer (i.e. a non-root user). The setup procedure

will give this user/group some permissions in specific paths/files
to perform server-specific operations.

If you have not yet created a user and group for the server,
create this user and group using your native operating
system utilities.

System User [nobody]: nobody
System Group [nobody]: nobody

The standard directory server network port number is 389. However, if
you are not logged as the superuser, or port 389 is in use, the
default value will be a random unused port number greater than 1024.
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If you want to use port 389, make sure that you are logged in as the
superuser, that port 389 is not in use.

Directory server network port [389]: 389

Each instance of a directory server requires a unique identifier.
This identifier is used to name the various

instance specific files and directories in the file system,

as well as for other uses as a server instance identifier.

Directory server identifier [ozoneauthority]: ozoneauthority

The suffix is the root of your directory tree. The suffix must be a valid DN.
It is recommended that you use the dc=domaincomponent suffix convention.

For example, if your domain is example.com,

you should use dc=example,dc=com for your suffix.

Setup will create this initial suffix for you,

but you may have more than one suffix.

Use the directory server utilities to create additional suffixes.

Suffix [dc=nccoe, dc=test]: dc=nccoe, dc=test

Certain directory server operations require an administrative user.

This user is referred to as the Directory Manager and typically has a

bind Distinguished Name (DN) of cn=Directory Manager.

You will also be prompted for the password for this user. The password must
be at least 8 characters long, and contain no spaces.

Press Control-B or type the word "back", then Enter to back up and start
over.

Directory Manager DN [cn=Directory Manager]: cn=Directory Manager
Password: password

Password (confirm): password

Your new DS instance 'ozoneauthority' was successfully created.
Exiting ..

Log file is '/tmp/setup C4mdK.log'

Setup the directory structure
Modify the file /usr/local/authority/bin/389SetupDirectory.ldif

Set the correct DN structure and passwords for the ozone authority user and tree
[root@ozone binl# wvi 389SetupDirectory.ldif
[root@ozone bin]# cat 389SetupDirectory.1ldif

#Create the User for Ozone Authority

dn: uid=ozone, ou=Special Users, dc=nccoe, dc=test
changetype: add

objectClass: inetorgperson

objectClass: organizationalPerson

objectClass: person

objectClass: top
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cn: Ozone Authority
sn: Authority
givenName: Ozone

uid: ozone
userPassword: PRS$Sword

#make the people writable by ozone

dn: ou=People, dc=nccoe, dc=test

changetype: modify

add: aci

aci: (targetattr="*") (version 3.0;acl "ozone authority";allow (all) (userdn =
"ldap:///uid=ozone, ou=Special Users, dc=nccoe, dc=test");)

#Create the Ozone 0OU

dn: ou=0zone, dc=nccoe, dc=test

changetype: add

objectClass: organizationalUnit

objectClass: top

ou: Ozone

aci: (targetattr="*") (version 3.0;acl "ozone authority";allow (all) (userdn =
"ldap:///uid=ozone, ou=Special Users, dc=nccoe, dc=test");)

#Create required Attributes and Object Classes

dn: cn=schema

changeType: modify

add: attributetypes

attributetypes: ( 1.3.6.1.4.1.26135.1.1.1.2 NAME 'authorizationProof' DESC
'Ozone Authorization Proof' SYNTAX 1.3.6.1.4.1.1466.115.121.1.40 SINGLE-VALUE
X-ORIGIN 'user defined' )

attributetypes: ( 2.23.136.1.1.2 NAME 'cscaMasterList' DESC 'CSCA Master
List' SYNTAX 1.3.6.1.4.1.1466.115.121.1.40 SINGLE-VALUE X-ORIGIN 'user
defined' )

dn: cn=schema

changeType: modify

add: objectclasses

objectclasses: ( 1.3.6.1.4.1.26135.1.1.3 NAME 'ozoneAuthority' DESC '' SUP
top STRUCTURAL MAY (authorizationProof $ cscaMasterList) X-ORIGIN 'user
defined' )

Modify the directory using the LDIF

[root@ozone binl# ldapmodify -x -D "cn=Directory Manager" -W -f
/usr/local/authority/bin/389SetupDirectory.1dif

Enter LDAP Password:

adding new entry "uid=ozone, ou=Special Users, dc=nccoe, dc=test"
modifying entry "ou=People, dc=nccoe, dc=test"

adding new entry "ou=Ozone, dc=nccoe, dc=test"

modifying entry "cn=schema"

modifying entry "cn=schema"
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13.4 OzoNE CONSOLE SERVER CONFIGURATION

Before proceeding ensure that OzoneAuthority has been started by running startauthority.sh on

the OzoneAuthority machine.
1. Open Ozone Console.
Go to File>Properties, Figure 160, below.

Enter the Ozone Authority URL.

A T o

Click Save to the connection information.

Authority | Administration

Click Select Certificate and select the Ozone Authority Certificate.
Select SHA1withRSA as the Message Signature Algorithm.

Ozone Authority URL:
https://ozaneautharity.”
Ozone Authority Cerificate:

[ validate Authority Certificate

DC=com, DC=o0zoneauthority, OU=5ervers, CN=o0zone: | Select Certificate.

Message Timeout (minutes):  Message Signature Algarithm
5B |SHATwithRSA |

Figure 160. Ozone Authority Connection Information

Create the publication point for the proofs

1. Select Publication > Add Publication Point > Add LDAP Publication Point, Figure 161

Enter a name for the publication point.

Enter a base context, if any.

Select the port.

Enter the password for the user.

© N o v kWD

Confirm the password.
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Add LDAP Publication Point

Publication Poirt Name
Ozone Authorty LDAP

Hostname or I[P Address:

ozoneautharity |:| Use secure connection
Fioot Context Paort Number
389 =
Usemame
uid=ozone, ou=special users, dc=nccoe, do=test
Password Re4ype password
[ Save ] [ Cancel

Figure 161. Ozone LDAP Publication Point

Import the desired groups from the RSA Adaptive directory
1. Right-click on the Groups proof.
2. Select Import Group from Active Directory, Figure 162.
3. Enter the directory connection information.
Directory Connection o S|
Hosthame or P Address: Part Murnber
1721643 2383 =

[] Connect &nonymously  [] Secure Connection
Uszername

ch=directon manager

Pazzword

HHMMEMEMHRNN

Root Contest

au=IT, do=master, do=tesy

[ Connect H Cancel I

Figure 162. Ozone Directory Connection Information

4. Select a group to import, see Figure 163.

5. Check the box to Import New Entities.
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3737 6. Check the box to Import Associated Groups.
3738 7. Then select Import

Mame Digtinguizhed Mame

Impart Mew E ntities Import Azzociated Groups

| New Directory Connection | | Impot || Cancel
3739
3740 Figure 163. Ozone Import Group from Directory
3741 8. Select the publication schedule as shown in Figure 164.
3742 9. Select the publication point as shown in Figure 164.
3743 10. Select the distribution point as shown in Figure 164.
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Mewy Proof Damain Users

Infarmatian | Paars | Entities | Adrniristiatars | Usage Pariads | Athentication | Attribiites | Contacts|
Marne:
Superiar Praaf

au=Giraups, oush aster Autharization Group, ousOzons, desmountaitsygraup, descanm

D escription

Schedule Public:ation Points Distribution Points

[Daily |

Digest Type
[BuID -

Froaf Type
@ Standard ) Black List ) Gatsway

Diomain U zers - ou=Groups, ou=Master Authorization Group, ou=0zone. de=mountaireyaroup, de=com

[F=NEcR ==

Save | | Cancel

Figure 164. Ozone New Proof Information

11. Click the Administrators tab as shown in Figure 165
12. Click the Add Administrators button.
13. Select the users who will administer the proof.

14. Then select Add Entities
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| Information | Peers | Entities| Administrators | Uzage Periods I Authentication | Aftributes I Eontactsl

Seanch:

Search Add Administrators

Remaove Certificate

Marne:

Distinguished Mame

Ozone Administrator 1

CH=0zone Administrator 1, OU=people, DC=0zoneauthority, D1,

Dzone Administrator 2

inimum number of administrators required to approve changes.

CH=0zone Administrator 2, 01J=people, DC=0zoneauthority, 0.

’ Save ] [ Cancel ]

Figure 165. Ozone New Proof Administrators

15. Click the Save button.

Create the Ozone Server Configuration

1. Select Configuration > Ozone Server > New...

2. Click the Add proof from tree... button.

3. Select a proof Ozone Server should use for authorizations as shown in Figure 166.
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& | ou=Master Authorization Group, ou=0Ozone, de=NCCOE, dc=test |

----- 1 ou=Applications, ou=Master Authorization Group, ou=Ozone,

d
----- v | ou=Attibute Types, ou=Master Authorization Group, ou=0Ozor
EI.',':I ou=aroups, ou=Master Authorization Group, ou=Czone, dc=h
- ou=Domain Users, ou=Groups, ou=Master Authorization (

i | 3

| Select || Cancel

Figure 166. Ozone Peer Proofs
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4. Set the number of proof references (Depth) the proof may follow in order to authorize a
credential as shown in Figure 167.

5. Ensure that the locations where the Ozone Server will retrieve the proof are correct.
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Proof Name

QU=Domain Users, OU=Groups, OlU=Master Authorzation Group, QU=0zone, DC=MNCCOE, D|
Proof 1D
30818404160414788355db43¥a83d 34405d 5d oebB4 7883 1add 306231233021 060355040

2 =

Ozone Authorty Cerificate:
DC=com, DC=ozoneauthority, OJ=5ervers, CN=ozoneauthe Wiew... ] [ Select...

Femove Protocol Source

ol ozoneauthority.’

Figure 167. Ozone Add Authorization Proof

6. Click the Save button.

7. Repeat Steps 2—6 until you have selected all of the proofs Ozone Server should initially
retrieve for Authorizations.
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Retry {in Seconds)
Lttilize group proofs |5 E"

Remowve Corfigured Proofs

OU=Domain Users, O0U=Groups, OU=Master Authorization Group, OlU=0zone, DC=MCCOE. ...

| Addprocffie.. || Removepoof | [ Save configuration | | Cancel

| Add proof from tree... |

| Add proof manualy... |

Figure 168. Ozone Server Configuration

8. Click the Save configuration button as shown in Figure 168.
9. Select a certificate to be used to digitally sign the configuration.
10. Save the file as ServerConfiguation.xml.

11. SCP the file to the Ozone Server machine.

13.5 OzONE SERVER INSTALLATION

Create keys and certificates and store in Java Keystore (JKS)

Install java
[root@ozone ~]# yum install java

Install Ozone Server
[rootRozoneserver ~]# ed /usr/local/
[root@ozoneserver locall# tar -xzf ~/Ozone\ Server-2014.tar.gz

Copy the keystore to the conf directory
[rootRozoneserver locall# mkdir /usr/local/server/bin/conf/
[root@ozoneserver locall# cp ~/server.jks server/bin/conf/

Copy the configuration and license files to the conf directory

[root@ozoneserver locall# cp ~/ServerConfiguration.xml server/bin/conf/
[root@ozoneserver locall# cp ~/ServerLicense.xml server/bin/conf/
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Run the Ozone Server
[root@ozoneserver bin]# ./startServer.sh
POST [MAIN] v2.1.301

;N\ /7 NI NT (R

7N T/ NTENN

L NN

L/ NN ] |

L/ NN

NN/ /NN /NN

\ // \ /o1 N

/ |

| B -

\__ N/ _ NV NN/ _ N
YL /N v /]

| /N 1NN

Fri May 15 14:31:33 EDT 2015

May 15, 2015 2:31:35 PM com.pericore.util.PericoreProvider jsafeJCEinit
POST: [FIPS] FIPS-140 compliance self-test passed.

Found Java version: 1.8.0 31

Working in: /usr/local/server/bin

/usr/local/server/bin/conf/server.cfg not found. Run setup [Y] : Y
env.work/usr/local/server/bin

Found Java Version: 1.8.0 31

Ozone Server Setup Utility

*HFAXWARNING* * *

This product MUST be installed by a Pericore Certified Engineer. Pericore,
Inc. cannot be held liable for damages resulting from negligent or fraudulent
actions of unauthorized or unqualified administrators. Please review all
documentation thoroughly before continuing. Continuation of this
configuration process represents an agreement to abide by the Pericore EULA.
I agree to all terms and conditions set forth by Pericore, Inc. [N] : y
Enable Startup Password? [N] : n

May 15, 2015 2:31:37 PM
com.pericore.util.ObjectIdentifierFactory$0OIDDataloader debug

INFO: ObjectIdentifierFactory Read 240.165 kb in 3.313 ms; Indexed 2,415 Arcs
in 52.438 ms; 2,310(1,054:5) keys => 2.003 kb

Server Configuration Directory:

1: /usr/local/server/bin/conf

2: Other...

Choice [1] : 1

Select the XML License File:

1: /usr/local/server/bin/conf/ServerLicense.xml
2: Other...

Choice [1] : 1
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Select the XML Configuration File:
1: /usr/local/server/bin/conf/ServerConfiguration.xml

2: Other...
Choice [1] : 1
Page 1 | Current Directory: /usr/local/server/bin
[00] ../
[01] 1lib/
[02] conf/
Select Server Identity Keystore [ # ] : 2
Page 1 | Current Directory: /usr/local/server/bin/conf
[00] ../
[01] server.jks
Select Server Identity Keystore [ # ] : 1
Enter password for server.jks : 123456
Is the Private Key Alias 'server' correct? [Y] : Y
Enable logging? [Y] : Y
Log File Roll Size (Kb) [512] : 512

Configured Client Services: 0
Choose an option:
1: Configure Authorization Service

2: Configure a Proof Proxy

3: Configure an Info Page

4: Configure a Push Service

5: Done Configuring Web Services
Choice [1] : 1

Configuring XACML Authorization Service

Service Port [8080] : 443
Service Context [/AuthorizationService] : /AuthorizationService
Enable WS-Security? [Y] : ¥

SOAP Signature Method:

1: RSA SHAl

2: RSA SHA256

3: RSA SHA384

4: RSA SHA512

Choice [1] : 2

Enable WS-Security Client Authentication? [N] : N
Configured Client Services: 1

Choose an option:

1: Configure Authorization Service

2: Configure a Proof Proxy

3: Configure an Info Page

4: Configure a Push Service

5: Done Configuring Web Services

Choice [1] : 5

Enable SSL? [N] : y

Service Port [8080] : 443

Enable SSL Client Authentication? [N] : N
Enable SSL? [N] : N
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Modify Advanced Performance Options? [N] : N

Writing server configuration...
Thank you for choosing Ozone Server
Goodbye.

[root@ozoneserver locall# /usr/local/server/bin/startServer.sh

13.6 OzONE ENVOY INSTALLATION

Ozone Envoy was installed and not utilized in the builds. The functions it provides, automated
CRLs and certificate collection, were not required in the solution.

Create keys and certificates and store in Java Keystore (JKS)

Install java
[root@ozoneenvoy ~]# yum install java

Install Ozone Envoy
[rootRozoneenvoy ~]# ed /usr/local/
[rootQ@Qozoneenvoy locall# tar -xzf ~/Ozone\ Envoy-2014.tar.gz

Copy the keystore to the bin directory
[root@ozoneenvoy locall# cp ~/envoy.jks envoy/bin/

Edit the envoy.txt file to set configuration options
### Ozone Suite (c) Pericore, Inc. 2007-2014.
### All rights reserved.

C
#H#
#4#4 envoy.txt - Ozone Envoy 2014 Configuration File ###

##4 ##4

### Author: Jacob Dilles <jdilles@mountaireygroup.com> ###
#H# ###

##4# Date: 1 Jan 2014 #44#

##4 ##4

##4 Notes: This is a sample Ozone Envoy 4.1.0 Setup Configuration File ###
### demonstrating configuration options for Mobile Enrollment. ###

#44 #H4

### In a production environment, you should exclude the /pass= ###

##4 properties and provide them on the command line during setup.###

#4#4 After installation is complete, this file should be deleted ###

### or 'chown root; chgrp 0; chmod 000' to secure it. ###

FHAH A R R R R
#44

### General Envoy Configuration

S i
FHEHFHHH#H###HF Identity Keystore Configuration ##########4#44
BHEHH A AR AR AR AR AR R 4
### This keystore is used for:
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### - Authenticating with Ozone Authority
### - Secure log signing
system/identity/store=envoy.jks

####4### Authority Listener Configuration

### This web service endpoint listens for push configuration and fetch
requests

### from Ozone Authority. It should match what you entered in Ozone Console

fauthority/host.name=
authority/port=4242
authority/path=/
authority/mode=ANY

### Authority Web Service Endpoint Logging
authority/log/enable=true
authority/log/path=var/log
authority/log/rollsize=10485760
authority/log/format=CLF

F A
#H#4 44444444 Enrollment Configuration ###############4
iFd st TR E TR

### Enable enrollment
enroll/enable=false

Run Ozone Envoy to complete the setup
[root@ozoneenvoy binl# ./startEnvoy.sh

May 15, 2015 3:09:04 PM
com.pericore.util.ObjectIdentifierFactory$OIDDatalLoader debug

INFO: ObjectIdentifierFactory Read 240.165 kb in 14.366 ms; Indexed 2,415
Arcs in 63.198 ms; 2,310(1,054:5) keys => 2.003 kb

May 15, 2015 3:09:06 PM com.pericore.util.PericoreProvider jsafedJCEinit
POST: [FIPS] FIPS-140 compliance self-test passed.

/ O\ /7 NN | (R)
L/ Nt/ /1 /7 N 11 NN | ||

O A T I R N O I

O O L e e I N N |
[ 2 I U T NN O B

\N_ /S NN /NN
\ // \ /o N
\ |

I o

I " NN/ N

|| LNV /)

\ [ 1IN/ N /N,

A

2014 Mobile Edition | /

Ozone (R) Envoy copyright (c) Pericore, Inc. 2007-2014

217 | NIST Cybersecurity Practice Guide SP 1800-2c



4012
4013
4014
4015
4016
4017
4018
4019
4020
4021
4022
4023
4024
4025
4026
4027
4028
4029
4030
4031

4032

4033

4034
4035
4036
4037
4038
4039
4040
4041

DRAFT

Fri May 15 15:09:04 EDT 2015
Ozone Envoy Mobile 2014 Setup Utility
Ozone Suite copyright (c) Pericore, Inc. 2007-2014.
All rights reserved.

***WARNING* * *

This product MUST be installed by a Pericore Certified Engineer.

Improper configuration of Ozone Envoy Tool may cause security
vulnerabilities.

I agree to all terms and conditions set forth by Pericore, Inc. [N]

envoy.jks

system/identity/store [/usr/local/envoy/bin/envoy.jks]
Enter password for envoy.Jjks

Is the Private Key Alias 'envoy' correct? [Y] : ¥

[POST] Starting Authority Listener: https://ozoneenvoy:4242/
>

Return to Ozone Console to complete Ozone Envoy Configuration

13.7 OzONE CONSOLE ENVOY CONFIGURATION

Create a proof to store the certificates retrieved by Ozone Envoy
1. Open Ozone Console.
Select an administrator certificate to log in as shown in Figure 169.
Select Proof>New Proof..
Enter a name for the proof.
Select the publication schedule.

Select the publication point(s).

N o u kW N

Select the distribution point(s).
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10.
11.
12.

13

15.

MNew Proof: Demain Certificates

Information | Peers | Entities | Administrators | \Usage Periods | Authentication I Attributes | Corrtacts|

==

Name

Superior Proof
ou=Applications, ou=Master Authorization Group, ou=Dzone, de=NCCOE, do=test
Description

[ Primary Schedule - ] Czone Authority LDAP

Digest Type
[Certi‘ﬁcate hd ]

Domain Certificates ) ou=Applications, ou=Master Authorization Group, ou=0zone, de=NCCOE, do=test

Schedule Publication Points Distribution Points

LDAP Distribution Point

Proof Type
@ Standard () Black List ) Gateway

Save ] [ Cancel

Figure 169. Ozone New Proof Information

Click the Administrators tab.

Select the administrators to manage the proof.
Click the Authentication tab.

Click the Add from file... button.

Select the CA and intermediate CA certificates to be used to authenticate certificates

retrieved.

. Select the Certificate Revocation Lists tab as shown in Figure 170.

14.

Enter a CRL grace period, the number of hours a CRL can be considered valid after its

next update time.

Click the Add... button to add a CRL.
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16.
17.
18.
19.
20.
21.

22.
23.

24.

25.

| Information | Peers | Entiies | Administrators | Usage Periods | Adthertication | Atibutes | Contacts |
Include Authentication Information in Proof Validate Expired Certficates
CA Certificates |} ertiicate Revocation Lisis || Source Corfiguration | PKIX Constraints |
Remove CRL lasuer This Update Nesxt Update
&l CM=Mourt Airey Group Cerificate Authority, OU=_.. | 1/20072015 723 | 2/19/2015 7:23:35 AM
Requirs unexpired CRL CRL Graceperiod hours ’ Add ] ’ e ]
| sawe | | cancel |

Figure 170. Ozone New Proof Authentication CRLs

Select the Source Configuration tab ash shown in Figure 171.
Enter hostname or IP address of the LDAP server.

Enter the port the LDAP server is listening on.

Check the box for LDAPS.

Enter the base context of where user certificates can be obtained.

Enter the attributeName for the certificates, either userCertificate or
userCertificate;binary

Enter the base context of where updated CRLs can be obtained.

Enter the attributeName for the CRLs, typically certificateRevocationList shown in Figure
156.

Enter the connection information:
e If connecting anonymously, check the box for anonymous connections.
e If a username/password is required for the connection, enter them.

Enter the number of hours after which Ozone Envoy should check the directory for new
certificates.
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MNew Proof: Domain Certificates EI@

| Information I Peers | Entities | Administrators | Usage Periods | Authertication |:°dtrib|.rtes I Corltadsl

[ Include Authentication Information in Proof [[] Validate Expired Certificates

[[] Enroliment Source

Hostname or |P Address: Port Number

152.168.10.100 385 = [[] Use secure connection
Ertity base context Attribute Name

ou=people, do=nccoe, do=test userCertificate

CRL Base Context CRL Attribute Name

ou=ca, dc=nccoe, de=test certificateRevocation List

Usemame

Connect Anorymously

Password Retype password

Refresh Time (Hours)
24 =

-

’ Save ] [ Cancel

Figure 171. Ozone New Proof Authentication Source Configuration

26. Click Save.

Configure Ozone Authority to connect to Ozone Envoy

1.

2
3.
4

Select Enrollment>Envoy Configuration.
Enter the hostname or IP address of the Ozone Envoy. See Figure 172..
Enter the port number Ozone Envoy is listening on.

Enter the number of hours that should elapse between connections to Ozone Envoy to
check for new information.

Enter the number of minutes to before attempting to reconnect to Ozone Envoy if the
connection fails.

Click Save.
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Envoy Configuration

Ervoy Hostmame or IP Address

o[- eS|
Ervvoy Part

=

ozoneenvoy| 4247 =

Envoy Connection Interval (Hours) Ernvoy Retry Interval (Minutes)
24 = 15 =

b b

[ Save ] | Cancel |

Figure 172. Ozone Envoy Configuration

The XNode was installed in the DMZ network. The Xnode is a standalone IdAM demonstration
capability including a personal identification verification (PIV) card reader, PIV Interoperability
(PIV-1) cards, keypad and electric door strike. The XNode was preconfigured to poll the IP
address of the cloud based IdAM system at the Xtec control center. No additional configuration
information is required. The identities on the PIV cards included access allowed and access
denied status for demonstration purposes.

14.1 SEecURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for
authorized devices and users

NIST 800-53 rev 4 Security Controls: AC-2, IA Family, PE-2, PE-3, PE-4, PE-5, PE-6, PE-9

15.1 OVERVIEW

The NCCoE used the GlobalSign Enterprise PKI platform to issue and manage North American
Energy Standards Board (NAESB) WEQ-12 digital certificates used for secure network access of
for both internal and external users, see Figure 173. The certificates were used in conjunction
with the MAG Ozone product to provide high assurance attributes for the Personal Profile
Application (PPA). The application has three main information groups for which actions can be
authorized: Personal Information, Credit Reports, and Criminal History. Based on the
authorizations associated with a credential, results pages are dynamically populated.
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Figure 173. GlobalSign Overview
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Systems.

The North American Energy Standards Board (NAESB) serves as an industry forum for the
development and promotion of business process standards which can lead to a seamless
marketplace for wholesale and retail natural gas and electricity, as recognized by its customers,
business community, participants, and regulatory entities. GlobalSign is an active participant of
the NAESB Cyber-Security standards committee and is a NAESB-authorized Certificate Authority

(CA). For more information about NAESB, go to https://www.naesb.org/.

GlobalSign’s NAESB-compliant certificate-based authentication solution is managed through a
Saas service accessed through a web-based portal. The web portal gives organizations control of
Digital IDs issued to individuals using one of four NIST defined assurance levels. Set-up usually
takes less than three days. Another advantage of the web-portal is that all of the lifecycle
functions including issuance, re-issuance, renewal, and revocation are available to the

administrator.
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15.1.1 Managing the Account

Managing the account is accomplished using the GlobalSign Certificate Management Center
(GCC). GCC is a web-based interface allowing you to access your certificates anywhere with an
Internet connection. Within the platform, administrators may add additional users and delegate
some or all certificate management functions.

15.1.2 What Is a Profile? / Profile Management

A profile, or certificate profile, contains the organization’s identity information that will be used
for all NAESB WEQ-12 digital certificates issued from the account. Organization identity
information includes the organization legal name, country code, and optionally locality, state,
and up to three fixed organization units as well as assurance level.

15.1.3 What Is a License?
GlobalSign NAESB digital certificates are valid for either (1) or (2) years and must be issued
within (12) months of license ordering.

GlobalSign NAESB digital certificates are sold in “license packs” (i.e., in quantities of 5, 10, 25,
50, etc.) Certificates are issued with either (1) or (2) year validities and must be issued within
(12) months of license ordering.

15.2 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for
authorized devices and users

NIST 800-53 rev 4 Security Controls: AC-2, IA Family

15.3 How To ORDER CERTIFICATES

15.3.1 Step 1: Get a GlobalSign Gee Account
Request a GlobalSign Certificate Center account here —
https://www.globalsign.com/en/verticals/energy/.

15.3.2 Step 2: Order Certificate License Pack
Once you have your GCC account credentials, use the following link to login —
www.globalsign.com/en/login/. See Figure 174.
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Ordering Certificates from GlobalSign is Quick & Easy

User Name : [
* English one byte characters
e.g) PAR™ admin
Password :
* English one byte characters
4148
4149 Figure 174. GlobalSign Login Page
4150
4151  Click on the “Enterprise PKI” tab as shown in Figure 175.
4152 ACCOUNT & FINANCE | | SSL CERTIFICATES [ MANAGED SSL. [ e I3
4153 Figure 175. GlobalSign Enterprise PKI Tab
4154

4155  Click “Order Licenses” from the left hand menu as shown in Figure 176.

El DOCUMENT, CODE
L & EMAIL SIGNING

ENTERPRISEPKI &

ACCOUNT & FINANCE SSL CERTIFICATES [J MANAGED SSL

ePKl Home

~ License Selection

MY CERTIFICATES
@ View Admin Menu

Options Enterprise PKI - Home
MY LICENSES
@ Order Licenses
© 3earch License Orders fa
MYPROFILES @ﬂ @i’} 'J
© Profile Configuration T
© Order Additional Profiles Find Licenses Configure Profile Manage Portal Edit Email Templates
9 Search Profiles
4156
4157 Figure 176. GlobalSign Order Licenses Page
4158

4159  Choose the “Enterprise PKI Pro For Personal Digital ID” license pack you intend to purchase and
4160  click next as shown in Figure 177.
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License Selection

Product Details

Personal Sign

O Enterprise PKI Pro For Personal Digital ID 5 pack
O Enterprise PKI Pro For Personal Digital ID 10 pack
O Enterprise PKI Pro For Personal Digital ID 25 pack
@® Enterprise PKI Pro For Personal Digital 1D 50 pack

4161

4162 Figure 177. GlobalSign License Selection Page

4163

4164  Choose your validity period (1 or 2 year certificate), see Figure 178.

4165
1. Product Details 2. Completed
LEMay LMl 3> Payment 3» Confirm Details
Product Details - Enterprise PKI Pro For Personal Digital ID 50 pack
Ceﬂﬂicate Valid.'rty_ Required ®1 year
Mul1.:|-year offers significant per annum 2 year
savings
Campaign Code | ||Redeem code|
If you have a Campaign Code please enter and click "Redeem Code”. This page wil be
reloaded with your appropriate discount.
Coupon Code | |Redeem code]
If you have & one-off Coupon Code for a particular promotion please enter and click
"Redeem Code”. This page will be reloaded with your appropriate discount.
TOTAL COST (inc. Tax) $0
4166
4167 Figure 178. GlobalSign Product Details

4168  Provide payment details as shown in Figure 179.

Payment Details

Purchase Order Number

Enter if you have a PO Mumber. This will be displayed in your Invoice
Payment Method ') Paymentin arrears
'® Credit Card

Credit Card Details & Billing Address
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Figure 179. GlobalSign Payment Details

Confirm your order details and check the box confirming you understand that the license pack

will expire 12 months from the order date, Figure 180.

Confirm Details

License Details

Product Enterprise PKI Pro For Personal Digital 1D 50 pack
Certificate Validity 1year

Campaign Code

Coupon Code

TOTAL COST (inc. Tax) 50

Payment Details

Purchase Order Number

Others

Special Instructions
#| paquirza | understand that this license pack will expire 12 months from the order date.

Figure 180. GlobalSign Confirm Details

15.3.3 Step 3: Set Up Organization Profile
Click “Order Additional Profiles” from the left navigation menu as shown in Figure 181.

DOCUMENT, CODE I
E EMAIL SIGNING :l

ACCOUNT & FINANCE [ SSL CERTIFICATES [ MANAGED SSL M ENTERFRISEPKI &

SREtHOm: _ License Selection

MY CERTIFICATES '

© View Admin Menu
Options Enterprise PKI - Home

MY LICENSES

© Order Licenses

© Search License Orders

MY PROFILES ( | = @l :
i g o /
— ¥ e

© Profile Configuration -
|_e order Additional Profies |
© Search Profiles

Find Licenses Configure Profile Manage Portal Edit Email Templates

Figure 181. GlobalSign Order Additional Profiles

Enter your Organization Profile details. Please note the details you enter will be vetted and

included as the certificate identity within your issued certificate, see Figure 182.
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Additionally select the Assurance level appropriate for the risk associated with the transaction.
Contact GlobalSign NAESB experts for additional guidance on this topic.

Certificate Profile Details

These details will be vetted and included as the certified identity within your issued Certificate. Make sure the details entered
are correct - we will vet the details you include. To assist you, some details will be pre-populated from previous pages or from
your GCC account details, you may overwrite these if needed.

Note. Within the form below you have the ability to define the cerfificates DistinguishedName (DN). One optional element

is a freeform Organizational Unit (OU) description. The OU field allows you to enter a value that suits your business needs with

a description such as “Marketing Team Building 5" for example. It is not mandatory to enter this but please note that

if you choose to ‘Lock a unigue OU’ then this means that the description you have chosen cannot be used again and is

unigue to this profile. An example of where you might choose to do this is for client authentication situations where each certificate
needs one or two fixed unigue strings to allow access such as ‘0" and "OU'".

Organization Required Your company legal name

Organizational Unit Opticnal unless locked as
unique

Lock a unique OU

Locality optional

State or Province optional

ColbCHeatess United States - US v
Assurance Level RUDIMENTARY
®BASIC
MEDIUM
HIGH

Figure 182. GlobalSign Certificate Profile Details

Confirm your profile details (Figure 183) and then review and accept the EPKI Service
Agreement that includes important NAESB WEQ-012 obligations. Note the EPKI Service
Agreement binds you to obligations as outlined in the GlobalSign Certificate Policy and
Certificate Practice Statements, including Local Registration Authority, end user, and relying
party, as defined in the NAESB Public Key Infrastructure (PKI) Standards — WEQ-012.

Certificate Practice Statements can be found at http://www.globalsign.com/repository/
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Confirm Details

Lock a unique OU
Organization Your company legal name

Organizational Unit

State or Province NH

Locality Portsmouth
Country United States - US
Assurance Level RUDIMENTARY

ePKI Service Agreement

GlobalSign ePKI Service Agreement - Version 2.4

Figure 183. GlobalSign Confirm Details

15.3.4 Step 4: Vetting

Once you have placed your order, all of your information will be sent to GlobalSign’s vetting
department. The organization details you provided for your profile will be vetted by GlobalSign
using third party checks.

15.3.5 Step 5: Register for Your EPKI Administrator Certificate

Once your company profile has been approved, you will need to register for what is known as
an “EPKI Administrator Certificate.” An EPKI Administrator Certificate is required to authenticate
to secure areas of the EPKI service to register and manage end user certificates.

1. Login into GCC
2. Select “View Admin Menu Options” in the left hand menu to start the enrollment
process, see Figure 184.

ACCOUNT & FINANCE [ || SSL CERTIFICATES [ MANAGED SSL [ P ENTERPRISEPKI

ePKI Home License Selection
MY CERTIFICATES

@ View Admin Menu

Options Enterprise PKI - Home

Figure 184. GlobalSign View Admin Menu Options

3. Choose a certificate password. It is very important to remember this password.
4. Download your administrator certificate and follow the on screen prompts to install your
certificate.

Please follow the guide http://www.globalsign.com/support/ordering-guides/epki-
authentication-user-guide.pdf for step-by-step instructions on how to order, install, and use
your Administrator Certificate.
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CAUTION: If you need to access the EPKI administrator menu options from multiple machines,
you can copy your .pfx file to other computers and repeat the import process. Instructions for
importing your certificate can be found here -
https://support.globalsign.com/customer/portal/articles/1211387.

15.3.6 Step 6: Register and Issue Certificates to Individual Users
Click “Order Certificates” in the left navigation menu as shown in Figure 185.

NOTE: If you haven’t already authenticated to the secure section of the portal with your
Administrator Certificate, you may see “View Admin Menu Options” instead of the menu
options included in the image below. Simply click the “View Admin Menu Options” link and
select the appropriate certificate to gain access to this section of the portal.

MANAGED SSL 3 DOCUMENT, CODE

£ EMAIL SIGNING =

ACCOUNT & FINANCE { SSL CERTIFICATES [

ENTERPRISEPKI m@

o N .
LL ' = | p
B> = o /

Cenificales
Figure 185. GlobalSign Oder Certificates

Select the profile and license you want to use and click Next, see Figure 186.

ACCOUNT & FINANCE [ $SL CERTIFICATES [ MANAGED 85L [ e

& EMAIL SIGNING

ENTERPRISEPKI m@

Product Selection

1. Product Details

EREELE ) Certificate identity Details 3  Confirm Details

Product Details
Profile

Assurance

e 0 Licenses. Profile ID BaseDN Organization Organization Unit ST

© Search License Orders
GSUS NCCoE NIST
® MPP201410132058 Disabled GMO GiobalSign Inc Energy IDaM test BASIC
account
rofiles
License

Service License Unused number

® Enterprise PKI Pro For Personal Digital ID 1 year a7

Next o

Figure 186. GlobalSign Product Selection

Complete the certificate identity details (Figure 187) for the end user of the certificate, including
the common name (i.e., the individual’s first and last name) and the email addresses.
Organization name, and other fields will be pre-populated from the profile you selected.
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Certificate Identity Details

Common Name Requied

Organization GMO GlobalSign Inc

GSUS

Organizational Unit [Profile]

NCCoE NIST Energy IDaM fest account
Organizational Unit
Locality Portsmouth
State or Province NH
Cotintry United States - US

Email Address Fequire
Option cerificate delivery method - Select only 1
| have an externally generated CSR

Check only if you are an Advance

Figure 187. GlobalSign Certificate Identity Details

You will also need to choose a “pick up password”. The pick up password is a unique password
that you will give to the end user of the certificate. After you have completed the registration
process, the end user will receive an email invitation to pick up their certificate and at that time
they will be prompted for the pick up password (you gave them in an out-of-band method)
along with details of how to install their new certificate.

Finally, confirm the details of your certificate request as shown in Figure 188.
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Confirm Details

Product Details

Profile ID MPP201410132058

License ID MPL201410133096

Certificate Identity Details

Cominon Name Julie O
Organization

Organizational Unit

Locahty Forts

State or Province NH

Country

Email Address

Encrypling File System Disabled

MS SmartCard Logon

| have an externally generated CSR

D
PKCS$12 Opfion Disabled

Memao

Figure 188. GlobalSign Confirm Details

Repeat this process until you have requested certificates for all of your end users.

For further information on the features available in your GlobalSign Certificate Center please
visit: http://www.globalsign.com/support/ordering-guides/globalsign-epki-admin-guide.pdf

15.4 GLOBALSIGN’S IDENTITY AND ACCESS MANAGEMENT SOLUTION FOR MANAGING EXTERNAL USERS

For use cases involving external users (e.g. Independent System Operators (ISOs) operating
wholesale electric marketplaces), GlobalSign PKI can provide an identity and access
management (IAM) solution that enables management of external user (customer and partner)
identities and the online services and applications they can access.

15.5 GETTING HELP

GlobalSign provides technical support through our Client Service departments around the
world. Visit https://www.support.globalsign.com for detailed instructions on installing and
managing certificates, or contact support@globalsign.com or 1-877-467-7543 with specific
questions.

A Schneider Electric (SE) industrial firewall is installed on the physical network that contains the
industrial control system/SCADA components that can be accessed and controlled via the OT
network. The firewall is configured to monitor the data passing between the RADiFlow SCADA
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firewall and the OT network. The SE industrial firewall will alert if out-of- policy traffic is
detected on the network segment connecting the OT network and the SCADA network of
devices.

Install and Configure Schneider Tofino Firewall

1. Download the ConneXium software from the Schneider site as stated in the instructions
accompanying the firewall, start the ConneXium Tofino Configurator.

2. At the startup screen, click ‘Create New Project...’, Figure 189.

ConneXium Tofino Configurator Project Selection

Create a new project or open an existing project.

1% Create Mew Project...

[== Open Project...
(]

["] Set this as the default project and do not ask again

Figure 189. Create New Project

3. In Project name, enter the name you would like to use for the project, as shown in
Figure 190. Also fill in the Company field. When finished, click Next.
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MNew Project Wizard

Create a new project.

Project Mame:  Energy - Identity and Access Management

Company: NCCof|

Figure 190. New Project Wizard

4. In the Project Protection screen, Figure 191, choose a password to protect the project.
Then click Next.
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Project Protection

Specify the project protection settings.

The new praject will be protected by:
[+] License Activation Key

[ i

Password:

Confirm Password:

Password Strength: |

4272
4273 Figure 191. Project Protection
4274 In the Administrator Password screen,
Administrator Password
Specify the project Administrator Password.
[T Use Administrater Password
Password:
Confirm Password:
Password Strength: |
IMPORTANT: You cannot use the administrator password to recover a lost project
password.
Use the administrator password feature to prevent specific changes to the project file, When
set, the administrator password will be required to mowve the project file or change the
project protection settings.
Einish ] [ Cancel
4275 5. Figure 192, choose the administrator password. Then click Finish.
4276
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Figure 192. Administrator Password

6. Inthe Project Explorer Window, Figure 193, right click ‘Tofino SAs’ and select ‘New
Tofino SA. *Note: You can also chose to create a folder for the SAs to help organize
multiple areas.

i il ConneXium Tofino Configurato

Ch~= | v| g“ # BB | (% New Folder (S New Tofino SA ) Apply (2 Verify () Firmware Update

i Project Explorer = || & Tofino SAs

4 1 Energy - Identity and Access Manager || Name Tofino ID Configuration Stat.. Type Version  General Locat...
4 @ Tofino 5As
i;‘ Discovery
> (2 Asset Templates
2 Assets
> (& Protocols
» [Z= Special Rules

Figure 193. Project Explorer Window

7. Inthe Tofino ID field, Figure 194, enter the MAC address listed on the firewall hardware
sticker. Fill out the rest of the fields as necessary. Then click Finish.
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' Tofino SA

Create a new Tofino 54

i Ll
(RN

Tofino ID: | ‘ : ‘ : ' : .

Mame: Energy - Tofino SA|

Description:

General Location:

Specific Location:

Mode; Tect -
<Back | Net> || Finsh || Cancel
4285
4286 Figure 194. Tofino SA/MAC Address
4287 8. Right click on the ‘Assets’ icon in the Project Explorer frame, Figure 195, and click ‘New

ﬁ ConneXium Tofino Configurator

| c0 oo B || B @ 5| 08 New Folder B NewAset

4288  Asset.

@ Help ~

I [ Special Rules

| -
& Project Explorer (2 Assets Figure 195
4 (3 Energy - Identity and Access Manager || Name Type Manufacturer Model General Locat...  Specific Locat... P Address Sub) .
» (8 Tofino Ss Project
I [ Asset Templates
L= Explorer
> & Protocols
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9.

In the New Asset window, Figure 196, set the name of the device, as well as the type
and all other fields as necessary. Then click Next.

(I 1
Asset
Create a new asset.
Mame: Mew Asset
Type: = Computer -
Description:
Manufacturer:
Model:

General Lecation:

Specific Location:

Asset Tag:

<Back | Ned>

J |

Finish

i

Cancel

Figure 196. New Asset
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4298 10. Fill in the IP address and/or the MAC address fields, Figure 197, then click Finish.
4299 11. Repeat steps 8-10 for all devices on the network. When they are configured, click on the
4300 ‘Assets’ icon, Figure 197, in the Project Explorer frame (if it isn’t already selected) and
4301 there should be a list of all the configured Assets.
(e - p=e)
Y~ &= ['ﬁ] '| [T S| :'5 20| % Mew Folder gNawAs;et | 9f v (T Help =
/|| @ Project Explorer g |2 Assets
4 = ES-ldAM MName ’ Type Manufacturer Model General Locat.. Specific Locat.. IP Address
> 5 Tofino SAs (3 OT - HMI Workstation  Computer VM Network  OT Network 1721666
b € Asset Templates (2 RADiFlow 3180 Metwork Equipm... RADiFlow 3180 Lab2 Ontopof rack 1721664
> | Assets| [l RaspberryPi Modbus Controller 7 7 Lab2 On Desk? 17216610
» (& Protocols [ SEL-2411 Controller Schweitzer SEL-2411 Lab2 Ontop of Met... 172.166.100

©» [# Special Rules

4302

4303 Figure 197. Project Explorer Assets Icon

4304 12. Under the Project Explorer frame, click the dropdown arrow next to ‘Tofino SAs’, then
4305 choose the SA created earlier, Figure 198. From there, click on ‘Firewall’ in the Project
4306 Explorer frame to display current firewall rules. This should be empty currently.
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(@ oo o R e

I~ & E%ﬁ‘]v|m| £ =@x|¢CraateRma |g{v®Help-

i
& Project Explorer £, Tofino SA - Firewall Mo ARP rule exists. The NetConnect LSM will not funct...thout ARP. Click here to create the default ARP rule.

i 1= ES-IdAM
| i Tofino SAs Rule Table
&2 Discovery The firewall rules configured for this Tofino SA

E-EEEC“E”S | Asset Interface  Direction Asset Inteface  Protocol Permission  Log  Type
4@ Tofina SA

] General
B Event Logger
) Firewall

(2 Asset Templates

(2 Assets

(2. Protocols

(> Special Rules

4 (1] r

Figure 198. Project Explorer Tofino SA Icon

13. To create the first rule, click on the ‘+ Create Rule’ button above the Tofino SA-Firewall
title, Figure 198, above. Then ensure the ‘Standard rule’ radio button is selected and
click ‘Next’, Figure 199.

. e .
i New Firewall Rule Wizard m- ™ EIES
— -

Rule Type

Select the type of firewall rule you want to create.

@ Standard rule
() Select a special rule type from the list below:

% Tofino Rapid Network Recovery

<Back || Ned> || Finish || Cancel
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Figure 199. Rule Type

14. On the next screen, Figure 200, there a few options to determine. First is Asset 1, you
must choose the interface. This will be where the traffic is coming from into the device.
In the Lab Build, Asset 1 is the OT Workstation, which is connected to a network that is
connect to the External interface on the firewall. Select the ‘Select an asset from the list
below’ radio button for both Asset 1 and Asset 2, and select the systems to create a rule
between. Also, select the direction of the traffic using the arrow buttons in the middle.
When finished, select Next.

[ New Firewall Rule Wizard El
Assets
Select the assets involved in this firewall rule,
Assetl Directicn BAsset 2
Interface: External Interface: Internal
© Any O Any
() IP Address: () IP Address:
7 MAC Address: ) MAC Address:
@) Select an asset from the list below: @) Select an asset from the list below:
MName IP Address MAC Address Mame IP Address MAC Address
OT - HMI Worl 172.16.6.6 00:00:00:00:00:00 OT - HMI Worl 172.16.6.6 00:00:00:00:00:00
2 RADiFlow 3180 1721664 00:00:00:00:00:00 2 RADiFlow 3180 1721664 00:00:00:00:00:00
[ RaspberryPiM 17216610 00:00:00:00:00:00 [ RaspberryPi M 17216610 00:00:00:00:00:00
[l SEL-2411 172166100 00:00:00:00:00:00 EL-2411 172166100 00:00:00:00:00:00
’ < Back H Mext = ] [ Finish l [ Cancel

Figure 200. Firewall Rule Wizard
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4324 15. On the Asset Rule Profiles, Figure 201, select the ‘Manually create the firewall rules for
4325 the selected assets’ radio button. Click Next.
r-ﬂ Nfew Firewall Rule Wizz

Asset Rule Profiles

Select whether you want to use the asset rule profiles or not.

The previously selected assets contain associated rule profiles that can be used to determine a set of firewall rules.

) Use rule profiles associated with selected assets to build firewall rules

@ Manually create the firewall rules for the selected assets

4326

4327 Figure 201. Asset Rule Profiles

4328 16. On the Protocol screen, Figure 202, choose the protocol to be checked against. There are
4329 drop down menus for ‘Common Industrial’, ‘Common IT’, and ‘Vendor Specific.” For this
4330 example, we are choosing SSH and Telnet (by holding the CTRL key, you can select

4331 multiple protocols). Then choose the Permission on the right side of the screen, as well
4332 as whether to log or not. Then click Finish.
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4333 Note: By default, any traffic that does not match the rules in the firewall will
4334 automatically be denied.
[ New Firewall Rule Wizard :— :- NI
Protocol

Select protocols, specify the permission type, and specify whether logging is enabled for this firewall rule,

Protocol Permission
== Common Industrial @ o Allow
= CommenIT ©) @ Deny
(= Vendor 5pecific () ) Enforcer
Logging

Enable Logging

Tip: Use Shift + click to select a range of protocols; use Ctrl + click to select multiple protocols out of sequence.

[ <Back | nNet> |[ Fnsh | [ Cancel
4335 Figure 202. Protocol Window
4336 17. After that is completed, the firewall rule should be listed in the Rule Table, Figure 203.
ﬁ:unne)ﬁum Tofino ...-.. ;ur- -E =] 25
iR Al=1 @'|m|-*‘[ﬁ|§i§|%CreateRule |€§{V®Help
& Project Explorer & Tofino SA - Firewall No ARP rule exists. IP traffic will not be allowed without ARP. Click here to create the default ARP rule.
4 5 ES-IdAM
[ Tofino SAs| Ll e
b {8 Asset Templates The firewall rules configured for this Tofino SA
b (B Assets ! Asset Interface Direction  Asset Interface Protocol Permission  Log  Type
b & Protocols ] 3 0T - HMI Works... External = (2 RADiFlow3180  Intemal  dp Telnet @ alow [ Stand
b @ Special Rules ] [ oT - HMI Works... Edternal 4= (2 RADiFlow 3180 Intemal @ 5SH @ alow [ Stand:
4 I 3
Rule Details

Additional options for the selected firewall rule

= General

Rate Limit: | / |second -

Burst Limit:
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4337 Figure 203. Rule Table
4338 18. Repeat steps 13 through 17 for the remainder of the rules needed.
4339 19. Finally, press the save button on the menu bar. Circled in red below in Figure 204.
E ConneXium Tofino Configurator . - - | = | EImER |1i
i - 1= | ﬁl| (el | =5 Create Rule | 97 v (F)Help ~ ;
@ iject Explnrer = i, Tofino SA - Firewall Enforcer functionality is available for the highlighted rule. Click here to change rule permission to Enforcer. |
= 55\-[:;?:'0 SAs Rule Table
g Asset Templates The firewall rules configured for this Tofino SA
5 Assets | Asset Interface Direction Asset Interface Protocel Permission  Log Type :[
2 procats . - 6 @ . O ;
& Special Rules [] HMIWorkstation [...] External — =p [ sEL-2411 Internal & MODBUS/TCP € Enforcer Stand: || §
] = % (]
| = % (5] |
| = % 5] |
O = % @ |
O = % @ |
| = @ O %
0 &= @ @ ]
[ [ - ) @ ]
4 [ [ | b
Rule Details
Additicnal options for the selected firewall rule
5 General ED Enforcer
Rate Limit: | 10000 [ |second -
Burst Lirit: | 50000
4340 L )
4341 Figure 204. Save rules in Project Explorer
4342 20. Place a FAT/FAT32 formatted USB device into the computer running the ConneXium
4343 Tofino Configurator, then right click ‘Tofino SAs’ in the Project Explorer pane and select

4344 ‘Apply.” If the project asks you to save, press ‘OK’.
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Apply Configuratic

Apply Configuration l
Select the Tofino SA(s) you want to configure and the appropriate transport method for applying the configuration,

Marme Transport Method Restrictions
I [7] (5} Energy - Tofino SA

| Check All| | Uncheck Al

) Network
@ USE Drive

Location: I

[ Use as default location

4345 21. In the Apply Configuration pane, Figure 205, ensure that your SA is selected in the table
4346 at the top, and the ‘USB Drive’ radio button is selected. Then browse to the top-level
4347 directory of your USB drive. Then click Finish.
4348 Figure 205. Apply Configuration Pane
4349 22. A popup, Figure 206, will notify you of successful completion.

lJ Loadable USE Drive Created = |

Aug 19, 2015 at 5:52:27 PM: Leadable USE drive created for:
Energy - Tofino 54

4350 . y

245 | NIST Cybersecurity Practice Guide SP 1800-2c



4351

4352
4353
4354

4355
4356
4357
4358

4359
4360
4361

4362

4363
4364
4365

4366

4367

4368

4369
4370
4371
4372
4373

4374
4375
4376
4377
4378

4379

4380
4381
4382
4383
4384

DRAFT

Figure 206. Loadable USB Drive Popup

23. Ensure the firewall has been powered on and has been running for at least one minute,
then plug the USB device used to copy the Tofino configuration to into the USB port on
the back of the firewall.

24. Press the Save/Load/Reset button twice, setting it to the Load setting (Pressing once
should turn the indicator light to green, pressing it again will change it from green to
amber). After a few seconds, the device will begin displaying lights that move from right
to left across the LEDs on the back, indicating the configuration is being loaded.

25. Once the lights stop moving right to left, wait a few seconds, and ensure the Fault LED
does not light up. Then remove the USB drive and place it back into the computer
running the ConneXium Tofino Configurator software.

26. Right click ‘Tofino SAs’ in the Project Explorer pane and select ‘Verify'.

27. At the Verify Loaded Configuration window, select the Tofino SA in the table, and select
the ‘USB Drive’ radio button. Then select the USB drive using the Browse button. Finally,
press Finish.

28. A popup will notify you of successful verification, and configuration is complete.

STIG compliance reports were generated for the STIG-compliant OS installations that were used
in the build. The reports for each installation are provided in the following subsections. Neither
the Windows 7 Console on the IT network nor the OT Management Windows 7 Workstation on
the OT network were STIG-compliant installations, so compliance reports for those OSs are not
provided.

The Linux implementations (except SUSE Linux) were configured to meet the DoD CentOS 6
STIG, because no CentOS 7 STIG was available at the time the build was implemented. The STIG
guidelines are available on-line at http://iase.disa.mil/stigs/os/Pages/index.aspx . The OS
configurations for each Linux implementation are listed below. The compliance results reports
identify the configuration items that do not conform to the STIG configuration guide.

Compliance reports are provided for the following OSs:

e SQL Server on IdAM Network STIG Compliance Report

e RSA IMG SUSE Linux Server STIG Compliance Report

e RSA Adaptive Directory Centos 7 Server STIG Compliance Report
e AlertEnterprise Microsoft Server STIG Compliance Report

e [T Domain Controller STIG Compliance Report
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e |IT Windows 7 Workstations STIG Compliance Report

e Ozone Authority and Ozone Server Centos 6 Server STIG Compliance Report
e Ozone Envoy Centos 6 Server STIG Compliance Report

e OT Domain Controller STIG Compliance Report

e OT ConsoleWorks Windows Server 2012 STIG Compliance Report

e OT Windows 7 Workstations STIG Compliance Report

e PACS Domain Controller STIG Compliance Report

e PACS Console Windows Server 2012 STIG Compliance Report

e Baseline CentOS 7 Linux Configuration

17.1 SQL SERVER ON IDAM NETWORK STIG COMPLIANCE REPORT

Status STIG ID Rule ID Vuln ID Severity  Rule Title

N/A SQL2-00- SV-53912r1_rule V-41389 CAT Il SQL Server must maintain and support organization-defined
000300 security labels on stored information.

N/A SQL2-00- SV-53914r1_rule V-41391 CAT Il SQL Server must maintain and support organization-defined
000400 security labels on information in process.

N/A SQL2-00- SV-53916r1_rule V-41392 CAT Il SQL Server must maintain and support organization-defined
000500 security labels on data in transmission.

N/A SQL2-00- SV-53917r1_rule V-41393 CAT Il SQL Server must allow authorized users to associate security labels
000900 to information in the database.

N/A SQL2-00- SV-53920r1_rule V-41395 CAT Il SQL Server must be protected from unauthorized access by
00920 developers.

N/A SQL2-00- SV-53921r1_rule V-41396 CAT Il SQL Server must be protected from unauthorized access by
009300 developers on shared production/development host systems.

PASS SQL2-00- SV-53922r2_rule V-41397 CAT Il Administrative privileges, built-in server roles and built-in database
00950 roles must be assigned to the DBMS login accounts that require

them via custom roles, and not directly.

PASS SQL2-00- SV-53918r2_rule V-41394 CAT Il SQL Server utilizing Discretionary Access Control (DAC) must
011050 enforce a policy that limits propagation of access rights.

UNKNOWN  SQL2-00- SV-53928r2_rule V-41402 CAT Il SQL Server must provide audit record generation capability for
011200 organization-defined auditable events within the database.

What is

considered

auditable?

17.2 RSA IMG SUSE LINUX SERVER STIG COMPLIANCE REPORT

OpenSCAP Evaluation Report

17.2.1 Evaluation Characteristics
Target machine dvd-acm
Benchmark URL U RedHat 6 V1R6_STIG _SCAP_1-1 Benchmark-xccdf.xml
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Performed by root

4400 17.2.2 Compliance and Scoring
4401  The target system did not satisfy the conditions of 107 rules! Furthermore, the results of 12 rules
4402  were inconclusive. Please review rule results and consider applying remediation.

4403 17.2.3 Rule Results

4404 60 passed
4405 107 failed
4406 12 other

4407  17.2.4 Severity of Failed Rules

4408 0 other
4409 53 low
4410 53 medium
4411

4412 17.2.5 Score
Scoring system Score Maximum Percent

urn:xccdf:scoring:default 33.519554  100.000000 33.52%

4413 Search
Title Severity Result
Red Hat Enterprise Linux 6 Security Technical Implementation Guide

SRG-0S-999999

Automated file system mounting tools must not be

enabled unless needed.
SRG-0S-000062

Auditing must be enabled at boot by setting a kernel

parameter.
SRG-0S-999999

The /etc/gshadow file must be owned by root. medium fail
SRG-0S-999999

The /etc/gshadow file must be group-owned by root. medium fail
SRG-0S-999999

The /etc/gshadow file must have mode 0000. medium fail
SRG-0S-999999

The system must use a separate file system for /tmp. low fail
SRG-0S-999999

The system must use a separate file system for /var. low fail
SRG-0S-999999

The system must use a separate file system for /var/log. low fail
SRG-0S-000259

Library files must be owned by root. medium fail
SRG-0S-000044

The system must use a separate file system for the

system audit data path.
SRG-0S-000045 iﬁ&l

The audit system must alert designated staff members

when the audit storage volume approaches capacity.
SRG-0S-000259

All system command files must be owned by root. medium fail
SRG-0S-999999

The system must use a separate file system for user low fail

low error

low fail

low fail

medium fail
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Title
home directories.
SRG-0S-000078
The system must require passwords to contain a minimum

of 14 characters.
SRG-0S-000075
Users must not be able to change passwords more than
once every 24 hours.
SRG-0S-000076
User passwords must be changed at least every 60 days.
SRG-0S-000071
The system must require passwords to contain at least
one numeric character.
SRG-0S-000103
The system package management tool must
cryptographically verify the authenticity of system software

ackages during installation.
SRG-0S-000232 E%El
A file integrity tool must be installed.
SRG-0S-000273
The operating system must enforce requirements for the
connection of mobile devices to operating systems.
SRG-0S-000248
There must be no .rhosts or hosts.equiv files on the
system.
SRG-0S-000249
The system must disable accounts after excessive login
failures within a 15-minute interval.
SRG-0S-999999
The /etc/shadow file must be group-owned by root.
SRG-0S-999999
The /etc/shadow file must have mode 0000.
SRG-0S-999999
IP forwarding for IPv4 must not be enabled, unless the
system is a router.
SRG-0S-000146
The operating system must prevent public IPv4 access
into an organizations internal networks, except as
appropriately mediated by managed interfaces employing
boundary protection devices.
SRG-0S-000231
The systems local IPv4 firewall must implement a deny-all,

allow-by-exception policy for inbound packets.
SRG-0S-000096 )!Eﬁl

The Datagram Congestion Control Protocol (DCCP) must
be disabled unless required.

SRG-0S-000096
The Stream Control Transmission Protocol (SCTP) must
be disabled unless required.

SRG-0S-000096
The Reliable Datagram Sockets (RDS) protocol must be

disabled unless required.
SRG-0S-000096 EE&|
The Transparent Inter-Process Communication (TIPC)

protocol must be disabled unless required.
SRG-0S-000215
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medium

medium

medium

low

medium

medium

medium

high

medium

medium

medium

medium

medium

medium

medium

medium

low

medium

fail

fail

fail

fail

fail

fail

fail

fail

fail

fail

fail

fail

error

fail

fail

fail

fail

fail

Result
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Title
The operating system must back up audit records on an
organization defined frequency onto a different system or

media than the system being audited.
SRG-0S-000043 Eﬁﬁ|

The operating system must support the requirement to

centrally manage the content of audit records generated

by organization defined information system components.
SRG-0S-000062

The audit system must be configured to audit all attempts

to alter system time through settimeofday.
SRG-0S-999999
The system must not accept IPv4 source-routed packets
on any interface.
SRG-0S-999999
The system must not accept ICMPv4 redirect packets on
any interface.
SRG-0S-999999
The system must not accept ICMPv4 secure redirect
packets on any interface.
SRG-0S-000062
The audit system must be configured to audit all attempts

to alter system time through clock settime.
SRG-0S-999999
The system must log Martian packets.
SRG-0S-999999
The system must not accept IPv4 source-routed packets
by default.
SRG-0S-000062
The audit system must be configured to audit all attempts

to alter system time through /etc/localtime.
SRG-0S-000004
The operating system must automatically audit account
creation.
SRG-0S-999999
The system must not accept ICMPv4 secure redirect
packets by default.
SRG-0S-999999
The system must ignore ICMPV4 redirect messages by
default.
SRG-0S-000239
The operating system must automatically audit account
modification.
SRG-0S5-999999
The system must not respond to ICMPv4 sent to a
broadcast address.
SRG-0S-000240
The operating system must automatically audit account

disabling actions.
SRG-0S-999999

The system must ignore ICMPv4 bogus error responses.
SRG-0S-000241 EE&|

The operating system must automatically audit account
termination.

SRG-0S-000142
The system must be configured to use TCP syncookies.
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medium

medium

low

medium

medium

medium

low

low

medium

low

low

medium

low

low

low

low

low

low

medium

fail

fail

fail

fail

fail

fail

fail

fail

fail

fail

fail

fail

fail

fail

pass

fail

fail

fail

fail

Result
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Title

SRG-0S-999999
The audit system must be configured to audit
modifications to the systems Mandatory Access Control
(MAC) configuration (SELinux).

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications
using chmod.

SRG-0S-999999
The system must use a reverse-path filter for IPv4 network

traffic when possible by default.
SRG-0S-000064

The audit system must be configured to audit all
discretionary access control permission modifications
using chown.

SRG-0S-999999
The IPv6 protocol handler must not be bound to the
network stack unless needed.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications
using fchmod.

SRG-0S-999999
The system must ignore ICMPV6 redirects by default.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications
using fchmodat.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications
using fchown.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications
using fchownat.

SRG-0S-000152
The system must employ a local IPv4 firewall.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications
using fremovexattr.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications
using fsetxattr.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications
using Ichown.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications

using Iremovexattr.
SRG-0S-000064
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low
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low

medium

low

medium

low

low

low
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low

low

low
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fail

fail
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fail

fail

fail

fail

fail

error

fail

fail

fail

fail
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Title Severity Result

The audit system must be configured to audit all
discretionary access control permission modifications low fail
using Isetxattr.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications low fail
using removexattr.

SRG-0S-000064
The audit system must be configured to audit all
discretionary access control permission modifications low fail
using setxattr.

SRG-0S-000064
The audit system must be configured to audit successful
file system mounts.

SRG-0S-000069
The system must require passwords to contain at least

one uppercase alphabetic character.
SRG-0S-000266 Ea)ﬁ|

The system must require passwords to contain at least
one special character.

SRG-0S-000070
The system must require passwords to contain at least
one lowercase alphabetic character.

SRG-0S-000072
The system must require at least four characters be
changed between the old and new passwords during a low fail

assword change.

SRG-0S-000021 Ekﬂl
The system must disable accounts after three consecutive
unsuccessful logon attempts.

SRG-0S-000120 E%El
The system must use a FIPS 140-2 approved
cryptographic hashing algorithm for generating account medium fail
password hashes (system-auth).

SRG-0S-000064
The audit system must be configured to audit user
deletions of files and programs.

SRG-0S-000120
The system must use a FIPS 140-2 approved
cryptographic hashing algorithm for generating account medium fail

assword hashes (login.defs).
SRG-0S-000120 Eﬁﬁi
The system must use a FIPS 140-2 approved
cryptographic hashing algorithm for generating account medium fail
password hashes (libuser.conf).
SRG-0S-000064
The audit system must be configured to audit changes to
the /etc/sudoers file.
SRG-0S-999999
The system boot loader configuration file(s) must be
owned by root.
SRG-0S-000064
The audit system must be configured to audit the loading

and unloading of dynamic kernel modules.
SRG-0S-999999 !Eﬁl

low fail

low fail

low fail

low fail

medium fail

low fail

low fail

medium fail

medium fail
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Title Severity Result
The system boot loader configuration file(s) must be
roup-owned by root.
SRG-0S-000096 Em
The xinetd service must be disabled if no network services
utilizing it are enabled.

SRG-0S-999999
The system boot loader configuration file(s) must have

mode 0600 or less permissive.
SRG-0S-000096 !Eﬁl

The xinetd service must be uninstalled if no network

services utilizing it are enabled.
SRG-0S-000080

The system boot loader must require authentication. medium fail
SRG-0S-000080

The system must require authentication upon booting into

single-user and maintenance modes.
SRG-0S-000080

The system must not permit interactive boot. medium fail
SRG-0S-000022

The system must require administrator action to unlock an

account locked by excessive failed login attempts.
SRG-0S-999999

The system must not send ICMPV4 redirects by default. medium fail
SRG-0S-999999

The system must not send ICMPV4 redirects from any

interface.
SRG-0S-000096

The ypbind service must not be running. medium error
SRG-0S-999999

The cron service must be running. medium fail
SRG-0S-999999

The avahi service must be disabled. low error
SRG-0S-000056

The system clock must be synchronized continuously, or

at least daily.
SRG-0S-999999

The system must set a maximum audit log file size. medium fail
SRG-0S-000062

The audit system must be configured to audit all attempts

to alter system time through adjtimex.
SRG-0S-999999

The system must retain enough rotated audit logs to cover

the required log retention period.
SRG-0S-000096

The atd service must be disabled. low error
SRG-0S-999999

The system default umask for daemons must be 027 or

022.
SRG-0S-999999

The system default umask in /etc/login.defs must be 077. low fail
SRG-0S-999999

The system default umask in /etc/profile must be 077. low fail
SRG-0S-999999

The system default umask for the csh shell must be 077. low fail
SRG-0S-000096

medium fail

medium error

medium fail

low fail

medium fail

medium fail

medium fail

medium error

low fail

medium fail

low fail
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Title Severity

The rdisc service must not be running. low
SRG-0S-999999

The system default umask for the bash shell must be 077. low
SRG-0S-999999

The postfix service must be enabled for mail delivery. low
SRG-0S-000096

The netconsole service must be disabled unless required. low
SRG-0S-000248

X Windows must not be enabled unless required. medium
SRG-0S-999999

Process core dumps must be disabled unless needed. low
SRG-0S-000027

The system must limit users to 10 simultaneous system

logins, or a site-defined number, in accordance with low

operational requirements.
SRG-0S-000160 Eﬁﬁl
The system must provide VPN connectivity for
communications over untrusted networks.
SRG-0S-000024
A login banner must be displayed immediately prior to, or
as part of, graphical desktop environment login prompts.
SRG-0S-000034
The Bluetooth service must be disabled. medium
GENO006660
Accounts must be locked upon 35 days of inactivity. low
SRG-0S-000118
The operating system must manage information system
identifiers for users and devices by disabling the user
identifier after an organization defined time period of
inactivity.
SRG-0S-999999
All public directories must be owned by a system account. low
SRG-0S-999999
The system must use a Linux Security Module configured
to enforce limits on system services.
SRG-0S-999999
The system must use a Linux Security Module configured

to limit the privileges of system services.
SRG-0S5-999999 Eﬂﬁ|

The operating system, upon successful logon/access,
must display to the user the number of unsuccessful
logon/access attempts since the last successful
logon/access.

SRG-0S-999999
The audit system must switch the system to single-user
mode when available audit storage volume becomes medium
dangerously low.

low

medium

low

medium

low

medium

17.3 RSA ADAPTIVE DIRECTORY CENTOS 7 SERVER STIG COMPLIANCE REPORT

XCCDF Test Result

Introduction
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4418  Test Result

Result ID Profile Start time End time  Benchmark Benchmark
version
xccdf_org.open- (Default 2015-04-08 | 2015-04-08
scap_testresult_default-profile profile) 08:16 08:17 embedded 1
4419  Target info
Targets Addresses Platforms
e  adaptivedir e 127.00.1 e cpe:/o:redhat:enterprise_linux:6

e 172.16.43
e 0:0:0:0:0:0:0:1
e e80:0:0:0:250:56ff:fe89:8965

4420 Score

system
urn:xccdf:scoring:default 96.65 100.00 96.65%

4421  17.3.1 Rule Results Summary

. . not not not . .
pass fixed fail error . informational unknown total
selected checked applicable
a3 ] 0o /6 J 0o /. 0l 0ol 0o | 0 [ 0 179
Title Result

Auditing must be enabled at boot by setting a kernel parameter. fail
The audit system must be C(_)nfigured to audit modifications to the systems Mandatory Access Control fail
(MAC) configuration (SELinux).

The system boot loader configuration file(s) must be owned by root. fail
The system boot loader configuration file(s) must be group-owned by root. fail
The system boot loader configuration file(s) must have mode 0600 or less permissive. fail
The system boot loader must require authentication. fail

4423

4424 17.4 ALERTENTERPRISE MICROSOFT SERVER STIG COMPLIANCE REPORT

4425  Non-Compliance Report - U_Windows_2008 R2_MS V1R15 STIG_SCAP_1-0 Benchmark

Vi9 I3 SCAP Compliance Checker - 3.1.2

4427 Score | System Information | Stream Information | Results | Detailed Results
4428  Score
O Adjusted Score: 30.04%
Original Score: 30.04%
O Compliance Status: RED
[ ]
4429
Pass: 79 Not Applicable: 0 BLUE: Score equals 100
Fail: 184 Not Checked: 0 GREEN: Score is greater than or equal to 90
Error: 0O Not Selected: 0 YELLOW: Score is greater than or equal to 80
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4460
4461
4462
4463
4464
4465
4466
4467
4468
4469
4470
4471
4472
4473
4474
4475
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Unknown: 0 Total: 263 RED: Score is greater than or equal to 0
System Information

Target: WIN-IPERGL2ELUD

Operating System: Windows Server 2008 R2 Standard
OS Service Pack:

Results

e  Unsupported Service Packs
o  Systems must be at supported service pack (SP) or release levels. - Fail

Legal Notice Display
o Therequired legal notice will be configured to display before console logon. - (CCE-10673-2) - Fail

e  Caching of logon credentials
o  Caching of logon credentials will be limited. - (CCE-10926-4) - Fail
e Anonymous shares are not restricted
o  Anonymous enumeration of shares will be restricted. - (CCE-10557-7) - Fail
e  Bad Logon Attempts
o  The number of allowed bad-logon attempts will meet minimum requirements. - (CCE-11046-0) - Fail
e  Bad Logon Counter Reset
O  The time before the bad-logon counter is reset will meet minimum requirements. - (CCE-11059-3) - Fail
e  Lockout Duration
o  The lockout duration will meet minimum requirements. - (CCE-10399-4) - Fail
e  Rename Built-in Guest Account
o  The built-in guest account will be renamed. - (CCE-10747-4) - Fail
e Rename Built-in Administrator Account
o  The built-in administrator account will be renamed. - (CCE-10976-9) - Fail
e  LanMan Authentication Level
o  The LanMan authentication level will be set to Send NTLMv2 response only\refuse LM & NTLM. - (CCE-10984-3)
- Fail
e  Deny Access from the Network
o  The Deny access to this computer from the network user right on member servers must be configured to
prevent access from highly privileged domain accounts and local administrator accounts on domain systems
and unauthenticated access on all systems. - (CCE-10733-4) - Falil

Smart Card Removal Option
O  The Smart Card removal option will be configured to Force Logoff or Lock Workstation. - (CCE-10573-4) - Fail
e  Format and Eject Removable Media
O  Ejection of removable NTFS media is not restricted to Administrators. - (CCE-10637-7) - Fail
e  Password Expiration Warning
o  Users will be warned in advance that their passwords will expire. - (CCE-10930-6) - Fail
Disable Media Autoplay
o  Autoplay will be disabled for all drives. - (CCE-11126-0) - Fail
e  Anonymous Access to Named Pipes
o Named pipes that can be accessed anonymously will be configured to contain no values. - (CCE-10944-7) - Fail
e  Remote Assistance - Solicit Remote Assistance
o  Solicited Remote Assistance will not be allowed. - (CCE-11723-4) - Fail
e  Undock Without Logging On
o A system must be logged on to before removing from a docking station. - (CCE-10883-7) - Fail

e  Storage of Passwords and Credentials
O  The system will be configured to prevent the storage of passwords and credentials - (CCE-10292-1) - Fail
e  Force Logoff When Logon Hours Expire
o  The system will be configured to force users to log off when their allowed logon hours expire. - (CCE-10588-2) -
Fail
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e  Session Security for NTLM SSP Based Clients

o  The system will be configured to meet the minimum session security requirement for NTLM SSP based clients. -
(CCE-10035-4) - Fail

FIPS Compliant Algorithms

O  The system will be configured to use FIPS-compliant algorithms for encryption, hashing, and signing. - (CCE-
10789-6) - Fail

TS/RDS - Session Limit

o Remote Desktop Services will limit users to one remote session. - (CCE-12016-2) - Fail

TS/RDS - Password Prompting

o  Remote Desktop Services will always prompt a client for passwords upon connection. - (CCE-11299-5) - Fail

TS/RDS - Set Encryption Level

o  Remote Desktop Services will be configured with the client connection encryption set to the required level. -
(CCE-11677-2) - Fail

TS/RDS - Do Not Use Temp Folders

o  Remote Desktop Services will be configured to use session-specific temporary folders. - (CCE-10669-0) - Fail

TS/RDS - Delete Temp Folders

o  Remote Desktop Services will delete temporary folders when a session is terminated. - (CCE-12046-9) - Fail

TS/RDS - Time Limit for Disc. Session

O  Remote Desktop Services will be configured to set a time limit for disconnected sessions. - (CCE-11117-9) - Fail

TS/RDS - Time Limit for Idle Session

O  Remote Desktop Services will be configured to disconnect an idle session after the specified time period. - (CCE-
11506-3) - Fail

e  Remote Assistance - Offer Remote Assistance
O  The system will be configured to prevent unsolicited remote assistance offers. - (CCE-11625-1) - Fail

e  Error Reporting - Report Errors

O  The system will be configured to prevent automatic forwarding of error information. - (CCE-11750-7) - Fail

Safe DLL Search Mode

o  The system will be configured to use Safe DLL Search Mode. - (CCE-10772-2) - Fail

Media Player - Disable Automatic Updates

o  Media Player must be configured to prevent automatic checking for updates. - (CCE-11298-7) - Fail

e  Session Security for NTLM SSP based Servers

O  The system will be configured to meet the minimum session security requirement for NTLM SSP based servers. -
(CCE-10040-4) - Fail

Audit Log Warning Level

o  The system will generate an audit event when the audit log reaches a percent full threshold. - (CCE-11011-4) -
Fail

Disable IP Source Routing

O  The system will be configured to prevent IP source routing. - (CCE-10732-6) - Fail

e  Disable ICMP Redirect

o  The system will be configured to prevent ICMP redirects from overriding OSPF generated routes. - (CCE-10518-
9) - Fail

Disable Router Discovery

o  The system will be configured to disable the Internet Router Discover Protocol (IRDP). - (CCE-10768-0) - Fail

e  TCP Connection Keep-Alive Time
O  The system will be configured to limit how often keep-alive packets are sent. - (CCE-10381-2) - Fail

e  Name-Release Attacks
O  The system will be configured to ignore NetBIOS name release requests except from WINS servers. - (CCE-

10653-4) - Fail

e  TCP Data Retransmissions
o  The system will limit how many times unacknowledged TCP data is retransmitted. - (CCE-10941-3) - Fail

e  Screen Saver Grace Period
O  The system will be configured to have password protection take effect within a limited time frame when the

screen saver becomes active. - (CCE-10019-8) - Fail

e  Remotely Accessible Registry Paths and Sub-Paths

o Unauthorized remotely accessible registry paths and sub-paths will not be configured. - (CCE-10935-5) - Fail
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e  Strong Key Protection
o  Users will be required to enter a password to access private keys. - (CCE-11035-3) - Fail
Optional Subsystems
o  Optional Subsystems will not be permitted to operate on the system. - (CCE-10913-2) - Falil
e  Software Restriction Policies
o  Software certificate restriction policies will be enforced. - (CCE-10900-9) - Fail
TS/RDS - Secure RPC Connection.
o  The Remote Desktop Session Host will require secure RPC communications. - (CCE-11368-8) - Fail
e  Group Policy - Registry Policy Processing
o  Group Policy objects will be reprocessed even if they have not changed. - (CCE-12754-8) - Fail
SMB Client Packet Signing (Always)
o  The Windows SMB client will be enabled to always perform SMB packet signing. - (CCE-10970-2) - Fail
e  Minimum Password Length
o  For systems utilizing a logon ID as the individual identifier, passwords will, at a minimum, be 14 characters. -
(CCE-10372-1) - Fail
e Display of Last User Name
o  The system will be configured to prevent the display of the last user name on the logon screen. - (CCE-10788-8)
- Fail
Audit Policy Subcategory Setting
o  Audit policy using subcategories will be enabled. - (CCE-10112-1) - Falil
IPSec Exemptions
o IPSec Exemptions will be limited. - (CCE-10018-0) - Fail
UAC - Admin Approval Mode
o  User Account Control approval mode for the built-in Administrator will be enabled. - (CCE-11028-8) - Fail
UAC - Admin Elevation Prompt
o  User Account Control will, at a minimum, prompt administrators for consent. - (CCE-11023-9) - Fail
e  UAC - User Elevation Prompt
o  User Account Control will automatically deny standard user requests for elevation. - (CCE-10807-6) - Fail
e  Enumerate Administrator Accounts on Elevation
o  The system will require username and password to elevate a running application. - (CCE-11450-4) - Fail
TS/RDS - Prevent Password Saving
o  Passwords will not be saved in the Remote Desktop Client. - (CCE-11905-7) - Fail
TS/RDS - Drive Redirection
O  Local drives will be prevented from sharing with Remote Desktop Session Hosts (Remote Desktop Services
Role). - (CCE-11709-3) - Fail
RPC - Unauthenticated RPC Clients
o  Unauthenticated RPC clients will be restricted from connecting to the RPC server. - (CCE-10881-1) - Fail
RPC - Endpoint Mapper Authentication
o  Client computers will be required to authenticate for RPC communication. - (CCE-10715-1) - Fail
e Internet Download / Online Ordering
o  Web publishing and online ordering wizards will be prevented from downloading a list of providers. - (CCE-
11136-9) - Fail
e  Printing Over HTTP
o  Printing over HTTP will be prevented. - (CCE-11360-5) - Fail
HTTP Printer Drivers
o  Downloading print driver packages over HTTP will be prevented. - (CCE-11563-4) - Fail
e  Windows Update Device Drive Searching
o  Windows will be prevented from using Windows Update to search for drivers. - (CCE-10357-2) - Fail
IPv6 Transition
o IPv6 will be disabled until a deliberate transition strategy has been implemented. - Fail
e  Windows Peer to Peer Networking
o  Windows Peer-to-Peer networking services will be turned off. - (CCE-11604-6) - Fail
Prohibit Network Bridge
o  Network Bridges will be prohibited in Windows. - (CCE-12074-1) - Fail
Root Certificates Update
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o  Root Certificates will not be updated automatically from the Microsoft site. - (CCE-11264-9) - Fail
e  Event Viewer Events.asp Links
o  Event Viewer Events.asp links will be turned off. - (CCE-10693-0) - Fail
e Internet File Association Service
o The Internet File Association service will be turned off. - (CCE-10697-1) - Fail
Order Prints Online
o  The Order Prints Online wizard will be turned off. - (CCE-11243-3) - Fail
e  (Classic Logon
o  The classic logon screen will be required for user logons. - (CCE-11256-5) - Fail
RSS Attachment Downloads
o  Attachments will be prevented from being downloaded from RSS feeds. - Fail
e  Windows Explorer — Shell Protocol Protected Mode
o  Windows Explorer shell protocol will run in protected mode. - (CCE-11530-3) - Fail
e  Windows Installer — IE Security Prompt
o  Users will be notified if a web-based program attempts to install software. - (CCE-10343-2) - Fail
e  Windows Installer — User Control
o  Users will be prevented from changing installation options. - (CCE-10906-6) - Fail
e  Windows Installer — Vendor Signed Updates
o  Non-administrators will be prevented from applying vendor signed updates. - (CCE-11468-6) - Falil
Media Player — First Use Dialog Boxes
O  Users will not be presented with Privacy and Installation options on first use of Windows Media Player. - (CCE-
11596-4) - Fail
e  Network — Mapper I/O Driver
o  The Mapper I/0 network protocol driver will be disabled. - (CCE-10484-4) - Fail
Network — Responder Driver
O  The Responder network protocol driver will be disabled. - (CCE-11304-3) - Fail
Network — WCN Wireless Configuration
O  The configuration of wireless devices using Windows Connect Now will be disabled. - (CCE-11242-5) - Fail
e  Network — Windows Connect Now Wizards
o  The Windows Connect Now wizards will be disabled. - (CCE-11155-9) - Fail
e Device Install — PnP Interface Remote Access
o Remote access to the Plug and Play interface will be disabled for device installation. - (CCE-11248-2) - Fail
e Device Install — Drivers System Restore Point
o A system restore point will be created when a new device driver is installed. - (CCE-10546-0) - Fail
e  Device Install — Generic Driver Error Report
O An Error Report will not be sent when a generic device driver is installed. - (CCE-12274-7) - Fail
e  Driver Install — Device Driver Search Prompt
o  Users will not be prompted to search Windows Update for device drivers. - (CCE-11319-1) - Fail
e  Handwriting Recognition Error Reporting
o  Errors in handwriting recognition on Tablet PCs will not be reported to Microsoft. - (CCE-11030-4) - Fail
e  Power Mgmt — Password Wake on Battery
o  Users will be prompted for a password on resume from sleep (on battery). (Applicable to Server 2008 R2 if the
system is configured to sleep.) - (CCE-12088-1) - Fail
e  Power Mgmt — Password Wake When Plugged In
o  The user will be prompted for a password on resume from sleep (Plugged In). (Applicable on Server 2008 R2 if
the system is configured to sleep.) - (CCE-11651-7) - Fail
e  Remote Assistance — Session Logging
o  Remote Assistance log files will be generated. - (CCE-11263-1) - Fail
e  Game Explorer Information Downloads
o  Game explorer information will not be downloaded from Windows Metadata Services. - (CCE-11739-0) - Fail
e  Error Reporting — Logging
o  Error Reporting events will be logged in the system event log. - (CCE-11621-0) - Fail
e  Error Reporting — Windows Error Reporting
o  Windows Error Reporting to Microsoft will be disabled. - (CCE-11708-5) - Fail
e  Error Reporting — Additional Data
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o Additional data requests in response to Error Reporting will be declined. - (CCE-11584-0) - Fail

e  Windows Explorer — Heap Termination
o  Windows Explorer heap termination on corruption will be disabled. - (CCE-10981-9) - Fail

e  Logon - Report Logon Server

o  Users will be notified if the logon server was inaccessible and cached credentials were used. - (CCE-12260-6) -
Fail

Media DRM - Internet Access

o  Windows Media Digital Rights Management will be prevented from accessing the Internet. - (CCE-11052-8) -
Fail

TS/RDS — COM Port Redirection

O  The system will be configured to prevent users from mapping local COM ports and redirecting data from the
Remote Desktop Session Host to local COM ports. (Remote Desktop Services Role) - (CCE-10600-5) - Fail

TS/RDS - LPT Port Redirection

o  The system will be configured to prevent users from mapping local LPT ports and redirecting data from the
Remote Desktop Session Host to local LPT ports. (Remote Desktop Services Role) - (CCE-11623-6) - Fail

TS/RDS - PNP Device Redirection

O  The system will be configured to prevent users from redirecting Plug and Play devices to the Remote Desktop
Session Host. (Remote Desktop Services Role) - (CCE-11128-6) - Fail

TS/RDS — Smart Card Device Redirection

o  The system will be configured to ensure smart card devices can be redirected to the Remote Desktop Session.
(Remote Desktop Services Role) - (CCE-11517-0) - Fail

TS/RDS - Printer Redirection

O  The system will be configured to allow only the default client printer to be redirected in the Remote Desktop
session. (Remote Desktop Services Role) - (CCE-10977-7) - Fail

TS/RDS — Remove Disconnect Option

o  The system will be configured to remove the Disconnect option from the Shut Down Windows dialog box on the
Remote Desktop Client. (Remote Desktop Services Role) - (CCE-11997-4) - Fail

e  Windows Customer Experience Improvement Program
o  The Windows Customer Experience Improvement Program will be disabled. - (CCE-11354-8) - Fail

e  SPN Target Name Validation Level
o  The service principal name (SPN) target name validation level will be turned off. - (CCE-10617-9) - Fail

e  Computer Identity Authentication for NTLM

o  Services using Local System that use negotiate when reverting to NTLM authentication will use the computer
identity vs. authenticating anonymously. - (CCE-10817-5) - Fail

NTLM NULL Session Fallback

o NTLM will be prevented from falling back to a Null session. - (CCE-10812-6) - Fail

PKU2U Online Identities Authentication

O  PKU2U authentication using online identities will be prevented. - (CCE-10839-9) - Fail

e  Kerberos Encryption Types
o Kerberos encryption types will be configured to prevent the use of DES encryption suites. - (CCE-10843-1) - Fail

e  |Pv6 Source Routing

o  IPv6 source routing will be configured to highest protection. - (CCE-10888-6) - Fail

IPv6 TCP Data Retransmissions

o  IPv6 TCP data retransmissions will be configured to prevent resources from becoming exhausted. - (CCE-10804-
3) - Fail

Elevate when setting a network’s location

o Domain users will be required to elevate when setting a network’s location. - (CCE-11610-3) - Fail

e  Direct Access — Route Through Internal Network
o  All Direct Access traffic will be routed through the internal network. - (CCE-11300-1) - Fail

e  Windows Update Point and Print Driver Search
o  Windows Update will be prevented from searching for point and print drivers. - (CCE-11976-8) - Falil

e  Prevent device metadata retrieval from Internet
o  Device metadata retrieval from the Internet will be prevented. - (CCE-11589-9) - Fail

e  Prevent Windows Update for device driver search
o  Device driver searches using Windows Update will be prevented. - (CCE-11787-9) - Fail
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MSDT Interactive Communication
o  Microsoft Support Diagnostic Tool (MSDT) interactive communication with Microsoft will be prevented. - (CCE-
10855-5) - Fail
e  Windows Online Troubleshooting Service
o  Access to Windows Online Troubleshooting Service (WOTS) will be prevented. - (CCE-11161-7) - Fail
Disable PerfTrack
o  Responsiveness events will be prevented from being aggregated and sent to Microsoft. - (CCE-11889-3) - Fail
e  Application Compatibility Program Inventory
o  The Application Compatibility Program Inventory will be prevented from collecting data and sending the
information to Microsoft. - (CCE-11043-7) - Fail
Autoplay for non-volume devices
o  Autoplay will be turned off for non-volume devices. - (CCE-11375-3) - Falil
Turn Off Game Updates
o Downloading of game update information will be turned off. - (CCE-11807-5) - Fail
e  Prevent Joining Homegroup
o  The system will be prevented from joining a homegroup. - (CCE-10691-4) - Fail
e  Windows Anytime Upgrade
o  Windows Anytime Upgrade will be disabled. - (CCE-10544-5) - Fail
e  Explorer Data Execution Prevention
o  Explorer Data Execution Prevention will be enabled. - (CCE-12161-6) - Fail
Default Autorun Behavior
o  The default autorun behavior will be configured to prevent autorun commands. - (CCE-11431-4) - Fail
e  Legal Banner Dialog Box Title
o  The Windows dialog box title for the legal banner will be configured. - (CCE-10010-7) - Fail
e Access this computer from the network
o  Unauthorized accounts will not have the "Access this computer from the network" user right. - (CCE-10086-7) -
Fail
Adjust memory quotas for a process
o  Unauthorized accounts will not have the "Adjust memory quotas for a process" user right. - (CCE-10849-8) - Fail
Allow log on locally
o Unauthorized accounts will not have the "Allow log on locally" user right. - (CCE-10853-0) - Fail
Back up files and directories
o  Unauthorized accounts will not have the "Back up files and directories" user right. - (CCE-10880-3) - Fail
e  Bypass traverse checking
o  Unauthorized accounts will not have the "Bypass traverse checking" user right. - (CCE-10369-7) - Fail
Change the system time
o  Unauthorized accounts will not have the "Change the system time" user right. - (CCE-10122-0) - Fail
Change the time zone
o  Unauthorized accounts will not have the "Change the time zone" user right. - (CCE-10897-7) - Falil
e Deny log on as a batch job
O  The Deny log on as a batch job user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems and unauthenticated access on all systems. - (CCE-10596-5) -
Fail
e Deny log on as service
o The Deny log on as a service user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. -
(CCE-10226-9) - Fail
e  Deny log on locally
o  The Deny log on locally user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems and unauthenticated access on all systems. - (CCE-10750-8) -
Fail
Deny log on through Remote Desktop \ Terminal Services
O  The Deny log on through Remote Desktop Services user right on member servers must be configured to prevent
access from highly privileged domain accounts and local administrator accounts on domain systems and
unauthenticated access on all systems. - (CCE-10878-7) - Fail
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e  Force shutdown from a remote system
o Unauthorized accounts will not have the "Force shutdown from a remote system" user right. - (CCE-10785-4) -
Fail
e  Generate security audits
o  Unauthorized accounts will not have the "Generate security audits" user right. - (CCE-10274-9) - Fail
e Impersonate a client after authentication
o  Unauthorized accounts will not have the "Impersonate a client after authentication" user right. - (CCE-9946-5) -
Fail
® Increase a process working set
o  Unauthorized accounts will not have the "Increase a process working set" user right. - (CCE-10548-6) - Fail
Load and unload device drivers
o  Unauthorized accounts will not have the "Load and unload device drivers" user right. - (CCE-10202-0) - Fail
e Logon as a batch job
o Unauthorized accounts will not have the "Log on as a batch job" user right. - (CCE-10549-4) - Fail
o  Replace a process level token
o  Unauthorized accounts will not have the "Replace a process level token" user right. - (CCE-10599-9) - Fail
Restore files and directories
o Unauthorized accounts will not have the "Restore files and directories" user right. - (CCE-10805-0) - Fail
Shut down the system
o  Unauthorized accounts will not have the "Shut down the system" user right. - (CCE-10439-8) - Fail
Audit - Credential Validation - Failure
o  The system will be configured to audit "Account Logon > Credential Validation" failures. - Fail
Audit - Computer Account Management - Failure
o  The system will be configured to audit "Account Management > Computer Account Management" failures. - Fail
Audit - Other Account Management Events - Success
o  The system will be configured to audit "Account Management > Other Account Management Events" successes.
- Fail
Audit - Other Account Management Events - Failure
o  The system will be configured to audit "Account Management > Other Account Management Events" failures. -
Fail
Audit - Security Group Management - Failure
o  The system will be configured to audit "Account Management > Security Group Management" failures. - Fail
Audit - User Account Management - Success
Audit - User Account Management - Failure
o  The system will be configured to audit "Account Management > User Account Management" failures. - Fail
Audit - Process Creation - Success
o  The system will be configured to audit "Detailed Tracking > Process Creation" successes. - Fail
Audit - File System - Failure
o  The system will be configured to audit "Object Access > File System" failures. - Fail
Audit - Registry - Failure
o  The system will be configured to audit "Object Access > Registry" failures. - Fail
Audit - Audit Policy Change - Failure
o  The system will be configured to audit "Policy Change > Audit Policy Change" failures. - Fail
Audit - Sensitive Privilege Use - Success
o  The system will be configured to audit "Privilege Use > Sensitive Privilege Use" successes. - Fail
Audit - Sensitive Privilege Use - Failure
o  The system will be configured to audit "Privilege Use > Sensitive Privilege Use" failures. - Fail
Audit - IPSec Driver - Success
O  The system will be configured to audit "System > IPSec Driver" successes. - Fail
Audit - IPSec Driver - Failure
O  The system will be configured to audit "System > IPSec Driver" failures. - Fail
Audit - Security State Change - Failure
o  The system will be configured to audit "System > Security State Change" failures. - Fail
Audit - Security System Extension - Success
o  The system will be configured to audit "System > Security System Extension" successes. - Fail
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Audit - Security System Extension - Failure

o  The system will be configured to audit "System > Security System Extension" failures. - Fail

6to4 State

O  The 6to4 IPv6 transition technology will be disabled. - (CCE-11356-3) - Fail

IP-HTTPS State

O  The IP-HTTPS IPv6 transition technology will be disabled. - (CCE-10832-4) - Fail

ISATAP State

o  The ISATAP IPv6 transition technology will be disabled. - (CCE-11141-9) - Fail

e  Teredo State
o The Teredo IPv6 transition technology will be disabled. - (CCE-11865-3) - Fail

e  Maximum Log Size - Application
O  The Application event log will be configured to a minimum size requirement. - (CCE-11143-5) - Fail

e  Maximum Log Size - Security
o  The Security event log will be configured to a minimum size requirement. - (CCE-11033-8) - Fail

e  Maximum Log Size - Setup
o  The Setup event log will be configured to a minimum size requirement. - (CCE-11717-6) - Fail

e  Maximum Log Size - System
o  The System event log will be configured to a minimum size requirement. - (CCE-11174-0) - Fail

e  Device Install Software Request Error Report
o  Windows will be prevented from sending an error report when a device driver requests additional software

during installation. - (CCE-11336-5) - Fail

e  Always Install with Elevated Privileges Disabled

o  The Windows Installer Always install with elevated privileges must be disabled. - (CCE-12401-6) - Fail

Local admin accounts filtered token policy enabled on domain systems.

o  Local administrator accounts must have their privileged token filtered to prevent elevated privileges from being
used over the network on domain systems. - Fail

WINCC-000078

o  The Enhanced Mitigation Experience Toolkit (EMET) system-wide Address Space Layout Randomization (ASLR)
must be enabled and configured to Application Opt In. - Fail

WINCC-000079

o The Enhanced Mitigation Experience Toolkit (EMET) Default Protections for Internet Explorer must be enabled. -
Fail

WINCC-000080

O  The Enhanced Mitigation Experience Toolkit (EMET) Default Protections for Recommended Software must be
enabled. - Fail

WINCC-000081

o The Enhanced Mitigation Experience Toolkit (EMET) Default Protections for Popular Software must be enabled.
- Fail

e  WINCC-000082

o  The Enhanced Mitigation Experience Toolkit (EMET) system-wide Data Execution Prevention (DEP) must be
enabled and configured to at least Application Opt Out. - Fail

WINCC-000083

o The Enhanced Mitigation Experience Toolkit (EMET) system-wide Structured Exception Handler Overwrite
Protection (SEHOP) must be configured to Application Opt Out. - Fail

e  WINGE-000100

O  The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. -
Fail

WINGE-000200

o  Agroup named DenyNetworkAccess must be defined on domain systems to include all local administrator
accounts. - Fail
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17.5 IT DOMAIN CONTROLLER STIG COMPLIANCE REPORT

Non-Compliance Report - U_Windows2012_DC_V1R3_STIG_SCAP_1-1_Benchmark

SCAP Compliance Checker - 3.1.2

Score | System Information | Stream Information | Results | Detailed Results
Score

0 Adjusted Score: 91.13%
Original Score: 91.13%
° 0 Compliance Status: GREEN

Pass: 267 Not Applicable: 0 BLUE: Score equals 100
Fail: 26 Not Checked: 0 GREEN: Score is greater than or equal to 90
Error: 0O Not Selected: 0 YELLOW: Score is greater than or equal to 80

Unknown: 0 Total: 293 RED: Score is greater than or equal to 0
System Information

Target: ITDC

Operating System: Windows Server 2012 R2 Standard
OS Service Pack:

Domain: ES-IDAM-B1

Results

e  Bad Logon Attempts
o  The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail
e  Force Logoff When Logon Hours Expire
O  The system must be configured to force users to log off when their allowed logon hours expire. - (CCE-25367-4)
- Fail
LDAP Signing Requirements
o  Domain controllers must require LDAP access signing. - (CCE-23587-9) - Fail
e  Computer Account Password Change
o  Domain controllers must be configured to allow reset of machine account passwords. - (CCE-24692-6)
- Fail
e  Remotely Accessible Registry Paths and Sub-Paths
O  Unauthorized remotely accessible registry paths and sub-paths must not be configured. - (CCE-25426-8) - Fail
e  Minimum Password Length
o  Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail
e  Media DRM - Internet Access
e  Software Certificate Installation Files
o  Software certificate installation files must be removed from a system. - Fail
e Legal Banner Dialog Box Title
o  The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail
e Access this computer from the network
O Unauthorized accounts must not have the Access this computer from the network user right on domain
controllers. - Fail

Allow log on locally
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o  Unauthorized accounts must not have the Allow log on locally user right. - (CCE-25228-8) - Fail
Back up files and directories
o  Unauthorized accounts must not have the Back up files and directories user right. - (CCE-25380-7) - Fail
e  Bypass traverse checking
O  Unauthorized accounts must not have the Bypass traverse checking user right. - (CCE-25271-8) - Fail
Change the system time
o  Unauthorized accounts must not have the Change the system time user right. - (CCE-24185-1) - Fail
Change the time zone
o Unauthorized accounts must not have the Change the time zone user right. - (CCE-24632-2) - Fail
Force shutdown from a remote system
o  Unauthorized accounts must not have the Force shutdown from a remote system user right. - (CCE-24734-6) -
Fail
® Increase a process working set
o  Unauthorized accounts must not have the Increase a process working set user right. - (CCE-24162-0) - Fail
e Increase scheduling priority
e  Load and unload device drivers
o Unauthorized accounts must not have the Load and unload device drivers user right. - (CCE-24779-1) - Fail
e Logon as a batch job
o  Unauthorized accounts must not have the Log on as a batch job user right. - (CCE-23386-6) - Fail
Restore files and directories
o Unauthorized accounts must not have the Restore files and directories user right. - (CCE-25518-2) - Fail
Shut down the system
o Unauthorized accounts must not have the Shut down the system user right. - (CCE-23500-2) - Fail
Add workstations to domain
o  Unauthorized accounts must not have the Add workstations to domain user right. - (CCE-23271-0) - Fail
Audit Directory Service Access - Success
O  The system must be configured to audit DS Access - Directory Service Access successes. - Fail
Audit - Directory Service Access - Failure
O  The system must be configured to audit DS Access - Directory Service Access failures. - Fail
Audit - Directory Service Changes - Success
o  The system must be configured to audit DS Access - Directory Service Changes successes. - Fail
Audit - Directory Service Changes - Failure
o  The system must be configured to audit DS Access - Directory Service Changes failures. - Fail
e  WINGE-000100
O  The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. -
Fail

17.6 1T WINDOWS 7 WORKSTATIONS STIG COMPLIANCE REPORT

Non-Compliance Report - U_Windows_7_V1R23_STIG_SCAP_1-0_Benchmark

SCAP Compliance Checker - 3.1.2
Score | System Information | Stream Information | Results | Detailed Results

Score

0 Adjusted Score: 94.72%
Original Score: 94.72%
° 0 Compliance Status: GREEN
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4932

4933
4934
4935
4936
4937
4938
4939
4940
4941
4942
4943
4944
4945
4946
4947
4948
4949
4950
4951
4952
4953

DRAFT

Pass: 251 Not Applicable: 0 BLUE: Score equals 100
Fail: 14 Not Checked: 0 GREEN: Score is greater than or equal to 90
Error: 0O Not Selected: 0 YELLOW: Score is greater than or equal to 80
Unknown: 0 Total: 265 RED: Score is greater than or equal to 0

System Information

Target:

Operating System:
OS Service Pack:
Domain:

Processor:

Processor Architecture:

Processor Speed:
Physical Memory:
Manufacturer:
Model:

Serial Number:
BIOS Version:

Interfaces:

Results

e Legal Notice Display
o  Therequired legal notice must be configured to display before console logon. - (CCE-8973-0) - Fail
e  Bad Logon Attempts
o Number of allowed bad-logon attempts does not meet minimum requirements. - (CCE-9136-3) - Fail

ITWORKS1

Windows 7 Enterprise

Service Pack 1

ES-IDAM-B1

Intel(R) Xeon(R) CPU E5-2660 0 @ 2.20GHz
Intel64 Family 6 Model 45 Stepping 7

2200 MHz

6144 mb

VMware, Inc.

VMware Virtual Platform

VMware-42 09 b3 57 32 50 16 c6-cb 47 45 dd e3 a9 68 f1

6.00

e  [00000007] Intel(R) PRO/1000 MT Network Connection
o 172.16.5.6
o 00:50:56:89:A2:29

e  Secure Print Driver Installation
o  Print driver installation privilege is not restricted to administrators. - (CCE-9026-6) - Fail

e  Deny Access from the Network

O  The Deny access to this computer from the network user right on workstations must be configured to prevent
access from highly privileged domain accounts and local administrator accounts on domain systems and

unauthenticated access on all systems. - (CCE-9244-5) - Fail
e  Force Logoff When Logon Hours Expire

o The system is not configured to force users to log off when their allowed logon hours expire. - (CCE-9704-8) -

Fail

e  Minimum Password Length

o  For systems utilizing a logon ID as the individual identifier, passwords must be a minimum of 14 characters in

length. - (CCE-9357-5) - Fail

TS/RDS - Remote User Connections
o Terminal Services / Remote Desktop Services - Prevent users from connecting using Terminal Services or

Remote Desktop. - (CCE-9985-3) - Fail
e  Unnecessary Features Installed
O  Unnecessary features are installed. - Fail
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4954 e Denylogon as a batch job

4955 o The Deny log on as a batch job user right on workstations must be configured to prevent access from highly
4956 privileged domain accounts on domain systems and unauthenticated access on all systems. - (CCE-9212-2) - Fail
4957 e Deny log on as service

4958 o The Deny log on as a service user right on workstations must be configured to prevent access from highly
4959 privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. -
4960 (CCE-9098-5) - Fail

4961 e Denylogon locally

4962 o  The Deny log on locally user right on workstations must be configured to prevent access from highly privileged
4963 domain accounts on domain systems and unauthenticated access on all systems. - (CCE-9239-5) - Fail

4964 e Deny log on through Remote Desktop \ Terminal Services

4965 o  The Deny log on through Remote Desktop Services user right on workstations must prevent all access if RDS is
4966 not used by the organization. If RDS is used, it must be configured to prevent access from highly privileged
4967 domain accounts and local administrator accounts on domain systems and unauthenticated access on all
4968 systems. - (CCE-9274-2) - Fail

4969 e  Enable accounts to be trusted for delegation

4970 e WINGE-000100

4971 o  The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. -
4972 Fail

4973 e  WINGE-000200

4974 o  Agroup named DenyNetworkAccess must be defined on domain systems to include all local administrator
4975 accounts. - Fail

4976

4977 17.7 OzONE AUTHORITY AND OZONE SERVER CENTOS 6 SERVER STIG COMPLIANCE REPORT

4978  XCCDF Test Result

4979 17.7.1 Introduction
4980  Test Result

Result ID Profile Start time End time  Benchmark Benchmark
version
xccdf_org.open- (Default 2015-04-08 | 2015-04-08
scap_testresult_default-profile profile) 07:58 07:59 embedded 1
4981  Target info
Targets Addresses Platforms
e localhost.localdomain e 127.0.0.1 e cpe:/o:redhat:enterprise_lint

172.16.4.11

[ ]
e 0:0:0:0:0:0:0:1
e fe80:0:0:0:250:56ff:fe89:76dd

4982 Score

system
urn:xccdf:scoring:default 95.53 100.00 95.53%

4983  17.7.2 Rule Results Summary

not not not
selected checked | applicable
171 0 8 0 0 0 0 0 0 179

informational unknown total

pass fixed fail error
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Title Result

Auditing must be enabled at boot by setting a kernel parameter. fail
Library files must be owned by root. fail
The audit system must be cpnfigured to audit modifications to the systems Mandatory Access Control fail
(MAC) configuration (SELinux).

The system boot loader configuration file(s) must be owned by root. fail
The system boot loader configuration file(s) must be group-owned by root. fail
The system boot loader configuration file(s) must have mode 0600 or less permissive. fail
The system boot loader must require authentication. fail
The system must provide VPN connectivity for communications over untrusted networks. fail

4985

4986 17.8 OzONE ENVOY CENTOS 6 SERVER STIG COMPLIANCE REPORT

4987  XCCDF Test Result

4988 17.8.1 Introduction
4989  Test Result

Result ID Profile Start time End time  Benchmark Benchmark
version
xccdf_org.open- (Default 2015-04-08 | 2015-04-08
scap_testresult_default-profile profile) 08:02 08:03 embedded 1
4990 Target info
Targets Addresses Platforms
e localhost.localdomain e 127.0.0.1 e cpe:/o:redhat:enterprise_lint

172.16.4.12

[ ]
e (0:0:0:0:0:0:0:1
e fe80:0:0:0:250:56ff:fe89:980a

4991 Score

system
urn:xccdf:scoring:default 96.09 100.00 96.09%

4992  17.8.2 Rule Results Summary

. . not not not . .
pass fixed fail error  ected  checked applicable informational unknown  total
a2/ 0o /7 J 0o J 0o [ 0 | 0 | 0 [ 0 179
Title Result
Auditing must be enabled at boot by setting a kernel parameter. fail
The audit system must be cpnfigured to audit modifications to the systems Mandatory Access Control fail
(MAC) configuration (SELinux).
The system boot loader configuration file(s) must be owned by root. fail
The system boot loader configuration file(s) must be group-owned by root. fail
The system boot loader configuration file(s) must have mode 0600 or less permissive. fail
The system boot loader must require authentication. fail
The system must provide VPN connectivity for communications over untrusted networks. fail
4994
4995
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http://172.16.33.88:9080/AlertEnterprise/#ruleresult-idp59061600
http://172.16.33.88:9080/AlertEnterprise/#ruleresult-idp59061600
https://www.globalsign.com/en/login#ruleresult-idp59247648
http://www.globalsign.com/repository/#ruleresult-idp59258336
http://iase.disa.mil/stigs/os/Pages/index.aspx#ruleresult-idp59589392
http://nccoe.nist.gov/#ruleresult-idp44525104
http://www.globalsign.com/support/ordering-guides/epki-authentication-user-guide.pdf#ruleresult-idp44899232
http://www.globalsign.com/support/ordering-guides/epki-authentication-user-guide.pdf#ruleresult-idp44899232
http://www.cisco.com/c/en/us/td/docs/security/ise/1-4/installation_guide/b_ise_InstallationGuide14/b_ise_InstallationGuide14_chapter_0100.html#ruleresult-idp45063904
https://support.ca.com/#ruleresult-idp45074592
https://access.redhat.com/documentation/en-US/JBoss_Enterprise_Application_Platform/6.3/html/Installation_Guide/Install_JBoss_Enterprise_Application_Platform_6_Microsoft_Windows_Service.html#ruleresult-idp45085280

4996

4997

4998
4999

5000

5001

5002

5003

5004
5005
5006
5007
5008
5009
5010
5011
5012
5013
5014
5015
5016
5017
5018
5019
5020
5021
5022
5023
5024
5025
5026

DRAFT

17.9 OT DOMAIN CONTROLLER STIG COMPLIANCE REPORT

Non-Compliance Report - U_Windows2012_DC_V1R3_STIG_SCAP_1-1_Benchmark

SCAP Compliance Checker - 3.1.2
Score | System Information | Stream Information | Results | Detailed Results

Score

O Adjusted Score: 91.13%
Original Score: 91.13%
° O Compliance Status: GREEN

Pass: 267 Not Applicable: 0 BLUE: Score equals 100
Fail: 26 Not Checked: 0 GREEN: Score is greater than or equal to 90
Error: 0O Not Selected: 0 YELLOW: Score is greater than or equal to 80

Unknown: 0 Total: 293 RED: Score is greater than or equal to 0
System Information

Target: OTDC

Operating System: Windows Server 2012 R2 Standard
OS Service Pack:

Domain: OT-ES-IDAM-B1

Results

e  Bad Logon Attempts
o  The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail
e B
e  Force Logoff When Logon Hours Expire
O  The system must be configured to force users to log off when their allowed logon hours expire. - (CCE-25367-4)
- Fail
LDAP Signing Requirements
o  Domain controllers must require LDAP access signing. - (CCE-23587-9) - Fail
e  Computer Account Password Change
o  Domain controllers must be configured to allow reset of machine account passwords. - (CCE-24692-6) - Fail
e  Remotely Accessible Registry Paths and Sub-Paths
O  Unauthorized remotely accessible registry paths and sub-paths must not be configured. - (CCE-25426-8) - Fail
e  Minimum Password Length
o  Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail
e  Software Certificate Installation Files
o  Software certificate installation files must be removed from a system. - Fail
Legal Banner Dialog Box Title
o  The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail
Access this computer from the network
O  Unauthorized accounts must not have the Access this computer from the network user right on domain
controllers. - Fail

e  Adjust memory quotas for a process
Allow log on locally
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5027
5028
5029
5030
5031
5032
5033
5034
5035
5036
5037
5038
5039
5040
5041
5042
5043
5044
5045
5046
5047
5048
5049
5050
5051
5052
5053
5054
5055
5056
5057
5058
5059
5060
5061
5062

5063

5064
5065

5066
5067

5068
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o  Unauthorized accounts must not have the Allow log on locally user right. - (CCE-25228-8) - Fail
Allow log on through Remote Desktop Services
Back up files and directories
o  Unauthorized accounts must not have the Back up files and directories user right. - (CCE-25380-7) - Fail
e  Bypass traverse checking
O  Unauthorized accounts must not have the Bypass traverse checking user right. - (CCE-25271-8) - Fail
Change the system time
o  Unauthorized accounts must not have the Change the system time user right. - (CCE-24185-1) - Fail
e  Change the time zone
o  Unauthorized accounts must not have the Change the time zone user right. - (CCE-24632-2) - Fail
e  Force shutdown from a remote system
o  Unauthorized accounts must not have the Force shutdown from a remote system user right. - (CCE-24734-6) -
Fail
® Increase a process working set
o  Unauthorized accounts must not have the Increase a process working set user right. - (CCE-24162-0) - Fail
e Load and unload device drivers
o Unauthorized accounts must not have the Load and unload device drivers user right. - (CCE-24779-1) - Fail
e Logon as a batch job
o  Unauthorized accounts must not have the Log on as a batch job user right. - (CCE-23386-6) - Fail
Restore files and directories
o Unauthorized accounts must not have the Restore files and directories user right. - (CCE-25518-2) - Fail
Shut down the system
o Unauthorized accounts must not have the Shut down the system user right. - (CCE-23500-2) - Fail
Add workstations to domain
o  Unauthorized accounts must not have the Add workstations to domain user right. - (CCE-23271-0) - Fail
Audit Directory Service Access - Success
O  The system must be configured to audit DS Access - Directory Service Access successes. - Fail
e  Audit - Directory Service Access - Failure
O  The system must be configured to audit DS Access - Directory Service Access failures. - Fail
Audit - Directory Service Changes - Success
o  The system must be configured to audit DS Access - Directory Service Changes successes. - Fail
Audit - Directory Service Changes - Failure
o  The system must be configured to audit DS Access - Directory Service Changes failures. - Fail
e  WINGE-000100
O  The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. -
Fail

17.10 OT CONSOLEWORKS WINDOWS SERVER 2012 STIG COMPLIANCE REPORT

Non-Compliance Report - U_Windows2012_MS_V1R3_STIG_SCAP_1-1_Benchmark

SCAP Compliance Checker - 3.1.2
Score | System Information | Stream Information | Results | Detailed Results

Score
0 Adjusted Score: 97.13%
Original Score: 97.13%
0 Compliance Status: GREEN
[ ]
Pass: 271 Not Applicable: 0 BLUE: Score equals 100
Fail: 8 Not Checked: 0 GREEN: Score is greater than or equal to 90
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5069

5070

5071
5072
5073
5074
5075
5076
5077
5078
5079
5080
5081
5082
5083
5084
5085
5086
5087
5088
5089
5090
5091
5092
5093
5094

DRAFT

Error: O
Unknown: 0

Not Selected: 0

YELLOW: Score is greater than or equal to 80

Total: 279 RED: Score is greater than or equal to 0

System Information

Target:

Operating System:
OS Service Pack:
Domain:

Processor:

Processor Architecture:

Processor Speed:
Physical Memory:
Manufacturer:
Model:

Serial Number:
BIOS Version:

Interfaces:

Results

e  Bad Logon Attempts
o  The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail

OT-CONSOLEWORKS

Windows Server 2012 R2 Standard

OT-ES-IDAM-B1

Intel(R) Xeon(R) CPU E5-2660 0 @ 2.20GHz

Intel64 Family 6 Model 45 Stepping 7

2200 MHz

8192 mb

VMware, Inc.

VMware Virtual Platform

VMware-42 09 c2 cc c1 37 31 5¢-2d 94 63 96 80 d2 05 fe

6.00

e  [00000010] Intel(R) 82574L Gigabit Network Connection
o 172.16.6.8
o 00:50:56:89:56:86

e  Force Logoff When Logon Hours Expire

o The system must be configured to force users to log off when their allowed logon hours expire. - (CCE-25367-4)

- Fail

e  Minimum Password Length
o  Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail

Legal Banner Dialog Box Title

o  The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Falil
e  Deny log on as a batch job

o The Deny log on as a batch job user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems, and from unauthenticated access on all systems. - (CCE-25215-

5) - Fail

Deny log on as service
o The Deny log on as a service user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. -

(CCE-23117-5) - Fail

8) - Fail
WINGE-000100

o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. -

Fail

Deny log on locally
o The Deny log on locally user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems, and from unauthenticated access on all systems. - (CCE-24460-
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5096

5097
5098

5099

5100

5101

5102

5103
5104

5105
5106

5107

DRAFT

17.11 OT WINDOWS 7 WORKSTATIONS STIG COMPLIANCE REPORT

Non-Compliance Report - U_Windows_7_V1R23_STIG_SCAP_1-0_Benchmark

SCAP Compliance Checker - 3.1.2
Score | System Information | Stream Information | Results | Detailed Results

Score

O Adjusted Score: 95.47%
Original Score: 95.47%
° O Compliance Status: GREEN

Pass: 253 Not Applicable: 0 BLUE: Score equals 100
Fail: 12 Not Checked: 0 GREEN: Score is greater than or equal to 90
Error: 0O Not Selected: 0 YELLOW: Score is greater than or equal to 80

Unknown: 0 Total: 265 RED: Score is greater than or equal to 0
System Information

Target: OTWORKS1

Operating System: Windows 7 Enterprise

OS Service Pack: Service Pack 1

Domain: OT-ES-IDAM-B1

Processor: Intel(R) Xeon(R) CPU E5-2660 0 @ 2.20GHz

Processor Architecture: | Intel64 Family 6 Model 45 Stepping 7

Processor Speed: 2200 MHz

Physical Memory: 4096 mb

Manufacturer: VMware, Inc.

Model: VMware Virtual Platform

Serial Number: VMware-42 09 49 1e Oa 42 38 8e-03 d2 8f e6 31 25 5a 63

BIOS Version: 6.00

Interfaces: e  [00000007] Intel(R) PRO/1000 MT Network Connection
o 172.16.6.6

o 00:50:56:89:0B:7A

Results

e Legal Notice Display
o Therequired legal notice must be configured to display before console logon. - (CCE-8973-0) - Falil

e  Bad Logon Attempts
o Number of allowed bad-logon attempts does not meet minimum requirements. - (CCE-9136-3) - Falil

e  Secure Print Driver Installation
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o  Print driver installation privilege is not restricted to administrators. - (CCE-9026-6) - Fail
e  Deny Access from the Network
O  The Deny access to this computer from the network user right on workstations must be configured to prevent
access from highly privileged domain accounts and local administrator accounts on domain systems and
unauthenticated access on all systems. - (CCE-9244-5) - Fail
e  Force Logoff When Logon Hours Expire
o The system is not configured to force users to log off when their allowed logon hours expire. - (CCE-9704-8) -
Fail
e  Minimum Password Length
o  For systems utilizing a logon ID as the individual identifier, passwords must be a minimum of 14 characters in
length. - (CCE-9357-5) - Fail
e Deny log on as a batch job
o The Deny log on as a batch job user right on workstations must be configured to prevent access from highly
privileged domain accounts on domain systems and unauthenticated access on all systems. - (CCE-9212-2) - Fail
e Deny log on as service
o The Deny log on as a service user right on workstations must be configured to prevent access from highly
privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. -
(CCE-9098-5) - Fail
e  Deny log on locally
o  The Deny log on locally user right on workstations must be configured to prevent access from highly privileged
domain accounts on domain systems and unauthenticated access on all systems. - (CCE-9239-5) - Fail
e Deny log on through Remote Desktop \ Terminal Services
o  The Deny log on through Remote Desktop Services user right on workstations must prevent all access if RDS is
not used by the organization. If RDS is used, it must be configured to prevent access from highly privileged
domain accounts and local administrator accounts on domain systems and unauthenticated access on all
systems. - (CCE-9274-2) - Fail
e  WINGE-000100
O  The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. -
Fail
WINGE-000200
o  Agroup named DenyNetworkAccess must be defined on domain systems to include all local administrator
accounts. - Fail

17.12 PACS DOMAIN CONTROLLER STIG COMPLIANCE REPORT

SCAP Compliance Checker - 3.1.2

Score | System Information | Stream Information | Results | Detailed Results
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Score

91.47 %

Pass: 268 Not Applicable:
Fail: 25 Not Checked:

Error:0  Not Selected: 0

Unknown: 0

System Information

Target:

Operating System:

OS Service Pack:

Domain:

Stream Information

PACS-ES-IDAM-B1

Adjusted Score: 91.47 %
Original Score: 91.47 %
Compliance Status: GREEN

Score equals 100
Score is greater than or equal to 90

YELLOW: Score is greater than or equal to 80

Total: 293 RED: Score is greater than or equal to 0

Windows Server 2012 R2 Standard

Release Info « Release: 3 Benchmark Date: 28 Oct 2014

Stream: U_Windows2012_DC_V1R3_STIG_SCAP_1-1_Benchmark

Title: Windows Server 2012 / 2012 R2 Domain Controller Security Technical Implementation Guide

Description: The Windows Server 2012 / 2012 R2 Domain Controller Security Technical Implementation Guide (STIG) is published as a

tool to improve the security of Department of Defense (DoD) information systems. Comments or proposed revisions to this
document should be sent via e-mail to the following address:
disa.letterkenny.FSO.mbx.stig-customer-support-mailbox@ mail.mil.

Notice: Developed_by_DISA_for_the_DoD

Target « cpe:/o:microsoft:windows_server_2012:-
Platforms:

Identity true

Authenticated:

5141
5142 Detailed Results

5143 1.  Bad Logon Attempts - The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail
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5145
5146
5147
5148
5149
5150
5151
5152
5153
5154
5155
5156
5157
5158
5159
5160
5161
5162
5163
5164
5165
5166
5167
5168
5169
5170
5171
5172
5173
5174
5175
5176
5177
5178

5179

5180

5181
5182

5183

5184

5185
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2. Force Logoff When Logon Hours Expire - The system must be configured to force users to log off when their allowed logon hours
expire. - (CCE-25367-4) - Fail

3. LDAP Signing Requirements - Domain controllers must require LDAP access signing. - (CCE-23587-9) - Fail

4.  Computer Account Password Change - Domain controllers must be configured to allow reset of machine account passwords. -
(CCE-24692-6) - Fail

5.  Remotely Accessible Registry Paths and Sub-Paths - Unauthorized remotely accessible registry paths and sub-paths must not be
configured. - (CCE-25426-8) - Fail

6.  Minimum Password Length - Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail

7.  Legal Banner Dialog Box Title - The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail

8.  Access this computer from the network - Unauthorized accounts must not have the Access this computer from the network user
right on domain controllers. - Fail

9.  Allow log on locally - Unauthorized accounts must not have the Allow log on locally user right. - (CCE-25228-8) - Fail

10. Back up files and directories - Unauthorized accounts must not have the Back up files and directories user right. - (CCE-25380-7) - Fail

11. Bypass traverse checking - Unauthorized accounts must not have the Bypass traverse checking user right. - (CCE-25271-8) - Fail

12. Change the system time - Unauthorized accounts must not have the Change the system time user right. - (CCE-24185-1) - Fail

13. Change the time zone - Unauthorized accounts must not have the Change the time zone user right. - (CCE-24632-2) - Fail

14. Force shutdown from a remote system Unauthorized accounts must not have the Force shutdown from a remote system user right. -
(CCE-24734-6) - Fail

15. Increase a process working set - Unauthorized accounts must not have the Increase a process working set user right. - (CCE-24162-0)
- Fail

16. Load and unload device drivers - Unauthorized accounts must not have the Load and unload device drivers user right. -
(CCE-24779-1) - Falil

17. Log on as a batch job - Unauthorized accounts must not have the Log on as a batch job user right. - (CCE-23386-6) - Fail

18. Restore files and directories - Unauthorized accounts must not have the Restore files and directories user right. - (CCE-25518-2) - Fail

19. Shut down the system - Unauthorized accounts must not have the Shut down the system user right. - (CCE-23500-2) - Fail

20. Add workstations to domain - Unauthorized accounts must not have the Add workstations to domain user right. - (CCE-23271-0) - Fail

21. Audit Directory Service Access - Success - The system must be configured to audit DS Access - Directory Service Access successes. -
Fail

22. Audit - Directory Service Access - Failure - The system must be configured to audit DS Access - Directory Service Access failures. - Fail

23. Audit - Directory Service Changes - Success - The system must be configured to audit DS Access - Directory Service Changes
successes. - Fail

24. Audit - Directory Service Changes - Failure - The system must be configured to audit DS Access - Directory Service Changes failures. -
Fail

25. WINGE-000100 - The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - Fail

17.13 PACS CONSOLE WINDOWS SERVER 2012 STIG COMPLIANCE REPORT

Non-Compliance Report - U_Windows2012_MS_V1R3_STIG_SCAP_1-1_Benchmark

SCAP Compliance Checker - 3.1.2
Score | System Information | Stream Information | Results | Detailed Results

Score

O Adjusted Score: 96.06%
Original Score: 96.06%
® 0 Compliance Status: GREEN

Pass: 268 Not Applicable: 0 BLUE: Score equals 100
Fail: 11 Not Checked: 0 GREEN: Score is greater than or equal to 90
Error: 0O Not Selected: 0 YELLOW: Score is greater than or equal to 80

Unknown: 0 Total: 279 RED: Score is greater than or equal to 0
System Information
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Target:

Operating System:
OS Service Pack:
Domain:
Processor:
Processor Architecture:
Processor Speed:
Physical Memory:
Manufacturer:
Model:

Serial Number:
BIOS Version:

Interfaces:

Results

e  Bad Logon Attempts
o  The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail

PACS-CONSOLE

Windows Server 2012 R2 Standard

PACS-ES-IDAM-B1

Intel(R) Xeon(R) CPU E5-2660 0 @ 2.20GHz

Intel64 Family 6 Model 45 Stepping 7

2200 MHz

8192 mb

VMware, Inc.

VMware Virtual Platform

VMware-42 09 dc 00 da 26 44 78-07 ea f5 33 59 b9 af 46

6.00

e  [00000010] Intel(R) 82574L Gigabit Network Connection
o 172.16.7.11
o  00:50:56:89:F8:E0

e  Force Logoff When Logon Hours Expire

O  The system must be configured to force users to log off when their allowed logon hours expire. - (CCE-25367-4)

- Fail

e  Minimum Password Length
o  Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail
e Legal Banner Dialog Box Title

o  The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail

Adjust memory quotas for a process
O  Unauthorized accounts must not have the Adjust memory quotas for a process user right. - (CCE-25112-4) - Fail

e  Bypass traverse checking

o Unauthorized accounts must not have the Bypass traverse checking user right. - (CCE-25271-8) - Fail

e  Deny log on as a batch job

o The Deny log on as a batch job user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems, and from unauthenticated access on all systems. - (CCE-25215-

5) - Fail

e Deny log on as service

o The Deny log on as a service user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. -

(CCE-23117-5) - Fail

e  Deny log on locally

o  The Deny log on locally user right on member servers must be configured to prevent access from highly
privileged domain accounts on domain systems, and from unauthenticated access on all systems. - (CCE-24460-

8) - Fail

e  Replace a process level token

O  Unauthorized accounts must not have the Replace a process level token user right. - (CCE-24555-5) - Fail

e  WINGE-000100
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5247
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5249
5250
5251
5252
5253

5254
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o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. -
Fail

17.14 BASELINE CENTOS 7 LINUX CONFIGURATION

How To STIG/Configure Centos 7
Install fresh Centos 7 server image, using Minimal Install. The following are assumptions in the
installation:

e Separate partitions for /var, /var/log, /var/log/audit, /tmp, /home
e Networking is configured for your network

yum update -y

yum install wget openscap-utiles aide libreswan iptables-service ntp
mkdir {reports,xml}

cd xml

wget http://iase.disa.mil/stigs/Documents/u RedHat 6 VIR6 STIG SCAP 1-
1 Benchmark.zip

unzip u RedHat*

Run Initial Test

oscap xccdf eval --report ../reports/report.html --cpe *cpe-
dictionary.xml *Benchmark-xccdf.xml

python -m SimpleHTTPServer
Go to http://<Centos 7 IP Address>:8000/ to view the results of the STIG test

1. Next add the following files to the following locations:
e rules_d-audit.rules > /etc/audit/rules.d/audit.rules
e audit.rules > fetc/audit/audit.rules
e audit.conf > fetc/audit/audit.conf
e system-auth > /etc/pam.d/system-auth
e system-au0 0 * * * root /sbin/aide -checkth-ac > /etc/pam.d/system-auth-ac
e sysctl.conf > Jetc/sysctl.conf
e password-auth-ac > /etc/pam.d/password-auth-ac
e iptables > /etc/sysconfig/iptables
2. Next edit the following files:
1. In /etc/logindefs add/change variables to:
PASS MIN LEN 14
PASS MIN DAYS 1
PAS S:MAX:DAY S 60

2. Add the following to /etc/crontab:
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5255 o 00***root /sbin/aide -check

5256 3. In /etc/modprobe.d/disabled.conf (create if doesn't exist), add:
5257 install usb-storage /bin/false

5258 install dccp /bin/false

5259 install sctp /bin/false

5260 install rds /bin/false

5261 install tipc /bin/false

5262 install ipv6 /bin/false

5263 4. Remove any line in /etc/securetty that starts with 'vc' or 'ttyS'
5264 5. Add to /etc/rsyslog.conf

5265 * . * @Q@<any remote syslog server IP address>:514

5266 6. Add to /etc/sysconfig/init

5267 SINGLE=/sbin/sulogin
5268 PROMPT=no

5269 7. Edit fetc/ntp.conf

5270 o place '#'in front of any line that starts with 'server'

5271 ° Add'server tick.usno.navy.mil'

5272 8. For all files /etc/csh.cshrc, /etc/profile, /etc/login.defs, and /etc/bashrc

5273 o Change any 'umask' line to 'umask 077' and any 'UMASK' line to 'UMASK 077'
5274 9. Add to /etc/inittab

5275 id:3:initdefault:

5276 10. Add to /etc/security/limits.conf

5277 * hard core 0
5278 * hard maxlogins 0

5279 11. Edit /etc/default/useradd

5280 o Change 'INACTIVE=-1' to 'INACTIVE=35'

5281 12. yum remove firewalld

5282 13. chkconfig ntpd on

5283 14. service ntpd start

5284 15. In -sf /lib/systemd/system/multi-user.target /etc/systemd/system/default.target

5285  17.14.1 Baseline CentOS 7 Configuration Files
5286 1. Audit.rules file contents:

5287 2. Audit.conf file contents:

5288 3. iptables file contents:

5289 4. Password_auth-ac file contents
5290 5. rules_d-audi.rules file contents
5291 6. Sysctl.conf files contents

5292 7. system-auth file contents

5293 8. system-auth-ac file contents
5294
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5298
5299
5300
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5302
5303
5304
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5309
5310
5311
5312
5313
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5316
5317
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5329
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5337
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5339
5340
5341
5342
5343
5344
5345
5346
5347
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17.14.2 Audit.rules File Contents
#

# This file controls the configuration of the audit daemon

#

log file = /var/log/audit/audit.log
log format = RAW

log group = root

priority boost = 4

flush = INCREMENTAL

freqg = 20

num logs = 5

disp gos = lossy

dispatcher = /sbin/audispd

name format = NONE

##name = mydomain

max log file = 6

max log file action = ROTATE

space left = 75

space left action = email

action mail acct = root

admin_ space left = 50

admin space left action = SINGLE
disk full action = SUSPEND

disk error action = SUSPEND

##tcp listen port =
tcp listen queue =
tcp max per addr =
##tcp client ports 10
tcp client max idle = 0
enable krb5 = no

krb5 principal = auditd
##krb5 key file = /etc/audit/audit.key

I = o

24-65535

17.14.3 Audit.conf File Contents
#

# This file controls the configuration of the audit daemon

#

log file = /var/log/audit/audit.log
log format = RAW

log group = root

priority boost = 4

flush = INCREMENTAL

freqg = 20

num logs = 5

disp gos = lossy

dispatcher = /sbin/audispd
name format = NONE

##name = mydomain
max log file = 6

max log file action = ROTATE
space left = 75
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space left action = email

action mail acct = root

admin_ space left = 50

admin space left action = SINGLE
disk full action = SUSPEND

disk error action = SUSPEND
##tcp listen port =

tcp listen queue = 5

tcp max per addr =1

##tcp client ports = 1024-65535
tcp client max idle = 0

enable krb5 = no

krb5 principal = auditd
##krb5 key file = /etc/audit/audit.key

17.14.4 iptables File Contents

# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015
*nat

:PREROUTING ACCEPT [219:23061]

:INPUT ACCEPT [2:120]

:OUTPUT ACCEPT [125:7804]

:POSTROUTING ACCEPT [125:7804]

:OUTPUT direct - [0:0]
:POSTROUTING ZONES - [0:0]
:POSTROUTING ZONES SOURCE - [0:0]
:POSTROUTING direct - [0:0]
:POST public - [0:0]

:POST public _allow - [0:0]

:POST public deny - [0:0]

:POST public log - [0:0]

: PREROUTING ZONES - [0:0]

: PREROUTING ZONES SOURCE - [0:0]
:PREROUTING direct - [0:0]

:PRE public - [0:0]

:PRE public allow - [0:0]

:PRE public deny - [0:0]

:PRE public log - [0:0]

—-A PREROUTING -j PREROUTING direct

-A PREROUTING -j PREROUTING ZONES SOURCE

—-A PREROUTING -j PREROUTING ZONES

—-A OUTPUT -3j OUTPUT direct

—-A POSTROUTING -3j POSTROUTING direct

—-A POSTROUTING -3j POSTROUTING ZONES SOURCE
—-A POSTROUTING -3j POSTROUTING ZONES

—-A POSTROUTING ZONES -o ensl60 —-g POST public
-A POSTROUTING ZONES -g POST public

—-A POST public -3j POST public log

-A POST public -3j POST public deny

-A POST public -j POST public allow

—-A PREROUTING ZONES -i ensl60 -g PRE public
—-A PREROUTING ZONES -g PRE public

-A PRE public -j PRE public log

-A PRE public -j PRE public deny
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-A PRE public -j PRE public allow

COMMIT

# Completed on Tue Jan 27 13:28:25 2015
# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015
*mangle

:PREROUTING ACCEPT [94235:148159541]
:INPUT ACCEPT [94155:148151187]

:FORWARD ACCEPT [0:0]

:OUTPUT ACCEPT [43012:2796100]
:POSTROUTING ACCEPT [43027:2798919]
:FORWARD direct - [0:0]

:INPUT direct - [0:0]

:OUTPUT direct - [0:0]

:POSTROUTING direct - [0:0]

:PREROUTING ZONES - [0:0]

: PREROUTING ZONES SOURCE - [0:0]
:PREROUTING direct - [0:0]

:PRE public - [0:0]

:PRE public allow - [0:0]

:PRE public deny - [0:0]

:PRE public log - [0:0]

—-A PREROUTING -j PREROUTING direct

-A PREROUTING -j PREROUTING ZONES SOURCE
—-A PREROUTING -j PREROUTING ZONES

-A INPUT -3 INPUT_direct

-A FORWARD -j FORWARD direct

-A OUTPUT -3j OUTPUT direct

—-A POSTROUTING -3j POSTROUTING direct

-A PREROUTING ZONES -i ensl60 -g PRE_publiC
-A PREROUTING ZONES -g PRE_publiC

-A PRE public -j PRE public log

-A PRE public -j PRE public deny

-A PRE public -j PRE public allow

COMMIT

# Completed on Tue Jan 27 13:28:25 2015
# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015
*security

: INPUT ACCEPT [94003:148133781]

:FORWARD ACCEPT [0:0]

:OUTPUT ACCEPT [43012:2796100]

:FORWARD direct - [0:0]
:INPUT direct - [0:0]
:OUTPUT direct - [0:0]

—-A INPUT -j INPUT direct

-A FORWARD -j FORWARD_direct

-A OUTPUT -3j OUTPUT direct

COMMIT

# Completed on Tue Jan 27 13:28:25 2015
# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015
*raw

:PREROUTING ACCEPT [94236:148159577]
:OUTPUT ACCEPT [43012:2796100]

:OUTPUT direct - [0:0]

:PREROUTING direct - [0:0]
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—-A PREROUTING -j PREROUTING direct

-A OUTPUT -
COMMIT
# Completed

# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015

*filter
:INPUT DROP

j OUTPUT direct

on Tue Jan 27 13:28:25 2015

[0:0]

: FORWARD ACCEPT [0:0]

:OUTPUT ACCEPT [0:0]

: FORWARD IN ZONES - [0:0]

: FORWARD IN ZONES SOURCE - [0:0]
: FORWARD OUT ZONES - [0:0]

: FORWARD OUT ZONES SOURCE - [0:0]

: FORWARD di
:FWDI publi
:FWDI publi
:FWDI publi
:FWDI publi
:FWDO publi
:FWDO publi
:FWDO publi
:FWDO publi
:INPUT ZONE
: INPUT ZONE
:INPUT dire
:IN public

:IN public
:IN public
:IN public
:OUTPUT dir
—-A INPUT -m
-A INPUT -i
-A INPUT -j
-A INPUT -7
-A INPUT -j
-A INPUT -p
-A INPUT -j
—-A FORWARD

—-A FORWARD

—-A FORWARD

—-A FORWARD

—-A FORWARD

—-A FORWARD

—-A FORWARD

—-A FORWARD

—-A FORWARD

-A OUTPUT -
-A FORWARD _
-A FORWARD

rect = [0:0]
c - [0:0]
c _allow - [0:0]
c deny - [0:0]
c log - [0:0]
c - [0:0]
c allow - [0:0]
c deny - [0:0]
c log - [0:0]
S - [0:0]
S _SOURCE - [0:0]
ct = [0:0]
- [0:0]
allow - [0:0]
deny - [0:0]
log - [0:0]
ect - [0:0]

conntrack --ctstate RELATED,ESTABLISHED -3j ACCEPT
lo -j ACCEPT

INPUT direct

INPUT ZONES SOURCE

INPUT ZONES

icmp -3 ACCEPT

REJECT --reject-with icmp-host-prohibited
-m conntrack --ctstate RELATED, ESTABLISHED -3j ACCEPT
-i lo -j ACCEPT
-] FORWARD direct
-j FORWARD IN ZONES SOURCE
-] FORWARD IN ZONES
-j FORWARD OUT ZONES_SOURCE
-] FORWARD OUT ZONES
-p icmp -3 ACCEPT
-j REJECT --reject-with icmp-host-prohibited
J OUTPUT direct

IN ZONES -i ensl60 -g FWDI public

IN ZONES -g FWDI public

-A FORWARD OUT_ ZONES -0 ensl60 -g FWDO public
-A FORWARD OUT ZONES -g FWDO public

-A FWDI pub
-A FWDI pub
-A FWDI pub

lic -j FWDI public log
lic -j FWDI public deny
lic -j FWDI public allow
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5509 -A FWDO public -3j FWDO public log

5510 -A FWDO public -j FWDO public deny

5511 -A FWDO public -j FWDO public _allow
5512 -A INPUT ZONES -i ensl160 -g IN public
5513 -A INPUT ZONES -g IN public

5514 -A IN public -j IN public log

5515 -A IN public -j IN public deny

5516 -A IN public -j IN public allow

5517 -A IN public allow -p tcp -m tcp --dport 22 -m conntrack --ctstate NEW -j
5518 ACCEPT

5519 comMIT

5520 # Completed on Tue Jan 27 13:28:25 2015
5521

5522  17.14.5 Password_auth-ac File Contents

5523  #%PAM-1.0

5524 # This file is auto-generated.

5525 # User changes will be destroyed the next time authconfig is run.
5526 auth required pam env.so

5527 auth sufficient pam unix.so nullok try first pass

5528 auth [default=die] pam faillock.so authfail deny=3 unlock time=604800
5529 fail interval=900

5530 auth required pam faillock.so authsucc deny=3 unlock time=604800
5531 fail interval=900

5532 auth requisite pam succeed if.so uid >= 1000 quiet success

5533 auth required pam deny.so

5534

5535 account required pam unix.so

5536 account sufficient pam localuser.so

5537 account sufficient pam succeed if.so uid < 1000 quiet

5538 account required pam permit.so

5539

5540 password requisite pam pwquality.so try first pass local users only
5541 retry=3 authtok type=

5542  password sufficient pam unix.so sha5l2 shadow nullok try first pass
5543  use authtok

5544  password required pam deny.so

5545

5546 session optional pam keyinit.so revoke

5547 session required pam limits.so

5548 -session optional pam systemd.so

5549 session [success=1 default=ignore] pam succeed if.so service in crond
5550 quiet use uid

5551 session required pam unix.so

5552

5553  17.14.6 rules_d-audi.rules File Contents
5554 # This file contains the auditctl rules that are loaded

5555 # whenever the audit daemon is started via the initscripts.
5556 # The rules are simply the parameters that would be passed
5557 # to auditctl.

5558

5559 # First rule - delete all

5560 -D
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5561

5562 # Increase the buffers to survive stress events.

5563 # Make this bigger for busy systems

5564 -b 320

5565

5566 # Feel free to add below this line. See auditctl man page
5567 # STIG Stuff Below

5568

5569  # audit time rules

5570 -a always,exit -F arch=b64 -S adjtimex -S settimeofday -S clock settime -k
5571 audit time rules

5572 -w /etc/localtime -p wa -k audit time rules

5573

5574  # audit account changes

5575 -w /etc/group -p wa -k audit account changes

5576 -w /etc/passwd -p wa -k audit account changes

5577 -w /etc/gshadow -p wa -k audit account changes

5578 -w /etc/shadow -p wa -k audit account changes

5579 -w /etc/security/opasswd -p wa -k audit account changes
5580

5581 # MAC-policy

5582 -w /etc/selinux -p wa -k MAC-policy

5583

5584 # export

5585 -a always,exit -F arch=b64 -S mount -F auid>=500 -F auid!=4294967295 -k
5586 export

5587 -a always,exit -F arch=b64 -S mount -F auid=0 -k export

5588

5589 # delete

5590 -a always,exit -F arch=b64 -S rmdir -S unlink -S unlinkat -S rename -S
5591 renameat -F auid>=500 -F auid!=4294967295 -k delete

5592 -a always,exit -F arch=b64 -S rmdir -S unlink -S unlinkat -S rename -S
5593 renameat -F auid=0 -k delete

5594

5595 # actions

5596 -w /etc/sudoers -p wa -k actions

5597

5598 # modules

5599 -w /sbin/insmod -p x -k modules

5600 -w /sbin/rmmod -p x -k modules

5601 -w /sbin/modprobe -p x -k modules

5602 -a always,exit -F arch=b64 -S init module -S delete module -k modules
5603

5604 # perm mod

5605 -a always,exit -F arch=b32 -S chmod -F auid>=500 -F auid!=4294967295 -k
5606 perm mod

5607 -a always,exit -F arch=b32 -S chmod -F auid=0 -k perm mod

5608 -a always,exit -F arch=b32 -S fchmod -F auid>=500 -F auid!=4294967295 -k
5609 perm mod

5610 -a always,exit -F arch=b32 -S fchmod -F auid=0 -k perm mod

5611 -a always,exit -F arch=b64 -S chmod -F auid>=500 -F auid!=4294967295 -k
5612 perm mod

5613 -a always,exit -F arch=b64 -S chmod -F auid=0 -k perm mod

284 | NIST Cybersecurity Practice Guide SP 1800-2c



5614
5615
5616
5617
5618
5619
5620
5621
5622
5623
5624
5625
5626
5627
5628
5629
5630
5631
5632
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5641
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5655
5656
5657
5658
5659
5660
5661
5662
5663
5664
5665
5666
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-a always,exit
perm mod
-a always,exit

-a always,exit
perm mod
-a always,exit
-a always,exit
perm mod
-a always,exit

-a always,exit
perm mod
-a always,exit
-a always,exit
perm mod
-a always,exit

-a always,exit
perm mod
-a always,exit
-a always,exit
perm mod
-a always,exit

-a always,exit
perm mod
-a always,exit
-a always,exit
perm mod
-a always,exit

-a always,exit

-F arch=b64 -S
-F arch=b64 -S
-F arch=b32 -S
-F arch=b32 -S
-F arch=b64 -S
-F arch=b64 -S
-F arch=b32 -S
-F arch=b32 -S
-F arch=b64 -S
-F arch=b64 -S
-F arch=b32 -S
-F arch=b32 -S
-F arch=b64 -S
-F arch=b64 -S
-F arch=b32 -S
-F arch=b32 -S
-F arch=b64 -S
-F arch=b64 -S

-F arch=b32 -S

auid!=4294967295 -k perm mod

-a always,exit
-a always,exit

-F arch=b32 -S
-F arch=bo6c4 -S

auid!=4294967295 -k perm mod

-a always,exit

-a always,exit
k perm mod
-a always,exit
-a always,exit
k perm mod
-a always,exit

-a always,exit
perm mod
-a always,exit
-a always,exit
perm mod
-a always,exit

-F arch=bo6c4 -S

-F arch=b32 -S
-F arch=b32 -S
-F arch=bo6c4 -S
-F arch=bo6c4 -S
-F arch=b32 -S
-F arch=b32 -S
-F arch=bo6c4 -S
-F arch=bo6c4 -S

fchmod -F auid>=500 -F auid!=4294967295 -k

fchmod -F auid=0 -k perm mod

fchmodat -F auid>=500
fchmodat -F auid=0 -k
fchmodat -F auid>=500
fchmodat -F auid=0 -k
fchown -F auid>=500 -F

fchown -F auid=0 -k
fchown -F auid>=500

fchown -F auid=0 -k

chown -F

chown -F
chown -F

chown -F

fchownat

fchownat
fchownat

fchownat

fremovexattr

fremovexattr
fremovexattr

fremovexattr
fsetxattr -F

fsetxattr
fsetxattr

-F
-F
fsetxattr -F
lchown -F

lchown -F
lchown -F

lchown -F
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auid>=500

auid=0 -k
auid>=500

auid=0 -k

auid>=500

auid=0 -k
auid>=500

auid=0 -k

pe
-F

pbe

-F

per
-F

per

-F auid>=500

-F auid=0 -k
-F auid>=500

-F auid=0 -k

-F auid>=

-F auid=0
-F auid>=

-F auid=0

auid>=500

auid=0 -k
auid>=500
auid=0 -k

-F

pbe
-F

re

-F auid!=4294967295 -k

perm mod
-F auid!=4294967295 -k

perm mod
auid!=4294967295 -k

rm_mod
auid!=4294967295 -k

rm_mod
auid!=4294967295 -k

m_mod
auid!=4294967295 -k

m_mod
-F auid!=4294967295 -k

perm mod
-F auid!=4294967295 -k

perm mod
500 -F
-k perm mod
500 -F
-k perm mod
-F auid!=4294967295 -
perm mod
-F auid!=4294967295 -
perm mod
auid!=4294967295 -k
rm_mod
auid!=4294967295 -k
rm_mod
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5667 -a always,exit -F arch=b32 -S lremovexattr -F auid>=500 -F

5668 auid!=4294967295 -k perm mod

5669 -a always,exit -F arch=b32 -S lremovexattr -F auid=0 -k perm mod
5670 -a always,exit -F arch=b64 -S lremovexattr -F auid>=500 -F

5671 auid!=4294967295 -k perm mod

5672 -a always,exit -F arch=b64 -S lremovexattr -F auid=0 -k perm mod
5673

5674 -a always,exit -F arch=b32 -S lsetxattr -F auid>=500 -F auid!=4294967295 -
5675 k perm mod

5676 -a always,exit -F arch=b32 -S lsetxattr -F auid=0 -k perm mod

5677 -a always,exit -F arch=b64 -S lsetxattr -F auid>=500 -F auid!=4294967295 -
5678 k perm mod

5679 -a always,exit -F arch=b64 -S lsetxattr -F auid=0 -k perm mod

5680

5681 -a always,exit -F arch=b32 -S removexattr -F auid>=500 -F auid!=4294967295
5682 -k perm mod

5683 -a always,exit -F arch=b32 -S removexattr -F auid=0 -k perm mod

5684 -a always,exit -F arch=b64 -S removexattr -F auid>=500 -F auid!=4294967295
5685 -k perm mod

5686 -a always,exit -F arch=b64 -S removexattr -F auid=0 -k perm mod

5687

5688 -a always,exit -F arch=b32 -S setxattr -F auid>=500 -F auid!=4294967295 -k
5689 perm mod

5690 -a always,exit -F arch=b32 -S setxattr -F auid=0 -k perm mod

5691 -a always,exit -F arch=b64 -S setxattr -F auid>=500 -F auid!=4294967295 -k
5692 perm mod

5693 -a always,exit -F arch=b64 -S setxattr -F auid=0 -k perm mod

5694

5695  17.14.7 Sysctl.conf Files Contents

5696 # System default settings live in /usr/lib/sysctl.d/00-system.conf.
5697 # To override those settings, enter new settings here, or in an
5698 /etc/sysctl.d/<name>.conf file

5699 #

5700 # For more information, see sysctl.conf(5) and sysctl.d(5).

5701 net.ipvd.ip forward = 0

5702 net.ipv4.conf.all.accept source route = 0
5703 net.ipvéd.conf.all.accept redirects = 0

5704 net.ipv4.conf.all.secure redirects = 0

5705 net.ipv4.conf.all.log martians = 1

5706 net.ipv4.conf.default.accept source route = 0

5707 net.ipv4.conf.default.secure redirects = 0
5708 net.ipvéd.conf.default.accept redirects = 0
5709 net.ipv4.icmp echo ignore broadcasts = 1

5710 net.ipv4.icmp ignore bogus error responses = 1
5711 net.ipvéd.tcp syncookies =1

5712 net.ipvd.conf.all.rp filter = 1

5713 net.ipv4.conf.default.rp filter = 1

5714 net.ipvé6.conf.default.accept redirects =
5715 net.ipvéd.conf.default.send redirects = 0

5716 net.ipv4.conf.all.send redirects = 0
5717

0
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5751

5752
5753
5754
5755
5756
5757
5758
5759
5760
5761
5762
5763
5764
5765
5766
5767
5768
5769
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17.14.8 system-auth File Contents

#%$PAM-1.0

# This file is auto-generated.

# User changes will be destroyed the next time authconfig is run.
auth required pam env.so

auth sufficient pam unix.so try first pass

auth [default=die] pam faillock.so authfail deny=3 unlock time=604800
fail interval=900

auth required pam faillock.so authsucc deny=3 unlock time=604800
fail interval=900

auth requisite pam succeed if.so uid >= 1000 quiet success

auth required pam deny.so

account required pam unix.so

account sufficient pam localuser.so

account sufficient pam succeed if.so uid < 1000 quiet
account required pam permit.so

password required pam cracklib.so retry=3 minlen=14 dcredit=-1 ucredit=-1
ocredit=-1 lcredit=-1 difok=4

password requisite pam pwquality.so try first pass local users only
retry=3 authtok type=

password sufficient pam unix.so shab5l2 shadow try first pass use authtok
password required pam deny.so

session optional pam keyinit.so revoke

session required pam limits.so

-session optional pam systemd.so

session [success=1 default=ignore] pam succeed if.so service in crond
quiet use uid

session required pam unix.so

session required pam lastlog.so showfailed

session required pam limits.so

17.14.9 system-auth-ac File Contents

#%$PAM-1.0

# This file is auto-generated.

# User changes will be destroyed the next time authconfig is run.
auth required pam env.so

auth sufficient pam unix.so try first pass

auth [default=die] pam faillock.so authfail deny=3 unlock time=604800
fail interval=900

auth required pam faillock.so authsucc deny=3 unlock time=604800
fail interval=900

auth requisite pam succeed if.so uid >= 1000 quiet success

auth required pam deny.so

account required pam unix.so

account sufficient pam localuser.so

account sufficient pam succeed if.so uid < 1000 quiet
account required pam permit.so
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5770 password required pam cracklib.so retry=3 minlen=14 dcredit=-1 ucredit=-1
5771 ocredit=-1 lcredit=-1 difok=4

5772 password requisite pam pwquality.so try first pass local users only
5773 retry=3 authtok type=

5774  password sufficient pam unix.so shab5l2 shadow try first pass use_ authtok
5775 password required pam deny.so

5776

5777 session optional pam keyinit.so revoke

5778 session required pam limits.so

5779 -session optional pam systemd.so

5780 session [success=1 default=ignore] pam succeed if.so service in crond
5781 quiet use uid

5782 session required pam unix.so

5783 session required pam lastlog.so showfailed

5784 session required pam limits.so

5785

5786 17.15 BASELINE CENTOS 7 STIG COMPLIANCE

5787  Note the STIG compliance test is based on the CentOS 6 STIG compliance analysis. At the time
5788 this testing was completed the CentOS 7 STIG had not been published.

5789 Introduction

5790 Test Result

Result ID Profile I?nd Benchmark Bench.mark
time version
xccdf _org.open- (Default 2015- 2015-
scap_testresult_default- rofile) 03-11 03-11 embedded 1
profile P 12:25 | 12:26

5791  Target info

Targets Addresses Platform
e localhost.localdomain e 127.0.0.1 e o cpe:/o:redhat:enterprise_linux:6
e 10.32.2.59

e 0:0:0:0:0:0:0:1
fe80:0:0:0:250:56ff:fe89:5cab

5792 Score

system

urn:xccdf:scoring:default 96.65 100.00 96.65%

5793 Results overview
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5794  Rule Results Summary

. . not not not . .
pass fixed fail | error informational unknown total

selected | checked applicable

173 0 6 0 0 0 0 0 0 179

5795  17.15.1 Rule Results Summary

Title Result

Auditing must be enabled at boot by setting a kernel parameter. fail
The audit system must be configured to audit modifications to the systems Mandatory fail
Access Control (MAC) configuration (SELinux).

The system boot loader configuration file(s) must be owned by root. fail
The system boot loader configuration file(s) must be group-owned by root. fail
The system boot loader configuration file(s) must have mode 0600 or less permissive. fail
The system boot loader must require authentication. fail

5796
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5797
Acronym Literal Translation
AD Active Directory
CA Certificate authority (also used as shorthand for the name of the
company “CA Technologies”)
CIP Critical Infrastructure Protection
.CSV Comma-Separated Value
DISA Defense Information Systems Agency
DMz Demilitarized Zone
DoD Department of Defense
EMS Energy Management System
ICS Industrial Control System
I[dAM Identity and Access Management
IEMS RADiIFlow ICS/SCADA router configuration management software
ISE Identity Services Engine
iISIM Industrial Service Management Tool
IT Information Technology
JRE Java Runtime Environment
NAS Network Attached Storage
NCCoE National Cybersecurity Center of Excellence
NERC North American Electric Reliability Corporation
NIST National Institute of Standards and Technology
0S Operating System
oT Operational Technology
PACS Physical Access Control System
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Acronym Literal Translation

PLC Programmable Logic Controller

RAM Random Access Memory

RTU Remote Terminal Unit

SCADA Supervisory Control and Data Acquisition

STIG Security Technical Implementation Guideline

VLAN Virtual Local Area Network

VM Virtual Machine

VPN Virtual Private Network

WAR Web Application Archive
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